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Introduction

Linux is truly amazing when you consider how it originated and how it
continues to evolve. From its modest beginning as the hobby of one
person — Linus Torvalds of Finland — Linux has grown into a full-fledged
operating system with features that rival those of any commercial UNIX
operating system. To top it off, Linux — with all of its source code — is
available free of cost to anyone. All you have to do is download it from an
Internet site or get it on CDs or a DVD for a nominal fee from one of many
Linux CD vendors.

Linux certainly is an exception to the rule that “you get what you pay for.”
Even though Linux is free, it is no slouch when it comes to performance, fea-
tures, and reliability. The robustness of Linux has to do with the way it is
developed and updated. Many developers around the world collaborate to
add features. Incremental versions are continually downloaded by users and
tested in a variety of system configurations. Linux revisions go through
much more rigorous beta testing than any commercial software does.

Since the release of Linux kernel 1.0 on March 14, 1994, the number of Linux
users around the world has grown exponentially. Many Linux distributions —
combinations of the operating system with applications and installation
tools — have been developed to simplify the installation and use. Some
Linux distributions are commercially sold and supported, while many con-
tinue to be freely available.

Unlike many freely available software programs, Linux comes with extensive
online information on topics such as installing and configuring the operating
system for a wide variety of PCs and peripherals. A small group of hard-core
Linux users are expert enough to productively use Linux with the online
documentation alone. A much larger number of users, however, move to
Linux with some specific purpose in mind (such as setting up a Web server
or learning Linux). Also, a large number of Linux users use their systems at
home. For these new users, the online documentation is not easy to use, and
the documentation typically does not cover the specific uses of Linux that
the user may have in mind.

If you're beginning to use Linux, what you need is a practical guide that not
only gets you going with the installation and setup of Linux, but also shows
you how to use Linux for a specific task, such as setting up a Web server or
developing software. You may also want to try out different Linux distribu-
tions before settling on one that you like.
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About This Book

Accordingly, Linux All-in-One Desktop Reference For Dummies comes with a
DVD that includes seven different Linux distributions — Debian GNU/Linux
3.1r0, Fedora Core 5, Knoppix 4.0.2, MEPIS 3.3.1, SUSE Linux 10.0, Ubuntu
5.04, and Xandros 3.02 Open Circulation Edition — and the instructions to
install and use any of these distributions. (Hint: Use Knoppix Live CD directly
from this book’s DVD for a quick, no-risk Linux experience.)

About This Book

Linux All-in-One Desk Reference For Dummies gives you eight different quick-
reference guides in a single book. Taken together, these eight minibooks pro-
vide detailed information on installing, configuring, and using Linux.

What you’ll like most about this book is that you don’t have to read it
sequentially chapter by chapter, or for that matter, even the sections in a
chapter. You can pretty much turn to the topic you want and quickly get the
answer to your pressing questions about Linux, be it about using the
OpenOffice.org word processor or setting up the Apache Web server.

Here are some of the things you can do with this book:

4 Install and configure Linux — Debian, Fedora Core, Knoppix, MEPIS,
SUSE, Ubuntu, or Xandros — from the DVD-ROM included with the book.
(You can use Knoppix by simply booting from the DVD.)

4+ Connect the Linux PC to the Internet through a DSL or cable modem.
4+ Set up dialup networking with PPP.

4 Add a wireless Ethernet to your existing network.

4+ Get tips, techniques, and shortcuts for specific uses of Linux, such as

e Setting up and using Internet services: Web, Mail, News, FTP, NFS,
and DNS.

e Setting up a Windows server using Samba.
* Using Linux commands.
e Using Perl], shell, and C programming on Linux.

¢ Using the OpenOffice.org office suite and other applications that
come with Linux.

4+ Understand the basics of system and network security.

4+ Perform system administration tasks.
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Conventions Used in This Book

[ use a simple notational style in this book. All listings, filenames, function
names, variable names, and keywords are typeset in a monospace font for
ease of reading. I italicize the first occurrences of new terms and concepts
and then provide a definition right there. I show typed commands in bold-
face. The output of commands and any listing of files is shown in a mono-
space font.

What You Don’t Have to Read

Each mini reference book zeros in on a specific task area — such as using the
Internet or running Internet servers — and then provides hands-on instruc-
tions on how to perform a series of related tasks. You can jump right to a sec-
tion and read about a specific task. You don’t have to read anything but the
few paragraphs or the list of steps that relate to your question. Use the Table
of Contents or the Index to locate the pages relevant to your question.

You can safely ignore text next to the Technical Stuff icons as well as the
sidebars. However, if you are the kind of person who likes to know some of
the hidden details of how Linux works, by all means, dig into the Technical
Stuff icons and the sidebars.

Who Are You?

[ assume that you are somewhat familiar with a PC — you know how to turn
it on and off and you have dabbled a bit with Windows. Considering that
most new PCs come preloaded with Windows, this assumption is safe, right?
And you know how to use some of the Windows applications such as
Microsoft Office.

When installing Linux on your PC, you may want to retain your Windows 2000
or Windows XP installations. I assume you don’t mind shrinking the Windows
partition to make room for Linux. For this you can use the gtparted utility
included with Knoppix on this book’s companion DVD or invest in a good
disk-partitioning tool such as Symantec’s Norton PartitionMagic, available at
www . powerquest .com/partitionmagic. (No, I don’t have any connec-
tions with Symantec.)

[ also assume that you're willing to accept the risk that when you try to
install Linux, some things may not quite work. Problems can happen if you
have some uncommon types of hardware. If you are afraid of ruining your
system, try finding a slightly older spare Pentium PC that you can sacrifice
and then install Linux on that PC. Or simply run Knoppix directly from the
DVD included with this book.
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How This Book Is Organized

How This Book Is Organized

Linux All-in-One Desk Reference For Dummies has eight minibooks, each of
which focuses on a small set of related topics. If you're looking for informa-
tion on a specific topic, check the minibook names on the spine or consult
the Table of Contents.

This desk reference starts with a minibook that explains the basics of Linux
and guides you through the installation process (a very useful aspect of this
book because you typically do not purchase a PC with Linux pre-installed).
The second minibook serves as a user’s guide to Linux — it focuses on
exploring various aspects of a Linux workstation, including the GNOME and
KDE GUIs and many of the applications that come bundled with Linux. The
third minibook covers networking, and the fourth minibook goes into using
the Internet. The fifth minibook introduces system administration. The sixth
minibook turns to the important subject of securing a Linux system and its
associated network. The seventh minibook shows you how to run a variety
of Internet servers from mail to a Web server. The eighth and final minibook
introduces you to programming.

Here’s a quick overview of the eight books and what they contain:

Book I: Linux Basics: What is Linux? Understanding what’s new in the Linux
2.6 kernel. Installing, configuring, and troubleshooting different Linux distri-
butions (Debian, Fedora Core, Knoppix, MEPIS, SUSE, Ubuntu, and Xandros).
Taking Linux for a test drive.

Book II: Linux Desktops: Exploring GNOME and KDE. Using the shell (what’s
a shell anyway?). Navigating the Linux file system. Exploring the applications
such as multimedia software as well as the text editors (vi and emacs).

Book III: Networking: Connecting the Linux PC to the Internet through a
dialup connection or a high-speed always-on connection such as DSL or
cable modem. Configuring and managing TCP/IP networks, including wire-
less networks.

Book IV: Internet: Using various Internet services such as e-mail, Web surf-
ing, and reading newsgroups. Transferring files with FTP.

Book V: Administration: Performing basic system administration. Managing
user accounts and the file system. Installing applications. Working with
devices and printers. Using USB devices. Upgrading and customizing the
Linux kernel.

Book VI: Security: Understanding network and host security. Securing the
host and the network. Performing security audits.
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Sometimes, | use sidebars to highlight interest-  or give a little insightinto a related topic. If you're
ing, but not critical, information. Sidebars explain  in a hurry, you can safely skip the sidebars.
concepts you may not have encountered before

Sidebars

Book VII: Internet Servers: Managing the Internet services. Configuring the
Apache Web server. Setting up the FTP server. Configuring the mail and news
servers. Providing DNS. File sharing with NFS. Using Samba to set up a
Windows server.

Book VIII: Programming: Finding out the basics of programming. Exploring
the software development tools in Linux. Writing shell scripts. Learning C
and Perl programming.

Appendix: About the DVD: Summarizes the contents of the book’s compan-
ion DVD-ROM.

What's on the DUD?

The DVD contains seven Linux distributions — it’s a combined Fedora Core 4
and Knoppix DVD that contains a distros folder with ISO image files for
Debian, Knoppix, MEPIS, SUSE, Ubuntu, and Xandros, organized into individ-
ual folders. You may use the DVD in accordance with the license agreements
accompanying the software. To find out more about the contents of the DVD,
please consult the appendix.

Icons Used in This Book

0,
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Following the time-honored tradition of the All-in-One Desk Reference For
Dummies series, | use icons to help you quickly pinpoint useful information.
The icons include the following:

The Distribution Specific icon points out information that applies to specific
distributions — Debian, Fedora Core, Knoppix, MEPIS, SUSE, Ubuntu, and
Xandros — that this book covers.

The Remember icon marks a general, interesting fact — something that you
want to know and remember.
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The Tip icon marks things that you can do to make your job easier.

The Warning icon highlights potential pitfalls. With this icon, I'm telling you:
“Watch out! This could hurt your system!”

The Technical Stuff icon marks technical information that could be of inter-
est to an advanced user (or those aspiring to be advanced users).

Where to Go from Here

It’s time to get started on your Linux adventure. Take out the DVD and install
Linux — pick a distribution, any distribution (as long as it’s Debian, Fedora
Core, Knoppix, MEPIS, SUSE, Ubuntu, or Xandros). Then, turn to a relevant
chapter and let the fun begin. Use the Table of Contents and the Index to
figure out where you want to go. Before you know it, you’ll become an expert
at Linux!

[ hope you enjoy consulting this book as much as I enjoyed writing it!
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Chapter 1: Introducing Linux

In This Chapter

v+~ Explaining what Linux is
» Going over what Linux distributions typically include
+ Discovering what Linux helps you manage

v Getting started

Ibet you've heard about Linux. If you're wondering what exactly Linux is
and what it can help you do, this chapter is all about answering those
questions. Here I provide a broad picture of Linux and tell you how you can
start using it right away.

By the way, this book covers Linux for Intel 80x86 and Pentium processors
(basically any PC that can run any flavor of Windows).

What Is Linux?

You know that your PC is a bunch of hardware — things you can touch, like
the system box, monitor, keyboard, and mouse. The system box contains
the most important hardware of all — the central processing unit (CPU), the
microchip that runs the software (any program that tells the computer how
to do your bidding), which you actually can’t touch. In a typical Pentium 4
PC, the Pentium 4 microprocessor is the CPU. Other important hardware in
the system box includes the memory (RAM chips) and the hard drive — and
one program has to run all this stuff and get it to play nice: the operating
system.

The operating system is software that manages all the hardware and runs
other software at your command. You, the user, provide those commands by
clicking menus and icons or by typing some cryptic text. Linux is an operat-
ing system — as are UNIX, Windows 98, Windows 2000, and Windows XP.
The Linux operating system is modeled after UNIX; in its most basic, no-frills
form, the Linux operating system also goes by the name Linux kernel.

The operating system is what gives a computer — any computer — its per-
sonality. For example, you can run Windows 98 or Windows XP on a PC —
and on that same PC, you can also install and run Linux. That means that
depending on which operating system is installed and running at any partic-
ular time, the same PC can be a Windows 98, Windows XP, or Linux system.



10  what Is Linux?

Does Linux really run on any computer?

Linux runs on many different types of computer
systems — and it does seem able to run on
nearly any type of computer. Linus Torvalds and
other programmers originally developed Linux
for the Intel 80x86 (and compatible) line of
processors. Nowadays, Linux is also available
for systems based on other processors — such
as those with AMD’s 64-bit AMDG64 processors,
the Motorola 68000 family, Alpha AXPs, Sun
SPARCs and UltraSPARCs, Hewlett-Packard's

HP PA-RISC, the PowerPC and PowerPC64
processors, and the MIPS R4x00 and R5x00.
More recently, IBM has released its own ver-
sion of Linux for its S/390 and zSeries main-
frames. This book covers Linux for Intel 80x86
and Pentium processors. (These are known as
the 1A32 architecture processors, or 386,
because they support the instruction set of the
80386 processor.)

The primary job of an operating system is to load software (computer pro-
grams) from the hard drive (or other permanent storage) into the memory
and get the CPU to run those programs. Everything you do with your com-

puter is possible because of the operating system, so if the operating system

somehow messes up, the whole system freezes. You know how infuriating it
is when your favorite operating system — maybe even the one that came
with your PC — suddenly calls it quits just as you were about to click the
Send button after composing that long e-mail to your friend. You try the
three-finger salute (pressing Ctrl+Alt+Delete), but nothing happens. Then it’s
time for the Reset button (provided your computer’s builders were wise
enough to include one). Luckily, that sort of thing almost never happens
with Linux — it has a reputation for being a very reliable operating system.

In technical mumbo jumbo, Linux is a multiuser, multitasking operating

system. All this means is that Linux enables multiple users to log in, and
Linux can run more than one program at the same time. Nearly all operating
systems are multiuser and multitasking these days, but when Linux first

started in 1994, multiuser and multitasking were big selling points.

Linux distributions

A Linux distribution consists of the Linux kernel (the operating system) and
a collection of applications, together with an easy-to-use installation pro-
gram. By the way, most people just say Linux to refer to a specific Linux

distribution.

You find many Linux distributions, and each includes the standard Linux
operating system and the following major packages:
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4+ The X Window System: It’s the graphical user interface.

4 One or more graphical desktops: Among the most popular are GNOME
and KDE.

4+ A selection of applications: Linux programs come in the form of ready-
to-run software, but the source code (the commands we humans use to
tell the computer what to do) is included (or easily available), as is its
documentation.

Current Linux distributions include a huge selection of software — so
much that some distributions usually require multiple CD-ROMs or a
single DVD-ROM (which this book includes).

The development and maintenance of the Linux kernel, software packages in
a Linux distribution, and the Linux distributions themselves are organized as
open source projects. In a nutshell, open source means access to the source
code and the right to freely redistribute the software without any restrictions.
There’s a lot more to the definition than my succinct note. To find out more
details of what open source means and the acceptable open source licenses,
you can visit the Open Source Initiative Web site at www . opensource.org.

Table 1-1 lists a few major Linux distributions along with a brief description
of each. There are many more Linux distributions besides the ones I show in
Table 1-1.

To find out more about Linux distributions, visit DistroWatch.com at www .
distrowatch.com. At that Web site, you can read up on specific distribu-
tions as well as find links for ordering CDs or DVDs for specific distributions.

Table 1-1 Maijor Linux Distributions

Distribution Description

Debian GNU/Linux This noncommercial distribution started in 1993 and continues to
be a popular distribution with many volunteer developers around the
world contributing to the project. Debian is a huge distribution. The
binary packages alone require 14 CDs or 2 DVDs. However, if you
have an Internet connection, you can install a base system by using
a single Debian network install CD, available at www . debian.
org/CD/netinst. After you have installed the base Debian
system, you can install and upgrade Debian packages easily with
a package installer called apt -get where apt stands for the
Advanced Package Tool. Debian is available free of charge from
www . debian. org. Debianis the basis for several other recent
distributions including Knoppix, MEPIS, Ubuntu, and Xandros.

(continued)
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Table 1-1 (continued)

Distribution

Description

Fedora Core

This distribution is the successor to Red Hat Linux — the Linux distri-
bution from Red Hat. Fedora Core 1, released in November 2003, was
the successor to the Red Hat Linux 9. Fedora Core is freely available.
Fedora Core uses the Red Hat Package Manager (RPM) format for its
software packages. You can download Fedora Core fromhttp://
fedora.redhat.com.

Gentoo Linux

This is a noncommercial, source-based (meaning that all software is
provided in source code form) distribution that first appeared in 2002.
The installer provides some binary packages to get the Linux going,
but the idea is to compile all source packages on the user’s computer.
This makes it time consuming to build a full-fledged Gentoo system
with the latest graphical desktops, multimedia, and development tools
because all the packages have to be downloaded and compiled.
Gentoo Linux is freely available from www . gentoo . org.

Knoppix

This Live CD distribution is based on Debian and named after its
developer, Klaus Knopper, of Germany. Knoppix can be used as a
recovery tool (to fix problems with an already-installed Linux system)
because you can run Knoppix directly from the CD without having to
firstinstall it on the hard drive. The Knoppix CD stores software in
compressed format, and Knoppix decompresses the programs on the
fly. Using this approach, Knoppix can pack up to 2GB of software on
a CD. Knoppix uses the Debian package management. For informa-
tion on downloading Knoppix free of charge, visit the Knoppix Web
site at www . knopper .net/knoppix/index-en.html.

Linspire

This commerecial distribution was first released in 2002 under the
name LindowsQS. Linspire uses the Debian package format and offers
software download for a fee through what it calls the Click-N-Run
Web-based interface. You can download a Live CD version called
LindowsLive! via BitTorrent, a peer-to-peer, file-sharing system. For
more information about Linspire, visitwww . Linspire.com.

Mandriva Linux

This popular distribution began life as a 1998 release of Red Hat Linux
with an easy-to-use installer and with KDE as the default desktop.
Until recently, this distribution was called Mandrakelinux. Mandriva
Linux uses the Red Hat Package Manager (RPM) format for its soft-
ware packages. You can get the Mandriva Linux Download Edition

(a 3-CD/DVD set) at www . mandrivalinux. com. Click the
Download link for more information.

MEPIS Linux

This Debian-based Live CD distribution was first released in July
2003. It also includes a graphical installer that can be launched from
the Live CD to install MEPIS on the hard drive. MEPIS has good hard-
ware detection and it comes with Java and multimedia software,
which makes it popular. MEPIS uses the Debian package format.
You can download the SimplyMEPIS Live CD free of charge from
WWWwW.mepis.org.
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Distribution Description

Slackware Linux This is one of the oldest distributions, having been first released in
1992. Slackware uses compressed tar files for its packages and
provides a text-based installer with limited automatic detection of
hardware. You do all software configurations by editing text files.
Slackware is freely available from www . slackware. com.

SUSE Linux This commercial distribution switched to a community development
project called openSUSE in August 2005. SUSE Linux Open Source
Software (0SS) is now freely available, and the retail SUSE Linux is
based on the open source version. SUSE comes with the YaST instal-
lation and configuration tool. SUSE Linux uses RPM packages. The
openSUSE project provides the ISO image files for SUSE Linux
0SS from various mirror sites (see www . opensuse.org/
Download). Visit www . opensuse . org for more information
about SUSE Linux.

Ubuntu Linux This is a relatively new Debian-based, noncommercial Linux distribu-
tion that has become popular in a short time since its initial release in
2004. Ubuntu is available as both an install CD and a Live CD. Because
it's Debian based, you can install the basic desktop system from the
install CD and then use the apt—get tool to install other packages
as well as keep the system up to date. You can download Ubuntu free
of charge from www . ubuntulinux.org.

Xandros Desktop 0S  This distribution is the successor to Corel Linux and is based on
Debian. Xandros is aimed at first-time Linux users, with an installer
that can repartition the hard drive. The versatile Xandros File
Manager is a key selling point of Xandros. However, Xandros includes
some proprietary components that prevent redistribution. A limited
version of Xandros Desktop, called the Open Circulation Edition, is
available for free through BitTorrent. Visit www . xandros . com for
more information about Xandros.

As you can see from the brief descriptions in Table 1-1, some of the Linux
distributions, such as Knoppix and MEPIS, are in the form of Live CDs. A Live
CD (or Live DVD) includes a Linux kernel that you can boot and run directly
from the CD or DVD without having to first install it on your hard drive. Such
Live CD distributions can be handy if you want to try out a distribution
before you decide whether to install.

This book’s companion DVD works as a Knoppix Live DVD. You can run
Knoppix by simply booting your PC from the DVD and pressing Enter.

Many Linux distributions, such as SUSE Linux and Xandros Desktop, are
commercial products that you can buy online or in computer stores and
bookstores. If you have heard about open source and the GNU (GNU’s Not
UNIX) license, you may think that no one can sell Linux for profit. Luckily for
companies that sell Linux distributions, the GNU license — also called the
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GNU General Public License (GPL) — does allow commercial, for-profit dis-
tribution (but requires that the software be distributed in source-code form)
and stipulates that anyone may copy and distribute the software in source-
code form to anyone else. Several Linux distributions are available free of
charge under the GPL, which means that the publisher may include these
distributions on a DVD-ROM with this book and that you may make as many
copies of the DVD as you like.

Making sense of version numbers

The Linux kernel and each Linux distribution has its own version number.
Additional software programs (such as GNOME and KDE) that come with the
Linux distribution have their own version numbers as well. The version num-
bers for the Linux kernel and the Linux distributions are unrelated, but each
has particular significance.

Linux kernel version numbers

After Linux kernel version 1.0 was released on March 14, 1994, the loosely
knit Linux development community adopted a version-numbering scheme.
Version numbers such as 1.x.y and 2.x.y, where x is an even number, are con-
sidered the stable versions. The last number, y, is the patch level, which is
incremented as problems are fixed. For example, 2.6.14 is a typical, stable
version of the Linux kernel. Notice that these version numbers are in the
form of three integers separated by periods — Major.Minor.Patch — where
Major and Minor are numbers denoting the major and minor version num-
bers, and Patch is another number representing the patch level.

Version numbers of the form 2.x.y with an odd x number are beta releases
for developers only; they may be unstable, so you should not adopt such
versions for day-to-day use. For example, if you were to find version 2.7.5
of the Linux kernel, the 7 in the minor version number tells you it’s a beta
release. Developers add new features to these odd-numbered versions of
Linux.

You can find out about the latest version of the Linux kernel online at
www . kernel . org.

Distribution-specific version numbers

Each Linux distribution has a version number as well. These version num-
bers usually follow the format x.y, where x is the major version, and y is
the minor version.
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Nowadays, if the minor version number is 0, it’s simply dropped — as in
Fedora Core 4 and Fedora Core 5. Unlike with the Linux kernel version num-
bers, no special meaning is associated with odd- and even-numbered minor
versions. Each version of a Linux distribution includes specific versions of
the Linux kernel and other major components, such as GNOME, KDE, and
various applications.

The developers of active Linux distributions usually release new versions of
their distribution on a regular basis — every six to nine months or so. For
example, SUSE Linux 9.0 was released in October 2003; 9.1 was released in
April 2004; 9.2 came out in October 2004; 9.3 was released in April 2005; and
SUSE Linux 10.0 made its debut in October 2005. Typically, each new major
version of a Linux distribution provides significant new features.

Debian always has at least three releases at any time — stable, unstable, and
testing.

4+ Stable: Most users prefer this type of release because it is the latest offi-
cially released distribution.

4+ Unstable: This indicates that developers are working on this release.

4+ Testing: The release contains packages that have gone through some
testing but are not ready for inclusion in the stable release yet.

Linux Standard Base (LSB)

Linux has become important enough that there is a standard for Linux called
the Linux Standard Base (or LSB, for short). LSB is a set of binary standards
that should help reduce variations among the Linux distributions and pro-
mote portability of applications. The idea behind LSB is to provide applica-
tion binary interface (ABI) so that software applications can run on any Linux
(or other UNIX) systems that conform to the LSB standard. The LSB specifica-
tion references the POSIX standards as well as many other standards such as
the C and C++ programming language standards, the X Window System ver-
sion 11 release 6 (X11R6), and the Filesystem Hierarchy Standard (FHS). LSB
version 1.2 (commonly referred to as LSB 1.2) was released on June 28, 2002.
LSB 1.3 came out in January 2003, LSB 2.0 on August 30, 2004, LSB 3.0 on July
1, 2005, and LSB 3.1 was released on October 31, 2005.

The LSB specification is organized into two parts — a common specification
that remains the same across all types of processors and a set of hardware-
specific specifications, one for each type of processor architecture. For
example, LSB 1.2 has architecture-specific specifications for Intel 32-bit
(TA32) and PowerPC 32-bit (PPC32) processors. LSB 1.3 adds a specification
for the Intel 64-bit (IA64) architecture and IBM zSeries 31-bit (S390) and 64-
bit (§390X) processors, in addition to the ones for IA32 and PPC32. LSB 2.0
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added specification for the AMD 64-bit (AMD64 or X86_64) processors. The
current LSB specification — LSB 3.0 —supports seven processor architec-
tures: 1A32, 1A64, PPC32, PPC64 (64-bit PowerPC), S390, S390X, X86_64.

An LSB certification program exists. By now, several Linux distributions —
such as Red Hat Enterprise Linux 3 for x86, SUSE Linux 9.1, and Sun Java
Desktop System (JDS) 2 — are certified to be LSB 1.3 compliant, IA32 run-
time environments. Several others — such as Linpus 9.3, Mandrakelinux
Corporate Server 3.0, Novell Linux Desktop 9 for x86 with Service Pack 1,
SUSE Linux 9.2, and RAYS LX 1.0 (from Sun Wah Linux Limited) — are certi-
fied as LSB 2.0 compliant, IA32 runtime environment. SUSE Linux 10.0 is one
of the first LSB 3.0 compliant IA32 runtime environments. You can expect
more distributions to be LSB 3.0 certified in the near future.

To discover more about LSB, visit www.linuxbase.org. The latest list of
LSB-certified systems is available at

www . opengroup.org/lsb/cert/cert_prodlist.tpl

What a Linux Distribution Includes

A Linux distribution comes with the Linux kernel and a whole lot more soft-
ware. These software packages include everything from the graphical desk-
tops to Internet servers to programming tools to create new software. In
this section, I briefly describe some major software packages that come
bundled with typical Linux distributions. Without this bundled software,
Linux wouldn’t be as popular as it is today.

What is the GNU Project?

GNU is a recursive acronym that stands for else in source-code form. Users may, however,
GNU's Not UNIX. The GNU Project was have to pay for their individual copies of GNU
launched in 1984 by Richard Stallman to develop  software.

2 ol WD Le ppemin s, Tis The Free Software Foundation (FSF) is a tax-
EID [FRIREE CEVERCE n.early ey exempt charity that raises funds for work on the
WL cpmplete operating system except GNU Project. To find out more about the GNU
for the operating system kernel. All GNU soft- Project, visitts home pags at gnu. org
ware was distributed under the GNU General L L : '

You can find information about how to contact

Public License (GI.)L)'.GP.L esse_ntlally reqUITeS  +he Free Software Foundation and how to help
that the software is distributed in source-code .
the GNU Project.

form and stipulates that any user may copy,
modify, and distribute the software to anyone
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GNU software

At the heart of a Linux distribution is a collection of software that came from
the GNU Project. You get to know these GNU utilities only if you use your
Linux system through a text terminal — a basic command-line interface that
puts nothing much on-screen but a prompt at which you type in your com-
mands. (Or you could use a graphical window that mimics a text terminal
and still have use of GNU utilities.) The GNU software is one of the basic
parts of any Linux distribution.

As a Linux user, you may not realize the extent to which all Linux distribu-
tions rely on GNU software. Nearly all the tasks you perform in a Linux
system involve one or more GNU software packages. For example, the
GNOME graphical user interface (GUI) and the command interpreter (that
is, the bash) are both GNU software programs. By the way, the shell is the
command-interpreter application that accepts the commands you type

and then runs programs in response to those commands. If you rebuild

the kernel or develop software, you do so with the GNU C and C++ compiler
(which is part of the GNU software that accompanies Linux). If you edit text
files with the ed or emacs editor, you're again using a GNU software package.
The list goes on and on.

Table 1-2 lists some of the well-known GNU software packages that come
with most Linux distributions. I show this table only to give you a feel for all
the different kinds of things you can do with GNU software. Depending on
your interests, you may never need to use many of these packages, but
knowing they are there in case you ever need them is good.

Table 1-2 Well-Known GNU Software Packages

Software Package  Description

autoconf Generates shell scripts that automatically configure source-code
packages

automake Generates Makefile. infiles for use with autoconft

bash The default shell (command interpreter) in Linux

bc An interactive calculator with arbitrary precision numbers

Binutils A package that includes several utilities for working with binary files:

ar, as,gasp, gprof, 1d, nm, objcopy, objdump, ranlib,
readelf,size, strings,and strip

(continued)
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Table 1-2 (continued)
Software Package

Description

Coreutils

A package that combines three individual packages called Fileutils,
Shellutils, and Textutils and implements utilities such as chgrp,
chmod, chown, cp,dd, df,dir,dircolors,du, install,
1n,1ls,mkdir,mkfifo, mknod, mv, rm, rmdir, sync,
touch, vdir, basename, chroot, date, dirname, echo,
env, expr, factor, false, groups, hostname, id,
logname, nice, nohup, pathchk, printenv, printf,
pwd, seq, sleep, stty, su, tee, test, true, tty, uname,
uptime, users,who,whoami, yes, cut, join,nl, split,
tail,wc, and soon

GNUchess

A chess game

GNU C Library

For use with all Linux programs

cpio

Copies file archives to and from disk or to another part of the file
system

diff Compares files, showing line-by-line changes in several different
formats

ed A line-oriented text editor

emacs An extensible, customizable, full-screen text editor and computing
environment

Findutils A package thatincludes the £ind, locate, and xargs utilities

finger A utility program designed to enable users on the Internet to get
information about one another

gawk The GNU Project’s implementation of the awk programming
language

gcc Compilers for C, C++, Objective C, and other languages

gdb Source-level debugger for C, C++, and Fortran

gdbm A replacement for the traditional dbm and ndbm database libraries

gettext A set of utilities that enables software maintainers to internationalize
(that means make the software work with different languages such
as English, French, Spanish, and so on) a software package’'s user
messages

ghostscript An interpreter for the PostScript and Portable Document Format
(PDF) languages

ghostview An X Window System application that makes ghostscript
accessible from the GUI, enabling users to view PostScript or PDF
files in a window

The GIMP (The GNU Image Manipulation Program): An Adobe Photoshop-like
image processing program

GNOME Provides a graphical user interface (GUI) for a wide variety of tasks
that a Linux user may perform

gnumeric A graphical spreadsheet (similar to Microsoft Excel) that works in

GNOME
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Software Package

Description

grep package

Includes the grep, egrep, and fgrep commands that are used
to find lines that match a specified text pattern

groff A document-formatting system similarto trof £

gtk+ A GUI toolkit for the X Window System (used to develop GNOME
applications)

gzip A GNU utility for compressing and decompressing files

indent Formats C source code by indenting it in one of several different
styles

less A page-by-page display program similar to more, but with addi-
tional capabilities

libpng Alibrary for image files in the Portable Network Graphics (PNG)
format

mé An implementation of the traditional UNIX macro processor

make A utility that determines which files of a large software package
need to be recompiled, and issues the commands to recompile them

mtools A set of programs that enables users to read, write, and manipulate
files on a DOS file system (typically a floppy disk)

ncurses A package for displaying and updating text on text-only terminals

patch A GNU version of Larry Wall's program to take the output of di £ £
and apply those differences to an original file to generate the modi-
fied version

rcs (Revision Control System): Used for version control and management
of source files in software projects

sed A stream-oriented version of the ed text editor

Sharutils A package that includes shar (used to make shell archives out of
many files) and unshar (to unpack these shell archives)

tar A tape archiving program that includes multivolume support; the
capability to archive sparse files (files with big chunks of data that
are all zeros), handle compression and decompression, and create
remote archives; and other special features for incremental and full
backups

texinfo A set of utilities that generates printed manuals, plain ASCII text, and
online hypertext documentation (called info), and enables users to
view and read online info documents

time A utility that reports the user, system, and actual time that a process

uses

GUIs and applications

Face it — typing cryptic Linux commands on a terminal is boring. For
average users, using the system through a graphical user interface (GUI,
pronounced GOO-ee) — one that gives you pictures to click and windows
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(small w) to open — is much easier. This is where the X Window System, or
X, comes to the rescue.

X is kind of like Microsoft Windows, but the underlying details of how X
works are completely different from Windows. X provides the basic features
of displaying windows on-screen, but (unlike Microsoft Windows) it does not
come with any specific look or feel for graphical applications. That look and
feel comes from GUIs, such as GNOME and KDE, which make use of the X
Window System.

Most Linux distributions come with the X Window System in the form of
XFree86 or X.Org X11 — implementations of the X Window System for 80x86
systems. XFree86 and X.Org X11 work with a wide variety of video cards
available for today’s PCs.

Until early 2004, XFree86 from the XFree86 Project (www.xfree86.org) was
the most commonly used X Window System implementation for x86 systems.
However, around version 4.4, some changes to the XFree86 licensing terms
caused concerns to many Linux and UNIX vendors — they felt that the licens-
ing terms were no longer compatible with the GNU General Public License
(GPL). In January 2004, several vendors formed the X.Org Foundation

(www .x.org) to promote continued development of an open source X
Window System and graphical desktop. The first release of X.Org X11 uses
the same code that was used by XFree86 4.4, up until the time when the
XFree86 license changes precipitated the creation of X.Org Foundation.

As for the GUI, Linux distributions include one or both of two powerful GUI
desktops: KDE (K Desktop Environment) and GNOME (GNU Object Model
Environment). If both GNOME and KDE are installed on a PC, you can choose
which desktop you want as the default — or switch between the two. KDE
and GNOME provide desktops similar to those of Microsoft Windows and
the Mac OS. GNOME also comes with the Nautilus graphical shell that makes
finding files, running applications, and configuring your Linux system easy.
With GNOME or KDE, you can begin using your Linux workstation without
having to know cryptic Linux commands. However, if you ever need to use
those commands directly, all you have to do is open a terminal window and
type them at the prompt.

Linux also comes with many graphical applications. The most noteworthy
program is The GIMP (GNU Image Manipulation Program), a program for
working with photos and other images. The GIMP’s capabilities are on a par
with Adobe Photoshop.

Providing common productivity software — such as word processing, spread-
sheet, and database applications — is an area in which Linux used to be lack-
ing. This situation has changed, though. Linux comes with the OpenOffice.org
office productivity applications. In addition, you may want to check out these
prominent, commercially available, office productivity applications for Linux
that are not included on this book’s companion DVD-ROM:
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4+ Applixware: This office package is a good example of productivity soft-
ware for Linux. You can find it at www.vistasource.com.

4+ StarOffice: From Sun Microsystems (www.sun.com/staroffice),
StarOffice is another well-known productivity software package.

4+ CrossOver Office: From CodeWeavers (www.codeweavers.com/
products/cxoffice), you can use CrossOver Office to install your
Microsoft Office applications (Office 97, Office 2000, and Office XP) as
well as several other Windows applications in Linux.

As you can see, there’s no shortage of Linux office applications that are com-
patible with Microsoft Office.

Networks

Linux comes with everything you need to use the system in networks so that
the system can exchange data with other systems. On networks, computers
that exchange data have to follow well-defined rules, or protocols. A network
protocol is a method that the sender and receiver agree upon for exchanging
data across a network. Such a protocol is similar to the rules you might
follow when you’re having a polite conversation with someone at a party.
You typically start by saying hello, exchanging names, and then taking turns
talking. That’s about the same way network protocols work. The two com-
puters use the same protocol to send bits and bytes back and forth across
the network.

One of the most well-known and popular network protocols is Transmission
Control Protocol/Internet Protocol (TCP/IP). TCP/IP is the protocol of choice
on the Internet — the “network of networks” that now spans the globe. Linux
supports the TCP/IP protocol and any network applications that make use of
TCP/IP.

Internet servers

Some popular network applications are specifically designed to deliver infor-
mation from one system to another. When you send electronic mail (e-mail)
or visit Web sites using a Web browser, you use these network applications
(also called Internet services). Here are some common Internet services:

4+ Electronic mail (e-mail) that you use to send messages to any other
person on the Internet using addresses like joe@someplace.com
4+ World Wide Web (or simply, Web) that you browse using a Web browser

4+ News services, where you can read newsgroups and post news items to
newsgroups with names such as comp.os.linux.networking or
comp.os.linux.setup
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+ File transfer utilities that you can use to upload and download files

4+ Remote login that you can use to connect to and work with another
computer (the remote computer) on the Internet — assuming you have
the required username and password to access that remote computer

Any Linux PC can offer these Internet services. To do so, the PC must be con-
nected to the Internet, and it must run special server software called Internet
servers. Each of the servers uses a specific protocol for transferring informa-
tion. For example, here are some common Internet servers that you find in
Linux:

4 sendmail is the mail server for exchanging e-mail messages between
systems using SMTP (Simple Mail Transfer Protocol).

4+ Apache httpd is the Web server for sending documents from one
system to another using HTTP (HyperText Transfer Protocol).

4+ vsftpdis the server for transferring files between computers on the
Internet using FTP (File Transfer Protocol).

4+ inndis the news server for distribution of news articles in a store-and-
forward fashion across the Internet using NNTP (Network News Transfer
Protocol).

4 in.telnetd allows a user on one system to log in to another system on
the Internet using the TELNET protocol.

4+ sshd allows a user on one system to securely log in to another system
on the Internet using the SSH (Secure Shell) protocol.

Software development

Linux is particularly well suited to software development. Straight out of the
bozx, it’s chock-full of software-development tools such as the compiler and
libraries of code needed to build programs. If you happen to know UNIX and
the C programming language, you will feel right at home programming in
Linux.

As far as the development environment goes, Linux has the same basic tools
(such as an editor, a compiler, and a debugger) that you might use on other
UNIX workstations, such as those from IBM, Sun Microsystems, and Hewlett-
Packard (HP). What this means is that if you work by day on one of these
UNIX workstations, you can use a Linux PC in the evening at home to dupli-
cate that development environment at a fraction of the cost. Then you can
either complete work projects at home or devote your time to software you
write for fun and to share on the Internet.
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Just to give you a sense of Linux’s software-development support, here’s a Book |
list of various features that make Linux a productive software-development Chapter 1
environment:

4 GNU C compiler (gcc): Can compile ANSI-standard C programs.
4+ GNU C++ compiler (g++): Supports ANSI-standard C++ features.

4+ GNU compiler for Java (gcj): Can compile programs written in the Java
programming language.
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4 GNU make utility: Enables you to compile and link large programs.

4+ GNU debugger (gdb): Enables you to step through your program to find
problems and to determine where and how a program failed. (The failed
program’s memory image is saved in a file named core; gdb can exam-
ine this file.)

4+ GNU profiling utility (gprof): Enables you to determine the degree to
which a piece of software uses your computer’s processor time.

4+ Subversion, Concurrent Versions System (CVS) and Revision Control
System (RCS): Maintain version information and control access to the
source files so that two programmers don’t inadvertently modify the
same source file at the same time.

4+ GNU emacs editor: Prepares source files and even launches a compile-
link process to build the program.

4+ Perl: [s a scripting language that you can use to write scripts to accom-
plish a specific task, tying together many smaller programs with Linux
commands.

4+ Tool Command Language and its graphical toolkit (Tc1/Tk): Enable
you to build graphical applications rapidly.

4 Python: An interpreted programming language comparable to Perl and
Tcl. (For example, the Fedora Core installation program, called ana-
conda, is written in Python.)

4+ Dynamically linked, shared libraries: Allow your actual program files
to be much smaller because all the library code that several programs
may need is shared — with only one copy loaded in the system’s
memory.

Online documentation

As you become more adept at using Linux, you may want to look up informa-
tion quickly — without having to turn the pages of (ahem) this great book,
for example. Luckily, Linux comes with enough online information to jog
your memory in those situations when you vaguely recall a command’s
name but can’t remember the exact syntax of what you're supposed to type.
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Figure 1-1:
Online help
is available
from the GUI
desktops.

If you use Linux commands, you can view the manual page — commonly
referred to as the man page — for a command by using the man command.
(You do have to remember that command in order to access online help.)

You can also get help from the GUI desktops. Both GNOME and KDE desktops
come with help viewers to view online help information. Most distributions
include a help option in the desktop menu or a help icon on the desktop that
you can select to get online help. You can then browse the help information
by clicking the links on the initial help window. Figure 1-1 shows a typical
help window — this one from Ubuntu’s GNOME desktop.

Help Topics

Fle Edit Go Bookmarks Help

s

Help Topics

Help Topics

Desktop

Applications

Other Documentation
Manual Pages

About Ubuntu
A short description of Ubuntu 5.10

Ubuntu 5,10 Starter Guide
This document aims at answering guestions that are asked
frequently. It contains wiki entries from the ubuntu.com web
site, the mailing lists and all contribution that we received
through the Ubuntu Bugzilla.

What Linux Helps You Manage

As an operating system, Linux acts as the intermediary through which you —
as the “lord of the system” — manage all the hardware. The hardware includes
the system box, the monitor, the keyboard, the mouse, and anything else
connected to the system box. The catchall term peripheral refers to any
equipment attached to the system. If you use a laptop computer, all your
hardware is packaged into the laptop.

Inside that system box is the system’s brain — the microprocessor (Intel
Pentium 4, for example) or the CPU — that performs the instructions con-
tained in a computer program. When the microprocessor runs a computer
program, that program’s instructions are stored in the memory, or RAM.
RAM stands for random access memory. (That means that any part of the
memory can be accessed randomly — in arbitrary order.)
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The system box has another crucial component — the hard drive (or hard
disk, as it is sometimes called). The hard drive is the permanent storage
space for computer programs and data. It’s permanent in the sense that the
contents don’t disappear when you power off the PC. The hard drive is organ-
ized into files, which are in turn organized in a hierarchical fashion into direc-
tories and subdirectories (somewhat like organizing papers in folders inside
the drawers of a file cabinet).

To keep a Linux system running properly, you or someone else has to make
sure that the hardware is working properly and that the files are backed up
regularly. There is also the matter of security — making sure that only legiti-
mate people can access and use the system. These tasks are called system
administration.

If you use Linux at a big facility with many computers, a full-time system
administrator probably takes care of all system administration tasks. On the
other hand, if you run Linux on a home PC, you are the system administra-
tor. Don’t let the thought frighten you. You don’t have to know any magic
incantations or prepare cryptic configuration files to be a system administra-
tor. Most Linux distributions include many graphical tools that make system
administration a point-and-click job, just like running any other application.

Disks, CD-ROMs, and DUD-ROMs

Some Linux distributions come on a single DVD-ROM. After installation, the
Linux kernel and all the applications are stored on your hard drive — which
is where your PC looks first when you tell it to do something.

Typically, the hard drive is prepared to use Linux during the installation
process. After that, you usually leave the hard drive alone except to back up
the data stored there or (occasionally) to install new applications.

Using CD-ROMs or DVD-ROMs in Linux is easy. While you are logged in at the
GNOME or KDE desktop, just pop in a CD or DVD in the drive, and the system
should automatically detect the DVD/CD-ROM. Depending on the Linux distri-
bution, either a DVD/CD-ROM icon appears on the desktop or a file manager
automatically opens and displays the contents of the DVD/CD-ROM. If all else
fails, you can type a simple mount command to associate the DVD/CD-ROM
with a directory on your system. This whole process of accessing the files on
a CD or a DVD from Linux is called mounting the CD or the DVD.

Besides the hard drive and DVD/CD-ROM drive, of course, your PC may have
other drives, such as a floppy disk drive or a Zip drive, and using those disks
in Linux is also simple: You insert a disk and double-click the icon that repre-
sents the disk drive on the GUI desktop. Doing so mounts the disk so that
you can begin using it.

Book |
Chapter 1

xnur] Buionponuj



20 What Linux Helps You Manage

Peripheral devices

Anything connected to your PC is a peripheral device as are some compo-
nents (like sound cards) that are installed inside the system box. You can
configure and manage these peripheral devices in Linux.

One of the common peripherals is a printer, typically hooked up to the paral-
lel port of your PC. (Many distributions come with a graphical printer config-
uration tool that you can use to configure the printer.)

Another peripheral device that needs configuration is the sound card. Most
Linux distributions detect and configure sound cards, just as Windows does.
However, if Linux can’t detect the sound card correctly, you may have to run
a text mode or graphical tool to configure the sound card.

Linux configures other peripheral devices, such as the mouse and keyboard,
at the time of installation. You can pretty much leave them alone after
installation.

Nowadays, PCs come with the USB (Universal Serial Bus) interface; many
devices, including printers and scanners, plug into a PC’s USB port. One nice
feature of USB devices is that you can plug them into the USB port and unplug
them at any time — the device doesn’t have to be connected when you power
up the system. These devices are called hot plug because you can plug in a
device when the system is hot, meaning while it’s running. Linux supports
many hot plug USB devices. When you plug a device into the USB port, Linux
loads the correct driver and makes the device available to applications.

File systems and sharing

The whole organization of directories and files is called the file system. You
can, of course, manage the file system using Linux. When you browse the
files from the GNOME or KDE graphical desktop, you work with the familiar
folder icons.

QQN\BER A key task in caring for a file system is to back up important files. In Linux,
> you can use the tar program to archive one or more directories on a floppy
disk or a Zip drive. You can even back up files on a tape (if you have a tape
drive). If you have a CD or DVD burner, you can also burn a CD or DVD with
the files you want to back up or save for posterity.

Linux can also share parts of the file system with other systems on a net-
work. For example, you can use the Network File System (NFS) to share files
with other systems on the network. To a user on the system, the remote
system’s files appear to be in a directory on the local system.
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Linux also comes with the Samba package, which supports file sharing with Book |
Microsoft Windows systems. Samba makes a Linux system work just like a Chapter 1
Windows file or print server. You can also access shared folders on other
Windows systems on your network.

Network

Now that most PCs are either in a local area network (LAN) or connected to
the Internet, you need to manage the network as well. Linux comes with a
network configuration tool to set up the LAN. For connecting to the Internet
using a modem, there is usually a GUI Internet dialup tool.
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If you connect to the Internet using DSL (that’s the fast Internet connection
from the phone company) or cable modem, you need a PC with an Ethernet
card that connects to the cable or DSL modem. It also means that you have
to set up a local area network and configure the Ethernet card. But fortu-
nately, these steps are typically a part of Linux installation. If you want to do
the configurations later, you can by using a GUI network configuration tool.

Linux also includes tools for configuring a firewall, which is a protective
buffer that helps keep your system relatively secure from anyone trying to
snoop over your Internet connection. You can configure the firewall by using
iptables commands or by running a GUI firewall configuration tool.

Getting Started

Based on my personal experience in exploring new subjects, | prescribe a
four-step process to get started with Linux:

1. Install Linux on your PC

2. Configure Linux so that everything works to your liking

3. Explore the GUI desktops and the applications

4. Find out the details of specific subjects such as Internet servers
In the following sections, I explain this prescription a bit more.

Install

Microsoft Windows comes installed on your new PC, but Linux usually doesn’t.
So your first hurdle is to get Linux onto your PC.

After you overcome that initial human fear of the unknown, I'll bet you find
Linux fairly easy to install — but where do you get it in the first place? Well,
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Getting Started

the good news is that it’s free — available just for the downloading. For
example, you can visit the Linux Online Web site at www.1inux.org and
click the Download button.

Because a typical complete Linux distribution is huge — it takes up several
CDs or at least a single DVD — your best bet is to buy a book (such as this
one) that comes with Linux on a DVD-ROM. You can then do the installation
by following the instructions in the book.

Just to pique your curiosity, installation involves creating space on the hard
drive for both Windows and Linux. If you want to install a distribution that’s
in the form of ISO image file, you have to burn a CD or DVD (depending on
the size of the ISO image) for that distribution. Then you boot the PC with
that CD or DVD, which starts the Linux installation that creates the Linux
partitions and installs Linux software packages from the DVD. Along the way,
you configure many items — from the Ethernet card (if any) to the X Window
System.

Configure

When you finish installing Linux, the next step is to configure individual
system components (for example, the sound card and the printer) and
tweak any needed settings.

If you aren’t getting a graphical login screen, the X Window System may not
have been configured correctly during installation. You have to fix the X con-
figuration file for the GUI to work.

You may also want to configure your GUI desktop of choice — GNOME or
KDE or both. Each has configuration tools. You can use these tools to adjust
the look and feel of the desktop (background, title fonts, even the entire
color scheme).

After you're through with the configuration step, all the hardware on your
system and the applications should run to your liking.

Explore

With a properly configured Linux PC at your disposal, you are ready to
explore Linux itself. You can begin the exploration from the GUI desktop
that you get after logging in.

Explore the GUI desktops — GNOME and KDE — and the folders and files
that make up the Linux file system. You can also try out the applications
from the desktop. You find office and multimedia applications and Internet
applications to explore.
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Also try out the shell — open up a terminal window and type some Linux
commands in that window. You can also explore the text editors that work in
text mode. Knowing how to edit text files without the GU]I, just in case the
GUI is not available, is a good idea. At least you won’t be helpless.

Find out more

After you explore the Linux landscape and know what is what, you can then
dig in deeper and find out more about specific subject areas. For example,
you may be interested in setting up Internet servers. You can then learn the
details of setting up individual servers such as sendmail for e-mail, Apache
for a Web server, and the INN server for news.

You can choose to find out about many more areas, such as security, pro-
gramming, and system administration.

Of course, you can expect this step to go on and on, even after you have
your system running the way you want it — for now. After all, learning is a
lifelong journey:.

Bon voyage!
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Chapter 2: Installing Linux

In This Chapter

+~ Understanding the installation steps

»* Making a list of your PC’s hardware

v Trying out Knoppix from the DVD

v+ Burning CDs or DVDs for your distribution
1~ Setting aside hard drive space for Linux
v~ Installing Debian

v Installing Fedora Core

v~ Installing MEPIS

v~ Installing SUSE Linux

+~ Installing Ubuntu

v Installing Xandros Desktop

pCs come with Microsoft Windows pre-installed. If you want to use
Linux, you first have to install it.

This book comes with a DVD-ROM that contains several Linux distributions —
Debian, Fedora, Knoppix, MEPIS, SUSE, Ubuntu, and Xandros. Some are full
distributions, and a few are Live CDs that you can try without installing on the
hard drive. (Full distributions mean everything you need to install those distri-
butions, whereas Live CDs mean CDs from which you can directly boot Linux.)
The version of Xandros on the DVD is a limited version of Xandros Desktop
called the Open Circulation Edition. All you have to do to install or try any of
these distributions is follow the steps in this chapter.

You may feel a tad worried about installing a new operating system on your
PC because it’s a bit like brain surgery — or, rather, more like grafting a new
brain because you can install Linux in addition to Microsoft Windows. When
you install two operating systems like that, you can choose to start one or
the other as you power up the PC. The biggest headache in adding Linux to a
PC with Windows is creating a new disk partition — basically setting aside a



32 Following the Installation Steps

part of the hard drive for Linux. The rest of the installation is fairly routine —
just a matter of following the instructions. If you want to try any of the Live
CDs, you don’t have to do any disk partitioning, just boot your PC from the
Live CD. But most of all, just take a deep breath and exhale slooowwwly. You
have nothing to worry about because I explain everything in this chapter.

Following the Installation Steps

Installing any Linux distribution involves a number of steps. [ want to walk
you through them briefly, without the details. Then you can follow the
detailed steps for the specific distributions and install what you want from
this book’s companion DVD-ROM.

Before I explain the details of installing Linux, [ want to explain how I have
packed several Linux distributions on the DVD. Here’s the scoop on the
companion DVD:

4+ It’s a Fedora Core DVD together with Knoppix, which means you can
boot your PC from the DVD and either run Knoppix Live CD or install
Fedora Core directly from the DVD.

4 In addition to the Fedora Core files, the DVD contains a distros folder
within which there are several folders, one for each of the distributions —
Debian, Knoppix, MEPIS, SUSE, Ubuntu, and Xandros. In each folder, you
find that distribution’s ISO image files (an ISO image file contains the com-
plete contents and structure of a CD or a DVD). You have to burn these
ISO images onto CDs (or DVD, if an ISO image is meant for a DVD) before
using them to install that distribution.

4 SUSE is in the form of a Live DVD ISO image file that you can burn onto a
recordable DVD and use to run SUSE Linux on your PC without having to
install it on the hard drive.

Some Linux distributions require that you have quite a bit of information
about your PC’s hardware on hand before installation. If you plan to install
Debian, you should go ahead and gather information about your PC and

its peripheral components prior to starting the installation. Luckily, most
Linux installation programs can detect and work with most PC peripherals.
Nevertheless, it’s a good idea to figure out your PC’s hardware so that you
can troubleshoot in case something goes wrong with the installation.

The very first step is to burn the CD or DVD for your distribution unless you
plan to install Fedora Core or Knoppix. You can burn the CDs on any system
that has a CD/DVD burner. (You must have a DVD burner if you want to burn
a DVD, but a DVD burner can burn both CDs and DVDs.) Typically, if you
already have a Windows PC with a CD/DVD burner, you can simply use that
system to burn the CDs. Remember that you must have a DVD drive as well
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because you have to burn the CDs from this book’s companion DVD-ROM.
A PC with a DVD burner or a combination DVD-ROM and CD burner is ade-
quate for this task.

The second step is to make sure that your PC can boot from the DVD/CD
drive. Most new PCs can boot directly from the DVD/CD drive, but some PCs
may require intervention from you. Typically, the PC may be set to boot from
the hard drive before the DVD/CD drive, and you have to get into Setup to
change the order of boot devices.

To set up a PC to boot from the DVD drive, you have to go into Setup as the
PC powers up. The exact steps for entering Setup and setting the boot
device vary from one PC to the next, but typically they involve pressing a
key, such as F2. As the PC powers up, a brief message tells you what key to
press to enter Setup. When you’re in Setup, you can designate the DVD/CD
drive as the boot device. After your PC is set up to boot from the DVD/CD
drive, simply put the DVD or CD in the DVD/CD drive and restart your PC.

If you plan to try a Live CD distribution, such as MEPIS or Knoppix, the third
step is to boot your PC from the Live CD or DVD. Otherwise, the third step is
to make room for Linux on your PC’s hard drive. If you're running Microsoft
Windows, this step can be easy or hard, depending on whether you want to
replace Windows with Linux or keep both Windows and Fedora Core.

If you want to install Linux without removing (or disturbing) Windows, remem-
ber that your existing operating system — which is, I assume, Windows 95, 98,
Me, NT, 2000, or XP — uses the entire hard drive. That means you have to par-
tition (divide) the hard drive so that Windows can live on one part of it, and
Linux can live on the other. Doing so can be a scary step because you run the
risk of ruining the hard drive and wiping out whatever is on the drive.

To set aside space on your hard drive that the Linux installation program
can use, you should use a partitioning program to help you create the parti-
tion. If your PC runs Windows NT, 2000, or XP, you might want to invest in

a commercial hard drive partitioning product, such as Symantec’s Norton
PartitionMagic (www.powerquest .com/partitionmagic), which works
for Windows 95/98/Me systems as well. On the other hand, you can reparti-
tion your PC’s hard drive by simply booting Knoppix and then using a GUI
(graphical user interface) tool called QTParted that comes with Knoppix.

Note that the installers for some Linux distributions, such as SUSE and
Xandros Desktop, can automatically create partitions for Linux by reducing
the size of a Windows partition. In that case, you don’t need to use a tool
such as PartitionMagic or QTParted to shrink the size of the existing
Windows partition on your hard drive.
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Checking Your PC’s Hardware

After you set aside a hard drive partition for Linux, you can boot the PC from
the selected distribution’s CD and start the Linux installation. Quite a few
steps occur during installation, and they vary from one distribution to
another. When you've come this far, it should be smooth sailing. Just go
through the installation screens, and you're done in an hour or two. Most
installers bring up a GUI (some people pronounce it GOO-ee) and guide you
through all the steps. One key step during installation involves partitioning
the hard drive again, but this time, you simply use the extra partition you
created earlier. After a few configuration steps, such as setting up the net-
work and the time zone, you select the software packages to install and then
let the installer complete the remaining installation chores. Some distribu-
tions make it even easier and do away with the software selection step. They
install a default set of software packages.

At the end of the installation, you reboot the PC. When Linux runs for the
first time, you get a chance to perform some more configuration steps and
install additional software packages.

Checking Your PC's Hardware

If you're concerned that your PC may not be able to run Linux, here are
some of the key components of your PC that you need to consider before
you start the Linux installation:

4+ DVD drive: You must have a DVD drive (either DVD-ROM or DVD burner),
and the PC must be able to boot from that drive. (The exception: You can
order the installation CDs for Fedora Core using the coupon in the back
of this book.)

The exact model doesn’t matter. What matters is how the DVD drive con-
nects to the PC. Most new PCs have DVD drives that connect to the hard
drive controller (called IDE, for Integrated Drive Electronics, or ATA, for
AT Attachment). If you add an external DVD drive, it most likely con-
nects to the USB port. Any IDE/ATA or USB DVD drive works in Linux.

4+ Hard drives: Any IDE disk drive works in Linux. Another type of hard
drive controller is SCSI (Small Computer System Interface), which Linux
also supports. To comfortably install and play with Linux, you need
about 5GB of hard drive space. On the other hand, to try the Live CD
versions of Linux, such as Knoppix, you don’t need any space on the
hard drive.

4+ Keyboard: All keyboards work with Linux and the X Window System.

4+ Modem: If you plan to dial out to the Internet, you need a modem that
Linux supports. For software-based modems, called soft modems or win-
modems, you may have to download a driver from the manufacturer. (It
may or may not be freely available.)
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Monitor: The kind of monitor is not particularly critical except that it
must be capable of displaying the screen resolutions that the video card
uses. The screen resolution is expressed in terms of the number of pic-
ture elements (pixels), horizontally and vertically (for example, 1024 x
768). The installer can detect most modern monitors. If it doesn’t detect
your monitor, you can select a generic monitor type with a specific reso-
lution (such as 1024 x 768). You can also specify the monitor by its make
and model (which you can find on the back of the monitor).

Mouse: The installation program can detect the mouse. All types of
mouse (such as PS/2 or USB) work with Linux and the X Window System.

Network card: Not all PCs have network cards, but if yours does, the
installer can probably detect and use it. If you have problems, try to find
the make and model (such as Linksys LNE100TX Fast Ethernet Adapter)
so that you can search for information on whether Linux supports that
card.

Processor: A 400 MHz Pentium II or better is best. The processor speed,
expressed in MHz (megahertz) or GHz (gigahertz), is not that important
as long as it’s over 400 MHz. But the faster the better. Linux can run

on other Intel-compatible processors, such as AMD, Cyrix, and VIA
processors.

RAM: RAM is the amount of memory your system has. As with process-
ing speed, the more RAM, the better. You need 256MB to install both
Linux and the X Window System and to comfortably run a GUI desktop.

SCSI controller: Some high-performance PCs have SCSI controllers that
connect disk drives and other peripherals to a PC. If your PC happens to
have a SCSI controller, you might want to find out the make and model of
the controller.

Sound card: If your PC has a sound card and you want to have sound in
Linux, you have to make sure it’s compatible. You can configure the
sound card after successfully installing Linux.

Video card: Linux works fine with all video cards (also known as display
adapters) in text mode, but if you want the GUI, you need a video card
that works with the X Window System. The installer can detect a sup-
ported video card and configure the X Window System correctly.
However, if the installer cannot detect the video card, it helps if you
know the make and model of your video card.

Printer: In addition to this hardware, you also need to find out the make
and model of any printer you plan to use in Linux.

Many distributions, such as Debian GNU/Linux, work on any hardware that’s

compatible with the Linux kernel. For information on Linux-compatible hard-
ware, see www. t1dp.org/HOWTO/Hardware-HOWTO.
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To check whether your PC’s hardware is compatible with SUSE Linux, visit
the SUSE Linux Hardware Compatibility List at http://hardwaredb.
suse.de. For MEPIS, consult the MEPIS Hardware Database at www .mepis
lovers.org/hwdatabase. There is a hardware compatibility list for
Ubuntu at https://wiki.ubuntu.com//HardwareSupport/. For
Xandros Desktop, you can find the Hardware Compatibility list at www .
xandros.com/support/hcl.html.

Trying Out the Knoppix Live CD

\\3

Before you install anything, you'd find it worthwhile to try out Knoppix

(the K is silent) from the companion DVD. In addition to getting a feel for a
Linux desktop, you can perform a few additional pre-installation chores from
Knoppix. If you decide to install a distribution other than Fedora — Debian,
MEPIS, SUSE, Ubuntu, or Xandros — you can burn the CDs or DVDs from the
ISO image files provided on this book’s companion DVD. You can also use the
QTParted tool under Knoppix to make room for Linux on your hard drive.

To start Knoppix, follow these steps:

1. Boot your PC from this book’s companion DVD.

A boot: prompt appears. At this prompt, you can enter various com-
mands to control the boot process. In particular, you can type com-
mands to disable some types of hardware detection that may be causing
the installation to fail.

2. A few minutes later, you see the KDE GUI desktop that Knoppix uses.

You can now start using Knoppix.

If you try Knoppix on a laptop and it hangs after displaying a message about
probing SCSI (that’s the name of a type of interface), then reboot. When the
boot: prompt appears, type knoppix noscsi. That should get you through
the problem by telling Knoppix not to check for SCSI. For PCs that have
problems with ACPI (Advanced Configuration and Power Interface), type
knoppix acpi=off at the boot prompt. Press F3 at the boot prompt for a list
of Knoppix boot options.

After you get the Knoppix desktop, you can begin exploring Knoppix.
Consult Chapter 4 of this minibook for more information on trying out Linux.
If you want to use Knoppix to burn CDs or resize a hard drive partition, con-
sult the “Using Knoppix to burn CDs or DVDs” section and the “Resizing a
partition with QTParted in Knoppix” section in this chapter.

When you finish using Knoppix, choose Main Menu=>Logout and select
Restart Computer from the KDE End Session dialog box that appears. After
Knoppix shuts down, remove the DVD and press Enter.
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Burning CDs or DUDs from 1SO Images

\V

This book’s companion DVD includes Debian, MEPIS, SUSE, Ubuntu, and
Xandros distributions in the form of ISO images, organized into separate fold-
ers within the distros folder of the DVD. To install any of these distribu-
tions, you must first burn the selected distribution’s ISO images onto CD or
DVD, as the case may be. You can typically perform this step on a PC with a
CD/DVD burner, most likely while using Microsoft Windows because most
new PCs come with Windows pre-installed. Another option is to boot Knoppix
from the companion DVD and then burn the CD or DVD using Knoppix. I
describe these options in the next two sections.

Using a CD burner application

In Microsoft Windows, you can use a CD burner application, such as Nero, to
burn ISO images onto recordable CDs. If you don’t have a CD burner applica-
tion for Microsoft Windows, boot Knoppix from the DVD and choose Main
Menu>Multimedia>K3b from the GUI desktop to start the CD/DVD burning
application. The exact steps for burning a CD from an ISO image depends

on the CD burner application that you use. The general steps are as follows.
(Use the same instructions to burn a DVD, provided you have a DVD burner.)

1. Place the companion DVD-ROM into the PC’s DVD drive.

If your DVD drive is a combination DVD/CD burner, you have to first
copy the ISO image files of the Linux distribution from the DVD to the
PC’s hard drive so that you can use the same drive to burn the CDs.

2. Start the CD burner application.
3. From the CD burner application, open the image file.

The exact steps depend on the CD burner application. In K3b under
Knoppix, choose Tools=>CD=Burn CD Image from the menu. In other CD
burner applications, you typically do this by selecting File=>Open. From
the Open dialog box, select the ISO image file for the distribution. If you
are unsure, search the application’s online help for information on burn-
ing a CD from an ISO image.

. Place a blank, recordable CD in the CD burner.
5. Burn the ISO image onto the recordable CD.

™

Typically, the CD burner application has a toolbar button that you can
click to start burning the ISO image onto the blank CD.

6. If the distribution has more ISO images, repeat Steps 2 through 4 for
the remaining ISO images.

Live CD distributions come in a single ISO image that you can burn on a
single CD. Other distributions typically come in multiple ISO images, and
you have to burn each image file onto a separate CD.
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Using Knoppix to burn CDs or DUDs

If you have a DVD-ROM drive and a separate DVD/CD burner, you can boot
Knoppix from the companion DVD and then use Knoppix to burn the CD or
DVD. In this case, Knoppix works from the DVD-ROM drive, and you can still
burn CDs or DVDs on the separate DVD/CD burner.

After Knoppix boots, open a terminal window by clicking the terminal pro-
gram icon on the desktop panel. You can use the cdrecord command to
burn a CD and the growisofs command to burn a DVD.

Here are the steps to use cdrecord to burn an ISO image on a blank record-
able CD:

1. Type cdrecord -scanbus and look at the last part of the output starting
with the line scsibus0.

For example, here is the relevant part of that command’s output from a
PC with a DVD burner:

scsibus0:
0,0,0 0) 'SONY ' 'DVD RW DRU-800A ' 'KY0l' Removable

1)
2)
3)
4)
5)
6)
7)

* %k sk ok ok

[ NeleNeNeNe N}

Note the three comma-separated numbers for the DVD/CD burner that
you want to use. In this example, the numbers are 0, 0, 0. Use these
numbers with the dev option in the cdrecord command in Step 5.

2. Type cd /cdrom/distros to change directory to where the ISO files are
located on the DVD-ROM.

3. Use the cd command to change to the subdirectory for the distribu-
tion whose ISO file you want to burn on a CD. Type Is -1 to see the ISO
file’s name.

4. Place a blank recordable CD in the burner.

5. Type the following command to burn the CD, but replace filename.
iso with the name of the ISO image file for your distribution:

cdrecord -v -pad speed=1 dev=0,0,0 filename.iso

If the cdrecord command does not work, simply choose Main Menu=>
Multimedia=>K3b from the Knoppix desktop. This starts the K3b CD/DVD
burner application. You can then follow the instructions in the “Using a
CD burner application” section to burn the CD.
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Burning a DVD ISO image onto a recordable DVD is also simple. Here are the Book |
steps: Chapter 2

1. Type cdrecord -scanbus and look at the last part of the output starting

with the line scsibus0. z
D
For example, here is the relevant part of that command’s output from a =
PC with a DVD burner: <
scsibus0: g
0,0,0 0) 'SONY ' 'DVD RW DRU-800A ' 'KYO0l' Removable e

CD-ROM

1)
2)
3)
4)
5)
6)
7)

* %k sk ok ok %

O O OO o oo

Note the second column of numbers from 0 through 7 where the DVD
burner is listed. In this example, the DVD burner is at number 0. For this
number, use /dev/scd0 as the device name in the growisofs com-
mand in Step 5. Remember to change the 0 in the device name to what-
ever number corresponds to your DVD burner in the output of the
cdrecord -scanbus command.

2. Type cd /cdrom/distros to change directory to where the ISO files are
located on this book’s companion DVD.

You booted Knoppix from the DVD, so the DVD is still in the DVD-ROM
drive.

3. Use the cd command to change to the subdirectory for the distribu-
tion whose ISO file you want to burn on a CD. Type Is -1 to see the ISO
file’s name.

™

. Place a blank recordable DVD in the burner.

5. Type the following command to burn the DVD but replace filename.
iso with the name of the ISO image file for your distribution:

growisofs -dvd-compat -Z /dev/scdO=filename.iso
“&N\BER
& Most of the ISO images included on this book’s DVD are small enough to fit
on CDs. However, if you want, you can burn any CD ISO image on a DVD. The
ISO image for SUSE requires a DVD.

Setting Aside Space for Linux

In a typical Windows PC, Windows is sitting on one big partition, taking over
the whole hard drive. You want to shrink that partition and create room for
Linux. During Linux installation, the installation program uses the free space
for the Linux partitions.
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To try out any of the Live CD distributions — Knoppix or MEPIS — you don’t
have to repartition your hard drive. Just boot your PC from the Live CD and
you can start using these distributions. The MEPIS, SUSE, and Xandros
installers can nondestructively shrink a Windows partition (performing the
same task as a tool such as PartitionMagic), so you don’t need to perform
the repartitioning step beforehand. If you plan to install Fedora Core, Debian,
or any other Linux distribution on the hard drive, you have to repartition
your hard drive. If you want to resize the disk partition under Windows, you
can use Norton PartitionMagic (from Symantec) to resize and split disk parti-
tions in all Microsoft operating systems from Windows 95/98/Me to Windows
NT/2000/XP. It’'s a commercial product, so you have to buy it to use it. At the
time I'm writing this, the list price of Norton PartitionMagic 8.0 is $69.95

U.S. You can read about it and buy it at www . powerquest.com/
partitionmagic.

If you don’t already have PartitionMagic, no need to spend the money. Just
boot Knoppix from this book’s companion DVD and then use QTParted (a
GUI tool) to resize the Windows partitions. QTParted can resize NTFS parti-
tions used by Windows 2000 and XP.

Resizing the disk partition always involves the risk of losing all data on the
hard drive. Therefore, before you resize hard drive partitions using a disk
partitioning tool such as PartitionMagic, back up your hard drive. After
making your backup — and before you do anything to the partitions —
please make sure that you can restore your files from the backup.

Resizing a Windows patrtition using PartitionMagic
When you run PartitionMagic, it shows the current partitions in a window. If
you’re running Windows XP, your hard drive typically has two partitions:
one small, hidden partition that contains Windows XP installation files, and
a huge second NTFS partition that serves as the C: drive. You have to reduce
the size of the existing C: drive. Doing so creates unused space following that
partition. Then, during Linux installation, the installation program can create
new Linux partitions in the unused space.

To reduce the size of the Windows partition using PartitionMagic, follow
these steps:

1. In the partition map in PartitionMagic’s main window, right-click the
partition and choose Resize/Move from the context menu.
The Resize Partition dialog box appears.

2. In the Resize Partition dialog box, click and drag the right edge of the
partition to a smaller size.

For a large hard drive (anything over 10GB), reduce the Windows parti-
tion to 5GB and leave the rest for Fedora Core. If you have to live with a
smaller drive, try to create at least 4GB of space for Linux.
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3. Click OK and then click Apply to apply the changes. After
PartitionMagic has made the changes, click OK.

4. Reboot the PC.

You don’t have to do anything with the hard drive space left over after

41

shrinking the partition that used to be the C: drive. During installation, the
Linux installer uses that free space to install Linux.

Resizing a partition with OTParted in Knoppix

After Knoppix boots and the GUI desktop appears, follow these steps to

reduce the size of the Windows partition:

1. Choose Main Menu=>System=>QTParted from the Knoppix desktop.

The QTParted window appears, and the tool displays the drives it finds
on your PC. The first hard drive appears with a device name /dev/hda,

second one as

/dev/hdb, and so on.

2. Click the hard drive from the list of devices on the upper left side of
the QTParted window.

QTParted displays the drive’s information in the lower left side and

the partition information in the right side of the window, as shown in

Figure 2-1.
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3. From the list of partitions on the right, click the partition you want to

resize.
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Figure 2-2:
Resize a
hard drive
partition
from this
dialog box in
QTParted.

This would normally be the largest-sized partition (notice the Size
column in Figure 2-1). For Windows 2000 or XP, the partition type is
ntfs, as shown in the Type column in the list of partitions. In a typical

new PC, you should see two partitions — a smaller fat16 partition and

a large nt fs partition.
4. Choose Operations>Resize from the QTParted menu.

The Resize partition dialog box appears (see Figure 2-2).

Minimum Size; 13364 MB

Free Space Before: [0.00 Hime ~]

New Size: [T2000.00 Hve -]

Fras Space after: [6638.19 Hme +]

It Iz recommended to backup your data before do this DpQIQTIOM
QK | Cancel |

5. Type in a new size for the partition in the New Size text field (refer to

Figure 2-2) to create free space after that partition.

You should pick a size such that you get 4000MB or more free space

after the partition. You'll see the size of the free space in the Free Space

After field in the dialog box (see Figure 2-2).
6. Click OK to close the dialog box.

The hard drive partitions are not changed until you go through the next

step.

7. Choose Filec>Commit from the QTParted menu to put the partition
changes into effect.

Now the partition is changed and you have free space after the Windows

partition.

After you create free space on the hard drive for Linux, you can proceed to
install the Linux distribution of your choice using the CDs or DVD that you
have burned from the ISO image files provided on the companion DVD.

Installing Debian GNU/Linux

To install Debian (pronounced DEB-ee-un) GNU (some people say GUH-new)
/Linux, you first have to burn the CDs from the ISO images in the Debian



Installing Debian GNU/Linux 43

folder of the companion DVD (see the “Burning CDs or DVDs from ISO
Images” section, earlier in this chapter).

Note that the Debian installer does not install the X Window System. You
have to install X as a separate package after you finish installing the base
operating system.

Getting an overview of the installation

When you have the Debian CDs in hand, you are ready to install Debian
GNU/Linux. Before you dive into the installation, here is an overview of the
major steps in installing Debian:

1.

Before you begin the installation, remember to gather information about
your computer’s hardware because you may need to provide some
details if the Debian installer cannot detect some peripheral on your PC.

. Boot the PC from the Debian CD. After the PC boots, you see a boot

screen with a boot : prompt. You can press Enter to proceed, but if the
system hangs, you may need to reboot again and enter some boot
options such as linux acpi=off at the boot : prompt. The Linux kernel
then boots and starts the Debian installer.

3. Select the installation language.

4. Configure the network interface.

5. Create the hard drive partitions that will be used by Debian using the

10.

space you have freed up after shrinking the Windows partition. (See the
“Setting Aside Space for Linux” section in this chapter.) At a minimum,
you have to create a swap partition and a partition for the root file
system.

. Install and set up the base system, which includes the Linux kernel and

GNU utilities.

. Configure and install the GRUB boot loader so that it can start up Debian

as well as other operating systems installed on your hard drive.

. Reboot the PC to start the base Debian system and finish the configura-

tion steps — setting the time zone, setting the root password, and cre-
ating a normal user account, for example.

. Configure the Advanced Package Tool (APT) for further package installa-

tions. You have to identify sources such as the CDs (if you have them)
and Internet sites where Debian packages can be found. The installer
provides suggestions; all you have to do is select the sources.

Select software packages to install, including the desktop and various
servers.
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11. The installer either downloads the files from the Internet or gets what it
needs from the CD, installs all selected software, and then configures all
packages, including the X Window System. After completing the configu-
rations, the installer starts X and displays a graphical login screen.

After you install Debian GNU/Linux, you can use the apt-get command-line
tool to install other packages and even upgrade the entire distribution.

Completing the Debian installation

Start by inserting the first CD into your PC’s DVD/CD drive and then reboot
the PC. The PC boots from the CD and displays a screen that says Press F1
for help. It’s a good idea to press F1 and see the Help index, which tells
you what information you can get by pressing various function keys (from F1
through F10). Table 2-1 summarizes the help information that the function
keys provide.

Table 2-1 Function Keys at Debian Installer Boot Screen

Function Key What It Displays

F1 Help index

F2 What your PC must have in terms of memory and hard drive space for

installing Debian (at least 24MB of memory and 256MB hard drive
space for a minimal installation but this could change in the future)

F3 The ways you can boot Linux from the CD (for example, by typing linux
or expert or linux26 or expert26, with each loading a different kernel)

F4 An overview of the boot parameters you can enter and the details you
can get by pressing the function keys F5, F6, and F7

F5 Boot parameters for special machines, such as some IBM ThinkPads
and laptops with display problems

F6 Boot parameters for special disk controllers, such as Adaptec 151x,
152x, 1542, 274x, and 284x

F7 Boot parameters for use by the installer (For example, if you don't want

the installer to probe for USB, add the parameter debian-
installer/probe/usb=false.)

F8 Points you to www . debian. org and tells you how to get help

F9 Brief mention of the Debian project

F10 Information about copyrights and warranties that apply to Debian
GNU/Linux

After reading the help information, you can either press Enter to start or
type linux followed by any boot parameters, such as acpi=off, that you need
for your PC. After the Linux kernel loads, follow these steps to complete the
Debian GNU/Linux installation. (Make sure your PC has a broadband Internet
connection such as DSL or cable modem.)
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1. Select the language, the country or region, and the keyboard layout Book I
from the initial text mode screens. Chapter 2

Use the arrow keys to make your selection, and press Enter after each
selection. The installer then detects the hardware and loads compo-
nents of the Debian installer from the CD-ROM. Then the installer config-
ures the network with Dynamic Host Configuration Protocol (DHCP) and
prompts for a host name.
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2. Enter the host name for your computer.

The installer prompts for the domain name of your system and shows
the default in the text input field. (The default is what the installer gets
from the DHCP server.) You can simply press Enter to accept the default
domain name. Then the Debian installer starts the disk partitioning tool
that displays several options, as shown in Figure 2-3.

1 [11] Partition disks |

This installer can guide you through partitioning a disk for use hy
Debian, or if wou prefer, you can do it manually. If you do choose to
use the guided partitioning tool, you will still have a chance later

to see the results, customize 1t, and even undo the partitioning if
you do not like it.

Figure 2-3:

Debian Erase entire disk: IDEL master (hda) - 40.0 GB HDC WD400EB-11JEFD
. Manually edit partition table
installer

displays
these initial
disk
partitioning
options.

Partitioning method:

<Go Back:

3. If you have created free space for Debian, select the default choice
Use the Largest Continuous Free Space and press Enter.

If your hard drive already has partitions that you want to use for Debian,
select the Manually Edit Partition Table option and press Enter. The
installer displays further options together with the list of existing parti-
tions, as shown in Figure 2-4.
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Figure 2-4:
You can
manually
edit disk
partitions
from this
screen.

You can click one of the partitions and then edit its characteristics —
what file system to use, for example — and select a mount point for the
partition. When you’re done, you can finish partitioning and write the
partition table to the hard drive. (See Figure 2-5.)

Figure 2-5:
When
you're done,
write the
partition
table to the
hard drive.

The installer warns you that data on the selected partitions will be
destroyed, and after you select Yes, it completes the partitioning and
begins installing the base system.
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After installing the base operating system, the installer detects other
operating systems on any of the disk partitions and recommends
installing the GRUB boot loader on the hard drive’s first sector, called
the master boot record (MBR).

. Install the GRUB boot loader and reboot the PC.

The installer finishes installing the boot loader. Then it ejects the CD and
reboots the PC. When the PC reboots, Debian starts and guides you
through a number of configuration steps.

. Select the time zone and indicate if the PC’s hardware clock is set to

Greenwich Mean Time (GMT).
The answer is usually no.
Enter the root (the superuser) password.

Set up a normal user account by entering the requested information:
the username, the full name, and the password.

Configure APT by indicating sources from which you want Debian to
download software packages.

You have to pick a country and a server in that country identifying the
FTP and Web repositories containing the Debian packages. If your PC is
behind an HTTP proxy, you can specify the proxy as well. (If not, just
ignore this part.) Later on, you can use the apt-get command to install
or update various software packages that are available in the Debian
format. You can also identify a CD as a source of Debian packages, but
you can always get the latest software if you identify a server as the
source.

. Select the software packages to install.

Move the cursor using up- and down-arrow keys and press the spacebar
to select or deselect a package. You can pick from preconfigured pack-
ages that include: Desktop environment, Web server, Print server, DNS
server, File server, Mail server, and SQL database. You can also select
packages manually.

If you select the Desktop environment package, you get the X Window
System and the GNOME desktop.

After finishing selections, press Tab to highlight OK and then press
Enter.

The installer then begins to download and install the selected packages.
With a broadband cable or DSL connection to the Internet, this step may
take about an hour to complete.

Answer configuration questions as the installer prompts for informa-
tion to configure the software packages it has downloaded and
installed.
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The XFree86 package (the X Window System) is one of the packages the
installer configures. After finishing all the configurations, the installer
starts X, and you get a graphical login prompt.

11. Log in at the graphical login screen.
By default, the Debian installer installs the GNOME Desktop Manager
(gdm), which starts the GNOME desktop.

That’s it! You have Debian up and running now. You can explore it at your
leisure and install more software packages as you need them and as you
become more knowledgeable about Debian.

Installing Fedora Core

To install Fedora Core, insert this book’s companion DVD in the DVD drive
and restart your PC. (In Windows, choose Start=>Shutdown and then select
Restart from the dialog box.) If you use CDs, the installation steps are the
same as that for the DVD except that you have to swap CDs when prompted
by the installation program.

If your PC isn’t already set to boot from the DVD drive, you have to get into
Setup to change the order of boot devices.

After your PC powers up, it loads the Linux kernel from the DVD, and the
Linux kernel starts running the Fedora Core installation program. For the
rest of the installation, you work with the installation program’s GUI screens.

After a few moments, the text screen displays a Welcome message and a
boot: prompt. The Welcome message tells you that help is available by
pressing one of the function keys F1 through F5. To start installing Fedora
Core immediately, press Enter. You can also type in other options at the
boot: prompt. For example, if you think the DVD might be corrupted, type
linux mediacheck and press Enter to test the DVD media for any problems.
After the media check, you can continue with the installation.

Installing Fedora Core from the companion DVD-ROM on a fast (400 MHz
or better) Pentium PC takes about an hour or so, if you install nearly all
packages.

The Fedora Core installation program probes — attempts to determine the
presence of — specific hardware and tailors the installation steps accord-
ingly. For example, if the installation program detects a network card, the
program automatically displays the screens needed to configure your PC to
work with the network in Linux. You may see a different sequence of screens
from what I show in the following sections; the exact sequence depends on
your PC’s specific hardware configuration.
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If you run into any problems during the installation, turn to Chapter 3 of this
minibook. That chapter shows you how to troubleshoot common installation
problems.

Selecting keyboard and installation type

In this first phase of the installation, you go through a number of steps
before moving on to create the disk partitions for Fedora Core. Here are the
steps in the first phase:

1. Select the language you want from the list of languages on-screen, and
then click Next to proceed to the next step.

Each screen has online help available on the left side of the screen. You
can read the Help message to find out more about what you’re supposed
to do in a specific screen.

After you select the language, the installer displays a list of keyboard
layouts.

2. Select a keyboard layout suitable for your language’s character set
(for example, U.S. English in the United States) and click Next.

The installation program displays a screen asking whether you want to
install a new system or upgrade an older Fedora Core installation.

3. For a new Fedora Core installation, click Install and select the installa-
tion type.

For a new installation, you have to select one of the following installa-
tion types — Personal Desktop, Workstation, Server, or Custom. The
Personal Desktop, Workstation, and Server installations simplify the
installation process by partitioning the hard drive in a predefined
manner. The Personal Desktop installation creates a Fedora Core system
with a graphical environment along with productivity applications.

A Workstation-class installation installs a graphical environment as well
as software development tools. This type of installation also deletes all
currently existing Linux-related partitions, creating a set of new parti-
tions for Linux.

A Server installation sets up all the Internet servers, such as Web server,
FTP server, and Mail server. By default, the Server installation does not
install the graphical environment, but you can always add the packages
for the GUI desktops.

For maximum flexibility, select the Custom installation. That way you
can select only the packages you want to try out.
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Figure 2-6:
Select an
automatic
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option from
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The next major phase of installation involves partitioning the hard drive for
use in Fedora Core.

Partitioning the hard drive for Fedora Core

The Fedora Core installer displays a screen (see Figure 2-6) where you indi-
cate how you want to partition the hard drive. If you click the current selec-
tion (shown with an up-down arrow to its right), the installer displays the
following options for partitioning and using the hard drive:

4+ Remove all Partitions on selected drives and create default layout:
This option causes the Fedora Core installer to remove all partitions,
including those used by other operating systems, such as Microsoft
Windows. Use this only if you want Fedora Core as the only operating
system for your PC. Do not select this option if you want to retain any
existing Windows partitions.

4+ Remove linux partitions on selected drives and create default layout:
This option causes the installer to remove only the existing Linux parti-
tions and to create new partitions for installing Fedora Core. You can use
this option if you already have any version of Linux installed on your PC
and want to wipe it out and install the latest version of Fedora Core.

4+ Use free space on selected drives and create default layout: If you cre-
ated space for Linux by using PartitionMagic or the QTParted utility,
select this option to create the Linux partitions using the free space on
the hard drive. If you install Fedora Core on a new PC after resizing the
partition, this option is the right one to choose.

fedorg(f e~ _-)_J

Installation recuires partificning of your hard dive, By celaulf,
a partitioning layout is chosen which is reasonable for mest
users, You can sither choose 1o use this or creale your own,

| Remove Fnux partitions on selected drives and create default layout.

Selact the dive(s) to use for this installation.
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4+ Create custom layout: If you have one or more hard drives with already
existing partitions, use this option to designate which partitions to use
for installing Fedora Core.

Select the appropriate option and click Next. For example, if you select the
second option, the Fedora Core installation program displays a dialog box to
confirm your choice and to point out that all data in the existing Linux parti-
tions will be lost. Click Yes to continue. The installation program shows the
partitions it has prepared, as shown in Figure 2-7. The exact appearance of
this screen depends on your hard drive’s current partitions.
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sl
104508 WA

New | | Edt | | Delee | | Reset | | map | | wm |
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the Fedora _| Hide RAII&).de;ic.;s’LVM Wolurne Group members .

Core

installer. [ Relmase Noles
This Disk Setup screen displays a list of disk drives and the current partition
information for one of the drives. If you want to accept these partitions as is,
click Next to proceed.

V?‘NNG! If your PC doesn’t have enough memory (typically less than 128MB), the
installer asks if it can write the partition table and activate the swap parti-

tion. After you do this, your hard drive partitions are changed. Click Yes only
if you are committed to the new partitions and definitely want to install
Fedora Core.

Settmq up key system parameters

With the disk partitioning out of the way, you're almost ready to begin
installing the software packages. First, the Fedora Core installer prompts
you to set up some key system parameters. Specifically, you have to do
the following:
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4 Install the boot loader
4+ Configure the network
4 Set the time zone

4+ Set the root password

You can go through these steps fairly quickly.

Installing the boot loader

The installer displays a screen from which you can install the GRUB boot
loader. (GRUB stands for GRand Unified Bootloader.) The boot loader is a tiny
program that resides on the hard drive and starts an operating system when
you power up your PC. If you have Microsoft Windows on your hard disk, the
installer should detect the Windows partition and configure the boot loader
to load Windows as well. You can view the boot loader configuration and
edit the settings from the boot loader configuration screen.

You can skip the boot loader installation entirely. However, if you choose not
to install any boot loader during Linux installation, you won’t be able to start
Linux when you reboot the PC even though Linux is installed on the hard
drive. You can boot only whatever the current boot loader is set up to load.

For greater security (so no one can boot your system without a password),
select the Use a Boot Loader Password check box. The installer displays a
dialog box in which you can specify a password for GRUB.

After making your selections, click Next to continue.

Configuring the network

Assuming that your PC has a network card and the Linux kernel detects that
card, the Fedora Core installer displays a Network Configuration screen (as
shown in Figure 2-8).

From this screen, you can set up your network card’s IP address (so other
PCs in the network can talk to your PC). This screen displays a list of the net-
work devices (for example, Ethernet cards) installed on your PC. For each
network device, you can indicate how the IP address is set. Click the Edit
button next to the list and a dialog box appears; there you can specify the
options.

You can specify the IP (Internet Protocol) address for the network card auto-
matically using DHCP, where your PC gets its I[P address and other network
information from a DHCP server. This is often the case if your PC is con-
nected to a DSL or cable modem router.



Figure 2-8:
Configure
the network
options from
this screen.
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Select DHCP only if a DHCP server is running on your local area network. If
you choose DHCP, your network configuration is set automatically, and you
can skip the rest of this section.

If you do not configure the network using DHCP, you have to provide an IP
address and other network information such as the IP addresses of the pri-
mary DNS and the secondary DNS (the name servers that translate machine
names such as www.amazon.com into IP addresses). Enter any needed
parameters and click Next to continue.

Setting the time zone

After completing the network configuration, select the time zone — the dif-

ference between the local time and the current time in Greenwich, England,
which is the standard reference time (also known as Greenwich Mean Time

or GMT as well as UTC or Universal Coordinated Time). The installer shows
you a GUI with a map from which you can select the time zone in terms of a
geographic location. After you select your time zone, click Next to continue.

Setting the root password

The installer displays the Set Root Password screen from which you can set
the root password. Earlier versions of the Fedora Core installer enabled you
to add one or more user accounts at this step, but with this version you get
a chance to add user accounts when you run Fedora Core for the first time.
(See Chapter 4 of this minibook.)
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The root user is the superuser in Linux — the one with permissions to do
anything in the system. You're better off reserving that account for your own
exclusive use. You need to assign a password that you can remember but
that others cannot guess easily. Make the password at least eight characters
long, include a mix of letters and numbers, and (for good measure) throw in
some special characters, such as + or *.

Type the password on the first line, and re-enter the password on the next
line. Each character in the password appears as an asterisk (*) on-screen.
Both entries must match before the installation program accepts your pass-
word. This feature ensures that a mistyped (or guessed) password doesn’t
work.

You must enter the root password before you can proceed with the rest of
the installation. After you have done so, click the Next button to continue
with the installation.

Selecting and installing the package groups

After you set up the key system parameters, the installer displays a screen
from which you can select Fedora Core package groups to install. After you
select the package groups, you can take a coffee break and let the Fedora
Core installation program get busy formatting the disk partitions and copy-
ing all your selected files to those partitions.

A package group is made up of several Fedora Core packages. Each Fedora
Core package, in turn, includes many files that make up specific software.

Figure 2-9 shows the screen with the list of package groups (in effect, the
software components) that you can choose to install. The left side of the
screen displays the categories of package groups and the right side displays
the package groups for the currently selected category. An icon, a descrip-
tive label, and a check box identify each package group.

Some package groups are already selected, as indicated by the check marks
in the check boxes. Think of the selected package groups as the minimal set
of packages recommended for installation. You can, however, choose to
install any or all of the components. Use the mouse to move up and down
in the scrolling list and click a check box to select or deselect that package
group.

P In an actual production installation of Fedora Core, you install exactly the
package groups you need. However, when you're trying to learn everything
about Fedora Core, you need many different packages. If you have enough
hard drive space (at least 6GB) for the Linux partition, select the Everything
package group to install all the package groups so that you can try all that
Fedora Core has to offer.



Figure 2-9:
Select the
package
groups to
install from
this screen.
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In addition to the package groups that you select from the screen shown in
Figure 2-9, the Fedora Core installer automatically installs a large number of
packages needed to run the Linux kernel and the applications you select.
Even if you don’t select a single package group from this screen, the installa-
tion program installs a plethora of packages (they’re all needed simply to
run the core Linux operating system) and a minimal set of utilities.

Each package group requires specific packages to run. The Fedora Core
installation program automatically checks for any package dependencies
and shows you a list of any required packages you haven’t selected. In this
case, install the required packages.

After you select the package groups you want to install, click Next to
continue.

The installer then displays a screen informing you that installation is about to
begin. Click Next to proceed with the installation. The Fedora Core installer
formats the disk partitions and installs the packages. As it installs packages,
the installation program displays a status screen to show the progress of the
installation, including information such as total number of packages to install,
number installed so far, estimated amount of hard drive space needed, and
estimated time remaining until the installation is complete.

The hard drive formatting and installation can take quite a bit of time. So you
can take a break and check back in 15 minutes or so. When you come back,
you can get a sense of the time remaining from the status screen, which
updates continuously.
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After all of the packages install, the installer displays a message informing
you that installation is complete. Eject the DVD and click the Exit button to
reboot your PC. You can then perform additional configurations and install
additional software.

Configuring the firewall and SELinux after first boot

When you first reboot your PC after completing the Fedora Core installation,
a first-time configuration utility takes you through a number of additional
configuration steps that include accepting a license agreement, configuring
the firewall and SELinux, selecting the colors and resolution for the display,
setting up a user account, and checking the sound card. Of these steps, the
configuration of firewall and SELinux is important for your system’s security,
so [ briefly these steps next.

In the firewall and SELinux configuration steps, you configure the built-in
packet filter that comes with Linux, select the level of Security Enhanced
Linux (SELinux) access control, and customize these security levels to suit
your needs.

Note that SELinux is a mandatory access control framework developed by
the National Security Agency (NSA), a U.S. government agency, and is
included in Linux kernel 2.6. You can find more about SELinux at the NSA
Web site, www.nsa.gov/selinux. To explain briefly, SELinux access con-
trol goes beyond the traditional access control in Linux, which is based on
the user and group ID that owns a process or a file. SELinux views the
system in terms of subjects (users or processes) and objects (files, devices,
any system resources). Subjects can take on different roles, such as normal
user or system administrator. Each subject also has a domain, and each object
has a type. SELinux provides fine-grained control over who can access what
in a Linux system by defining what domains can access what types and how
one domain can transition into another when programs execute. It sounds
confusing, but you don’t need to understand everything to enjoy the
increased security provided by SELinux.

For the firewall, you have to select one of the following options:

4+ Disabled means that the firewall is not active and your system accepts
all types of connections without performing any security checking. Use
this option only if your system runs on a trusted network or if you plan
to set up a firewall configuration later on (the sooner the better).

4+ Enabled means that you want to set up a firewall. This means that your
system does not accept any connections other than those that you
explicitly enable. By default, the system accepts only DNS and DHCP
requests. You can then select the services, such as Mail and FTP, which
are allowed to pass through the firewall.
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For the SELinux access control configuration, you can set it to one of the fol-
lowing options:
4+ Enforcing means SELinux enforces mandatory access control.

4+ Permissive means SELinux prints warning messages but does not actu-
ally enforce the access control policies.

4 Disabled means SELinux is turned off.

You can also modify SELinux policy from the configuration screen, but it’s
safe to leave the SELinux access control set at its default setting.

When you’ve gone through all the configuration steps after the first reboot,
click Finish to get Fedora Core’s graphical login screen and start using
Fedora.

Installing MEPIS
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The companion DVD includes a single-CD ISO image for the MEPIS distribu-
tion — called SimplyMEPIS — that you can burn onto a CD and use as a Live
CD as well as an installation CD. (MEPIS, by the way, is pronounced MEH-pis.)
When you boot from the MEPIS CD, MEPIS runs directly off the CD, and you
get the MEPIS Live CD login screen, where you can log in using one of two
predefined usernames: demo or root.

4 Run the Live CD: To try out MEPIS as a Live CD system, click Demo in
the login window and type demo as the password.

4+ Install the distribution: To install MEPIS, click the Root icon in the login
window and type root as the password.

When you log in as root, you get the MEPIS desktop with a red background,
as shown in Figure 2-10 (trust me, it’s red: The red background reminds you
that you are logged in as root). From this desktop you can start the MEPIS
hard drive installation.

To install MEPIS on your PC’s hard drive, follow these steps:

1. Click the the INSTALL ME icon on the MEPIS desktop (see Figure 2-10).

The MEPIS OS Center window opens (see Figure 2-11). From the MEPIS
OS Center you can perform a number of system configuration mainte-
nance tasks, including installation of MEPIS onto a hard drive.
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3. Read the copyright notice, and if you agree, click Next to continue.

The MEPIS OS Center displays the first step of installation, which
includes three parts:

¢ Select the hard drive for installation.

¢ Run QTParted to rearrange partitions. This step is optional, but if
you have an existing Windows partition and need to create space for
MEPIS, click the Run QTParted button to shrink the Windows parti-
tion using QTParted. (For more information, see the “Resizing a parti-
tion with QTParted in Knoppix” section in this chapter.)

¢ Select whether you want to install using the whole disk or using a
set of existing hard drive partitions. | installed after I had created
some partitions, so [ selected the option to install on existing parti-
tions. If you elect to install on existing partitions, MEPIS OS Center
gives you the option to select partitions for the file system root, the
/home directory, and the swap partition. You have to designate one
partition for the root and another for swap.

4. Assign the root partition — the partition to be used for the file
system’s root — and the swap partition and click Next.

The MEPIS OS Center displays a dialog box asking for confirmation that
you really want to format and destroy all data in the assigned partitions.
Click Yes to get the MEPIS installation started. After copying the files from
the CD to the hard drive, the MEPIS OS Center proceeds to installing the
GRUB boot loader and selecting the kernels you want to boot.

5. Select whether you want to install GRUB on the master boot record
(MBR) and the kernel versions — 2.4 and 2.6 — that you want to
install.

You can usually accept the default choices of installing GRUB on the
MBR and booting the 2.6 version of the kernel.

6. After making your selections, click Next to continue.

7. Enter the root password and define a normal user account. Then
click Next.

8. Enter the host name and domain for the computer as well as the
Windows workgroup name. Then press Enter.

9. Select what services to start, including the Guarddog firewall service.
Also select the display driver. Then click Next.

10. Set the keyboard layout and the clock. Then click Next.
11. Click Finish to complete the MEPIS installation.

The message on the final installation step informs you that you can
get community support for MEPIS at www .mepis.org or www.mepis
lovers.com.
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After you remove the CD and reboot, you get the GRUB menu from which
you can boot MEPIS from your hard drive. You can then log in as a normal
user with the username you defined when you installed MEPIS.

Installing SUSE Linuy

The companion DVD does not include the full SUSE (I pronounce SUSE SOO-zq,
but many people say it differently) Linux distribution from the openSUSE
project because of limited space on the DVD. Instead, the DVD includes
the ISO image file for a SUSE Live DVD that enables you to run SUSE Linux
directly from the DVD. You can download the fill SUSE Linux distribution
from http://ftp.opensuse.org/pub/opensuse/distribution/
SL-0SS-stable/.
¥ To try the SUSE Linux Live DVD version, simply burn a DVD from the SUSE
Live DVD ISO image on this book’s companion DVD and then boot your PC
from that DVD (you need a DVD burner to burn the ISO file on DVD media).

To install the full SUSE distribution, you have two options:

4+ Install the full distribution directly over a high-speed Internet connec-
tion from one of the FTP servers that mirror the SUSE Linux distribution.

4 Install the full distribution by downloading and burning 5 CDs from
the SUSE Linux ISO images at http://ftp.opensuse.org/pub/
opensuse/distribution/SL-0SS-stable/, and then booting your
PC from the first CD. (For instructions on burning the CD, turn to the
“Burning CDs or DVDs from ISO Images” section in this chapter.)

In the following sections, first I go over the steps for performing an FTP
install, and then I describe the full SUSE install from the CDs.

Performing an FTP install

To install SUSE Linux from one of many FTP servers that mirror the SUSE dis-
tribution, you have to perform the following major steps:

1. Download the SUSE boot image from the FTP server and burn a CD with
that image.

2. Make a note of the FTP server’s IP address and the directory where the
SUSE distribution’s files are located.

3. Boot the PC with the boot CD. Type a command at the boot prompt to
begin an FTP install from the FTP server that you identify by its IP
address.
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If you have a PC that runs Windows and has a high-speed Internet connec-
tion, you can use that PC to download the boot image and burn the boot CD.
You can also use the PC to look up the IP address of the FTP server.

You also need to know the name of the network card installed in your PC
because you have to manually load the driver before you can start the SUSE
FTP install. You can find the FTP server’s IP address at the same time when
you download the SUSE installer’s boot image. I explain the steps in this
section.

Installing SUSE from an FTP server can take two hours or more over a typical
broadband DSL or cable modem connection to the Internet. Follow these
steps to do an FTP install from an FTP server over the network:

1. Use a Web browser to open the list of FTP servers at www. suse.com/
us/private/download/ftp/int_mirrors.html and find an FTP
server near you that’s marked Complete (that means the server has
the complete SUSE distribution and all updates).

The list of servers is organized by country, and it includes both FTP and
HTTP (Web) servers. Go to the section for the country nearest you and
pick the closest server that’s marked Complete.

If you perform this step in Microsoft Windows, open a command prompt
window (choose Start=>Run, type cmd, and press Enter) and type ping
followed by the name of the FTP server (for example, mirror.mcs.anl.
gov). You'll then see the IP address of the FTP server on the next line
(for example, 140.221.37.130). Write down that IP address for use
later on.

2. Click the FTP server link and find the directory that contains the
boot.iso file — that’s the SUSE installer’s boot image.

The directory depends on the version of SUSE. For example, for version
10.0, the boot . iso file is in the FTP server’s pub/suse/i386/10.0/
directory. The file is several tens of megabytes in size.

3. Download the boot . iso file and save it.
4. Burn the boot . iso image onto a CD.

Use your PC’s CD burner application to burn the ISO image named
boot.iso.

5. Go to the PC on which you want to do the SUSE FTP install, insert the
boot CD, and restart the PC.

If your PC isn’t set up to boot from the CD drive, you have to enter Setup
(by pressing a key such as F2 as the PC powers up) and change the
order of the boot devices.
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10.

11.

12.

13.

The PC reboots and after a few moments, displays a GUI screen with a
number of options. Use the arrow keys to move among list items and the
buttons on the screen. For example, if your PC has problems with ACPI,
select the option to install with ACPI disabled.

. Use the arrow keys to select the Installation option and press Enter.

This loads a Linux kernel and runs the installer. After detecting and ini-
tializing the hardware, the installer displays a message saying that it
cannot find the SUSE Linux installation source and is activating a manual
setup program. This is normal and you should press Enter to continue.
The installer then shows a list of languages.

. Use the arrow keys to select the language and press Enter.

The installer displays a list of keyboard maps — the language-dependent
layouts for the keyboard.

. Select the keyboard language and press Enter.

The installer displays the Main menu.

. Use arrow keys to select Start Installation or System and press Enter.

On the next screen, select Start Installation or Update and press Enter.

The installer displays a list of source mediums — this is where you
indicate where the installer can find the files it needs to perform the
installation.

Select Network as the source medium and press Enter.
The installer prompts you for the network protocol.
Select FTP as the network protocol and press Enter.

A dialog box prompts you to determine whether to configure the net-
work automatically by using the Dynamic Host Configuration Protocol
(DHCP). If your network uses DHCP as most do, select Yes and press
Enter. Otherwise, you have to enter the IP address and the name
server’s IP address at this step. The installer then prompts for the IP
address of the FTP server.

Enter the IP address of the FTP server that you found in Step 1
(for example, enter 140.221.37.130 for the FTP server mirror.
mcs.anl.gov).

The installer prompts you to indicate if you want to use a username and
password to connect to the FTP server.

Select No and press Enter.

Answer No because the FTP servers support anonymous FTP — which
means that anyone can log in with the username anonymous.

The installer also prompts you to indicate if you want to use an HTTP
proxy.
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14. Unless your PC is behind a proxy (which may be the case at some
organizations), select No and press Enter.

The installer then prompts you for the name of the directory where the
SUSE files are located.

15. Enter the name of the directory on the FTP server where the SUSE
Linux files are located and press Enter.

The directory name is the parent directory of the location where you
found the boot . iso file in Step 2. For example, if the boot . iso file is in
pub/suse/i386/10.0/boot/, then you should type
pub/suse/i386/10.0/ and press Enter.

The installer displays a message informing you that it is loading data
into RAM disk (which refers to an area of memory that acts as a hard
drive). When the installer finishes downloading data (about 62MB of
data), YaST (that’s what the SUSE installer is called) starts and displays
its initial GUI screen.

From this point on, the installation steps are the same as the ones for a
CD/DVD install, which I explain in the next section. You should jump to the
point where the YaST installer displays its initial GUI screen.

Installing SUSE Linux from CDs

To install SUSE Linux from the CDs that you have burned from the ISO
images on this book’s companion DVD, simply insert the first CD into your
PC’s CD/DVD drive and restart your PC. (In Windows, choose
Start>Shutdown and select Restart from the dialog box.) Note that you may
have to enter Setup and make sure that your PC is set to boot from the
CD/DVD drive.

After your PC powers up, a boot loader starts and displays an initial boot
screen with a menu of items. Table 2-2 lists each boot menu item and its
meaning. As you can see, you can perform a number of tasks from the boot
screen, including booting an existing installation from the hard drive and
starting a rescue system.

Table 2-2 SUSE Installer Boot Menu Items
Select This Item To Do This
Boot from Hard Disk  Boot the PC from a previously installed operating system from the

hard drive
Installation Automatically detect hardware and begin installing SUSE Linux
Installation — Disable support for ACPI (Advanced Configuration and Power
ACPI Disabled Interface) but otherwise detect hardware and start SUSE installation

(continued)
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Table 2-2 (continued)
Select This Item To Do This

Installation — Disable potentially troublesome features, such as ACPIl, APM

Safe Settings (Advanced Power Management), and DMA (direct memory access)
for IDE interface, and start installing SUSE. Select this option if the
installation hangs with any of the other options.

Rescue System Start a small Linux system in memory so that you can troubleshoot by
logging in as root

Memory Test Check to see if there is any problem with the PC’'s memory

Along the bottom of the SUSE installer boot screen, you see some informa-
tion about using function keys F1 through F6. Table 2-3 explains what each of
these functions does.

You can also provide other installer options — as well as Linux kernel
options — at the Boot Options text box below the boot menu. The installer
options control some aspects of the installer’s behavior, whereas the kernel
options are passed to the Linux kernel that starts when you start the installa-
tion. I explain many of these boot options in Chapter 3 of this minibook.

Table 2-3 Using Function Keys at the SUSE Installer Boot Screen

Press This To Do This
Function Key

F1 Get context-sensitive help— help information that relates to the cur-
rently selected item. Use the up- and down-arrow keys to read the Help
screen and the left- and right-arrow keys to jump between topics. You
can dismiss the Help screen by pressing Escape.

F2 Select the language and keyboard mapping to be used by the boot
loader.
F3 Select a screen resolution that you want the YaST installer to use for its

GULI. If the GUI screen fails to appear, you can select Text Mode for a text
mode interface.

F4 Select the source from which you want to install. The choices are: CD or
DVD; or network sources with different protocols, such as FTP, HTTP,
NFS, and SLP (Service Location Protocol).

F5 Update a driver module for new hardware for which drivers may not be
on the CD or DVD. You will be prompted to insert the updated driver
module on a floppy disk or CD-ROM after you start the installation.

The installer initially picks a rather high screen resolution for the GUI screen
(typically, 1280 x 1024 pixels). You should press F3, which brings up a menu
from which you can select a more reasonable screen resolution, such as 1024
x 768 pixels.
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After setting the screen resolution by pressing F2, select Installation from the Book I
boot menu and press Enter. This loads the Linux kernel from the DVD, and Chapter 2
the Linux kernel starts running the YaST installation program. For the rest of
the installation, you work with YaST’s GUI screens.

=3
° &
) If you run into any problems during the installation, turn to Chapter 3 of this %
minibook. That chapter shows how to troubleshoot common installation =
problems. c
(<]
x
Starting the SUSE install in VaST
YaST — the SUSE installer — displays a GUI screen (see Figure 2-12) from
which you install SUSE Linux on your PC’s hard drive and configure it.
The left side of the YaST screen shows the list of installation steps, which
are organized into two broad categories of tasks: Base Installation and
Configuration. An arrow marks the current step. For example, in Figure 2-12,
the arrow marks the Language selection step. After the step is complete,
YaST displays a check mark next to the step.
:'f:n';‘:;: £3 Language
® Llicense Agreement
»  System n.:alysls
® Desktop Selection
Configuration
D
®» FRelease Notes
® Hardware Configuraden
Figure 2-12:
The YaST
installer’s
main GUI
screen. -




06

\\3

Installing SUSE Linux

On the right side of the YaST screen (refer to Figure 2-12), you see the options
for the current step. You have to select options and click Accept to proceed
to the next installation step. You can abort the installation by clicking the
Abort button at any time during the process up until you confirm that you
want to really proceed with the installation.

At any installation step, click the Help button at the lower-left corner of the
YaST screen (refer to Figure 2-12) to view context-sensitive help information
for the current step. The Help area appears in the left side of the YaST

screen. Press the button again to return to view the list of installation steps.

Follow these steps to complete the base installation tasks in the YaST
installer:

1.

Select the language to be used during installation and for use in the
installed SUSE Linux system. Click Accept.

YaST probes the hardware and loads driver modules. YaST may prompt
you to confirm that it should load some driver modules. Then YaST dis-
plays a Media Check screen that gives you a chance to check the instal-
lation media. Click Start Check to perform the check and click Next
when done. YaST displays the license agreement.

. Read the license agreement and click the Yes button if you agree.

Then click Next to continue.

YaST prompts you to indicate if this is a new installation or an update.

. Assuming that you’re installing SUSE for the first time, select New

Installation and click Next.

YaST prompts you for the time zone.

. Select your time zone and click Next.

You can also click Change to change the current time and date, but these
are usually correct. After this step, YaST prompts you (see Figure 2-13)
to select a GUI desktop environment — GNOME or KDE, or some other
options such as a minimal graphics environment or a text mode system
that does not use GUI desktop. Your selection of the desktop environ-
ment determines what software packages YaST installs.

. Select the desktop you want and click Next.

YaST gathers information about the system and prepares a list of all the
installation settings, initially in an Overview tab. Click the Expert tab to
see a complete listing of the settings organized by category, as shown in
Figure 2-14. Table 2-4 summarizes the installation settings categories.
Note that you have to scroll down to see all the installation settings in
the screen shown in Figure 2-14.
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Table 2-4 Installation Settings Categories
Category What These Settings Specify
System Information about the PC’s hardware, including the processor

type and amount of memory

Keyboard Layout

Language and layout of the keyboard

Mouse

Type of mouse (for example, PS/2 mouse)

Partitioning

Information about the partitions that will be formatted and any
partitions that would be mounted on the Linux file system. You
should check to make sure that YaST uses the unused disk par-
titions you created when you set aside space for Linux (as
explained in the “Setting Aside Space for Linux” section, earlier
in this chapter). If your hard drive has only Microsoft Windows
installed, YaST offers to shrink the Windows partition and
create other required partitions to install SUSE Linux. If you
already have other partitions besides the Windows partition,
YaST selects appropriate partitions to use for SUSE Linux. You
can then click the Partitioning heading and from subsequent
steps accept the proposal or create a custom partition setup.

Software

What software YaST will install. This depends on what GUI
desktop — KDE or GNOME — you select at an earlier installa-
tion step.

Booting

Information about the boot loader that takes care of starting
Linux (as well as other operating systems, such as Windows XP,
that may be on the hard drive) when you reboot the PC. The
default is the GRUB boot loader, installed on the hard drive’s
master boot record (MBR).

Time Zone

Current time zone and date and time based on the selection you
made at an earlier installation step

Language

The language to be used by the installed SUSE Linux system

Default Runlevel

What processes Linux starts after booting. The default run level
is 5, which gives you a full multiuser system with networks
enabled and a graphical login screen.

6. Scroll down the list of Installation Settings, and click a heading to
view the settings and make any changes.

You can accept most settings as is.

7. After you have checked all installation settings, click Next.

YaST displays the warning you see in Figure 2-15. It tells you that this is
the point of no return. You can commit to the installation by clicking
Install, or you can return to the installation settings by clicking Back.
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Click the
Install
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Confirm Installation

All Information required for the base Installation IS now complete.

If you continue now, partitions on your hard disk will be formatted (erasing any
existing data in those partiions) according to the installation settings in the previous
dialogs.

Go back and check the seftings if you are unsure.

Back Install

8.

10.

11.

12.

If you’re certain that you want to continue with the installation, click
the Install button.

YaST begins the installation, which includes formatting and preparing
the hard drive partitions and copying SUSE Linux files to the hard drive.
As YaST installs the software packages, it displays a slide show that
introduces various features of SUSE Linux. After completing the base
installation, YaST prompts for the root password.

. Enter the password for the root user.

The root user is the administrator account that you can use to do any-
thing on the system — from installing software to adding new user
accounts.

Accept or Change the Network Configuration.
YaST displays the current settings (see the example in Figure 2-16).
If the settings are correct, you can simply click Next to continue.

Test the Internet connection and update the system with the YaST
Online Update service.

If there are updates, YaST asks if you want to run Online Update now.
Click OK to do so and YaST automatically selects a mirror site to down-
load the updates. All you have to do is click Next, click Accept, and
follow any instructions that YaST displays. This step can take a while to
complete, especially if there are many patches to download and install.
At the final step of patch download and installation, click Finish to con-
tinue with the rest of SUSE Linux installation.

Select the user authentication method and then click Next.

Select Local authentication if you do not have any network-based
authentication available.
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ISDN Adapters
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# Proxy is disabled.

Change... =

For Network authentication, you have to select one of three network
authentication methods — NIS (Network Information System), LDAP

(Lightweight Directory Access Protocol), or Samba (for Windows

networks).

13. For Local authentication, add a new local user by entering the user-

name, password, and other settings. Click Next to continue.

If you mark the Auto Login check box, SUSE Linux automatically logs in
this user when it starts. If your password has any flaws (such as using
the username as part of password), YaST informs you of this problem
and asks whether you really want to use a bad password. Then YaST dis-
plays the release notes.

14. Read the release notes and click Next.

The release notes contain last-minute information about the SUSE Linux
distribution, including any known problems and workarounds. It’s worth
glancing through so that you know about anything that might apply to

your PC’s hardware configuration.

15. Accept or change the displayed hardware configuration for your PC.
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The hardware configuration includes information about specific hard-
ware (such as your graphics card, monitor, sound card, printing system,
and so on). Typically, the displayed configuration should be acceptable,
but you should check each of the items. In particular, check the graphics
card configuration to see if YaST correctly detected the monitor and
graphics card. If not, you can make changes by clicking Graphics Cards
and changing the information in a subsequent window. After the configu-
ration steps are complete, YaST informs you that the installation is
complete.

16. Click Finish to complete the installation.

The installer reboots the system. If you installed the KDE GUI and enabled
Auto Login in Step 5, SUSE Linux restarts, automatically logs you in, and
brings up the KDE desktop. Otherwise, you can log in at the GUI login
screen and start using the system.

Installing Ubuntu

The companion DVD includes a single-CD ISO image for installing Ubuntu.
First, burn that ISO image onto a CD-R by following the steps outlined in the
“Burning CDs or DVDs from ISO Images” section of this chapter. Ubuntu is
based on Debian, so the installation steps are similar to those for Debian.

To install Ubuntu on your PC, follow these steps:

1. Boot your PC from the Ubuntu installation CD.

The initial boot screen prompts you to press Enter to start installation
or press F1 for more help. You can press F1 and look at help information
available by pressing the other function keys. These options are similar
to what you get at the Debian installer’s boot screen because Ubuntu is
based on Debian. To see a summary of the function keys and what they
do, refer to Table 2-1.

2. Press Enter or type a boot command followed by any options and then
press Enter.

For example, on a PC that does not support ACPI, I type linux acpi=off
to start the Ubuntu installation. The installer prompts you to select the
language.

3. Select the language and press Enter.
The installer shows your location based on your language choice.
4. Select the location and press Enter.

The installer shows your keyboard layout based on your language and
location.
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8.
9.

10.

. Select the keyboard layout and press Enter.

The installer detects hardware to find the CD-ROM drive and loads addi-
tional software from the CD. It detects the network hardware and config-
ures it using DHCP. Then it prompts you for a host name.

. Type a host name for your system and press Enter.

The installer detects the hard drives and prompts you to select the disk
partitioning method. If you have created space for Ubuntu on your hard
drive (see the “Setting Aside Space for Linux” section in this chapter),
select the option Use Largest Continuous Free Space for Ubuntu
installation.

. Select the largest continuous free space and press Enter (or select

existing partitions and assign them to specific mount points, such as
the file system root).

The installer installs the Ubuntu base system and asks if the system
clock is set to GMT (Greenwich Mean Time). The answer is usually No.
Then the installer prompts you for the time zone.

Select your time zone and press Enter.
Create a user account.

Type the full name of the user, the username, and the password, as
prompted by the installer. The installer configures APT — the Advanced
Package Tool — used to download and install packages in the future.

The installer lists all the operating systems that it finds installed on your
PC’s hard drive and asks if you want to install the GRUB boot loader on
the master boot record (MBR) of the hard drive.

Select Yes and press Enter to install GRUB.

The installer finishes installing GRUB and then unmounts and ejects the
CD. A message informs you that the first stage of installation is com-
plete. Remove the CD and press Enter to reboot the PC.

After the PC reboots, Ubuntu downloads and installs many more packages
from online repositories. (Your PC needs to be connected to the Internet for
everything to work.)

The X Window System and the GNOME GUI are among the packages Ubuntu
downloads and installs. After these packages are installed and configured,
Ubuntu starts a GUI login screen where you can log in using the user account
that you defined earlier. If, for some reason, X Window System does not
work, you have to troubleshoot X following the suggestions in Chapter 3 of
this minibook.
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The companion DVD does not include the full Xandros (you can call Xandros
ZAN-drose, unless someone tells you otherwise) Desktop distribution
because it’s a commercial product. Instead, the DVD includes the ISO image
for a limited version called Xandros Open Circulation Edition (OCE). You can
install the Xandros OCE to try out the Xandros Desktop before you decide
whether to buy the full distribution. In this section, I describe the installa-
tion process for Xandros OCE, which is similar to that for the full distribu-
tion except that the full distribution includes lots more software packages.

To install the Xandros OCE, burn a CD from the Xandros OCE ISO image
on this book’s companion DVD, and boot your PC from that CD. See the
section, “Burning CDs or DVDs from ISO Images,” earlier in this chapter,
for instructions.

The initial Xandros boot screen displays a logo and a message that says
Press Shift for Troubleshooting Options. If you do nothing, the Linux kernel
loads and starts a GUI installer. However, if the installation seems to hang,
reboot the PC, and this time press Shift at the boot screen. You then see a
number of options for starting the Linux kernel. The default is marked
Default Setup, but you have options to try various levels of APM and ACPI
support. Use the up- and down-arrow keys to select one of these alterna-
tives, and press Enter to get around problems with the installation process.
Also, if you can’t seem to get the GUI screen, try selecting the VESA Mode
Setup (take a look at Table 2-5 for more information on this). That could get
around any problems in starting the X Window System. Table 2-5 summa-
rizes the Xandros boot options that you can access by pressing Shift at the
initial boot screen.

Table 2-5 Xandros Boot Options at the Initial Boot Screen

This Option Does the Following

Default Setup Starts the Linux kernel with the option acpi=on (which enables sup-
port for ACPI)

ACPI 2 Setup Starts the Linux kernel with the options acpi=on noapic

(enables ACPI, but disables the APIC — Advanced Programmable
Interrupt Controller)

ACPI 3 Setup Starts the Linux kernel with the options acpi=on pci=biosirg
(enables ACPI, but uses BIOS settings to route interrupt requests
or IRQs)

ACPI 4 Setup Starts the Linux kernel with the options acpi=on pci=noacpi
(enables ACPI and does not use ACPI to route interrupt requests)

APM Setup Starts the Linux kernel with the option acpi=of f (disables ACPI)

(continued)
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Table 2-5 (continued)

This Option Does the Following

APM 2 Setup Starts the Linux kernel with the options acpi=off noapic (dis-
ables both ACPI and APIC)

APM 3 Setup Starts the Linux kernel with the options acpi=off
pci=biosirg(disables ACPI and uses BIOS settings to route
interrupt requests)

256-Color Setup Starts X Window System with the video card in a 256-color mode

(which should work on nearly all video cards)

VESA Mode Setup  Starts the X Window System with the VESA (Video Electronics
Standards Association) driver

Custom Setup Starts the Linux kernel with the option vga=normal (screen
appears in 80 x 25 text mode)

Restore Xandros Enables you to restore Xandros and fix problems

Rescue Console Starts the Linux kernel in single-user mode in an 80 x 25 text screen

where you can log in as root and fix problems

International Enables you to pick non-U.S. keyboard and language

Usually, you don’t have to do anything because the boot loader automati-
cally loads the Linux kernel and the driver modules. Then it reads the CD,
detects and configures hardware, and starts the X Window System and the
GUI installer. If all goes well, you should see the initial GUI screen, as shown
in Figure 2-17. Click Next to continue with the installation.

The next screen displays the infamous EULA — End User License Agree-
ment — of the commercial software world. (You guessed it — those of us
that like to have fun with the language call it YOO-la.) If you decide to con-
tinue, read the EULA, click I Accept the Agreement, and then click Next.

The Xandros installer then displays two choices for installation:

4+ Express Install: Installs Xandros on your PC with default settings and a
selection of commonly used software.

4 Custom Install: Enables you to control some of the steps in installing
Xandros, including the selection of software, the disk partitions used by
Xandros, and the network configuration.

I describe both install methods in the following sections.
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Using Xandros Express Install

Xandros Express Install is very simple — provided you want Xandros to use
the entire hard drive or take over an unused partition. In a nutshell, you
enter the root password and create a normal user account. Then review the
installation summary, click Finish, and the installer does the rest.

If you have Windows installed on your PC, the Xandros installer displays a
screen that asks you whether you want to keep Windows or overwrite it. The
default is to keep Windows. You can indicate your choice and click Next to
continue.

The next screen asks for the root (administrator) password and the name
of the computer. Enter the root password and confirm it by typing it again.
For the computer name, you can accept the name concocted by the Xandros
installer or type in something more meaningful to you. Then click Next.

Next, you get the chance to create a normal user account. Type in the
requested information, which includes the username and password, and
click Next. This username is used to log into Xandros.
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The installer displays an installation summary screen (shown in Figure 2-18)
for your review. Carefully check the information, in particular whether the
installation is going to take over a partition or the whole hard drive. If

you need to make changes, click Back. Otherwise, click Finish to start

the installation.

After the installer finishes installing Xandros, it prompts you to restart the
PC. When Xandros starts for the first time, it runs the First Run Wizard GUI,
which takes you through some configuration steps. These steps include set-
ting the date and time and choosing how currencies and dates are displayed.
You also get a chance to configure a printer.

Using Xandros Custom Install

The Custom Install method gives you some control over what software you
install. It also lets you identify specific disk partitions for the installation,
configure the network, and add multiple user accounts. To use Custom
Install, select the option from the Installation Selection screen — the screen
that appears right after you accept the EULA agreement — and then click
Next, as shown in Figure 2-19.
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The installer displays the Software Selection screen, where you can select
the applications that you want to install. You can pick from four predefined
sets of applications:

4 Minimal Desktop: Installs a basic set of applications

4+ Standard Desktop: Installs a recommended set of commonly used

applications

4+ Complete Desktop: Installs all standard applications plus more applica-
tions, such as some server software

4 Custom Desktop: Installs a base set of software (and you can then select
applications a la carte from the list that appears below these choices)

As you click to select any of these sets, you can see the detailed selections in
the list that appears below these choices. You can also add or delete any-
thing you want from the list, so the predefined sets should not constrain
your choices. Click Next after selecting the software that you want to install.

The installer then guides you through the disk configuration steps. The next
screen, shown in Figure 2-20, shows what the installer suggests. If you have
an available disk partition, the installer suggests taking over the hard drive
or a partition. (Don’t worry, you get to see exactly how the installer wants to
use the disk partitions and you can intervene, if necessary.)
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Figure 2-20:
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If you want to manage the disk partitions, click the Manage Disks and
Partitions item and click Next. The installer displays an editor where you can
delete and add partitions and assign mount points for partitions. For exam-
ple, you can assign a small 50MB partition to the /boot mount point and
assign a multi-gigabyte partition to the root file system (/). You can also
identify a swap partition approximately twice the size of available memory.
Linux uses the swap partition as virtual memory — a hard drive-based
extension of the PC’s memory.

Table 2-6 summarizes the possible options available in the Disk Configuration
screen. (Refer to Figure 2-20.) Note that only the options applicable to your
PC are available for selection. The others are grayed out.

Table 2-6 Options for Disk Configuration
This Option Does the Following
Use Free Space Uses the largest unallocated block of space on the hard drive

Take Over Disk or Partition Takes over an entire hard drive, a specific partition, or a previ-
ous version of Xandros and erases all data

Resize a Windows Partition Reduces the size of a Windows partition and installs Xandros in
the space that's freed up
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This Option Does the Following

Replace Existing Xandros ~ Upgrades a previous version of Xandros (keeps user accounts,

Desktop 0S renames directories with an __o14d suffix, and retains some
default settings)

Manage Disks and Enables you to create one or more disk partition(s) and specify

Partitions the mount point for each partition

If you decide to go with the default Take Over Disk or Partition, click Next
and the Xandros installer shows you the partition it plans to take over. If you
agree, click Next. The installer then displays the disk configuration in the
form of the location of the swap partition and the root file system, as shown
in Figure 2-21. A check box shows that the installer will load the boot man-
ager on the master boot record of the first IDE hard drive.

Note that the Xandros installer uses the ReiserFs file system for the disk par-
tition. Other file system choices are Ext2 or Ext3. You can go with the default
choice of ReiserFS.
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Figure 2-22:
Installation
summary for
custom
install.

After reviewing the Disk Configuration, click Next to continue. The installer
displays the Network Configuration. The default is to dynamically configure
the Ethernet card, which means that DHCP is used to obtain the IP addresses
of the network interface and the name servers. If this works for your net-
work, click Next. Otherwise, you have to click Edit and enter a static I[P
address for the network. You can also choose not to configure the network.
Click Next after completing the network configuration step.

The installer prompts for the root user password. You can also enter a com-
puter name. After you click Next to continue, the installer displays the User
Account Configuration screen, where you can define multiple user accounts.
For each user account, click Add and enter the required information. After
you are done adding user accounts, click Next.

The installer displays the Installation Summary screen (see Figure 2-22).

Review the information carefully and click Back to correct any errors. When
you are sure that the selections are acceptable, click Finish. The installer fin-
ishes installing Xandros and prompts you to restart the PC. After rebooting,
Xandros runs the First Run Wizard that guides you through a number of con-
figuration steps.

Congratulations! You can now start using Xandros Desktop.
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Chapter 3: Troubleshooting
and Configuring Linux

In This Chapter

* Troubleshooting the installation

v Configuring the X Window System

1~ Setting up printers

» Managing DVDs and CD-ROMs

v~ Installing additional software packages

During the installation of Linux, the installer attempts to detect key
hardware components, such as the SCSI controller and network card.
According to what it detects, the installer takes you through a sequence of
installation steps. For example, if the installer cannot detect the network
card, it skips the network configuration step. This is perfectly okay if you
don’t in fact have a network card, but if you do have one and the installer
mistakenly insists that you don’t, you have an installation problem on your
hands.

Another installation problem that might crop up occurs when you restart
the PC, and instead of a graphical login screen, you get a text terminal.
This means that something is wrong with the X Window System (or X)
configuration.

Also, typically the Linux installation doesn’t include configuration proce-
dures for every piece of hardware on your PC system. For example, most
installations do not set up printers during installation.

In this chapter, | show you some ways to troubleshoot installation problems.
I show you how to configure X to start with a GUI screen and how to config-
ure a printer.

You may also have to install additional software packages from the compan-
ion DVD-ROM. I show you how to install packages in different formats, such

as the Red Hat Package Manager (RPM) and Debian package — the two for-

mats in which most Linux software is distributed.
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Using Text Mode Installation

Most Linux installers attempt to use the X Window System to display the
graphical installation screens. If, for instance, the installer fails to detect a
video card, X does not start. If — for this reason or any other reason — the
installer fails to start X, you can always fall back on a text mode installation.
Then you can specify the video card manually or configure X later by using a
separate configuration program. You can also configure X by editing its text
configuration file.

Table 3-1 lists how you can get to the text mode installation from the initial
installer screen for the Linux distributions included on this book’s DVD.
Typically, the text mode installation sequence is similar to that of the graphi-
cal installation that I outline in Chapter 2 of this minibook. You respond to
the prompts and perform the installation.

Table 3-1 Text Mode Installation in Some Linux Distributions

Distribution How to Get to Text Mode Installer

Debian Works in text mode

Fedora Core Type text at the boot : prompt after you start the PC from the Fedora
Core CD or DVD

Knoppix Start Knoppix in text mode by typing knoppix 2 at the boot : prompt
(because Knoppix is a Live CD distribution, you do not have to install it)

SUSE At the first installation screen, press F3 and use the arrow keys to select
the text mode option. Press Enter.

Ubuntu Based on the Debian installer and works in text mode

Xandros Hold down the Shift key while booting the CD and select Rescue

Console. When the bash-3. 00# prompt appears, type quick_install
and follow the instructions.

Troubleshooting X

[ had this problem on an older PC every time I installed Linux: During instal-
lation, the GUI installation worked fine, but when I rebooted the PC for the
first time after installation, the graphical login screen didn’t appear. Instead,
I ended up with a text login screen or the boot process might seem to hang
with a gray screen. If this problem happens to you, here’s how you can trou-
bleshoot the problem:

1. Press Ctrl+Alt+Delete to reboot the PC.

The PC starts to boot. You get to a screen where the GRUB boot loader
prompts you for the operating system to boot. (If the distribution uses
LILO as the boot loader, you get a text prompt.)
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2. For GRUB, press the A key to add an option for use by the Linux
kernel. For LILO, skip this step.

The GRUB boot loader then displays a command line for the Linux
kernel and prompts you to add what you want.

3. For GRUB, type a space followed by the word single and press Enter.
For LILO, type linux single and press Enter.

The Linux kernel boots in a single-user mode and displays a prompt that
looks like the following:

sh-3.00#

Now you're ready to configure X.

X uses a configuration file (depending on your distribution, the file is called
XF86Config-4 or xorg.conf) to figure out the type of display card, moni-
tor, and the kind of screen resolution you want. The Linux installer prepares
the configuration file, but sometimes the configuration isn’t correct.

To quickly create a working configuration file, follow these steps:

1. Type the following command:
X -configure

This causes the X server to run and create a configuration file. The
screen goes blank, and then the X server exits after displaying some
messages. The last line of the message says the following in Fedora Core:

To test the server, run 'X -config ///etc/xorg.conf.new'

2. Use a text editor, such as vi, to edit the ///etc/xorg.conf . new file
and insert the following line after the line Section “Files”:

FontPath "unix/:7100"

On Fedora Core, you must also change /dev/mouse to /dev/input/
mice.

3. Type xfs & to start the X font server.

4. On Debian and MEPIS, try the new configuration file by typing X -xf86
config //XF86Config.new. On Fedora Core, SUSE, Ubuntu, and
Xandros, try the new configuration file by typing X -config ///etc/
xorg.conf .new.

If you see a blank screen with an X-shaped cursor, the configuration file
is working fine.

5. Press Ctrl+Alt+Backspace to kill the X server.

6. Copy the new configuration file to the /etc/x11 directory with the
following command (on Debian and MEPIS, change the first filename
to XF86Config.new and the second to XF86Config-4):

cp ///etc/xorg.conf.new /etc/X1ll/xorg.conf
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You now have a working X configuration file.
7. Reboot the PC by pressing Ctrl+Alt+Delete or typing reboot.

If all goes well, you should get the graphical login screen.

The X configuration file created by using the -configure option of the X
server does not display at the best resolution possible. To fine-tune the con-
figuration file, you have to run a utility to adjust the display settings after
you reboot the system. The exact utility depends on your Linux distribution,
but most distributions include a utility that enables you to configure the
video card, monitor, and display settings through a graphical user interface.

Resolving Other Installation Problems

I'm sure [ haven’t exhausted all the installation problems that are lurking out
there. Nobody can. There are so many different combinations of components
in Intel x86 PCs that Murphy’s Law practically requires some combination of
hardware to exist that the installation program can’t handle. This section
lists a few known problems. For others, [ advise you to go to Google Groups
(http://groups.google.com) and type in some of the symptoms of the
trouble. Assuming that others are running into similar problems, you can get
some indication of how to troubleshoot your way out of your particular
predicament.

Using Knoppix boot commands

The Knoppix Live CD can be a great troubleshooting tool because Knoppix
is good at detecting hardware, and you can run it directly from the CD. Of
course, sometimes you may have trouble starting Knoppix itself. If that hap-
pens, you can try entering Knoppix boot commands at the boot : prompt.
For example, if Knoppix seems to hang when trying to detect a SCSI card,
you can disable SCSI probing by typing knoppix noscsi at the boot :
prompt. Or, if you want the X server to load the nv module (for graphics
cards based on the NVIDIA chipset), you can type knoppix xmodule=nv at
the boot : prompt. Table 3-2 lists some common Knoppix boot commands.

Table 3-2 Some Common Knoppix Boot Commands
Boot Command What It Does
expert Starts in expert mode, which enables the user to interactively

set up and configure Knoppix

failsafe Boots without attempting to detect hardware (except for the
bare minimum needed to start Linux)

fb1280x1024 Uses fixed framebuffer graphics at the specified resolution
(specify the resolution you want, such as 1024 x 768, 800 x 600,
and so on)
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Boot Command

What It Does

knoppix 1 Starts Knoppix in run level 1 (single-user mode), which can be
used to perform rescue operations
knoppix 2 Starts at run level 2, which provides a text mode shell prompt only

knoppix acpi=off

Disables ACPI (Advanced Configuration and Power Interface)
completely

knoppix atapicd

Uses the ATAPI CD-ROM interface instead of emulating a SCSI
interface for IDE CD-ROM drives

knoppix
desktop=wmname

Uses the specified Window Manager instead of the default KDE
(wmname can be one of: fluxbox, icewm, kde, larswm,
twm, wmaker, or xfce.)

knoppix dma

Enables direct memory access (DMA) for all IDE drives

knoppix
floppyconfig

Runs the shell script named knoppix. sh from a floppy (The
shell script contains Linux commands that you want to run.)

knoppix fromhd=
/dev/hdal

Boots from a previously copied image of Live CD that’s in the
specified hard drive partition

knoppix hsync=80

Uses an 80 kHz horizontal refresh rate for X (enter the horizontal
refresh rate you want X to use)

knoppix lang=xx

Sets the keyboard language as specified by the two-letter code
xx (use one of the following for xx: cn = Simplified Chinese,
de = German, da= Danish, es = Spanish, £r = French, it =
Italian, n1 = Dutch, p1 = Polish, ru = Russian, sk = Slovak,

tr = Turkish, tw = Traditional Chinese, or us = U.S. English)

knoppix mem=256M

Specifies that the PC has the stated amount of memory (in
megabytes)

knoppix myconf=

Runs shell script knoppix. sh from the /dev/hdal parti-

/dev/hdal tion (enter the partition name where you have the knoppix.
sh file.)

knoppix myconf= Causes Knoppix to search for the file named knoppix. sh

scan and execute the commands in that file, if any

knoppix noeject Does not eject the Live CD after you halt Knoppix

knoppix noprompt Does not prompt to remove the Live CD after you halt Knoppix

knoppix nowheel Forces PS/2 protocol for a PS/2 mouse or touchpad (as opposed

mouse to being detected automatically)

knoppix noxxx Causes Knoppix to skip specific parts of the hardware detection

(where xxx identifies the hardware or server that should not be
probed: apic = Advanced Programmable Interrupt Controller,
agp = Accelerated Graphics Port, apm = Advanced Power
Management, audio=sound card, ddc = Display Data
Channel, dhcp = Dynamic Host Configuration Protocol, fstab
=file system table, firewire = I[EEE 1394 high-speed serial
bus, pcmcia = PC Card, scsi = Small Computer System
Interface, swap = hard drive space used for virtual memory,
usb = Universal Serial Bus)

(continued)
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Table 3-2 (continued)

Boot Command

What It Does

knoppix pci=bios

Uses BIOS directly for bad PCl controllers

knoppix pnpbios
=off

Skips the Plug and Play (PnP) BIOS initialization

knoppix screen=
1280x1024

Sets screen resolution to 1280 x 1024 pixels (enter whatever
resolution you want, such as 1024x768, 800x600,
640x480, and so on)

knoppix testcd

Checks the data integrity of the Live CD by using the MD5 sum

knoppix tohd=
/dev/hdal

Copies the Live CD to the specified hard drive partition and runs
from there

knoppix toram

Copies the Live CD to RAM (memory) and runs from there
(requires 1GB of RAM)

knoppix vga=ext

Uses 50-line text mode display

knoppix vsync=60

Uses a vertical refresh rate of 60 Hz for X (enter the vertical
refresh rate you want X to use)

knoppix
wheelmouse

Enables the IMPS/2 protocol for wheel mice

knoppix xmodule=
modname

Causes the X server to load the module specified by modname
so that X works on your video card (modname can be one of
ati, fbdev, 1810, mga, nv, radeon, savage, svga,
ors3.)

knoppix xserver=
progname

Starts the X server specified by progname (can be one of
XFree86 or XF86_SVGA)

When you have multiple Knoppix boot commands, simply combine them
into a single line. For example, to specify that you want to skip the SCSI auto
detection, turn off ACPI, use the U.S. keyboard, a wheelmouse, and require
the X server to load the nv module, you would enter the following at the

boot: prompt:

knoppix noscsi acpi=off lang=us wheelmouse xmodule=nv

The fatal signal 11 error

Some people get a fatal signal 11 error message during installation — and

it stops the process cold. This error usually happens past the initial boot

screen as the installer is starting its GUI or text interface. The most likely

cause of a signal 11 error during installation is a hardware error related to
memory or the cache associated with the CPU (microprocessor).
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Signal 11, also known as SIGSEGV (short for Segment Violation Signal), can
occur in Linux applications. A segment violation occurs when a process tries
to access a memory location that it’s not supposed to access. The operating
system catches the problem before it happens and stops the offending
process by sending it a signal 11. When that happens during installation, it
means the installer made an error while accessing memory, and the most
likely reason is a hardware problem. A commonly suggested cure for the signal
11 problem is to turn off the CPU cache in the BIOS. To do so, you have to
enter Setup while the PC boots (by pressing a function key, such as F2) and
turn off the CPU cache from the BIOS Setup menu.

If the problem is due to a hardware error in memory (in other words, the
result of bad memory chips), you can try swapping the memory modules
around in their slots. You may also consider replacing an existing memory
module with another memory module if you have one handy.

You can read more about the signal 11 problem at www.bitwizard.
nl/sigll.

Getting around the PC reboot problem

On some PCs, when you press Enter at the boot prompt, the initial Linux
kernel loads and immediately reboots the PC. This could be due to a bad
implementation of ACPI in the PC’s BIOS. To bypass the problem, type linux
acpi=off at the boot prompt to turn off ACPL. If that doesn’t work, consult
Table 3-3 for other boot options that you might want to try.

Using Linux kernel boot options

When you boot the PC for Linux installation, either from the DVD or the first
CD-ROM, you get a text screen with the boot : prompt. Typically, you press
Enter at that prompt or do nothing, and the installation begins shortly. You
can, however, specify quite a variety of options at the boot : prompt. The
options control various aspects of the Linux kernel startup, such as disabling
support for troublesome hardware or starting the X server using a specific X
driver module. Some of these boot options can be helpful in bypassing prob-
lems that you may encounter during installation.

To use these boot options, typically you type linux followed by the boot
options. For example, to perform text mode installation and tell the kernel
that your PC has 512MB of memory, you type the following at the boot :
prompt:

linux text mem=512M

Consult Table 3-3 for a brief summary of some of the Linux boot options. You
can use these commands to turn certain features on or off.
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Although I mention these Linux kernel boot commands in the context of
troubleshooting installation problems, you can use many of these com-
mands anytime you boot a PC with any Linux distribution and you want to
turn specific features on or off.

Table 3-3 Some Linux Boot Options

Use This Boot Option To Do This

allowcddma Enables DMA for CD/DVD drive

apic Works around a bug commonly encountered in the Intel 440GX
chipset BIOS and only executes with the installation program
kernel

acpi=off Disables ACPI in case there are problems with ACPI

dd Prompts for a driver disk during the installation of Red Hat Linux

display= Causes the installer GUI to appear on the remote system identi-

IP_address:0

fied by the IP address. (Make sure that you run the command
xhost +hostname onthe remote system where host
name is the host where you run the installer.)

driverdisk

Prompts for a driver disk during the installation of Red Hat Linux

enforcing=0

Turns off Security Enhanced Linux (SELinux) mandatory access
control

expert Enables you to partition removable media and prompts for a
driver disk

ide=nodma Disables DMA on all IDE devices and can be useful when
you're having IDE-related problems

ks Configures the Ethernet card using DHCP and runs a kickstart

installation by using a kickstart file from an NFS server identi-
fied by the boot server parameters provided by the DHCP server

ks=kickstartfile

Runs a kickstart installation by using the kickstart file, specified
by kickstartfile.(The idea behind kickstart is to create a
text file with all the installation options and then kickstartthe

installation by booting and providing the kickstart file as input.)

lowres

Forces the installer GUI to run at a lower resolution (640 x 480)

mediacheck

Prompts you to check the integrity of the CD image (also called
the I1SO image). Checking the image is done by computing the
MD5 checksum and comparing that with the official Fedora
Core value. It can take a few minutes to check a CD-ROM.

mem=xxxM

Overrides the amount of memory the kernel detects on the PC.
(Some older machines could detect only 16MB of memory, and
on some new machines, the video card may use a portion of the
main memory.) Make sure you replace xxx with the number
representing the megabytes of memory on your PC.

nmi_watchdog=1

Enables the built-in kernel deadlock detector that makes use of
Non-Maskable Interrupt (NMI)
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Use This Boot Option  To Do This CI?DOk '3
- apter
noapic Prevents the kernel from using the Advanced Programmable
Interrupt Controller (APIC) chip. (You can use this command on p.—
motherboards known to have a bad APIC.) S §_
nofirewire Does not load support for FireWire cg §
=
noht Disables Hyper-Threading, which is a feature that enables a é g
single processor to act as multiple virtual processors at the hard- - =
ware level. E ﬁ
- - - - X =
nomce Disables self-diagnosis checks performed on the CPU by using 2

Machine Check Exception (MCE). On some machines, these
checks are performed too often and need to be disabled.

nomount Does not automatically mount any installed Linux partitions in
rescue mode

nopass Does not pass the keyboard and mouse information to stage 2 of
the installation program

nopcmcia Ignores any PCMCIA controllers in system

noprobe Disables automatic hardware detection and instead prompts the

user for information about SCSI and network hardware installed
on the PC. You can pass parameters to modules by using this

approach.

noshell Disables shell access on virtual console 2 (the one you get by
pressing Ctrl+Alt+F2) during installation

nousb Disables the loading of USB support during the installation. (This
may be useful if the installation program hangs early in the process.)

nousbstorage Disables the loading of the usbstorage module in the installa-
tion program’s loader. It may help with device ordering on SCSI
systems.

reboot=b Changes the way the kernel tries to reboot the PC so that it can
reboot even if the kernel hangs during system shutdown

pci=noacpi Causes the kernel to not use ACPI to route interrupt requests

pci=biosirg Causes the kernel to use BIOS settings to route interrupt
requests (IRQs)

rescue Starts the kernel in rescue mode where you get a shell prompt
and can try to fix problems

resolution= Causes the installer GUI to run in the specified video mode. (Make

HHHXVVV sure you replace HHH and VvV with standard resolution num-
bers, such as 640x480,800x600,1024x768, and so on.)

selinux=0 Disables the SELinux kernel extensions

serial Turns on serial console support during installation

skipddc Skips the Display Data Channel (DDC) probe of monitors. (This is

useful if the probing causes problems.)

vnc Starts a VNC (Virtual Network Computing) server so that you can
control the GUl installer from another networked system that runs
a VNC client
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Figure 3-1:
Use the
foomatic-gui
to configure
and manage
printers in
Debian.

In most Linux distributions, you can set up printers only after you install the
distribution. The following sections outline the printer configuration steps
for each of the distributions on this book’s DVD — Debian, Fedora Core,
Knoppix, MEPIS, SUSE, Ubuntu, and Xandros.

Configuring printers in Debian

Debian comes with the foomatic-gui utility that enables you to configure a
printer through a graphical interface, shown in Figure 3-1. To configure a
printer, connect the printer to the appropriate port — parallel or USB —
and turn it on. Then follow these steps:

1. Choose Applications=>System Toolsc>Printers from the GUI desktop to
start the foomatic-gui.

If you are not logged in as root, a dialog box prompts you for the root
password.

If you cannot find the menu item, open a terminal window, su - to
become root, and then type export DISPLAY=:0.0; foomatic-gui. The
foomatic-gui utility displays its main window, as shown in Figure 3-1.

File Edit Settings Help

v ¢ @ X B &

Add

Mame Description

Done

2. Click Add on the toolbar. (Refer to Figure 3-1.)

The foomatic-gui tool starts the Add Printer Wizard (see Figure 3-2) that
guides you through the process of adding a new printer to your system.



o AddPrnter JEPG
Add a new printer queue
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The following pages will walk you through the process of
configuring & new printer queue using Foomatic.

If you have a USE or parallel printer, please make sure it is
connected to your computer and switched on. so it can be

Figure 3-2: detected by Foomatic-GUI.
The Add
Printer
Wizard
guides you
through the
steps. X cancel @ Bacl
3. Click Forward.
The Add Printer Wizard displays a number of different connection types
for the printer.
4. Select your printer connection from the list.
P To add a network-connected printer, click Detect Network Printers and

you see a list of printers, including Windows printers, available on your
network. After you select the printer connection, foomatic-gui requests a
name for the queue used to hold print jobs for that printer.

5. Enter a name for the printer queue as well as identifying information

about the printer (the location and a brief description) and click
Forward.

The foomatic-gui tool displays a list of printer makes and models.

6. Select the printer’s make and model and click Forward.

The foomatic-gui tool displays the drivers that apply to this printer.

7. Select the driver you want to use and click Forward.

Pick the driver marked Recommended. The foomatic-gui tool displays a
message saying that you can add the printer by clicking Apply.

8. Click Apply to add the printer.

From the foomatic-gui window (refer to Figure 3-1), you can select a printer
and click the Test Page button to print a test page.
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Figure 3-3:
Configure
and manage
printers
from the
printer con-
figuration
tool.

\\J

Configuring printers in Fedora Core

The Fedora Core installer does not include a printer configuration step, but
you can easily configure a printer from a graphical utility program. To set up
printers, follow these steps:

1. From the GNOME desktop, choose System=>Administration=>Printing.

If you're not logged in as root, the printer configuration tool prompts
you for the root password. The printer configuration tool is called
system-config-printer. Figure 3-3 shows its main window.

Action Test Help

& @ B

[ New | Edt Delete

t Apply

|Queue name v |5hared |Defaull |Descriplion

2. Click the New button to configure a new printer.

The Fedora Core’s Printer Configuration Wizard starts. The initial
window displays a message that assures you that nothing changes until
you click the Apply button at the end of all the steps.

3. Click Forward to continue.

4. Enter the name for the print queue and a short description of the
print queue. Then click Forward.

Use some systematic approach when naming the print queue. For exam-
ple, if  have an HP Laserjet 5000 printer on the second floor in Room
210, I might name the queue Room210HPLJ5000 because this name
makes finding the printer easier. Sometimes systems administrators
choose cute names such as kermit, piggy, elmo, cookiemonster,
and so on, but when you have a lot of printers, such cute schemes don’t
work well. Providing a clue about the printer’s location as well as the
make and model in the print queue’s name is best.

5. In the next screen (see Figure 3-4), select a queue type from the drop-
down list. Then click Forward.

Select the print queue type that applies to your situation. For example, if
you want to print on a shared Windows printer, select Networked
Windows (SMB).



Figure 3-4:
Select the
print queue
type from
this window.

[dev/Ipd

[ é‘ Rescan devices

Select a queue type: | Locally-connected j
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Add a new print queue e~ | D | >

Networked CUPS (|PP)
Networked UNIX (LPD)
Networked Windows (SMB)
Networked Novell (NCP)
Networked JetDirect

& Help | % Cancel | <l Back | B> Forward

To set up a printer connected to your PC’s parallel port, select Locally-
connected.

The following types of print queues are available:

Locally-connected: Refers to a printer connected directly to the serial,
parallel, or USB port of your PC.

Networked CUPS (IPP): Refers to a Common UNIX Printing System
(CUPS) print queue at another server on the network (IPP refers to
the Internet Printing Protocol used to communicate with the remote
CUPS server).

Networked UNIX (LPD): Refers to a print queue managed by the LPD
server on another UNIX system on the local network. (LPD refers to
Line Printer Daemon — another print spooler for UNIX systems.)

Networked Windows (SMB): Refers to a printer connected to another
PC on the local network that uses the Server Message Block (SMB)
protocol, the underlying protocol in Windows file and print sharing.

Networked Novell (NCP): Refers to a printer connected to a Novell
Netware server on the local network.

Networked JetDirect: Refers to an HP JetDirect printer connected
directly to the local network.

6. If you select Locally-connected, the lower part of the screen displays
information about the detected parallel port. Click the port to select it
and then click Forward to continue.

For other options, the screen prompts you to identify the network
printer. The way you specify a network printer depends on the network
type. For example, to use a networked CUPS printer on a host with the IP
address 192.168.0.8 on your local area network, you have to type a name
such as http://192.168.0.8:631/printers/HPLaserjetRoom210 where
HPLaserjetRoom210 is the name of the networked printer.
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7.

10.

11.

12.

Select the make and model of your printer, and click Forward.

Click the drop-down list (above the scrolling list) to display a list of
printer manufacturers. When you choose a printer manufacturer from
this list, the scrolling list displays the names of different printer models
from that manufacturer. If you have a PostScript printer, you can simply
go to the Generic list (Generic is one of the choices in the manufacturer
list) and select PostScript printer.

The last screen shows information about the new print queue.

. Review all information to make sure it’s correct, and click Finish to

create the print queue.

. When a dialog box appears asking whether you want to print a test

page, click Yes.

Doing so applies all changes and restarts the print-scheduler program
that takes care of printing. The printer now prints a test page, after
which a message box appears and asks you to check the test page.

Click OK to dismiss the message box.

The new print queue appears in the printer configuration window, and
you can submit print jobs to this queue.

Choose Action=Quit to close the printer configuration tool.

Or you can close the printer configuration window by clicking the X
button in the upper-right corner of the window’s frame.

You are prompted to save the printer information. Click Save to save
and quit the printer configuration tool.

Configuring printers in Knoppix and MEPIS

Most of the steps for configuring printers in Knoppix and MEPIS are similar
to each other, so I cover them both in this section. To add a printer in
Knoppix or MEPIS, follow these steps:

1.

From the Knoppix desktop, choose Main Menu->KNOPPIX>
Configure~>Configure printer(s). From the MEPIS desktop, choose
Main Menu=~>Print System= Print Manager.

A printer configuration tool starts. Figure 3-5 shows its main window in
MEPIS. The main window looks similar in Knoppix.

. Click Add on the toolbar and choose Add Printer/Class from the drop-

down menu.

The printer configuration tool starts the Add Printer Wizard (see
Figure 3-6) that guides you through the steps.
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3 cConfi Printing Manager Book |
|°~3\ d Gprirmer {5 Print Server :Print Manager ["]view (i Documentation Chapter3
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Advanced Faxing Tool (ksendfax) =

Type: Speclal (pseuds) printer
— State: Idle (accepring jobs)

. Location: KSendFax
Flgure 3'5: Descripton: Use ksendfax ko fax the current docurment
In Knoppix URl:
and MEP'S, Device:
configure Madsl:
and manage
printers
from this

GUI tool.

Print system currently used: | CUPS (Commar UK Frink System) | v]
Cannected to locahostE31

Introduction

Welcome,

This wizard will help to install a new printer on your
computer, It will guide you through the various steps of the
process of installing and configuring a printer for your
printing system. At each step, you can always go back
using the Back button.

We hope you'll enjoy this tool!
Figure 3-6:

Add a new The KDE printing team .
printer

through the

Add Printer

Wizard.

Cancel

3. Click Next and from the next screen select the type of printer connec-
tion. Then click Next.

This can be a local parallel, serial, or USB port, as well as a network
printer supporting different protocols such as TCP or IPP.
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Figure 3-7:
Select the
printer's
make and
model.

Depending on your printer’s connection type, the wizard prompts for
more information. For example, for a local printer, you have to select the
parallel, serial, or USB port from a list.

4. Provide information about the printer connection — the local port or
the URL identifying the network printer. Click Next.

The wizard displays a list of printer makes and models, as shown in
Figure 3-7.

Add Printer Wizard

Printer Model Selection
Manufacturer: Model:
ALPS = |HL-820 =
ANITECH HL-SE0
APOLLO MC-3000
APPLE MFC 7150C
‘?UEFF\: . MFC-5550MC
RS S | | MPc-8300
CANON MFC-5050
CAsIO MFC-5100¢ o
CIMIZEN MFC-8500
| |CITOH 'MFC-9600 ]
COMPAQ 7‘ MFC-P2500 =
(] PostScript printer Qther...
[] Baw printer (no driver needed)
Help | [ < Back | Next = | Cancel

5. Select your printer’s make and model and click Next.
The wizard displays a list of drivers along with its recommendation.
6. Select the printer driver and click Next.

The wizard displays a screen (see Figure 3-8) from which you can test
the printer settings.

7. Select whether you want banners after each print job and click Next.

8. Set any quotas, such as page limit or limit on the size of files sent to
the printer, and click Next.

9. Specify user access settings, such as which users can access the print
queue, and click Next.

10. Name the print queue and add the printer description. Click Next.

11. Review printer settings and click Finish to add the printer.



Figure 3-8:
Test the
printer
settings
before
installing a
printer.

Add Printer Wizard

Setting Up Printers

Printer Test

Now you can test the printer before finishing installation.
Use the Settings button to configure the printer driver and
the Test button to test your configuration. Use the Back
button to change the driver (your current configuration will
be discarded),

Manufacturer: BROTHER
Model: MFC-S600
Description: Brother MFC-89600 (Foomatic + hl1250)

Settings... ]

Help |

[ < Back | ( Next = H Cancel |

Figure 3-9:
To configure
anything,
start with
the YaST
Control
Center.

Configuring printers in SUSE

To add a printer in SUSE, follow these steps:

1. Choose Main Menu=>System=>Control Center (YaST), enter the root

97

password when prompted, and click Hardware on the left side of the
window.

The YaST Control Center displays information about various hardware,
as shown in Figure 3-9. As you can see, you can configure various hard-
ware from YaST.

YaST Control Center

Eile  Edit  Help

[ sonware
[l Hardware
B system

-

Kework Devices.

F¥ Retork Serdces

Securiy and Lisers

¥ riscenznesus

Configure printers.

Bluetooth .’__;‘ CD-RCM Drives

5 oisk conteaner B cragnics card and Monitor
]:GHmmvnrc Informaticn = | oz oMameas
. -~
-[ Infrared Desice o s loystick
) 4 Hesboard Lavaut { ‘j Mouse Mode
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Figure 3-10:
YaST
displays this
printer con-
figuration
window.
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2. Click Printer on the right side of the window.

YaST opens the printer configuration window and displays information
about any printers that it detects, as shown in Figure 3-10.

Printers *||| ~— Printer Configuration

I this dlaleg, ranage printers

an your sysen
Quewe Name | Device | Model ettt Queue
Adding a New
Configuration
Pressing Add cpenza list of
avallasie connections.
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Dalating, Editing,
and Setting as

Default

Select the printer in the fakie
ani press the appropriate
Euftan You can enly edit
conflguratans created with
YaST A change of default
printer will Take effect after the
et lagin

Advanced Settings
Press Advanced to modify EPSON Stylus COLOR 640
Parallel printer on [dew/ipl

This prirt=r is nat configured

advanced soooler ssttings or
=witch Detween the CLUPS and
Lemng sanolers.

Saving Changes
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3. If your printer is detected, go on to Step 4. If your printer is not
detected, click Add.

YaST displays a list of printer types (see Figure 3-11) from which you can
select your printer. The type depends on how your printer is connected
to your PC (through parallel, serial, USB, or network).

4. Select your printer type and click Next.

YaST prompts for more information, depending on the printer type you
select. For example, for a parallel printer, you have to identify the paral-
lel port to which the printer is attached.

5. Provide information about the printer connection and click Next.

YaST prompts for the printer queue’s name and other related
information.

6. Enter the name of the print queue, as well as some descriptive infor-
mation about the printer, and click Next.

YaST displays a list of printer makes and models.
7. Select your printer’s make and model. Then click Next.

YaST displays the current configuration information so that you can test
the configuration or edit it.
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Serial, IrDA, or
Bluetooth Printer
To configurs 3 printar
canrected locally, select
the type of the jocal
oot Lo which your
printar is conaected, —

CUPS Network
Server

To orint via a CUPS
network server, select
Print via CUPS
Network Server.

LPD-Style
Network Server
Ta print wla an LPD-style
network server, select
Print via LPD-Style
Network Server.

Parallel, USE, *|| .= Printer Type

Salact Your Printer Type:
8] Paratiel printer

) USB printer

1 Serial printer

(] IrDA printer
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Select your SMB Network
printer type || e
from this Dlect primt o st |5
window. —
8. Review the configuration information and click OK.
The Add Printer Wizard closes and returns to the YaST printer configura-
tion window.
9. Click OK to save the settings.
Configuring printers in Ubuntu
To add a printer in Ubuntu, follow these steps:
1. Choose System=>Administration=>Printing.
The Printers window appears, as shown in Figure 3-12.
= Printers —[alx]
printer Edit  Global Settings
Figure 312 Mew Printer
In Ubuntu,
manage
printers
from this

window.
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Figure 3-13:
Identify the
printer

connection
at this step.

2. Click New Printer (refer to Figure 3-12).

This starts the Add a Printer assistant (see Figure 3-13) that guides you
through the printer installation steps.

= Add a Printer ] 3

Lon
Step 1 of 2: Printer Connection
P '_

This assistant helps you set up a printer.

Printer Type: @ Local Printer
() Metwork Brinter

() Use a detected printer:

@ Use another printer by specifying a port:

Printer Eort:I Parallel Port #1 (CAMON) % |

¥ cancel |

3. Select a printer connection (refer to Figure 3-13) and then click
Forward.

You can select a printer type — local or network — or select a detected
printer or a printer port (USB or parallel port).

4. Select the printer manufacturer and pick the model from the list (see
Figure 3-14).
For that selected printer model, the recommended driver is displayed.
5. Click Apply.

This installs the printer and closes the Add a Printer assistant. The icon
for the printer appears in the Printers window shown in Figure 3-12.

Configuring printers in Xandros

When you run Xandros for the first time, the First Run Wizard gives you an
opportunity to configure printers. Figure 3-15 shows the screen where the
First Run Wizard displays information about printers and also gives you an
opportunity to add a new printer.



Figure 3-14:
Select the
printer make
and model
at this step.
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Add a Printer

Step 2 of 2: Printer Driver

Manufacturer: | Brother

EL3

[»]

MFC-E550MC
MFC 7150C
MFC-B300
MFC-8050
MFC-8100c
MFC-8500

MFC-9600 ||

MFC-P2500

Model:

Driver: | hl1250 (recommended)  (Suggested) :l [@_Inslall Dn’ver...|

[ ¥ cancel | [ 4 Back l [ o Apply

Figure 3-15:
The printer
configura-
tion step in
Xandros.

Run Wizard

If you have a printer connected directly to this computer or plan to use &
printer on the networs, you can configure the settings now, To sdd &
printer press the Add ballon,

Mote: Changes made inthis psge are applied immediataly.

Installed prnters:

Name Cornecticn Path Printer State

NENES ][ cancel

\\3

If you skip it during the first reboot, you can always start the First Run
Wizard by choosing Main Menur>Applications=>Systemc>First Run Wizard.

From the First Run Wizard’s Printers screen, follow these steps to configure a
printer:

1. Click the Add button in the First Run Wizard’s Printers screen (refer
to Figure 3-15).

The Add Printer Wizard starts, as shown in Figure 3-16.
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Add a Printer

How would you like this printer to be managed?

if the printer is directly connected to your computer, click Local
printer. If it is connected to ancther computer, or directly to the
network, click Netwark printer,

Figure 3-16:

(® Local printer

Th_e Add () Network printer
Printer
Wizard in
Xandros
prompts you
for printer
details.
2. Select the type of printer — Local Printer or Network Printer — and
click Next.
The wizard prompts for more information about the printer’s
connection.
3. Provide information about the printer’s connection and click Next.
For example, for a local printer, specify whether it’s a parallel or USB
printer. The wizard displays a screen from which you can select the
printer’s make, model, and a driver.
4. Select your printer’s make, model, and driver, as shown in Figure 3-17.
Click Next.
Eopmmeizas
Set Printer Model
Choose the printer manufacturer and model,
If your printer is not listed, consult your printer
documentation for & compatible printer,
Manufacturer:
lEIrother v]
— Mgl .
Figure 3-17: [MeE 8600 I:)
Select the Driver:
printer's [Foumatic + hi1250 _v]
make, Have PFD...
model, and
a driver. <gack | [ Mewt= | [ cencel
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The wizard gives you the option of printing a test page and completing
the printer configuration.

5. Click Finish to complete printer configuration.

After finishing printer configuration, the First Run Wizard continues with
other configuration tasks.

Managing DUDs and CD-ROMs

SPEC/
N3 S

(Z

SSTRBY,

The GUI desktop makes using DVDs and CD-ROMs in Linux easy. Just place a
DVD or a CD-ROM in the drive, and an icon appears on the desktop.

You can then access the CD or DVD by double-clicking the icon on the
desktop.

To access the files and folders, you simply double-click the icons that appear
in a GUI file manager window. In some Linux distributions, the GUI automati-
cally opens the contents of a CD or DVD in a file manager window soon after
you insert the CD or DVD in the drive.

If you see a DVD/CD-ROM icon, right-click that icon for a context menu. From
that menu, you can eject the CD or DVD when you are done.

The Knoppix and MEPIS desktops show icons for each detected drive. To
open a CD or DVD, simply click the icon for that drive. In SUSE, click the My
Computer icon, and click the icon for the DVD/CD drive. Ubuntu opens the
CD/DVD in a Nautilus window and also places an icon on the desktop.
Xandros Desktop opens the CD/DVD in a Xandros File Manager window.

Installing Other Software

The exact steps for installing software depend on the type of package in
which the software is distributed. Most Linux software comes in either an
RPM file or a Debian package file. The RPM files have an . rpm extension,
and the Debian packages have a . deb extension.

Most distributions provide GUI installers to ease the process of installing
new software packages. In this section, I provide a quick overview of adding
software in Debian, Fedora Core, SUSE, and Xandros. You typically do not
add software to Knoppix (or any other Live CD distribution) because Live
CD distributions run CD-ROM.
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Fedora Core and SUSE use RPM packages. Debian, MEPIS, Ubuntu, and
Xandros are all Debian-based distributions, and as expected, they typically
use Debian packages (also called DEB). However, both RPM and DEB pack-
ages can be installed in any Linux distribution.

Installing software in Debian, MEPIS, and Ubuntu

The best way to manage software packages in Debian and Debian-based dis-
tributions such as MEPIS and Ubuntu is to use APT — the Advanced
Packaging Tool — that you usually control through the apt-get command.

When you install Debian, one of the last steps is to configure the sources for
APT. The APT sources are the Internet servers (both FTP and Web) where
APT looks for software packages to download and install on your system.
Assuming that APT is properly configured and that your system has a high-
speed Internet connection, you can begin installing any package by typing
the following command in a terminal window:

apt-get install pkgname

where pkgname is the name of the package that you want to install. If you do
not know the package name, start by typing the following command in the
terminal window:

apt-cache search keyword

where keyword is related to the package you want to install. For example, to
search for a package that has the word screenshot in its description and also
contains the word KDE, | would type the following. (I use grep to search the
output for occurrences of the text KDE.)

apt-cache search screenshot | grep KDE

This command then prints the following line as the result:

ksnapshot - Screenshot application for KDE

This shows that the ksnapshot package is what I need. If this package was
not yet installed, I could then install it by typing the following command:

apt-get install ksnapshot

That, in a nutshell, is how you can use the command-line tools to look for
and install packages in Debian.
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Figure 3-18:
You can
install and
remove
packages
by using
Synaptic
Package
Manager.
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Debian, MEPIS, and Ubuntu also come with a GUI package installer for APT
called Synaptic Package Manager, which is quite intuitive to use. To try it,
choose Applications=>System Tools=>Synaptic Package Manager from the
GNOME desktop in Debian. In MEPIS, choose Main Menu=System=>Synaptic
Package Manager. In Ubuntu, choose Select System=>Administration=
Synaptic Package Manager. (In Ubuntu, when prompted for a password,
enter your normal user password because there is no root user in Ubuntu.)

After Synaptic Package Manager starts, it displays a Quick Introduction
dialog box that tells you, briefly, how to mark packages for installation,
upgrade, or removal, and how to get to the menu to perform these actions.
After reading the Introduction, click Close to get rid of that dialog box.

If your package information is older than 48 hours, another dialog box
prompts you to update the package information. Click Reload in that dialog
box. Synaptic Package Manager then downloads the latest package informa-
tion, closes the dialog box, and displays information about the packages in
the main window, as shown in Figure 3-18.
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By clicking the categories on the left side of the Synaptic Package Manager
window you can view lists of various categories of packages on the right side
of the window. A box to the left of each package indicates whether the pack-
age is installed or not. If you click on the package name, Synaptic Package
Manager displays information about the selected package in the lower-right
side of the window.

To select a package for installation or removal, click the box to the left of its
name and pick Mark for Installation or Mark for Removal from the pop-up
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Figure 3-19:
Use the Add
or Remove
Packages
utility to
manage
software in
Fedora
Core.

menu that appears. If selecting a package for installation requires other
packages, Synaptic Package Manager displays a dialog box with that informa-
tion, and you can click Mark to install the required packages also. Mark as
many packages as you want and click Apply on the toolbar to perform all
marked actions.

Installing software in Fedora Core

Most Fedora Core software comes in the form of RPM files. An RPM file is
basically a single package that contains everything — all the files and config-
uration information — needed to install a software product.

From the GNOME desktop, use the Add or Remove Packages utility — a
graphical utility for installing and uninstalling RPMs. Follow these steps:

1. Choose System=>Applications->Add/Remove Software.

If you're not logged in as root, a dialog box prompts you for the root
password. The Add or Remove Packages utility starts and gathers infor-
mation about the status of packages installed on your system. After it
sorts through the information about all the installed packages, the utility
displays the Package Management dialog box, which contains a list of all
the packages. (See Figure 3-19.)
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Figure 3-20:
Start
software
installation
or removal
from the
YaST
Control
Center.
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2. To install an uninstalled package group, select the check box to the
left of that package group’s name. For partially uninstalled package
groups, click the Details hyperlink that appears in a column to the
right of the package name.

A dialog box appears with details of the packages in the package group.

3. In the dialog box, select the packages that you want to install or
remove by clicking the names, and click Close to exit the dialog box.

You return to the Package Management dialog box, and if you added or
removed any package, the Update button becomes active.

4. Click the Update button to update the packages based on any addi-
tions or removals you made in the lists of packages.

Installing software in SUSE
In SUSE, follow these steps to install or remove software:

1. Choose Main Menu=YaST to start the YaST Control Center shown in
Figure 3-20.

The YaST Control Center displays categories of tasks on the left side and
specific tasks for that category on the right side.

. _F_'* Gnline Update

nstallation Source

5% System Update

2. Click the Software category on the left side so that the right side
shows the options for Software.

3. Click the Software Management icon on the right side (refer to
Figure 3-20).

YaST displays a new window where you can search for software
packages.
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Figure 3-21:
Look for
and install
software
from this
YaST
window.

4. Search for a package by name or select a package by browsing avail-
able packages.

To search for a package by name, type a keyword in the Search field

on the upper-left corner of the window and click Search. YaST displays
the matching packages in the right side of the window, as shown in
Figure 3-21. To browse for packages, click Filter in the upper-left corner,
select Package Groups from the drop-down list, and click a group to see
the list of individual packages in that group.

5. Click the Accept button in the bottom-right corner to begin installing
selected packages.

YaST checks for dependencies — if a package requires other packages to
install correctly — before installing packages. If you want to view what
changes would occur when you click Accept, click Filter and select
Installation Summary.

Installing software in Xandros

Xandros Desktop OS comes with Xandros Networks, which enables you to
buy software online as well as install software from a CD or DVD. To start
Xandros Networks, double-click the Xandros Networks icon on the Xandros
desktop. Xandros Networks starts, connects to a Xandros server, and dis-
plays information about installed, updated, and new applications, as shown
in Figure 3-22.
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Use
Xandros
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to install
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software.
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To look at the list of new applications, click the plus sign to the left of the

New Applications label on the left side of the Xandros Networks window (see
Figure 3-23). You get a further list of application categories. If you click a cat-
egory, the right side of the window shows the names of packages within that
category. You can then select a package or an entire category for installation.

To install any selected software packages, choose Filec>Enter Administrator
Mode. You will be prompted for the administrator (root) password.

After entering the root password, you can choose File>Install Selected
Applications. Xandros Networks checks for dependencies, prompts you

if any further information is needed, and downloads and installs the new
software.

If you have downloaded a Debian package, you can install it by choosing
FilewInstall DEB File from the Xandros Networks menu. Similarly, the menu
choice FilewInstall RPM File installs an RPM package. (For more about
installing RPM packages, see Book V, Chapter 4.)
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Figure 3-23:
Select the
packages
to install.
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Chapter 4: Trying Out Linux

In This Chapter

1 Starting Linux

+* Logging in

v Checking out the GUI desktops
1+ Playing with the shell

v Shutting down

ou're sitting in front of your PC about to turn it on. You know that the

PC has Linux installed. (Maybe you did the installing yourself, but
who’s keeping track?) You're wondering what to expect when you turn it on
and what you do afterward. Not to worry. If you're using Linux for the first
time, this chapter shows you how to log in, check out the graphical desk-
tops, try out some cryptic Linux commands, and finally, shut down the PC.

If you try out the Knoppix Live CD, all you have to do is boot from the
Knoppix Live CD (as explained in Book I, Chapter 2), and you can try it just
like any other Linux distribution.

For those of you who already know something about Linux, flip through this
chapter to see if anything looks new. You never know what you may not
know!

Starting Linux
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When you power up the PC, it goes through the normal power-up sequence
and loads the boot loader — GRUB or LILO, depending on your Linux distri-
bution and what you select during installation. The boot loader (once known
as the bootstrap loader) is a tiny computer program that loads the rest of
the operating system from the hard drive into the computer’s memory. The
whole process of starting up a computer is called booting.

For Live CDs (such as Knoppix) that boot from a CD, the boot loader is typi-
cally ISOLINUX, a boot loader designed to work from an ISO 9660 CD-ROM.

The LILO and GRUB boot loaders display a graphical screen with the names
of the operating systems that the boot loader can load. For example, if your
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PC has Windows and Linux, you see both names listed. You can then use the
up- and down-arrow keys to select the operating system you want to use. If
the PC is set up to load Linux by default, wait a few seconds, and the boot
loader starts Linux. To be more precise, the boot loader loads the Linux
kernel — the core of the Linux operating system — into the PC’s memory.

Other boot loaders, such as ISOLINUX, may display a text boot : prompt at
which you can type boot commands to load specific operating systems and
pass options to that operating system.

As the Linux kernel starts, you see a long list of opening messages, often
referred to as the boot messages. (You can see these messages at any time by
typing the command dmesg in a terminal window.) These messages include
the names of the devices that Linux detects. One of the first lines in the boot
messages reads

Calibrating delay loop... 4997.12 BogoMIPS (1lpj=2498560)
BogoMIPS is Linux jargon (explained in this chapter in a handy sidebar) for
a measure of time. The number that precedes BogoMIPS depends on your
PC’s processor speed, whether it’s an old 200 MHz Pentium or a new 4 GHz
Pentium 4. The kernel uses the BogoMIPS measurement when it has to wait
a small amount of time for some event to occur (such as getting a response
back from a disk controller when it’s ready).

What are BogoMIPS and LPJ?

As Linux boots, you get a message that says
Calibrating delay loop... 4997.12
BogoMIPS (1pj=2498560), with some
number before the word BogoMIPS. BogoMIPS
is one of those words that confounds new Linux
users, butit's just jargon with a simple meaning.

BogoMIPS is Linus’s invention (yes, the same
Linus Torvalds who started Linux), and it means
bogus MIPS. As you may know, MIPS is
an acronym for millions of instructions per
second — a measure of how fast your com-
puter runs programs. Unfortunately, MIPS isn't
a very good measure of performance; the MIPS
measurements of different types of computers
are difficult to compare accurately. BogoMIPS
is basically a way to measure the computer’s

speed that's independent of the exact proces-
sor type. Linux uses the BogoMIPS number to
calibrate a delay loop, in which the computer
keeps running some useless instructions until
a specified amount of time passes. Of course,
the reason for killing valuable processor time
like this is to wait for some slowpoke device to
get ready for work.

Oh ... about LPJ — it's a recent term that
stands for loops per jiffy, and it's another meas-
ure of time delay used by the kernel. The Linux
kernel considers time in increments of jiffies,
and a jiffy is defined as the time period that is
equal to one second divided by the value of a
kernel variable named HZ. In other words, there
are HZ jiffies in each second.
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After the boot messages display, some Linux distributions, such as Fedora Book |
Core, switch to a graphical boot screen that shows information about the Chapter 4
progress of system startup. When you boot some Linux distributions, such as
Fedora Core and Xandros Desktop OS, for the first time after installation, you
get a first-time configuration program that guides you through some configu-
ration steps, such as setting the date and time and adding user accounts. To
complete such first-time configuration steps, all you have to do is enter the
requested information.
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NSPEC,,  After Linux boots, you typically get a graphical login screen. For some Live

¢ (D distributions, such as Knoppix, you get the desktop without having to log
in as a user. On other Live CDs, such as MEPIS, you have to log in. In MEPIS,
you can log in as one of two predefined users — demo with password demo
or root with password root.

(2

Figure 4-1 shows the Knoppix desktop after [ booted a PC from the Knoppix
Live CD.

For a distribution such as SUSE, you might be logged in automatically. For
others, such as MEPIS, a typical graphical login screen looks similar to the
one shown in Figure 4-2.
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Figure 4-2:
The
graphical
login screen
is where
you log in as
a user.
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SimplyMEPIS 3.3.1-1 (2.6.10)

Username: naba |

password: | |

Login | Clear | | Menu v|

The login window in the middle of the screen displays a dialog box that has
text fields where you can type your username and password.

You can log in using any of the accounts you define during or after the installa-
tion. There is always the root username, which happens to be the superuser
(the administrator account). Whether you install Linux yourself or someone
installs it for you, you need to know the root password. Without that, you
cannot do many of the tasks necessary to find out how Linux works.

In Ubuntuy, you define only a normal user account; Ubuntu does not give
you the opportunity to define a root user account. Whenever you want

to perform any tasks that require you to be root, you have to use the sudo
command.

To log in as user spiderman, type spiderman in the first text field and press
Enter. (Move the cursor to the login dialog box before you begin typing.)
Then type spiderman’s password and press Enter. You then see the initial
graphical user interface (GUI — pronounced GOO-ee for short). What you
get depends on your choice of GUl — GNOME or KDE. If someone made the
choice for you, don’t worry — GNOME and KDE are both quite good and
versatile.
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Exploring GUI Desktops Chaptor

Most Linux distributions come with one or both of two GUI desktops —
GNOME and KDE. If you install both, you can try them out one by one. Each
distribution has its default GUI. Table 4-1 lists the default GUI desktops

of some Linux distributions. I provide an overview of the two major GUI
desktops — GNOME and KDE — in the following sections.
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Table 4-1 Default GUI Desktops for Some Linux Distributions
Distribution Defaunlt GUI Desktop

Debian Typically, Debian installs GNOME by default. But the user can
install any GUI desktop: GNOME, KDE, or XFCE. (XFCE is another
GUI desktop for UNIX systems. You can find more information
about XFCE at www . xfce.org.)

Fedora Core GNOME, but a user can install KDE as well and easily switch
between the two.

Knoppix KDE

MEPIS KDE

SUSE KDE is default, but a user can choose to install GNOME during
installation.

Ubuntu GNOME is default, but a user can install KDE from the Synaptic
Package Manager.

Xandros KDE with enhancements. (It's called Xandros Desktop.)

GNOME

GNOME stands for GNU Network Object Model Environment (and GNU, as
you probably know, stands for GNU’s Not UNIX). GNOME is a graphical user
interface and a programming environment. The latest GNOME release is 2.x,
also known as GNOME 2 for short. From the user’s perspective, GNOME is
like Microsoft Windows. Behind the scenes, GNOME has many features that
allow programmers to write graphical applications that can work together
well. In this chapter, I point out only some key features of the GNOME GUI,
leaving the details for you to explore on your own at your leisure.

If you're curious, you can always find out the latest information about
GNOME by visiting the GNOME home page at www . gnome . org.

If GNOME is the default desktop, after you log in, you see the GNOME GUI
desktop. Figure 4-3 shows the typical initial GNOME desktop for a user.
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Figure 4-3:
The initial
GNOME GUI
desktop
after
logging in.

You should not normally log in as root. When you log in as root, you could
accidentally damage your system because you can do anything when you’re
root. Always log in as a normal user. When you need to perform any task as
root, type su - in a terminal window and enter the root password.
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The exact appearance of the GNOME desktop depends on the current session
(the set of applications running at that time) and your Linux distribution. As
you can see, the initial GNOME desktop, shown in Figure 4-3, is very much
like the Windows desktop except that it has two taskbars, one along the top
and the other along the bottom edge of the screen. These are the GNOME
panels — similar to the Windows taskbar. You can access various menus and
launch applications from the top GNOME panel, whereas status information
(including icons for currently running applications) appears in the bottom
panel.

You can move and resize the windows just as you do in Microsoft Windows.
Also, as in the window frames in Microsoft Windows, the right corner of the
window’s title bar includes three buttons. The leftmost button reduces the
window to an icon, the middle button maximizes the window to fill up the
entire screen, and the rightmost button closes the window.
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The GNOME panels

Notice the two bars along the top and bottom edges of the GNOME desktop
shown in Figure 4-3. These are the GNOME panels, or simply, panels. The top
panel is for launching programs, whereas the bottom panel is for status
information (icons for the applications that are currently running and but-
tons for switching between desktops). The top panel also provides a display
area for small panel applets. Each panel applet is a small program designed
to work inside the panel. For example, the clock applet on the top panel’s far
right displays the current date and time.

The top and bottom panels in GNOME include several other applets besides
the clock applet. (The exact details depend on your Linux distribution.)

4+ Launcher applets: The buttons on the top panel to the right of the
Applications, Places, and System menu buttons are launcher applets.
Each of these applets displays a button with the icon of an application.
Clicking a button starts (launches) that application. Try clicking each of
these buttons to see what happens. The mouse and earth button
launches the Mozilla Firefox Web browser, whereas clicking the pen and
paper icon opens the OpenOffice.org Writer word processor. Move the
mouse over a button and a small Help message appears with information
about that button.

4+ The GNOME Pager applet: Located at the right edge of the bottom
panel, this applet provides a virtual desktop that’s larger than the physi-
cal dimensions of your system’s screen. The pager displays four pages in
a small display area. Each page represents an area equal to the size of
the display screen. To go to a specific page, click that page in the pager
window. The GNOME Pager applet displays buttons for each window
being displayed in the current virtual page.

4+ The GNOME Weather applet: Displays the local weather. You don’t see
this applet until you start it. You can start it from the context menu that
appears when you right-click in an empty area of the top panel.

The GNOME menu buttons

In Figure 4-4, the left side of the top panel starts with three menu buttons —
Applications, Places, and Desktop. (On GNOME desktops of other distribu-
tions, these three menu buttons may have different names.) The Applications
button, which I sometimes refer to as the Main Menu button, is similar to the
Start button in Microsoft Windows. You can launch applications from the
menu that pops up when you click the left mouse button on the Applications
button. Typically, this menu lists items that start an application. Most of the
menu items have an arrow; another pop-up menu appears when you place
the mouse pointer on an item with an arrow. Figure 4-4 shows a typical view
of the GNOME Applications menu on a Fedora Core system.

Book |
Chapter 4

xnuiy ng Buikyy



118 Exploring GUI Desktops

Figure 4-4:
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In Figure 4-4, the menu selection is Applications=Internet>Firefox Web
Browser. Notice that when you point to a menu selection, a help balloon
pops up with information about that selection.

The other two GNOME menus — Places and Desktop — enable you to per-
form the following categories of related tasks:

4+ Places menu has options for opening your home folder, viewing the
desktop, browsing the computer, connecting to various servers (such as
FTP and Windows shares), and searching for files.

4+ System menu is for editing desktop preferences, configuring system set-
tings, getting online help, locking the screen, and logging out. Systemr>
Administration enables you to start GUI system configuration utilities
for configuring, among other things, user accounts, root password,
security level, display, network, printers, and date and time. To config-
ure various Internet servers — Web, FTP, DNS, Samba, and others — go
to System=>Administration=>Server Settings.

You can start applets, such as the Weather applet, from the Add to Panel

dialog box (see Figure 4-5) that appears when you right-click the top GNOME
panel and select Add to Panel from the menu that pops up. For example, you
can add the Weather applet by selecting it in the Add to Panel dialog box and
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clicking Add. In the Add to Panel dialog box, you find many more categories
of applets you can try.
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- Weather Report

Monitor the current weather conditions, and forecasts

mr  Window List
T Switch between open windows

Window Selector
Switch between open windows

E- Workspace Switcher
0 Switch between workspaces

@ £

Explore all the items on the GNOME menus to see all the tasks you can per-
form from this menu. In particular, move the mouse pointer over the System=>
Preferences item to see your options for changing the appearance of the desk-
top. For example, you can change the desktop’s background from this menu,
as shown in Figure 4-6.

Customizing the GNOME desktop

By now, you may be itching to do a bit of decorating. No one likes to stick to
the plain GNOME desktop. After all, it’s your desktop. You can set it up any
way you want it. You can configure most aspects of the GNOME desktop’s
look and feel — the appearance and behavior — by choosing System=>
Preferences, and choosing from among the various options.

To see how the desktop decorating business works in Fedora Core, start by
choosing Systemr>Preferences>Desktop Background; a dialog box appears,
as shown in Figure 4-7.

From this dialog box, you can select a background of a solid color, a color
gradient, or a wallpaper (an image used as the background). A color gradient
background starts with one color and gradually changes to another color.
The gradient can be in the vertical direction (top to bottom) or horizontal
(left to right).
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To select a horizontal color gradient, follow these steps:

1. From the Desktop Colors drop-down list (refer to Figure 4-7), choose
the Horizontal Gradient option.



Figure 4-8:
The Pick a
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2. Click the Left Color button next to the drop-down list.

A color selection dialog box comes up (shown in Figure 4-8).

Pick a calor, =)

Hue: |230 :j Red: [134 [
Saturation: 3 Green: 143 E‘

Value: 75 E‘ Blue: 101 E‘

Color Name: |#B68FBF

Falette

_l EEEE =
I, EEE  EE

e

3. Pick a color and click OK.

4. Repeat the same process to select the right color.

After you complete these steps, the desktop shows the new background
color.

If you want to use an image as wallpaper, click the Add Wallpaper button in
the middle of the Desktop Background Preferences dialog box. The Add
Wallpapers dialog box appears, from which you can select an image to use as
wallpaper. By clicking the folder names in the Add Wallpapers dialog box, go
to the /usr/share/backgrounds/images directory. That directory has
the default.png file with the default wallpaper you see on the GNOME
desktop. To change the wallpaper, select an image you want. You can select
any Joint Photographic Experts Group (JPEG) or Portable Network Graphics
(PNG) format image file as wallpaper. After selecting an image, click OK.

The new wallpaper immediately appears on the desktop. When you’re done
making the changes, click the Close button (refer to Figure 4-7) to close the
dialog box and apply the changes.

Logging out of GNOME

To log out from GNOME in Fedora Core, choose Systemr>Log Out. Click OK
when a dialog box asks if you really want to log out. In GNOME desktop of
other distributions, you typically find the menu option to log out in the
second or third menu button from the left on the top panel.
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KDE

KDE stands for the K Desktop Environment. The KDE project started in
October 1996 with the intent to develop a common GUI for UNIX systems
that use the X Window System. The first beta version of KDE was released a
year later in October 1997. KDE version 1.0 was released in July 1998; KDE
2.0 on October 23, 2000; KDE 3.0 was released on April 3, 2002; and the latest
version — KDE 3.4 — was released on March 16, 2005.

From the user’s perspective, KDE provides a graphical desktop environment
that includes a window manager, the Konqueror Web browser and file man-
ager, a panel for starting applications, a help system, configuration tools,
and many applications, including the OpenOffice.org office suite, image
viewer, PostScript viewer, and mail and news programs.

For developers, KDE has class libraries and object models for easy applica-
tion development in C++. KDE is a large development project with many
collaborators.

You can always find out the latest information about KDE by visiting the KDE
home page at www . kde. org.

If your Linux system’s default GUI is KDE, you get the KDE GUI as soon as
you log in. Typically, you see an initial KDE desktop similar to the one shown
in Figure 4-9 — in this case, the KDE desktop in SUSE Linux.

You find that KDE is very easy to use and is similar in many ways to the
Windows GUI You can start applications from a menu that’s similar to the
Start menu in Windows. As in Windows, you can place folders and applica-
tions directly on the KDE desktop.

KDE panel

The KDE panel appearing along the bottom edge of the screen is meant for
starting applications. The most important component of the panel is the
Main Menu button on the left-most side of the panel. That button is like the
Start button in Windows. When you click the Main Menu button, a menu
appears. From this menu, you can get to other menus by moving the mouse
pointer over items that display a right-pointing arrow. For example, Figure
4-10 shows a typical menu selection for configuring various services.

You can start applications from this menu. That’s why the KDE documenta-
tion calls the Main Menu button the Application Starter.

Next to the Main Menu button, the panel includes many more buttons. If you
don’t know what a button does, simply move the mouse pointer over the
button; a small pop-up window displays a brief message about that button.
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Figure 4-11:
The initial
window of
the KDE
Control
Center.

Customizing the KDE desktop

KDE makes customizing the look and feel of the KDE desktop easy. Everything
you have to decorate the desktop is in one place: the KDE Control Center. To
start the KDE Control Center, choose Main Menu=>Control Center.

When the KDE Control Center starts, it displays the main window with a list
of items on the left side and some summary information about your system
in the workspace to the right, as shown in Figure 4-11.

aKDE Compenents.
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= KDE version: 3.4.2 Leval "b™
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. Click or the "Hela tab on te left o view felp for fhe edive ol module, Use the
“% ¥asT2 Mocules “Smmrch tmb if you are unsare where b look fora particwer cnfigurstion cption.

The KDE Control Center’s left side shows the items that you can customize
with this program. The list is organized into categories, such as Appearance &
Themes, Desktop, Internet & Network, KDE Components, Peripherals,
Security & Privacy, Sound & Multimedia, System Administration, and so

on. Click an item to view the subcategories for that item. Click one of the
subcategory items to change it. That item’s configuration options then
appear on the right side of the Control Center window.

To change the desktop’s background, click Appearance & Themes, and then
click Background. The right side of the Control Center (see Figure 4-12)
shows the options for customizing the desktop’s background.

If you want to change the background of a specific desktop, click the Setting
for Desktop drop-down list. From the list of desktops, you can select which
desktop background you want to change.
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For a colored background, select the No Picture radio button. From the Colors
drop-down list, you can select a single-color background or a variety of color
gradients (meaning the color changes gradually from one color to another) or
a pattern to be used as a background. You can then pick the colors by clicking
the color buttons that appear under the Colors drop-down list. After making
your selections, click Apply to try out the background. (If you don’t like what
you get, click Reset to revert back to the previous background.)

If you want to use a picture as background, select the Picture radio button
and click the folder icon to the right of the drop-down menu next to that
radio button. A dialog box comes up, showing the JPEG images in the /usr/
share/wallpapers directory. You can select any one of these images or
pick an image from another directory and click OK. Then click the Apply
button in the KDE Control Center to apply this wallpaper to the desktop. If
you don’t like the appearance, click Reset.

Logging out of KDE

When you’re done exploring KDE, log out. To log out of KDE, choose Main
Menur>Logout. You can also right-click empty areas of the desktop and
choose Logout from the context menu that appears.

Playing with the Shell

Linux is basically UNIX, and UNIX just doesn’t feel like UNIX unless you can
type cryptic commands in a text terminal. Although GNOME and KDE have
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Figure 4-13:
You can
type Linux
commands
at the shell
promptin a
terminal
window.

done a lot to bring us into the world of windows, icons, mouse, and pointer —
affectionately known as WIMP :-) — sometimes you're stuck with nothing but a
plain text screen with a prompt that looks something like this (when you log in
as naba):

naba@linux:/etc>

You see the text screen most often when something is wrong with the X
Window System, which is essentially the machinery that runs the windows
and menus that you normally see. In those cases, you have to work with the
shell and know some of the cryptic Linux commands.

You can prepare for unexpected encounters with the shell by trying out
some Linux commands in a terminal window while you’re in the GNOME

or KDE GUI. After you get the hang of it, you might even keep a terminal
window open, just so you can use one of those cryptic commands — simply
because it’s faster than pointing and clicking. Those two-letter commands do
pack some punch!

Starting the bash shell

Simply put, the shell is the Linux command interpreter — a program that
reads what you type, interprets that text as a command, and does what the
command is supposed to do.

Before you start playing with the shell, open a terminal window. In either
GNOME or KDE, the panel typically includes an icon that looks like a moni-
tor. When you click that icon, what appears is a window with a prompt, like
the one shown in Figure 4-13. That’s a terminal window, and it works just like
an old-fashioned terminal. A shell program is running and ready to accept
any text that you type. You type text, press Enter, and something happens
(depending on what you typed).

- Shell - Konsale -2

w  Bockmarks  Settings  Help

s | B Shell
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If the GNOME or KDE panel on your desktop does not seem to have an icon
that starts a terminal or shell window, search through the Main Menu hier-
archy and you should be able to find an item labeled Console or Terminal.
Selecting that item should then open up a terminal window.

The prompt that you see depends on the shell that runs in that terminal
window. The default Linux shell is called bash.

bash understands a whole host of standard Linux commands, which you can
use to look at files, go from one directory to another, see what programs are
running (and who else is logged in), and a whole lot more.

In addition to the Linux commands, bash can run any program stored in an
executable file. bash can also execute shell scripts — text files that contain
Linux commands.

Understanding shell commands

Because a shell interprets what you type, knowing how the shell figures out
the text that you enter is important. All shell commands have this general
format:

command optionl option2 ... optionN

Such a single line of commands is commonly called a command line. On a
command line, you enter a command followed by one or more optional
parameters (or arguments). Such command-line options (or command-line
arguments) help you specify what you want the command to do.

One basic rule is that you have to use a space or a Tab to separate the com-
mand from the options. You also must separate options with a space or a
Tab. If you want to use an option that contains embedded spaces, you have
to put that option inside quotation marks. For example, to search for two
words of text in the password file, | enter the following grep command.
(grep is one of those cryptic commands used to search for text in files.)

grep "WWW daemon" /etc/passwd

When grep prints the line with those words, it looks like this. (What you see
on your system may differ from what I show.)

wwwrun:x:30:8:WWW daemon apache:/var/lib/wwwrun:/bin/false

If you created a user account in your name, go ahead and type the grep
command with your name as an argument but remember to enclose the
name in quotes.
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Trying a few Linux commands

While you have the terminal window open, try a few Linux commands just
for fun. I guide you through some random examples to give you a feel for
what you can do at the shell prompt.

To see how long the Linux PC has been up since you last powered it up, type
the following. (Vote: I show the typed command in bold, followed by the
output from that command.)

uptime
12:06:34 up 59 days, 16:23, 4 users, load average:
0.56, 0.55, 0.37

The part up 59 days, 16:23 tells you that this particular PC has been up
for nearly two months. Hmmm . . . can Windows do that?

To see what version of Linux kernel your system is running, use the uname
command like this:

uname -srv

This runs the uname command with three options: -s, -r, and -v (which
can be combined as -srv, as this example shows). The -s option causes
uname to print the name of the kernel, -r prints the kernel release number,
and -v prints the kernel version number. The command generates the fol-
lowing output on one of my Linux systems:

Linux 2.6.14-1.1696_FC5 #1 Sat Nov 19 19:02:13 EST 2005
In this case, the system is running Linux kernel version 2.6.14.

To read a file, use the more command. For example, type more /etc/passwd
to read the /etc/passwd file. The resulting output looks similar to the
following:

root:x:0:0:root:/root:/bin/bash
bin:x:1:1:bin:/bin:/bin/bash
daemon:x:2:2:Daemon: /sbin: /bin/bash
lp:x:4:7:Printing daemon: /var/spool/lpd:/bin/bash
mail:x:8:12:Mailer

daemon: /var/spool/clientmqueue: /bin/false
news:x:9:13:News system:/etc/news:/bin/bash
uucp:x:10:14:Unix-to-Unix CoPy system:/etc/uucp:/bin/bash

lines deleted ...
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To see a list of all the programs currently running on the system, use the ps Book I
command, like this: Chapter 4
ps ax =
=
The ps command takes many options, and you can provide these options a
without the usual dash prefix. This example uses the a and x options. The a g
option lists all processes that you are running, and the x option displays -
the rest of the processes. The net result is that ps ax prints a list of all E

processes running on the system, as shown in the following sample output
of the ps ax command:

PID TTY STAT TIME COMMAND
17 S 0:01 init [5]
2 2 SN 0:00 [ksoftirgd/O0]
37 S< 0:00 [events/O0]
4 ? S< 0:00 [khelper]
9 ? S< 0:00 [kthread]
22 2 S< 0:00 [kblockd/0]
58 2 S 0:00 [kapmd]
79 7 S 0:00 [pdflush]
80 ? S 0:00 [pdflush]
82 7 S< 0:00 [aio/O0]
lines deleted ...
5325 ? Ss 0:00 /opt/kde3/bin/kdm
5502 ? S 0:12 /usr/X11R6/bin/X -br -nolisten
tcp :0 vt7 -auth /var/lib/xdm/authdir/authfiles/A:0-
plAOrt
5503 ? S 0:00 -:0
6187 ? Ss 0:00 /sbin/portmap
6358 ? Ss 0:00 /bin/sh /usr/X11R6/bin/kde
6566 ? Ss 0:00 /usr/sbin/cupsd
6577 ? Ssl 0:00 /usr/sbin/nscd

lines deleted ...

Amazing how many programs can run on a system even when only you are
logged in as a user, isn’t it?

As you can guess, you can do everything from a shell prompt, but it does
take some getting used to.

Shutting Down

When you’re ready to shut down Linux, you must do so in an orderly
manner. Even if you're the sole user of a Linux PC, several other programs
usually run in the background. Also, operating systems such as Linux try to
optimize the way that they write data to the hard drive. Because hard drive
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access is relatively slow (compared with the time needed to access memory
locations), data generally is held in memory and written to the hard drive in
large chunks. Therefore, if you simply turn off the power, you run the risk
that some files aren’t updated properly.

Any user (you don’t even have to be logged in) can shut down the system
from the desktop or from the graphical login screen, although some distribu-
tions, such as Debian, prompt you for the root password. Choose Main
Menur>Log Out (or look for a Log Out option in the menus). A Log Out dialog
box appears, providing the options for rebooting or halting the system or
simply logging out. To shut down the system, simply select Shutdown and
click OK. The system then shuts down in an orderly manner.

If the log out menu does not have an option to shut down, first log out and
then select Shutdown from the graphical login screen.

As the system shuts down, you see messages about processes shutting
down. You may be surprised at how many processes there are even when no
one is explicitly running any programs on the system. If your system does
not automatically power off on shutdown, you can manually turn off the
power.

Note that shutting down or rebooting the system may not require root
access. This is why it’s important to make sure that physical access to the
console is protected adequately so that anyone who wants to cannot simply
walk up to the console and shut down your system.
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Chapter 1: Introducing
the GUI Desktops

In This Chapter

v Discovering the common features of the GNOME and KDE GUIs

+ Introducing Debian’s GNOME desktop

+ Introducing Fedora Core’s GNOME desktop
+ Introducing the Knoppix desktop

v Introducing the MEPIS desktop

v+ Introducing the SUSE desktop

+” Introducing the Ubuntu’s GNOME desktop
v Introducing the Xandros desktop

Linux distributions come with one of two popular graphical user inter-
faces (GUIs) — GNOME and KDE. GNOME and KDE are similar to
Microsoft Windows, but they are unique in one respect. Unlike Microsoft
Windows, you can pick your GUI in Linux. If you don’t like GNOME, just log
out and log back in with the KDE, the other GUI. Try doing that with
Microsoft Windows!

GNOME and KDE were developed independently of Linux. In fact, GNOME
and KDE run on other UNIX operating systems besides Linux. You also have
the option to install other GUIs, such as FVYWM and Xfce, in Linux. Visit www .
freedesktop.org/wiki/Desktops to see a list of other X desktops
(desktops that run on X Window System).

This chapter explores the major features of GNOME and KDE. You can best
figure out these GUIs by simply starting to use them.

Each Linux distribution typically installs one of the GUIs by default. The
default GUI is GNOME in Debian, Fedora Core, and Ubuntu; and the default is
KDE in Knoppix, MEPIS, SUSE, and Xandros. In Debian, you can install either
GNOME or KDE. Each distribution also customizes GNOME or KDE to create
a desktop that is unique to the distribution. For this reason, I also provide
an overview of each distribution’s desktop — GNOME with Debian, Fedora
Core, and Ubuntu; and KDE with Knoppix, MEPIS, SUSE, and Xandros. Think
of this as a brief introduction. You have to explore the desktops on your
own because that’s the best way to get used to the GUIs.
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Getting to Know the Common Features of the GUIs

From a user’s perspective, both GNOME and KDE probably seem similar
because many features work similarly. Become familiar with these common
features so that you can rely on them no matter which GUI you choose to
use for your daily work.

Most importantly, no matter which GUI you decide to use, all GUI
applications — whether they are based on GNOME or KDE — run on all
GUI desktops. In other words, you can run KDE applications under GNOME
and vice versa. The only hurdle is that sometimes both GNOME and KDE
applications may not be installed by default.

For starters, the initial desktop for both GNOME and KDE looks like any
other popular GUI, such as Microsoft Windows or the Mac OS X desktop. For
example, Figure 1-1 and Figure 1-2, respectively, show typical GNOME and
KDE desktops.
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Figure 1-1: )
A typical fedora
GNOME
desktop.
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Both desktops (Figures 1-1 and 1-2) initially show icons for your computer,
your home folder, and the trash can for deleted files. The other major feature
of both GNOME and KDE desktops is the panel — the bar along the bottom
in KDE and the top and bottom bars in GNOME. Each panel is similar to the
Windows taskbar. It has buttons on the left (shortcuts to various programs)
and a time display to the right. The middle part of the panel shows buttons
for any applications you've started (or were automatically started for you).

A\

Move the mouse over any icon on the panel and a small pop-up window dis-
plays the name of that icon. The pop-up window also gives a hint about what
you can do with that icon.

Desktop context menus

Both GNOME and KDE desktops display a context menu when you right-click
a clear area on the desktop. The exact contents of that menu depends on the
desktop, but it typically offers menu options that enable you to perform the
following types of tasks:

4 Run a command.

4 Open a terminal window where you can type Linux commands.
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4 Create a new folder.

4+ Configure the desktop background.

4+ Rearrange the icons on the desktop.
For example, Figures 1-3 and 1-4, respectively, show the desktop context
menus in typical GNOME and KDE desktops. Desktop menu options with a

right-pointing arrow have other menus that appear when you put the mouse
pointer over the arrow.
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Icon context menus
Right-clicking any desktop icon in GNOME or KDE causes another menu to
appear. (See Figures 1-5 and 1-6.) Many items on this context menu are the
same no matter what icon you click, but right-clicking certain icons (for
example, the Trash icon) produces a somewhat different menu. You can
perform the following typical tasks from icon context menus:

4 Open a folder in a file manager.

4+ Open a file with an application that you choose.

4+ Rename the icon.

4+ Move the icon to trash.

4 View the properties of that icon.
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For the Trash icon, the icon context menu typically provides an option to per-
manently delete the items in the trash. (You get a chance to say Yes or No.)
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[ bet you see a pattern here. It’s the right-click. No matter where you are in a
GUI desktop, always right-click before you pick. You're bound to find some-
thing useful when you right-click!

The panel

The panel is the long bar that stretches across the top or bottom of the desk-
top. In GNOME, there are two panels. Figures 1-7 and 1-8 show typical views
of the GNOME top panel and the single KDE panel, respectively.

Book Il
Chapter 1

sdopjsaq In9
ay) buianposuj



138 Getting to Know the Common Features of the GUIs

Figure 1-7:
A typical
view of a
GNOME top
panel.

Figure 1-8:
Atypical
view of a
KDE panel.
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The panel is a parking place for icons. Some icons start programs when you
click them. Some show status (such as what programs are currently running)
as well as information such as date and time.

CELEE aou it

Starting at the left, the first icon (regardless of what it shows) is the Main
Menu button — it’s like the Start button in Microsoft Windows. Then come a
few icons that start various programs.

By the way, if you move the mouse pointer on top of an icon, a Help balloon
pops up and gives you a helpful hint about the icon.

To the right of the leftmost set of icons in the KDE panel, a Workspace
Switcher icon shows four rectangular areas, each representing a virtual desk-
top. The icon is variously known as Workspace Switcher, Desktop Pager, or
simply Pager. You can click one of these rectangles to switch to a different
virtual desktop. This feature is like having four separate virtual desktops to
work with. To be honest, | end up using only one desktop, but I like knowing
the others are there if | ever need them. On the other hand, if you're writing
code and preparing a user’s guide for a new program, you can use one desk-
top for all the coding work and a second desktop for writing the user’s guide.
You can, of course, switch from one desktop to the other with a single mouse
click.

The area to the right of the Desktop Pager icon displays buttons for the pro-
grams you have started so far. This area is blank if you have not yet started
any programs.



<MBER
@@

Getting to Know the Common Features of the GUIs 139

Other icons may be next to the Pager, but the date and time always appear at
the far-right edge of the panel.

Now for a little bit of technical detail about these icons on the panel. The
panel itself is a separate application; each icon is a button or a program
called an applet. The applets are little applications (also called plugins).
These panel applets can do things, such as launch other programs or display
the date and time. Before you can run an applet, you have to add it to the
panel. Right-click an empty area of the panel and select the appropriate
menu item to add an applet to the panel. After adding the applet, you can
right-click the applet’s icon to configure it or perform some task that the
applet supports.

If you right-click any icon — or right-click anywhere on the panel — you get
a context menu which allows you to do something relevant to that icon
(such as move it or remove it entirely). You can also set some preferences
and add more buttons and applets to the panel.

The Main Menu

The leftmost icon on the GNOME top panel and the KDE’s one and only panel
is the Main Menu button. That’s where you typically find all the applications,
organized into submenus. In this section, | provide some examples of the
Main Menu and point out some interesting items. You can then do further
exploration yourself.

On GNOME desktops, the leftmost menu button on the top panel is typically
labeled Applications, and the top panel has one or more additional menu
buttons, such as Places and Desktop in Fedora Core’s GNOME desktop.

Click the Main Menu button to bring up the first-level menu. Then mouse
over any menu item with an arrow to bring up the next-level menu and so
on. You can go through a menu hierarchy and make selections from the final
menu. Figures 1-9 and 1-10, respectively, show the main menu hierarchies in
typical GNOME and KDE desktops.

A word about the way I refer to a menu selection: I use the notation Main
Menu=>System~>Desktop Applet~>OpenOffice.Org Quickstarter to refer to the
menu selection shown in Figure 1-10. Similarly, I say choose Applications=>
Internet=>Firefox Web Browser to refer to the menu sequence highlighted in
Figure 1-9. You get the idea.
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Figure 1-9:
The main
menu
hierarchy
in a typical
GNOME
desktop.
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Figure 1-10:
The main
menu
hierarchy
in a typical
KDE
desktop.
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In most desktops, the top-level Main Menu has the following types of menu
categories:

4+ Accessories or Utilities: Lots of utility programs, such as a scientific cal-
culator, character selector, floppy formatter, dictionary, Palm Pilot or
Handspring sync, and so on.

4+ Games: A menu of — what else? Games (and a whole lot of them at
that — Solitaire, Mahjongg, Mines, Reversi, and many more)

4+ Graphics: Programs such as The GIMP (an Adobe Photoshop-like pro-
gram), a digital camera interface, a scanner interface, a screen-capture
program, and an Adobe Acrobat viewer

4+ Internet: Internet applications, such as the Web browser, e-mail reader,
and instant messenger

4+ Office: Office applications such as the OpenOffice.org office suite
(includes Writer word processor, Calc spreadsheet, Impress slide pres-
entation program, Draw drawing program, and much more)

4+ Preferences or Settings: Options to configure many aspects of the
system, including the appearance and the behavior of the desktop

4 Multimedia or Sound & Video: Multimedia applications such as CD
player, sound mixer, sound recorder, and volume control

4+ System: System administration tools for configuring your Linux system
The Main Menu typically also has a few menu items for some commonly per-
formed tasks, such as the following:

4 Main Menu~>Help: Displays online help.

4 Main Menu~>Run Command: Displays a dialog box where you can enter
the name of a program and then click Run to start that program.

4 Main Menu=>Search for Files (or Find Files): Runs a search tool from
which you can search for files.

4 Main Menu~>Lock Screen: Starts the screen saver and locks the screen.
When you want to return to the desktop, the system prompts you for
your password.

4 Main Menu~>Logout: Logs you out. (You get a chance to confirm
whether you really want to log out.)

The Main Menu in each distribution has different categories, but the menu
organization is similar enough that you can usually find what you need.

Okay. That’s all I'm telling you about the Main Menu. You’ll use the Main
Menu a lot as you use GNOME or KDE desktops. Even if it seems too much
initially, it all becomes very familiar as you spend more time with Linux.
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In the following sections, I provide an overview of specific desktops:
Debian’s GNOME desktop, Fedora Core’s GNOME desktop, Knoppix desktop,
MEPIS’s KDE desktop, SUSE desktop, Ubuntu’s GNOME desktop, and Xandros
desktop.

Introducing Debian’s GNOME Desktop

Debian’s default GNOME desktop has a simple look (see Figure 1-11) with
just three icons — a Computer icon, your home folder, and the Wastebasket
icon — on the desktop.

In Figure 1-11, note the following major items in Debian’s GNOME desktop
and what happens when you click each:

4+ Desktop Icons: The Computer icon opens your computer for browsing in
Nautilus File Manager. The Home Folder icon opens your home folder in
Nautilus File Manager (see Chapter 3 of this minibook for more informa-
tion on browsing folders with Nautilus).

4+ Wastebasket (or Trash) icon: Represents a place where deleted items
are stored until you empty the wastebasket.

4+ Applications Menu (Main Menu): Brings up the Main Menu, from which
you can select applications to run.

4+ Actions Menu: Provides menu options to run an application, search for
files, take a screenshot, lock the screen, and log out.

4 Nautilus File Browser: Opens your home folder in the Nautilus File
Manager in file browsing mode (see Chapter 3 of this minibook for an
explanation of browsing the file system with Nautilus).

4 Terminal Program: Opens a terminal window where you can type Linux
commands.

4+ Workspace Switcher: Each square brings up a different desktop. This is
similar to the Desktop Pager in KDE desktops.

4+ Show Desktop: Shows the desktop by minimizing all windows.

4+ Volume: Shows a volume control bar that you can use to change the
sound’s volume by dragging a slider.

4+ Window Selector: Displays a list of currently open windows from which
you can click and bring that window to the front and make it the cur-
rently active window.

4+ Date and Time: Displays current date and time, and clicking brings up a
calendar showing the current date.



Figure 1-11:
Debian’s
default
GNOME
desktop.
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Clicking Main Menu brings up the Main Menu, shown in Figure 1-12, that

gives you access to most of the applications in Debian. Of course, the exact
list of applications in various submenus depends on what you have installed,
but Figure 1-12 gives you a view of a typical Main Menu in Debian. To browse

the Main Menu, mouse over items that have a right arrow, and a submenu
pops up with more items.

The Actions Menu is the other menu that you can launch from the panel.
Through the Actions Menu, you can perform other tasks, such as run any
application, search for files, take screenshots, and log out.
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Figure 1-12:
Start
applications
from the
Main Menu
in Debian’s
GNOME
desktop.
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To explore Debian’s GNOME desktop, try clicking the panel icons to start the
applications. In particular, you can click the Nautilus File Browser icon on
the top panel to open your home folder in the Nautilus file manager. After
that window opens, you can explore other folders to get a feel for the file
system.

You can also click the Main Menu and mouse over the items to see all the
submenus to get an idea of the variety of applications that you can run in
Debian. You can, of course, click an item to start a specific application and
give each one a try.

Introducing Fedora Core’s GNOME Desktop

GNOME is the default GUI for Fedora Core. This means that when you first
log in at the GUI login screen, you get the GNOME desktop, as shown in
Figure 1-13. The desktop shows icons for the computer, your home folder,
and trash.

The following list touches on the major parts of the GNOME desktop and
gives a brief description of each part’s purpose:

4+ Desktop Icons: Double-click the Computer icon to view the contents of
the computer and double-click the Home icon to open your home folder
in a Nautilus File Manager window. The Trash icon holds deleted items.
The desktop also shows icons for other removable media such as CDs
and DVDs.



Figure 1-13:
The GNOME
desktop in
Fedora
Core.
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4+ Applications Menu (Main Menu): Brings up the Main Menu, from which
you can select applications to run.

4+ Places Menu: Displays a menu from which you can open your home
folder, view the desktop, browse the computer, connect to servers such
as FTP and Windows shares, and search for files.

Book

Chapter 1

sdopjsaq In9

ay) Buronponuj



746 Introducing the Knoppix Desktop

4+ System Menu: Brings up a menu from which you can edit desktop prefer-
ences, edit system settings, get online help, lock the screen, and log out.
Systemr>Administration=>Server Settings displays a menu that enables
you to start GUI system configuration utilities for configuring various
Internet servers, including Web, FTP, DNS, Samba, and others.

+

Firefox Web Browser: Runs the Mozilla Firefox Web browser.

+

Evolution: Starts the Evolution e-mail and calendar software.

4+ OpenOffice.org Writer: Runs OpenOffice.org Writer, a Microsoft Word-
like word processor.

4+ OpenOffice.org Impress: Runs the OpenOffice.org Impress slide-
presentation program (which is similar to Microsoft PowerPoint).

4+ OpenOffice.org Calc: Runs the OpenOffice.org Calc, a Microsoft Excel-
like spreadsheet program.

4+ Show Desktop: Shows the desktop by minimizing all windows.

4+ Workspace Switcher: Each square brings up a different workspace. This
has the same function as the Desktop Pager in KDE desktops.

4 Volume: Shows a volume control bar that you can use to change the
sound’s volume by dragging a slider.

4+ Date and Time: Displays current date and time, and clicking brings up a
calendar showing the current date.

Click Main Menu (refer to Figure 1-13) to open the main menu and explore
the categories. From the main menu, you can access nearly all applications
and utilities in Fedora Core.

Introducing the Knoppix Desktop

Knoppix does not require you to log in with a username. After you boot your
PC from the Knoppix CD, you end up with the initial Knoppix desktop shown
in Figure 1-15. Knoppix uses a customized version of KDE for its desktop, so
you may notice similarities with other KDE-based desktops such as MEPIS,
SUSE, and Xandros. In particular, the MEPIS desktop looks similar to the
Knoppix desktop because MEPIS also includes many of the same desktop
icons and panel items.

Compared to some other distributions, Knoppix has a lot of desktop icons
and panel items. This is primarily because Knoppix detects and adds desk-
top icons for all detected hard drive partitions, CD/DVD-ROM drives, and
floppy drives.
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In Figure 1-14, note the following major components of the Knoppix desktop:

4+ Desktop Icons: Knoppix displays icons for all hard drive partitions,
CD/DVD drives, and the floppy drive. Click to mount and open any of
these storage devices and access their contents. Additionally, there is a
Trash icon and a shortcut to the Knoppix manual (which Knoppix opens
in a Konqueror window after it starts).

4+ Hide Panel: The two end-points of the panel serve as Hide Panel but-
tons, which means that if you click one of them, the panel slides over
and disappears, leaving only the Hide Panel buttons. Click again and the
panel reappears. You can hide the panel to create more room for other
windows. Book Il

4+ Main Menu (K Menu): From this Main Menu (see Figure 1-15), you can Chapter 1

select applications to run, lock the screen, get online help, or log out.

4+ Knoppix Menu: Brings up a menu that you can use to perform tasks
such as configuring devices (printers, sound card), setting up a network,
turning a few servers such as SSH and Samba on or off, and opening a
root shell window where you can type commands as a superuser.
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4+ Window List: Click to view the list of currently open windows and to
arrange the windows on the desktop.

4+ Show Desktop: Shows the desktop by minimizing all windows.

4+ Home Folder: Opens your home directory in the Konqueror file
manager.

4 Terminal Program: Runs Konsole, a program that provides a terminal
window where you can type Linux commands.

4+ Konqueror Web Browser: Runs the Konqueror Web browser.
4+ Firefox Browser: Runs the Firefox Web browser.

4+ OpenOffice: Starts OpenOffice.org Writer, a Microsoft Word-like word
processor. You can start other OpenOffice.org programs such as
Impress, Calc, and Draw from the Main Menu.

4+ Desktop Pager: Each square brings up a different desktop.

4 Program Icons: This area shows icons for the currently running
programs.

4+ Keyboard Layout: Click to switch between a number of keyboard lay-
outs: U.S., German, and French. (The flag on the icon indicates which
country’s layout the keyboard is currently using.)

4+ Display Configuration: Click to change screen resolution or configure
the display.
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4+ Volume: Starts the KMix utility that enables you to change the volume as
well as control other aspects of the sound card.

4+ Date and Time: Displays the current date and time. Click to bring up a
calendar showing the current date.
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Figure 1-15:
Start
applications
from the
Knoppix
Main Menu.
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Figure 1-15 shows the Knoppix Main Menu that appears when you click Main
Menu on the panel. As in all desktops, the Main Menu is your first step to
accessing the applications in Knoppix. For a single-CD distribution, Knoppix
packs a surprisingly large number of applications, as you can probably
guess by looking at the application categories shown in the Main Menu in
Figure 1-15.
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The Knoppix Menu, shown in Figure 1-16, is another important menu that
you can open from the panel. This menu enables you to configure devices,
set up network connections, start servers, run some utility programs, and
open a root shell — a terminal window where you can type Linux com-
mands as root (the superuser).

To explore the rest of Knoppix, start by clicking the panel icons to start
applications such as the Web browser and OpenOffice.org Writer. One
good place to start is the Home icon that opens your home directory in
a Konqueror window. From that Konqueror window, you can explore the
rest of the file system.
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Figure 1-16:
Configure
network
connections
and devices
from the
Knoppix
Configura-
tion Menu.
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To mount and access files on any of the hard drive partitions detected by
Knoppix, simply click the icon on the desktop. Knoppix then mounts and
shows that partition’s contents in a Konqueror window. For example, on

my laptop I can click the Hard Disk Partition [hda2] icon on the desktop

to access the files on that partition. That partition happens to be an NTFS
partition with the Windows XP operating system on my laptop. Knoppix can
mount and open that partition so that I can access those partition files.

You can also click the Main Menu and explore the huge number of applica-
tions in Knoppix.

Oh, the secret of how Knoppix packs so many applications on a single CD
(with less than 700MB capacity): Knoppix stores the files in a compressed
format on the CD and then decompresses them on the fly as they are
needed. Impressive, isn’t it?

Introducing the MEPIS KDE Desktop

MEPIS is based on Debian, and it uses KDE as its desktop. Figure 1-17 shows
the initial MEPIS desktop. Note that the MEPIS desktop has desktop icons for
all storage devices and includes a large number of panel icons for accessing
many applications and utilities.

As Figure 1-17 shows, the MEPIS desktop includes the following key elements:

4+ Desktop icons: MEPIS displays desktop icons for all hard drive partitions,
CD/DVD drives, and the floppy drive. Click to open and view the contents
of any of these storage devices. The desktop also displays a Trash icon for
deleted items and an icon with a link to the MEPIS Web site.

Main Menu: Brings up the MEPIS main menu (see Figure 1-18) from
which you can perform a variety of tasks such as start applications, run
a command, get help, find files, access the MEPIS OS Center, start a new
session, or log out.



Introducing the MEPIS KDE Desktop 151

Deleted items

Storage devices Link to MEPIS Web site

Book Il
Chapter 1

sdopjsaq In9
ay) buianposuj

Figure 1-17:
The initial
MEPIS
deSktOp. 1 = 84.3°F =
Main D QP DT sl FERIEES LA
Menu | |
Text | Desktop System Weather
Control editor| Pager  performance
Center monitor Mount
CD & DVD Burning Windows
Info ) Shares
Center OpenOffice.org :
Clipboard | OpenOffice.org
KDE Kontact tool | Quickstart
Systems
Guard Konqueror Web browser Volume Date and Time
Terminal Firefox Web browser
program Home folder
Synapatic
Package Show Desktop

Manager || MEPIS 0S Center

File Manager

Browse Windows Network



152 Introducing the MEPIS KDE Desktop

Figure 1-18:
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MEPIS
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Info Center: Runs the KDE Info Center where you can view information
about the hardware devices and memory of your system.

KDE System Guard: Runs the KDE System Guard utility that enables you
to manage processes and monitor system performance.

Control Center: Starts the KDE Control Center from where you can con-
figure various aspects of the KDE desktop.

Terminal Program: Opens a terminal window with a root login where
you can type Linux commands.

MEPIS OS Center: Starts the MEPIS OS Center from which you can
access the MEPIS operating system installation and configuration utili-
ties. You can perform tasks such as repair partitions and change the
host name of your system.

Synaptic Package Manager: Runs the Synaptic package manager — a
GUI front-end to Debian APT (Advanced Package Tool) that you can use
to install or remove software packages.

File Manager: Starts Konqueror file manager with the privileges of the
root user (superuser).

Browse Windows Network: Opens a Konqueror file manager window
from which you can browse and access Windows shares.

Show Desktop: Click to hide all windows and show the desktop.

Home Folder: Opens your home directory in the Konqueror file
manager.
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Firefox Web Browser: Runs the Mozilla Firefox Web browser.
Konqueror Web Browser: Runs the Konqueror Web browser.
Kontact: Runs the Kontact personal information manager.
Text Editor: Runs the KWrite text editor.

CD/DVD Burning: Runs the K3B CD/DVD burning application.

OpenOffice.org Writer: Runs the OpenOffice.org Writer word process-
ing application.

Desktop Pager: Click on each square to bring up a different desktop.

System Performance Monitor: Displays the current system performance
(memory and processor usage).

Volume: Click to control sound volume.

Clipboard Tool: Click to see what you've cut and what you can paste
elsewhere.

OpenOffice.org Quickstart: Right-click to open a new OpenOffice.org
document.

Mount Windows Shares: Click to open the Smb4K that enables browsing
and mounting Windows shares.

Weather: Displays the current weather for a selected location (right-
click and select Configure KWeather to change location).

Date and Time: Displays the current date and time. Clicking brings up a
Time and Date utility for setting date and time.

The MEPIS Main Menu (refer to Figure 1-18) has a typical KDE main menu
structure that arranges the menu items into three broad categories — Most
Used Applications shows the icons for applications you have used recently,
All Applications has several submenus for accessing the applications, and
Actions shows menus for some common tasks such as accessing the printing
system, locking the screen, running a command, starting a new session, or
logging out. To familiarize yourself with what MEPIS has to offer as a desktop
operating system, go through the menus in the All Applications category of
the MEPIS Main Menu.

Introducing the SUSE Desktop

SUSE Linux is a commercial product, and it provides a customized desktop.
SUSE automatically logs in the local user that you defined during installation
and brings up the initial desktop, as shown in Figure 1-19.
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Follow along in Figure 1-19 as I point out some of the more noteworthy ele-
ments on the SUSE desktop:

4+ Desktop Icons: SUSE displays the usual desktop icons — a My Computer
icon for browsing the contents of the computer, a Trash icon, an icon for
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browsing the local Windows network, as well as icons for Firefox Web
browser, print manager, and OpenOffice.org office suite.

4 Main Menu: Brings up the Main Menu (see Figure 1-20) from which you
can start applications, lock the screen, get help, switch users, or log out.

4+ Home Folder: Opens your home directory in the Konqueror file
manager.

4+ Terminal Program: Runs Konsole, a program that provides a terminal
window where you can type Linux commands.

4+ SUSE Help Center: Starts the SUSE Help Center, where you can get help
on various aspects of SUSE Linux.

4+ Konqueror Web Browser: Runs the Konqueror Web browser.

4+ Kontact: Starts the Kontact personal information manager for KDR. From
Kontact you can read mail, manage your contacts, maintain your sched-
ule, read RSS feeds, and much more.

4+ Desktop Pager: Click each square to bring up a different desktop.

4+ Clipboard Tool: Click to see what has been cut and what you can paste
elsewhere.

4+ Powersaver Tool: Right-click to view a menu that you can use to start
the YaST Power Management module that enables you to edit power-
saver settings.

+

Volume: Click to control sound volume.

4 SUSE Hardware Tool: Click to view information about devices on the PC
and configure them.

4+ SUSE Watcher: Click to open a window you can use to both check for
online updates as well as start online updates.

4 Clock: Displays the current time. Clicking brings up a calendar showing
the current date.

4+ Hide Panel: The end-point of the panel serves as a Hide Panel button,
which means that if you click this icon, the panel slides to the right and
disappears, leaving only the end-point. Click again and the panel reap-
pears. You can hide the panel to create more room for other windows.

In addition to what you see on the SUSE desktop, you have many more choices
in the main menu that appears when you click Main Menu on the panel. See
Figure 1-20. Similar to the Windows Start button, the Main Menu is where you
start when you want to run an application.
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The SUSE Main Menu (refer to Figure 1-20) has three broad categories —
Most Used Applications shows the icons for applications you have used
recently, All Applications organizes the applications that you can access,
and Actions shows buttons for some common daily tasks such as locking
the screen, running a command, or logging out. You should browse the All
Applications category to familiarize yourself with what SUSE has to offer
as a desktop operating system.

Introducing the Ubuntu’s GNOME Desktop

Ubuntu uses the GNOME as its GUI desktop, with its characteristic top and
bottom panels, as shown in Figure 1-21. Unlike desktops in other distribu-
tions, Ubuntu does not use any desktop icons and has a clean look.



Figure 1-21:
The initial
Ubuntu
desktop.
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Applications Menu (Main Menu)

System
Menu Firefox Weh Browser
Evolution Volume Date
Places an
Menu Help Updates Time

@) Satjul 9. 1151 AM

€ Applicstions Places System

Show Desktop Workspace Switcher

Deleted items

As shown in Figure 1-21, Ubuntu’s GNOME desktop has the following major
features:

4 Applications Menu (Main Menu): Brings up the Main Menu, from which
you can select applications to run.

4 Places Menu: Displays a menu from which you can open the home
folder, browse the computer, connect to network servers, and search
for files.
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System Menu: Brings up a menu from which you can edit various appli-
cation preferences, perform system administration tasks such as install
and remove packages and update software through the Ubuntu Update
Manager, get online help, lock the screen, and log out.

Web Browser: Runs the Firefox Web browser.
Evolution: Starts the Evolution e-mail and calendar software.

Help: Displays online help information in Yelp — a documentation
viewer for GNOME.

Volume: Shows a volume control bar that you can use to change the
sound’s volume by dragging a slider.

Updates: Indicates if updates are available to install. Click to open a
window where you can view available updates and install them. Note
that, when prompted, you have to enter your normal user password.

Date and Time: Displays the current date and time; clicking brings up a
calendar showing the current date.

Show Desktop: Click to hide all windows and show the desktop.

Workspace Switcher: Each square brings up a different workspace. This
has the same function as the Desktop Pager in KDE desktops. Explore
the three menus (Application, Places, and System) to see the categories
of tasks you can perform from the selections in these menus.

Introducing the Xandros Desktop

The official name of the commercial Xandros distribution is Xandros Desktop
0S, so it’s no surprise that Xandros comes with a well-designed desktop.

On startup, Xandros automatically logs you in as a user (it uses the user
account that you defined during installation), and you get the initial desktop,
as shown in Figure 1-22.

Xandros is based on Debian, and it uses a customized version of KDE as its
desktop. As Figure 1-22 illustrates, you should note the following key ele-
ments in the Xandros desktop:

+

Desktop Icons: The Xandros desktop displays a number of desktop
icons: a Trash icon for deleted items, an icon for browsing your home
folder, icons representing links to Xandros Technical Support and
Quickstart guide, shortcuts to the Firefox Web browser, and an icon for
connecting to Xandros Networks (which is how you can download and
install updates and new applications in Xandros). You can double-click
to open these icons. The result of double-clicking depends on the icon.
For example, if you double-click the Xandros Quickstart Guide, the guide
opens in a Firefox Web browser window. On the other hand, double-
clicking the Home icon opens your home folder in Xandros File Manager.



Figure 1-22:
The initial
Xandros
desktop.
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4 Main Menu: Brings up the Main Menu (see Figure 1-23) from which you
can start applications, run a command, get help, switch users, or log out.

4+ Firefox Web Browser: Runs the Mozilla Firefox Web browser.

4 Thunderbird Mail: Starts the Mozilla Thunderbird Mail program for

accessing your e-mail.

4+ Xandros File Manager: Starts the Xandros File Manager, which is similar
to Windows Explorer in its layout and its ability to navigate local as well

as remote file systems.
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Figure 1-23:
Xandros
desktop
provides a
streamlined
Main Menu.

4+ Help: Click to open the Xandros Desktop Help Center window, where
you can get some help on Xandros and UNIX.

R

+

4+ Logout: Click to log out. (You have to confirm that you really want to

log out.)

4+ Clock: Displays the current time. Clicking brings up a Time and Date util-

ity for setting date and time.

4+ Hide Panel: Click to hide the panel. The panel slides to the right and dis-
appears, leaving only the button. Click again to view the panel. By hiding
the panel, you have more room for your application windows.

Xandros uses a streamlined Main Menu, shown in Figure 1-23, that appears
when you click Main Menu on the panel. The menu has all applications
organized into a single Applications category.

You can explore the Main Menu to find out more about the applications that
come with Xandros. I provide an overview of the applications in Chapter 4 of

this minibook.

Try out the Xandros File Manager by clicking the icon on the panel. From the
Xandros File Manager, you can browse various folders in your system, as
well as access any Windows shares on your local area network. You can do
all the usual things: move or copy files by dragging them and double-click on
files to open them. I found the Xandros File Manager to be a good starting

point for my Xandros sessions.

Most Used Applications
M Console
F% Screen Capture
All Applications
[ Applications 2
) Find »
W Control Center
= ®andros File Manager
Al & Xandros Networks
2] & Help

Actions
| Recent Documents b
£ Run Command...
| [0 Logout naba (Naba Barkakati)

# Launch

Show Desktop: Click to hide all windows and show the desktop.
Desktop Pager: Click each square to bring up a different desktop.
Volume: Click to change sound volume by dragging a slider.

Updates: Click to see status of Xandros updates and open Xandros
Networks to perform online updates.

Lock Desktop: Click to lock the screen so that no one can access it. (You
can access it again by entering your password.)



Chapter 2: Commanding the Shell

In This Chapter

+* Opening terminal windows and virtual consoles
1 Using the bash shell
v Discovering some Linux commands

 Writing shell scripts

S)metimes, things just don’t work. What do you do if the GUI desktop
stops responding to your mouse clicks? What if the GUI doesn’t start at
all? You can still tell your Linux system what to do, but you have to do it by
typing commands into a text screen. In these situations, you work with the
shell — the Linux command interpreter. I introduce the bash shell (the
default shell in most Linux distributions) in this chapter.

After you figure out how to work with the shell, you may even begin to like
the simplicity and power of the Linux commands. And then, even if you're a
GUI aficionado, someday soon you may find yourself firing up a terminal
window and making the system sing and dance with two- or three-letter
commands strung together by strange punctuation characters. (Hey, I can
dream, can’t I?)

Opening Terminal Windows and Virtual Consoles

First things first. If you're working in a GUI desktop, such as GNOME or KDE,
where do you type commands for the shell? Good question.

The easiest way to get to the shell is to open a terminal (also called console)
window. The GNOME and KDE GUIs in most distributions include an icon (or
a Main Menu option) to open a terminal window. Click that icon or choose
the menu option to get a terminal window. Now you can type commands to
your heart’s content.

If, for some reason, the GUI seems to be hung (you click and type but noth-
ing happens), you can turn to the virtual consoles. (The physical console is
the monitor-and-keyboard combination.) The idea of virtual consoles is to
give you the ability to switch between several text consoles even though
you have only one physical console. Whether you are running a GUI or not,
you can then use different text consoles to type different commands.
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To get to the first virtual console from the GNOME or KDE desktop, press

Ctrl+Alt+F1. Press Ctrl+Alt+F2 for the second virtual console, and so on. Each
of these virtual consoles is a text screen where you can log in and type Linux
commands to perform various tasks. When you’re done, type exit to log out.

You can use up to six virtual consoles. In most distributions, the seventh one
is used for the GUI desktop. To get back to the GUI desktop, press
Ctrl+Alt+F7.

Using the Bash Shell

If you’'ve used MS-DOS, you may be familiar with COMMAND . coM, the DOS
command interpreter. That program displays the infamous C: \> prompt. In
Windows, you can see this prompt if you open a command window. (To open
a command window in Microsoft Windows, choose Start=>Run, type com-
mand in the text box, and then click OK.)

Linux comes with a command interpreter that resembles COMMAND . COM in
DOS, but it can do a whole lot more. The Linux command interpreter is
called a shell.

The default shell in many Linux distributions is bash. When you open a ter-
minal window or log in at a text console, the bash shell is what prompts you
for commands. Then, when you type a command, the shell executes your
command. By the way, just as there are multiple GUIs (GNOME or KDE) for
Linux, you have the choice of shells besides bash. For example, the C shell is
an alternate shell that some people prefer. You can easily change your
default shell by using the chsh command.

In addition to the standard Linux commands, bash can execute any com-
puter program. So you can type the name of an application (the name is usu-
ally more cryptic than what you see in GNOME or KDE menus) at the shell
prompt, and the shell starts that application.

Understanding the syntax of shell commands

Because a shell interprets what you type, knowing how the shell processes
the text you enter is important. All shell commands have this general format
that starts with a command followed by options. (Some commands have no
options.)

command optionl option2 ... optionN
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Such a single on-screen line giving a command is commonly referred to as a
command line. On a command line, you enter a command, followed by zero
or more options (or arguments). These strings of options — the command
line options (or command line arguments) — modify the way the command
works so that you can get it to do specific tasks.

The shell uses a blank space or a tab to distinguish between the command
and options. Naturally, you help it by using a space or a tab to separate the
command from the options and the options from one another.

An option can contain spaces — all you have to do is put that option inside
quotation marks so that the spaces are included. For example, to search for
my name in the password file, I enter the following grep command (grep is
used for searching for text in files):

grep "Naba Barkakati" /etc/passwd
When grep prints the line with my name, it looks like this:
naba:x:1000:100:Naba Barkakati:/home/naba:/bin/bash

If you create a user account with your username, type the grep command
with your username as an argument to look for that username in the
/etc/passwd file.

In the output from the grep command, you can see the name of the shell
(/bin/bash) following the last colon (:).

The number of command line options and their format, of course, depends
on the actual command. Typically, these options look like -X, where X is a
single character. For example, the 1s command lists the contents of a direc-
tory. You can use the -1 option to see more details. For example, here is a
result of typing Is -1 in a user’s home directory:

total O

drwxr-xr-x 2 naba users 48 2005-09-08 21:11 bin
drwx------ 2 naba users 320 2005-09-08 21:16 Desktop
drwx------ 2 naba users 80 2005-09-08 21:11 Documents

drwxr-xr-x 2 naba users 80 2005-09-08 21:11 public_html
drwxr-xr-x 2 naba users 464 2005-09-17 18:21 sdump

If a command is too long to fit on a single line, you can press the backslash
key followed by Enter. Then, continue typing the command on the next line.
For example, type the following command. (Press Enter after each line.)

cat \
/etc/passwd
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The cat command then displays the contents of the /etc/passwd file.

You can concatenate (that is, string together) several shorter commands on
a single line. Just separate the commands by semicolons (;). For example,
the following command

cd; 1ls -1; pwd

changes the current directory to your home directory, lists the contents of
that directory, and then shows the name of that directory.

Combining shell commands

You can combine simple shell commands to create a more sophisticated
command. For example, suppose that you want to find out whether a device
file named sbpcd resides in your system’s /dev directory because some
documentation says you need that device file for a Sound Blaster Pro
CD-ROM drive. You can use the 1s /dev command to get a directory listing
of the /dev directory and then browse through it to see whether that listing
contains sbpcd.

Unfortunately, the /dev directory has a great many entries, so you may find
it hard to find any item that has sbpcd in its name. You can, however, com-
bine the 1s command with grep and come up with a command line that
does exactly what you want. Here’s that command line:

ls /dev | grep sbpcd

The shell sends the output of the 1s command (the directory listing) to the
grep command, which searches for the string sbpcd. That vertical bar (|) is
known as a pipe because it acts as a conduit (think of a water pipe) between
the two programs — the output of the first command is fed into the input of
the second one.

Controlling command input and output

Most Linux commands have a common feature — they always read from the
standard input (usually, the keyboard) and write to the standard output (usu-
ally, the screen). Error messages are sent to the standard error (usually to the
screen as well). These three devices often are referred to as stdin, stdout,
and stderr.

You can make a command get its input from a file and then send its output to
another file. Just so you know, the highfalutin’ term for this feature is input
and output redirection or I/0 redirection.
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Table 2-1 shows the syntax of common I/O redirection commands, and the
next few sections explain how to use some of these commands.

Table 2-1 Common Standard 1/0 Redirections

Task Command Syntax

Send stdout to afile command > file

Send stderr tofile command 2> file

Send stdout and stderr tofile command > file 2>&1

Read stdin from afile command < file

Read stdinfrom file.in and send command < file.in > file.out Book I
stdoutto file.out Chapter 2
Append stdout to the end of a file command >> file

Append stderr to the end of a file command 2>> file .9
Append stdout and stderr to the command >> file 2>&1 g‘g
end of a file 23
Read stdin from the keyboard until command <<c %g-

the character ¢

Pipe stdout to command?2 command | command2
Pipe stdout and stderr to command 2>&1 | command?2
command?2

Getting command input from a file

If you want a command to read from a file, you can redirect the standard
input to come from that file instead of from the keyboard. For example, type
the following command:

sort < /etc/passwd

This command displays a sorted list of the lines in the /etc/passwd file. In
this case, the less-than sign (<) redirects stdin so that the sort command
reads its input from the /etc/passwd file.

Saving command output in a file

To save the output of a command in a file, redirect the standard output to a
file. For example, type cd to change to your home directory and then type
the following command:

grep typedef /usr/include/* > typedef.out

This command searches through all files in the /usr/include directory for
the occurrence of the text typedef — and then saves the output in a file
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called typedef . out. The greater-than sign (>) redirects stdout to a file.
This command also illustrates another feature of bash: When you use an
asterisk (*), bash replaces the asterisk with a list of all filenames in the
specified directory. Thus, /usr/include/* means all the files in the /usr/
include directory.

If you want to append a command’s output to the end of an existing file
instead of saving the output in a new file, use two greater-than signs (>)
like this:

command >> filename

Another interesting use of sending stdout to a file is the use of the cat
command to quickly prepare small text files. For example, suppose that you
want to create a new text file where you want to keep storing lines of text
you type until you type ZZ and press Enter. Here is how you can accomplish
that task:

cat <<ZZ > input.txt

After you type this command, you can keep typing lines and type ZZ on a
line when done. Everything you type should be saved in the file input. txt.

Saving error messages in a file

Sometimes you type a command, and it generates a whole lot of error mes-
sages that scroll by so fast you can’t tell what’s going on. One way to see all
the error messages is to save the error messages in a file so that you can see
what the heck happened. You can do that by redirecting stderr to a file.

For example, type the following command:

find / -name COPYING -print 2> finderr

This command looks through the file system for files named COPYING but
saves all the error messages in the finderr file. The number 2 followed by

the greater-than sign (2>) redirects stderr to a file.

If you want to simply discard the error messages instead of saving them in a
file, use /dev/null as the filename, like this:

find / -name COPYING -print 2> /dev/null

That /dev/null is a special file — often called the bit bucket and sometimes
glorified as the Great Bit Bucket in the Sky — that simply discards whatever it
receives. So now you know what they mean when you hear phrases such as
“Your mail probably ended up in the bit bucket.”
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Typing less with automatic command completion

Many commands take a filename as an argument. To view the contents of the
/etc/modprobe. conf text file, for example, type the following command:

cat /etc/modprobe.conf

The cat command displays the /etc/modprobe.conf file. For any com-
mand that takes a filename as an argument, you can use a bash feature to
avoid having to type the whole filename. All you have to type is the bare
minimum — just the first few characters — to uniquely identify the file in its
directory.

To see an example, type cat /etc/mod but don’t press Enter; press Tab
instead. bash automatically completes the filename, so the command
becomes cat /etc/modprobe.cont. Now press Enter to run the command.

Whenever you type a filename, press Tab after the first few characters of the
filename. bash probably can complete the filename so that you don’t have to
type the entire name. If you don’t enter enough characters to uniquely iden-
tify the file, bash beeps. Just type a few more characters and press Tab
again.

Going wild with asterisks and question marks

You can avoid typing long filenames another way. (After all, making less work
for users is the idea of computers, isn’t it?)

This particular trick involves using the asterisk (*) and question mark (?)
and a few more tricks. These special characters are called wildcards because
they match zero or more characters in a line of text.

If you know MS-DOS, you may have used commands such as COPY *.* A:
to copy all files from the current directory to the A: drive. bash accepts simi-
lar wildcards in filenames. As you expect, bash provides many more wild-
card options than the MS-DOS command interpreter does.

You can use three types of wildcards in bash:
4 The asterisk (*) character matches zero or more characters in a file-

name. That means * denotes all files in a directory.

4+ The question mark (?) matches any single character. If you type test?,
that matches any five-character text that begins with test.

4+ A set of characters in brackets matches any single character from that
set. The string [aB] *, for example, matches any filename that starts
with a or B.
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Wildcards are handy when you want to do something to a whole lot of files.
For example, to copy all the files from the /media/cdrom directory to the
current directory, type the following:

cp /media/cdrom/*

bash replaces the wildcard character * with the names of all the files in the
/media/cdrom directory. The period at the end of the command represents
the current directory.

You can use the asterisk with other parts of a filename to select a more spe-
cific group of files. Suppose you want to use the grep command to search
for the text typedef struct in all files of the /usr/include directory that
meet the following criteria:

4 The filename starts with s.

4 The filename ends with . h.

The wildcard specification s* .h denotes all filenames that meet these crite-
ria. Thus you can perform the search with the following command:

grep "typedef struct" /usr/include/s*.h

The string contains a space that you want the grep command to find, so you
have to enclose that string in quotation marks. That way, bash doesn’t try to
interpret each word in that text as a separate command line argument.

The question mark (?) matches a single character. Suppose that you have
four files — imagel .pcx, image?2 .pcx, image3 .pcx, and image4 .pcx —
in the current directory. To copy these files to the /mnt/f1oppy directory,
use the following command:

cp image?.pcx /media/floppy

bash replaces the single question mark with any single character and copies
the four files to /mnt.

The third wildcard format — [ . ..] — matches a single character from a
specific set of characters enclosed in square brackets. You may want to com-
bine this format with other wildcards to narrow down the matching file-
names to a smaller set. To see a list of all filenames in the /etc/X11/xdm
directory that start with x or X, type the following command:

1ls /etc/X11/xdm/ [xX]*
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Repeating previously typed commands

To make repeating long commands easy for you, bash stores up to 500 old
commands as part of a command history (basically just a list of old com-
mands). To see the command history, type history. bash displays a num-
bered list of the old commands, including those that you entered during
previous logins.

If the command list is too long, you can limit the number of old commands
that you want to see. For example, to see only the ten most recent com-
mands, type this command:

history 10

To repeat a command from the list that the hi story command shows,
simply type an exclamation point (!), followed by that command’s number.
To repeat command number 3, type !3.

You can repeat a command without knowing its command number. Suppose
you typed more /usr/1ib/X11/xdm/xdm-config a few minutes ago and
now you want to look at that file again. To repeat the previous more com-
mand, type the following:

Imore

Often, you may want to repeat the last command that you just typed, per-
haps with a slight change. For example, you may have displayed the con-
tents of the directory by using the 1s -1 command. To repeat that
command, type two exclamation points as follows:

[

Sometimes, you may want to repeat the previous command but add extra
arguments to it. Suppose that 1s -1 shows too many files. Simply repeat that
command but pipe the output through the more command as follows:

'l | more

bash replaces the two exclamation points with the previous command and
then appends | more to that command.

Here’s the easiest way to recall previous commands: Just press the up-arrow
key, and bash keeps going backward through the history of commands you
previously typed. To move forward in the command history, press the down-
arrow key.
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Discovering and Using Linux Commands

You type Linux commands at the shell prompt. By Linux commands, ] mean
some of the commands that the bash shell understands as well as the com-
mand line utilities that come with Linux. In this section, [ introduce you to a
few major categories of Linux commands.

I can’t possibly cover every single Linux command in this chapter, but [ want
to give you a feel for the breadth of the commands by showing you a list of
common Linux commands in Table 2-2. The table lists common Linux com-
mands by category. Before you start memorizing any Linux commands,
browse this table.

Table 2-2 Overview of Common Linux Commands

Command Name Action

Getting Online Help

apropos Finds online manual pages for a specified keyword

info Displays online help information about a specified command
man Displays online help information

whatis Similar to apropos but searches for complete words only
Making Commands Easier

alias Defines an abbreviation for a long command

type Shows the type and location of a command

unalias Deletes an abbreviation defined using alias

Managing Files and Directories

cd Changes the current directory

chmod Changes file permissions

chown Changes file owner and group

cp Copies files

In Creates symbolic links to files and directories

1s Displays the contents of a directory

mkdir Creates a directory

mv Renames a file as well as moves a file from one directory to
another

rm Deletes files

rmdir Deletes directories

pwd Displays the current directory

touch Updates a file's time stamp
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Command Name Action

Finding Files

find Finds files based on specified criteria, such as name and size

locate Finds files using a periodically updated filename database. (The
database is created by the updatedb program.)

whereis Finds files based in the typical directories where executable
(also known as binary) files are located

which Finds files in the directories listed in the PATH environment

variable

Processing Files

cat Displays a file on standard output (can be used to concatenate
several files into one big file)

cut Extracts specified sections from each line of text in a file

dda Copies blocks of data from one file to another (used to copy
data from devices)

diff Compares two text files and finds any differences

expand Converts all tabs into spaces

file Displays the type of data in a file

fold Wraps each line of text to fit a specified width

grep Searches for regular expressions within a text file

less Displays a text file one page at a time (can go backward, also)

lpr Prints files

more Displays a text file, one page at a time (goes forward only)

nl Numbers all nonblank lines in a text file and prints the lines to
standard output

paste Concatenates corresponding lines from several files

patch Updates a text file using the differences between the original
and revised copy of the file

sed Copies a file to standard output while applying specified editing
commands

sort Sorts lines in a text file

split Breaks up a file into several smaller files with specified size

tac Reverses a file (last line first and so on)

tail Displays the last few lines of a file

tr Substitutes one group of characters for another throughout
a file

unig Eliminates duplicate lines from a text file

wc Counts the number of lines, words, and characters in a text file

zcat Displays a compressed file (after decompressing)

(continued)
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Table 2-2 (continued)

Command Name Action

zless Displays a compressed file one page at a time (can go back-
ward also)

zmore Displays a compressed file one page at a time

Archiving and Compressing Files

compress Compresses files

cpio Copies files to and from an archive

gunzip Decompresses files compressed with GNU Zip (gzip)

gzip Compresses files using GNU Zip

tar Creates an archive of files in one or more directories (originally
meant for archiving on tape)

uncompress Decompresses files compressed with compress

Managing Processes

bg Runs an interrupted process in the background

fg Runs a process in the foreground

free Displays the amount of free and used memory in the system

halt Shuts down Linux and halts the computer

kill Sends a signal to a process (usually used to terminate a
process)

1dd Displays the shared libraries needed to run a program

nice Runs a process with lower priority (referred to as nice mode)

ps Displays a list of currently running processes

printenv Displays the current environment variables

pstree Similar to ps but shows parent-child relationships clearly

reboot Stops Linux and then restarts the computer

shutdown Shuts down Linux

top Displays a list of most processor- and memory-intensive
processes

uname Displays information about the system and the Linux kernel

Managing Users

chsh Changes the shell (command interpreter)

groups Prints the list of groups that include a specified user

id Displays the user and group ID for a specified user name
passwd Changes the password

su Starts a new shell as another user or root (when invoked

without any argument)
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Command Name Action

Managing the File System

at Summarizes free and available space in all mounted storage
devices

du Displays disk usage information

fdformat Formats a diskette

fdisk Partitions a hard drive

fsck Checks and repairs a file system

mkfs Creates a new file system

mknod Creates a device file

mkswap Creates a swap space for Linux in a file or a hard drive partition

mount Mounts a device (for example, the CD-ROM) on a directory in
the file system

swapoff Deactivates a swap space

swapon Activates a swap space

sync Writes buffered (saved in memory) data to files

tty Displays the device name for the current terminal

umount Unmounts a device from the file system

Working with Date and Time

cal Displays a calendar for a specified month or year

date Shows the current date and time or sets a new date and time

Becoming root (superuser)

When you want to do anything that requires a high privilege level (for exam-
ple, administering your system), you have to become root. Normally, you
log in as a regular user with your everyday username. When you need the
privileges of the superuser, though, use the following command to become
root:

su -

That’s su followed by a space and the minus sign (or hyphen). The shell
then prompts you for the root password. Type the password and press
Enter.

Knoppix does not require you to enter any password to become root. After
you type su - and press Enter, you will become root. (The prompt will
change to indicate the change.) By the way, this is not as bad as it sounds
because Knoppix is a Live CD distribution that you run directly from the
CD-ROM, and the idea is to use Knoppix to try out Linux or fix some prob-
lems in an existing Linux installation.
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After you’re done with whatever you want to do as root (and you have the
privilege to do anything as root), type exit to return to your normal username.

Instead of becoming root by using the su - command, you can also type
sudo followed by the command that you want to run as root. In Ubuntu,
you must use the sudo command because you do not get to set up a root
user when you install Ubuntu. If you are listed as an authorized user in the
/etc/sudoers file, sudo executes the command as if you were logged in
as root. Type man sudoers to read more about the /etc/sudoers file.

Managing processes

Every time the shell executes a command that you type, it starts a process.
The shell itself is a process as are any scripts or programs that the shell runs.

Use the ps ax command to see a list of processes. When you type ps ax,
bash shows you the current set of processes. Here are a few lines of output
when I type ps ax --cols 132. (I also include the --cols 132 option to
ensure that you can see each command in its entirety.)

PID TTY STAT TIME COMMAND
17 S 0:01 init [5]
22 SN 0:00 [ksoftirqgd/0]
32 S< 0:00 [events/0]
4 7 S< 0:00 [khelper]
92 S< 0:00 [kthread]
19 »? S< 0:00 [kacpid]
75 2 S< 0:00 [kblockd/0]
115 » S 0:00 [pdflush]
116 »2 S 0:01 [pdflush]
118 »? S< 0:00 [aio/0]
117 2 S 0:00 [kswapd0]
711 2 S 0:00 [kseriod]
1075 2 S< 0:00 [reiserfs/0]
2086 2 S 0:00 [kjournald]
2239 ? S<s 0:00 /sbin/udevd -d
. lines deleted ...
6374 2 S 1:51 /usr/X11R6/bin/X :0 -audit 0 -auth
/var/lib/gdm/:0.Xauth -nolisten tcp vt7
6460 ? Ss 0:02 /opt/gnome/bin/gdmgreeter
6671 ? Ss 0:00 sshd: naba [priv]
6675 ? S 0:00 sshd: naba@pts/0
6676 pts/0 Ss 0:00 -bash
6712 pts/0 S 0:00 vsftpd
14702 2 S 0:00 pickup -1 -t fifo -u
14752 pts/0 R+ 0:00 ps ax --cols 132

In this listing, the first column has the heading PID and shows a number for
each process. PID stands for process ID (identification), which is a sequential
number assigned by the Linux kernel. If you look through the output of the
ps ax command, you see that the init command is the first process and
that it has a PID, or process number, of 1. That’s why init is referred to as
the “mother of all processes.”
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The cOMMAND column shows the command that created each process, and
the TIME column shows the cumulative CPU time used by the process. The
STAT column shows the state of a process — S means the process is sleep-
ing, and R means it’s running. The symbols following the status letter have
further meanings; for example < indicates a high-priority process and +
means that the process is running in the foreground. The TTY column shows
the terminal, if any, associated with the process.

The process ID, or process number, is useful when you have to forcibly stop
an errant process. Look at the output of the ps ax command and note the
PID of the offending process. Then, use the ki1l command with that
process number. To stop process number 8550, for example, start by typing
the following command:

kill 8550

If the process doesn’t stop after five seconds, repeat the command. The next
step in stopping a stubborn process is to type kill -INT pid, where pid is the
process number. If that does not work, try the following command as a last
resort:

kill -9 8550

The -9 option means send signal number 9 to the process. It just so hap-
pens that signal number 9 is the KILL signal, which should cause the
process to exit. You could also type this command as kill KILL pid where
pidis the process ID.

Working with date and time

You can use the date command to display the current date and time or set a
new date and time. Type date at the shell prompt and you get a result similar
to the following:

Mon Dec 5 20:51:07 EST 2005

As you can see, the date command alone displays the current date and
time.

To set the date, log in as root and then type date followed by the date and
time in the MMDDhhmmYYYY format, where each character is a digit. For
example, to set the date and time to December 31, 2006 and 9:30 p.m., you

type

date 123121302006
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The MMDDhhmmYYYY date and time format is similar to the 24-hour mili-
tary clock, and has the following meaning:

4+ MM is a two-digit number for the month (01 through 12).

4+ DD is a two-digit number for the day of the month (01 through 31).

4 hh is a two-digit hour in 24-hour format. (00 is midnight and 23 is 11 p.m.)
4+ mm is a two-digit number for the minute (00 through 59).

4+ YYYY is the four-digit year (such as 2006).

The other interesting date-related command is cal. If you type cal without
any options, it prints a calendar for the current month. If you type cal fol-
lowed by a number, cal treats the number as the year and prints the calen-
dar for that year. To view the calendar for a specific month in a specific year,
provide the month number (1 = January, 2 = February, and so on) followed
by the year. Thus, to view the calendar for January 2006, type cal 1 2006 and
you get the calendar for that month, as follows:

January 2006
Su Mo Tu We Th Fr Sa
1 2 3 4 5 6 7
8 9 10 11 12 13 14
15 16 17 18 19 20 21
22 23 24 25 26 27 28
29 30 31

Processing files

You can search through a text file with grep and view a text file, a screen
at a time, with more. For example, to search for my username in the /etc/
passwd file, | use

grep naba /etc/passwd

To view the /etc/inittab file a screen at a time, | type

more /etc/inittab

As each screen pauses, | press the spacebar to go to the next page.

Many more Linux commands work on files — mostly on text files, but some

commands also work on any file. I describe a few of the file-processing tools
next.
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Counting words and lines in a text file

[ am always curious about the size of files. For text files, the number of char-
acters is basically the size of the file in bytes (because each character takes
up a byte of storage space). What about words and the number of lines,
though?

The Linux wc command comes to the rescue. The wc command displays the
total number of characters, words, and lines in a text file. For example, type
wc /etc/inittab and you see an output similar to the following:

97 395 2926 /etc/inittab

In this case, wc reports that 97 lines, 395 words, and 2,926 characters are in
the /etc/inittab file. If you simply want to see the number of lines in a
file, use the -1 option and type wc -1 /etc/inittab. The resulting output
should be similar to the following:

97 /etc/inittab
As you can see, with the -1 option, we simply displays the line count.

If you don’t specify a filename, the wc command expects input from the stan-
dard input. You can use the pipe feature (|) of the shell to feed the output of
another command to wc, which can be handy sometimes.

Suppose you want a rough count of the processes running on your system.
You can get a list of all processes with the ps ax command, but instead of
counting lines manually, just pipe the output of ps to wc and you get a rough
count automatically:

ps ax | we -1
86

Here the ps command produces 86 lines of output. Because the first line
simply shows the headings for the tabular columns, you can estimate that
about 85 processes are running on your system. (Of course, this count prob-
ably includes the processes used to run the ps and we commands as well,
but who'’s really counting?)

Sorting text files

You can sort the lines in a text file by using the sort command. To see how
the sort command works, first type more /etc/passwd to see the current
contents of the /etc/passwd file. Now type sort /etc/passwd to see the
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lines sorted alphabetically. If you want to sort a file and save the sorted ver-
sion in another file, you have to use the bash shell’s output redirection fea-
ture like this:

sort /etc/passwd > ~/sorted.text

This command sorts the lines in the /etc/passwd file and saves the output
in a file named sorted. text in your home directory.

Substituting or deleting characters from a file

Another interesting command is tr — it substitutes one group of characters
for another (or deletes a selected character) throughout a file. Suppose

that you have to occasionally use MS-DOS text files on your Linux system.
Although you may expect to use a text file on any system without any prob-
lems, you find one catch: DOS uses a carriage return followed by a line feed
to mark the end of each line whereas Linux uses only a line feed.

On your Linux system, you can get rid of the extra carriage returns in the
DOS text file by using the tr command with the -d option. Essentially, to
convert the DOS text file named £ilename.dos to a Linux text file named
filename.linux, type the following:

tr -d '\015' < filename.dos > filename.linux

In this command, '\015"' denotes the code for the carriage-return character
in octal notation.

Splitting a file into several smaller files

The split command is handy for those times when you want to copy a file
to a floppy disk but the file is too large to fit on a single floppy. You can then
use the split command to break up the file into multiple smaller files, each
of which can fit on a floppy.

By default, split puts 1,000 lines into each file. The new, split files are
named by groups of letters such as aa, ab, ac, and so on. You can specify a
prefix for the filenames. For example, to split a large file called hugefile.
tar into smaller files that fit onto several high-density 3.5-inch floppy disks,
use split as follows:

split -b 1440k hugefile.tar part.
This command splits the hugefile. tar file into 1440K chunks so each one

can fit onto a floppy disk. The command creates files named part.aa,
part.ab, part.ac, and so on.
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To combine the split files back into a single file, use the cat command as
follows:

cat part.?? > hugefile.tar

In this case, the two question marks (??) match any two-character extension
in the filename. In other words, the filename part . ? ? matches all filenames
such as part.12, part.aa, part.ab, part.2b, and so on.

Writing Shell Scripts

If you've ever used MS-DOS, you may remember MS-DOS batch files. These Chapter 2
are text files with MS-DOS commands. Similarly, shell scripts are also text files
with a bunch of shell commands.

If you aren’t a programmer you may feel apprehensive about programming,
but shell programming can be as simple as storing a few commands in a file.
Right now, you might not be up to writing complex shell scripts, but you can
certainly try out a simple shell script.

lI3ys ayy
Buipuewwon

To try your hand at a little shell programming, type the following text at the
shell prompt exactly as shown and then press Ctrl+D when you're done:

cd

cat > simple

#!/bin/sh

echo "This script's name is: $0"
echo Argument 1: $1

echo Argument 2: $2

Press Ctrl+D.

The cd command changes the current directory to your home directory.
Then the cat command displays the next line and any other lines you type
before pressing Ctrl+D. In this case, [ use > simple to send the output to a
file named simple. After you press Ctrl+D, the cat command ends, and you
see the shell prompt again. You created a file named simple that contains
the following shell script:

#!/bin/sh

echo "This script's name is: $0"
echo Argument 1: $1

echo Argument 2: $2

The first line causes Linux to run the bash shell program (of the name
/bin/bash). The shell then reads the rest of the lines in the script.
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Just as most Linux commands accept command line options, a bash script
also accepts command line options. Inside the script, you can refer to the
options as $1, $2, and so on. The special name $0 refers to the name of the
script itself.

To run this shell script, first you have to make the file executable (that is,
turn it into a program) with the following command:

chmod +x simple

Now type ./simple one two to run the script, and it displays the following
output:

This script's name is: ./simple
Argument 1: one
Argument 2: two

The . / prefix to the script’s name indicates that the simple file is in the cur-
rent directory.

This script simply prints the script’s name and the first two command line
options that the user types after the script’s name.

Next, try running the script with a few arguments, as follows:

./simple "This is one argument" second-argument third
This script's name is: ./simple

Argument 1: This is one argument

Argument 2: second-argument

The shell treats the entire string within the double quotation marks as a
single argument. Otherwise, the shell uses spaces as separators between
arguments on the command line.

Most useful shell scripts are more complicated than this simple script, but
this simple exercise gives you a rough idea of how to write shell scripts.

Place Linux commands in a file and use the chmod command to make the file
executable. Voila! You created a shell script!



Chapter 3: Navigating the
Linux File System

In This Chapter

+* Understanding the Linux file system
+~ Navigating the file system with Linux commands
» Understanding file permissions

* Manipulating files and directories with Linux commands

T) use files and directories well, you need to understand the concept of a
hierarchical file system. Even if you use the GUI file managers to access
files and folders (folders are also called directories), you can benefit from a

lay of the land of the file system.

In this chapter, | introduce you to the Linux file system, and you discover
how to work with files and directories with several Linux commands.

Understanding the Linux File System

Like any other operating system, Linux organizes information in files and
directories. Directories, in turn, hold the files. A directory is a special file
that can contain other files and directories. Because a directory can contain
other directories, this method of organizing files gives rise to a hierarchical
structure. This hierarchical organization of files is called the file system.

The Linux file system gives you a unified view of all storage on your PC. The
file system has a single root directory, indicated by a forward slash (/).
Within the root directory is a hierarchy of files and directories. Parts of the
file system can reside in different physical media, such as hard drive, floppy
disk, and CD-ROM. Figure 3-1 illustrates the concept of the Linux file system
(which is the same in any Linux system) and how it spans multiple physical
devices.



182 Understanding the Linux File System

CD-ROM Hard Disk Floppy Disk
o~ @
: 4
. [ 5
/(root) . Linux File System
Figure 3-1: ," l l l l l
The Linux \ /bin  /boot /dev  /etc .. /media /sbin ;" Jusr
file system
provides a :
unified view
of storage IR /media/cdrom /media/ﬂog)py
that may
span multi-
ple storage
devices. Jusr/X11R6  /usr/lib  /usr/local ... /usr/share ... /usr/src ..

If you're familiar with MS-DOS or Windows, you may find something missing
in the Linux file system: You don’t find drive letters in Linux. All disk drives
and CD-ROM drives are part of a single file system.

In Linux, you can have long filenames (up to 256 characters), and filenames
are case-sensitive. Often these filenames have multiple extensions, such as
sample. tar.Z. UNIX filenames can take many forms, such as the following:
index.html, Makefile, binutils-2.15.92.0.2-5.i386.rpm,
vsftpd_2.0.3-1_1i386.deb, .bash_profile,and httpd_src.tar.gz.

To locate a file, you need more than just the filename. You also need informa-
tion about the directory hierarchy. The extended filename, showing the full
hierarchy of directories leading to the file, is called the pathname. As the
name implies, it’s the path to the file through the maze of the file system.
Figure 3-2 shows a typical pathname for a file in Linux.

As Figure 3-2 shows, the pathname has the following parts:

4+ The root directory, indicated by a forward slash (/) character.

4 The directory hierarchy, with each directory name separated from the
previous one by a forward slash (/) character. A / appears after the last
directory name.

4 The filename, with a name and one or more optional extensions. (A
period appears before each extension.)
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First-level Second-level Third-level Filename

directory directory directory
Y Y

Y
/ | home |/ | naba | /|public_html |/ | index.html
A A A Al 4 A
Root Directory separator Name Extension
directory

The Linux file system has a well-defined set of top-level directories, and some
of these directories have specific purposes. Finding your way around the file
system is easier if you know the purpose of these directories. You also become
adept at guessing where to look for specific types of files when you face a
new situation. Table 3-1 briefly describes the top-level directories in the
Linux file system.

Table 3-1 Top-Level Directories in the Linux File System
Directory Description
/ This root directory forms the base of the file system. All files and

directories are contained logically in the root directory, regardless of
their physical locations.

/bin Contains the executable programs that are part of the Linux operating
system. Many Linux commands, such as cat, cp, 1s, more, and tar,
are located in /bin.

/boot Contains the Linux kernel and other files that the LILO and GRUB boot
managers need. (The kernel and other files can be anywhere, but plac-
ing them in the /boot directory is customary.)

/dev Contains special files that represent devices attached to the system

/etc Contains most system configuration files and the initialization scripts (in
the /etc/rc.d subdirectory)

/home Conventional location of the home directories of all users. User naba’s
home directory, for example, is /home /naba.

/1lib Contains library files for all programs stored in /sbin and /bin direc-
tories (including the loadable driver modules) needed to start Linux

/lost+found  Directory for lost files. Every disk partition has a 1ost+found directory.

/media A directory for mounting file systems on removable media, such as
CD/DVD-ROM drives, floppy disks, and Zip drives. Contains the
/media/floppy directory for mounting floppy disks and the
/media/cdromor /media/cdromO directory for mounting
the CD/DVD-ROM drive. If you have a CD/DVD recorder, you find a
/media/cdrecorder directory instead of /media/cdrom.

(continued)
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Table 3-1 (continued)

Directory Description

/mnt A directory for temporarily mounted file systems

/opt Provides a storage area for large application software packages. For
example, some distributions install the OpenOffice.org office suite in the
/opt directory.

/proc A special directory that contains various information about the
processes running in the Linux system

/root The home directory for the root user

/sbin Contains executable files representing commands typically used for
system-administration tasks and used by the root user. Commands
such ashalt and shutdown reside in the /sbin directory.

/srv Contains data for services (such as Web and FTP) offered by this system

/sys A special directory that contains information about the devices, as seen
by the Linux kernel

/tmp A temporary directory that any user can use as a scratch directory,
meaning that the contents of this directory are considered unimportant
and usually are deleted every time the system boots

/usr Contains the subdirectories for many important programs, such as the X
Window System (in the /usr/x11R6 directory) and the online
manual. (Table 3-2 shows some of the standard subdirectories in
/usr.)

/var Contains various system files (such as logs), as well as directories for

holding other information, such as files for the Web server and anony-
mous FTP server

The /usr and /var directories also contain a number of standard subdirec-
tories. Table 3-2 lists the important subdirectories in /usr. Table 3-3 shows
a similar breakdown for the /var directory.

Table 3-2 Important /usr Subdirectories

Subdirectory Description

/usr/X11R6 Contains the X Window System software

/usr/bin Contains executable files for many more Linux commands,
including utility programs that are commonly available in Linux
but aren't part of the core Linux operating system

/usr/games Contains some old Linux games

/usr/include Contains the header files (file names ending in . h) for the C

and C++ programming languages; also includes the X11 header
filesinthe /usr/include/x11 directory and the Linux
kernel header files inthe /usr/include/1inux directory
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Subdirectory Description

/usr/lib Contains the libraries for C and C++ programming languages;
also contains many other libraries, such as database libraries,
graphical toolkit libraries, and so on

/usr/local Contains local files. The /usr/local/bin directory, for
example, is supposed to be the location for any executable
program developed on your system.

/usr/sbin Contains many administrative commands, such as commands
for electronic mail and networking

/usr/share Contains shared data, such as default configuration files and
images for many applications. For example, /usr/share/
gnome contains various shared files for the GNOME desktop,
and /usr/share/doc hasthe documentation files for
many Linux applications (such as the bash shell, the Sawfish
window manager, and The GIMP image-processing program).

/usr/share/man Contains the online manual (which you can read by using the
man command)

/usr/src Contains the source code for the Linux kernel (the core operat-
ing system)

Table 3-3 Important /var Subdirectories

Subdirectory Description

/var/cache Storage area for cached data for applications

/var/lib Contains information relating to the current state of applications

/var/lock

Contains locked files to ensure that a resource is used by one
application only

/var/log Contains log files organized into subdirectories. The syslogd server
stores its log files in /var/1log, with the exact content of the files
depending on the sys1ogd configuration file /etc/syslog.
conf. For example, /var/log/messages is the main system log
file; /var/log/secure contains log messages from secure serv-
ices (such as sshd and xinetd); and /var/log/maillog con-
tains the log of mail messages.

/var/mail Contains user mailbox files

/var/opt Contains variable data for packages stored in /opt directory

/var/run Contains data describing the system since it was booted

/var/spool Contains data that's waiting for some kind of processing

/var/tmp Contains temporary files preserved between system reboots

/var/yp

Contains Network Information Service (NIS) database files
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Using GUI File Managers
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Both GNOME and KDE desktops come with GUI file managers that enable
you to easily browse the file system and perform tasks such as copying or
moving files. The GNOME file manager is called Nautilus and the KDE file
manager is Konqueror. | briefly describe these GUI file managers in the fol-
lowing sections.

Using the Nautilus shell

The Nautilus file manager (more accurately called a graphical shell) comes
with GNOME. Nautilus is intuitive to use; it’s similar to the Windows Active
Desktop. You can manage files and folders and also manage your system
with Nautilus.

The latest version of Nautilus has changed from what you may have known
in previous versions of Red Hat Linux or Fedora Core. Nautilus now provides
a new object window view in addition to the navigation window that you
know from the past. When you double-click any object on the desktop,
Nautilus opens an object window that shows that object’s contents. If you
want the older navigation window with its Web browser-like user interface,
right-click a folder and choose Opent>Browse Folder from the pop-up menu.

Viewing files and folders in object windows

When you double-click a file or a folder, Nautilus opens that object in what it
calls an object window. Unlike the Nautilus windows of the past — windows
that enabled you to navigate the directory hierarchy — the object window
doesn’t have Back and Forward buttons, toolbars, or side panes. For exam-
ple, double-click the Computer icon on the left side of the GNOME desktop,
and Nautilus opens an object window where it displays the storage devices
in the computer, including the file system. If you then double-click an object
inside that window, Nautilus opens another object window where that object’s
contents appear. Figure 3-3 shows the result of double-clicking some objects
in Nautilus.

The Nautilus object window has a sparse user interface that has just the
menu bar. You can perform various operations from the menu bar, such as
open an object using an application, create folders and documents, and
close the object window.

Burning data CDs from Nautilus

If you have a CD recorder attached to your system (it can be a built-in
ATAPI CD recorder or an external one attached to the USB port), you can
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use Nautilus to burn data CDs. From a Nautilus object window, you can
access the CD Creator built into Nautilus. Just follow these simple steps:

1. In any Nautilus object window, choose Places->CD Creator.

Nautilus opens a CD Creator object window.

Note: If you don’t have any Nautilus object windows open, just double-

click the Computer icon on the desktop.

2. From other Nautilus windows, drag and drop into the CD Creator
window whatever files and folders you want to put on the CD.

To get to files on your computer, double-click the Computer icon to open
it in Nautilus and find the files you want. Then drag and drop those file

or folder icons into the CD Creator window.

3. From the CD Creator window, choose File->Write to Disc.

Nautilus displays a dialog box where you can select the CD recorder, the
write speed, and several other options, such as whether to eject the CD

when done. You can also specify the CD title.
4. Click the Write button.
Nautilus burns the CD.

= Computer -0Ox

=

Ble Edit Miew Places Help

n
o
3

=1
5
w

| =2 I =0Ox

- Fle Edit Wiew Places Help
naba's Home E=1 = = =]

& home -0x
ik

Y b oila =dit wiew places belp

‘Wastebasket = naba -ox
Fle Edt \iew Places Help
& photos -0x

File Edit iew Flaces Help

d
inl & Api!. 2005 - Cherry Blossoms: -0 x

Fle Edit wiew places Help
A h

DSCNRLTT PG

Cam|

= #0073

I thom
g oo
fome Apr 18, ﬁ

DSCNS175 PG

N g
photos [re——

DESCNI1T7B PG DSCHN2179 PG DSCHoL180 PG

April B, 2005 - Cherry Slossoms * | 40 tems, Free space: 2.8 GB

4 : B3 Computer - 1 £ horne 22 naba 22 photes 23 April 8. 2005 - € B [naba@Inbdeb;

€ applications Actions [ [l Sun 24 Jul, 444 pra ) 53

Book Il
Chapter 3

wajsAg aji4 xnury
ay) bunebiney



188 Using GUI File Managers

Figure 3-4:
You can
view files
and folders
in the
Nautilus
navigation
window.

Browsing folders in a navigation window

If you prefer to use the familiar navigation window for browsing folders, you
have to do a bit of extra work. Instead of double-clicking an icon, right-click the
icon and choose Browse Folder from the context menu. Nautilus then opens
a navigation window with the contents of the object represented by the icon.
For example, right-click the Home Folder icon in the upper-left corner of the
GNOME desktop and select Browse Folder from the context menu. Nautilus
opens a navigation window where it displays the contents of your home
directory. (Think of a directory as a folder that can contain other files and
folders.) Figure 3-4 shows a typical view of the Nautilus navigation window.

File Browser: April 8, 2005 - Cherry Blossoms
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The navigation window is vertically divided into two parts. The left pane
shows different views of the file system and other objects that you can
browse with Nautilus. The right pane shows the files and folders in the cur-
rently selected folder in the left pane. Nautilus displays icons for files and
folders. For image files, it shows a thumbnail of the image.

The navigation window’s user interface is similar to that of a Web browser.
The window’s title bar shows the name of the currently selected folder. The
Location text box along the top of the window shows the full name of the
directory in Linuxspeak — for example, Figure 3-4 shows the contents of the
/home/naba/photos/April 8, 2005 - Cherry Blossoms directory.

If you’ve used Windows Explorer, you can use the Nautilus navigation window
in a similar manner. To view the contents of another directory, do the following:

1. Choose Tree from the Information drop-down menu (located in the
left window).



Figure 3-5:
The Nautilus
navigation
window
with a list
view of the
/etc/X11
directory.
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A tree menu of directories appears in that window. Initially the tree
shows your home folder and the file system’s root directory as a
FileSystem folder.

2. Click the right arrow next to the FileSystem folder; in the resulting
tree view, locate the directory you want to browse.

For example, to look at the /etc directory, click the right arrow next to
the etc directory. Nautilus displays the subdirectories in /etc and
changes the right arrow to a down arrow. X11 is one of the subdirecto-
ries in /etc that you view in the next step.

3. To view the contents of the x11 subdirectory, click x11.

The window on the right now shows the contents of the /etc/X11
directory.

Nautilus displays the contents of the selected directory by using different types
of icons. Each directory appears as a folder with the name of the directory
shown underneath the folder icon. Ordinary files, such as XF86Config-4,
appear as a sheet of paper. The X file is a link to an executable file.

The Nautilus navigation window has the usual menu bar and a toolbar.
Notice the View as Icons button in Figure 3-4 on the right side of the toolbar.
This button shows that Nautilus displays the directory contents with large
icons. Click the button, and a drop-down list appears. Select View as List
from the list, and Nautilus displays the contents by using smaller icons in a
list format, along with detailed information, such as the size of each file or
directory and the time when each was last modified, as shown in Figure 3-5.
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If you click any of the column headings — Name, Size, Type, or Date
Modified — along the top of the list view, Nautilus sorts the list according

to that column. For example, go ahead and click the Date Modified column
heading. Nautilus now displays the list of files and directories sorted accord-
ing to the time of their last modification. Clicking the Name column heading
sorts the files and folders alphabetically.

Not only can you move around different folders by using the Nautilus naviga-
tion window, you can also do things such as move a file from one folder to
another or delete a file. I don’t outline each step. The steps are intuitive and
similar to what you do in any GUI, such as Windows or Mac. Here are some
of the things you can do in Nautilus:

4+ To move a file to a different folder, drag and drop the file’s icon on the
folder where you want the file.

4+ To copy afile to a new location, select the file’s icon and choose Edit~
Copy File from the Nautilus menu. (Or you can right-click the file’s icon
and choose Copy File from the context menu.) Then move to the folder
where you want to copy the file and choose Edit=>Paste Files.

4+ To delete a file or directory, right-click the icon and choose Move to Trash
from the context menu. (You can do this only if you have permission to
delete the file.) To permanently delete the file, right-click the Trash icon on
the desktop and choose Empty Trash from the context menu. Of course,
do this only if you really want to delete the file. Once you Empty Trash,
you are never going to see the file again. If you have to retrieve a file
from the trash, double-click the Trash icon and then drag the file’s icon
back to the folder where you want to save it. You can retrieve a file from
the trash until you empty it.

4+ To rename a file or a directory, right-click the icon and choose
Rename from the context menu. Then you can type the new name
(or edit the name) in the text box that appears.

4+ To create a new folder, right-click an empty area of the window on the
right and choose Create Folder from the context menu. After the new
folder icon appears, you can rename it by right-clicking the icon and
choosing Rename from the context menu. If you don’t have permission
to create a folder, that menu item is grayed out.

Using Konqueror

Konqueror is a file manager and Web browser that comes with KDE. It’s intu-
itive to use — somewhat similar to the Windows Active Desktop. You can
manage files and folders (and also view Web pages) with Konqueror.



Figure 3-6:
You can
view

files and
folders in
Kongueror.
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Viewing files and folders

When you click a folder icon on the KDE desktop, Konqueror starts automat-
ically and opens that folder. For example, click the My Computer icon in the
upper-left corner of the KDE desktop in SUSE Linux. Konqueror runs and
displays the contents of your computer. Click the Home Folder icon on the
vertical toolbar in the left edge of the Konqueror window and then click
Home Folder on the middle pane. Konqueror displays the contents of your
home directory (think of a directory as a folder that can contain other files
and folders) in its main window. Figure 3-6 shows a typical user’s home
directory in Konqueror.
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If you've used Windows Explorer, you can use Konqueror in a similar manner.
The Konqueror window is vertically divided into three parts:
4+ A narrow left pane shows icons you can click to perform various tasks in

Konqueror.

4+ A wider middle pane (that can be toggled on or off) shows a tree view of
the current folder.

4 The widest pane (at the right) uses icons to show the files and folders in
the current folder.

Konqueror uses different types of icons for different files and shows a preview
of each file’s contents. For image files, the preview is a thumbnail version of
the image.
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The Konqueror window’s title bar shows the name of the currently selected
directory. The Location text box (along the top of the window) shows the full
name of the directory — in this case, Figure 3-6 shows the contents of the
/home /naba directory.

Use the leftmost vertical row of buttons to select other things to browse.
When you click one of these buttons, the middle pane displays a tree menu
of items that you can browse. For example, to browse other parts of the file
system, do the following:

1. From the leftmost vertical column of icons in the Konqueror window
(refer to Figure 3-6), click the Root Folder icon (the second icon from
the bottom).

A tree menu of directories appears in the middle pane.
2. In the tree view, locate the folder that you want to browse.

For example, to look at the etc folder, click the plus sign next to the etc
folder. Konqueror displays the other folders and changes the plus sign
to a minus sign.

3. To view the contents of the x11 subdirectory, scroll down and click x11.

The pane on the right now shows the contents of the /etc/x11 directory.

Konqueror displays the contents of a folder using different types of icons.
Each directory appears as a folder, with the name of the directory shown
underneath the folder icon. Ordinary files appear as a sheet of paper.

The Konqueror window has the usual menu bar and a toolbar. You can view
the files and folders in other formats as well. For example, choose Viewr>
View Mode=>Detailed List View to see the folder’s contents with smaller icons
in a list format (see Figure 3-7), along with detailed information (such as the
size of each file or directory, and at what time each was last modified).

If you click any of the column headings — Name, Size, File Type, or Modified,
to name a few — along the top of the list view, Konqueror sorts the list
according to that column. For example, if you click the Modified column
heading, Konqueror displays the list of files and folders sorted according to
the time of last modification. Clicking the Name column heading sorts the
files and directories alphabetically by name.

Not only can you move around different folders by using Konqueror, you can
also do things such as move a file from one folder to another or delete a file.
[ don’t outline each step because the steps are intuitive and similar to what
you do in any GUI (such as Windows or the Mac interface). Here are some
things you can do in Konqueror:
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4+ View a text file: Click the filename, and Konqueror runs the KWrite word
processor, displaying the file in a new window.

4+ Copy or move a file to a different folder: Drag and drop the file’s icon on
the folder where you want the file to go. A menu pops up and asks you
whether you want to copy, move, or simply link the file to that directory:.

4+ Delete a file or directory: Right-click the icon and choose Move to
Trash from the context menu. To permanently delete the file, right-click
the Trash icon on the desktop and choose Empty Trash from the context
menu. Of course, do this only if you really want to delete the file. When
you Empty Trash, the deleted files are really gone forever. If you want to
recover a file from the trash, double-click the Trash icon on the desktop
and from that window drag and drop the file icon into the folder where
you want to save the file. When asked whether you want to copy or move,
select Move. You can recover files from the trash until the moment you
empty the trash.
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4+ Rename a file or a directory: Right-click the icon and choose Rename
from the context menu. Then you can type the new name (or edit the old
name) in the text box that appears.
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4 Create a new folder: Choose View=>View Mode=Icon View. Then right-
click an empty area of the rightmost pane and choose Create Neww>
Directory from the context menu. Then type the name of the new direc-
tory and click OK. (If you don’t have permission to create a directory,
you get an error message.)
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Viewing Web pages

Konqueror is much more than a file manager. With it, you can view a Web
page as easily as you can view a folder. Just type a Web address in the
Location text box and see what happens. For example, Figure 3-8 shows the
Konqueror window after [ type www. irs.gov in the Location text box on the
toolbar and press Enter.
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Konqueror displays the Web site in the pane on the right. The left pane doesn’t
change.

Navigating the File System with Linux Commands

Although GUI file managers such as Nautilus (in GNOME) or Konqueror (in
KDE) are easy to use, you can use them only if you have a working GUI desk-
top. Sometimes, you may not have a graphical environment to run a graphical
file manager. For example, you may be logged in through a text terminal, or
X may not be working on your system. In those situations, you have to rely
on Linux commands to work with files and directories. Of course, you can
always use Linux commands, even in the graphical environment — all you
have to do is open a terminal window and type the Linux commands.
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In the sections that follow, I briefly show some Linux commands for moving
around the Linux file system.

Commands for directory navigation

In Linux, when you log in as root, your home directory is /root. For other
users, the home directory is usually in the /home directory. My home direc-
tory (when I log in as naba) is /home/naba. This information is stored in
the /etc/passwd file. By default, only you have permission to save files in
your home directory, and only you can create subdirectories in your home
directory to further organize your files.

Linux supports the concept of a current directory, which is the directory on
which all file and directory commands operate. After you log in, for example,
your current directory is the home directory. To see the current directory,
type the pwd command.

To change the current directory, use the cd command. To change the cur-
rent directory to /usr/1ib, type the following:

cd /usr/lib

Then, to change the directory to the cups subdirectory in /usr/1ib, type
this command:

cd cups

Now, if you use the pwd command, that command shows /usr/1ib/cups as
the current directory.

These two examples show that you can refer to a directory’s name in two ways:

4+ An absolute pathname (such as /usr/1ib) that specifies the exact
directory in the directory tree

4+ Arelative directory name (such as cups, which represents the cups
subdirectory of the current directory, whatever that may be)

If you type cd cups in /usr/1ib, the current directory changes to /usr/
1lib/cups. However, if I type the same command in /home/naba, the shell
tries to change the current directory to /home /naba/cups.

Use the cd command without any arguments to change the current directory
back to your home directory. No matter where you are, typing cd at the shell
prompt brings you back home!
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By the way, the tilde character (~) refers to your home directory. Thus the
command cd ~ also changes the current directory to your home directory.
You can also refer to another user’s home directory by appending that user’s
name to the tilde. Thus, cd ~superman changes the current directory to
the home directory of superman.

Wait, there’s more. A single dot (.) and two dots (. .) — often cleverly
referred to as dot-dot — also have special meanings. A single dot (.) indi-
cates the current directory, whereas two dots (. .) indicate the parent
directory. For example, if the current directory is /usr/share, you go
one level up to /usr by typing

cd

Commands for directory listings and permissions

You can get a directory listing by using the 1s command. By default, the 1s
command — without any options — displays the contents of the current
directory in a compact, multicolumn format. For example, type the next two
commands to see the contents of the /etc/X11 directory:

cd /etc/X11
1s

The output looks like this. (On the console, you see some items in different
colors.)

X Xsession.d cursors rgb.txt xkb
XF86Config-4 Xsession.options default-display-manager rstart xXserver
Xresources Xwrapper.config fonts sysconfig xsm
Xsession app-defaults gdm xinit

From this listing (without the colors), you cannot tell whether an entry is a
file or a directory. To tell the directories and files apart, use the -F option
with 1s like this:

ls -F

This time, the output gives you some more clues about the file types:

:C! Xsession.d/ cursors/ rgb. txt xkb/
XF86Config-4 Xsession.options default-display-manager rstart/ xserver/
Xresources/ Xwrapper.config fonts/ sysconfig/ xsm/
Xsession* app-defaults/ gdm@ xinit/

The output from 1s -F shows the directory names with a slash (/) appended
to them. Plain filenames appear as is. The at sign (@) appended to a file’s
name (for example, notice the file named X) indicates that this file is a link to
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another file. (In other words, this filename simply refers to another file; it’s a
shortcut.) An asterisk (*) is appended to executable files. (Xsession, for
example, is an executable file.) The shell can run any executable file.

You can see even more detailed information about the files and directories
with the -1 option:

1s -1

For the /etc/X11 directory, a typical output from 1s -1 looks like the
following:

total 84

LrwXrwxrwx 1 root root 20 Jul 15 20:32 X -> /usr/bin/X11/XFree86
-TW-r--r--— 1 root root 2878 Jul 16 14:50 XF86Config-4

drwxr-xr-x 2 root root 4096 Jul 15 20:32 Xresources

—TWXY-XY-X 1 root root 3456 Jun 1 01:59 Xsession

drwxr-xr-x 2 root root 4096 Jul 15 20:34 Xsession.d

-IW-r--r-- 1 root root 217 Jun 1 01:59 Xsession.options
—rw------- 1 root root 771 Jul 15 20:32 Xwrapper.config

drwxr-xr-x 2 root root 4096 Jul 15 20:35 app-defaults
. lines deleted ...

This listing shows considerable information about every directory entry —
each of which can be a file or another directory. Looking at a line from the
right column to the left, you see that the rightmost column shows the name
of the directory entry. The date and time before the name show when the
last modifications to that file were made. To the left of the date and time is
the size of the file in bytes.

The file’s group and owner appear to the left of the column that shows the
file size. The next number to the left indicates the number of links to the file.
(A link is like a shortcut in Windows.) Finally, the leftmost column shows
the file’s permission settings, which determine who can read, write, or
execute the file.

The first letter of the leftmost column has a special meaning, as the following
list shows:
4+ If the first letter is 1, the file is a symbolic link (a shortcut) to another file.
4+ If the first letter is 4, the file is a directory.
4+ If the first letter is a dash (-), the file is normal.
*

If the first letter is b, the file represents a block device, such as a disk
drive.

<+

If the first letter is c, the file represents a character device, such as a
serial port or a terminal.
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After that first letter, the leftmost column shows a sequence of nine charac-
ters, which appear as rwxrwxrwx when each letter is present. Each letter
indicates a specific permission. A hyphen (-) in place of a letter indicates no
permission for a specific operation on the file. Think of these nine letters as
three groups of three letters (rwx), interpreted as follows:

4+ The leftmost group of rwx controls the read, write, and execute permis-
sion of the file’s owner. In other words, if you see rwx in this position, the
file’s owner can read (r), write (w), and execute (x) the file. A hyphen in
the place of a letter indicates no permission. Thus the string rw- means
the owner has read and write permission but no execute permission.
Although executable programs (including shell programs) typically have
execute permission, directories treat execute permission as equivalent
to use permission: A user must have execute permission on a directory
before he or she can open and read the contents of the directory.

4 The middle three rwx letters control the read, write, and execute per-
mission of any user belonging to that file’s group.

4+ The rightmost group of rwx letters controls the read, write, and execute
permission of all other users (collectively referred to as the world).

Thus, a file with the permission setting rwx------ is accessible only to the
file’s owner, whereas the permission setting rwxr--r-- makes the file read-
able by the world.

An interesting feature of the 1s command is that it doesn’t list any file whose
name begins with a period. To see these files, you must use the 1s command
with the -a option, as follows:

ls -a

Try this command in your home directory, and then compare the result with
what you see when you don’t use the -a option:

1. Type cd to change to your home directory.

2. Type Is F to see the files and directories in your home directory.

3. Type Is -aF to see everything, including the hidden files.
Most Linux commands take single-character options, each with a minus sign
(think of this sign as a hyphen) as a prefix. When you want to use several
options, type a hyphen and concatenate (string together) the option letters,

one after another. Thus, 1s -al is equivalent to 1s -a -1 as well as
1ls -1 -a.
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Commands for changing permissions and ownerships

You may need to change a file’s permission settings to protect it from others.
Use the chmod command to change the permission settings of a file or a
directory.

To use chmod effectively, you have to specify the permission settings. A good
way is to concatenate letters from the columns of Table 3-4 in the order shown
(Who/Action/Permission).

Note: You use only the single character from each column — the text in
parentheses is for explanation only.

Table 3-4 Letter Codes for File Permissions
Who Action Permission

u (user) + (add) r (read)

g (group) - (remove) w (write)

o (others) = (assign) x (execute)

a (all) s (set user ID)

For example, to give everyone read access to all files in a directory, pick a
(for all) from the first column, + (for add) from the second column, and r
(for read) from the third column to come up with the permission setting a+r.
Then use the whole set of options with chmod, like this:

chmod a+r *.
On the other hand, to permit everyone to execute one specific file, type
chmod a+x filename

Suppose you have a file named mystuff that you want to protect. You can
make it accessible to no one but you if you type the following commands, in
this order:

chmod a-rwx mystuff
chmod u+rw mystuff

The first command turns off all permissions for everyone, and the second
command turns on the read and write permissions for the owner (you).
Type Is -1 to verify that the change took place. (You see a permission
setting of ~-rw------- .) Here’s a sample output from 1s -1:

drwxr-xXr-x 2 naba naba 4096 2005-07-24 16:56 sdump
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Note: The third and fourth fields show naba naba. These two fields show
the file’s user and group ownership. In this case, the name of the user is
naba and the name of the group is also naba. In some distributions, the
group ID is users.

Sometimes you have to change a file’s user or group ownership for everything
to work correctly. For example, suppose you are instructed (by a manual,
what else?) to create a directory named cups and give it the ownership of
user ID 1p and group ID sys. How do you it?

Well, you can log in as root and create the cups directory with the com-
mand mkdir:

mkdir cups

If you check the file’s details with the 1s -1 command, you see that the user
and group ownership is root root.

To change the owner, use the chown command. For example, to change the
ownership of the cups directory to user ID 1p and group ID sys, type

chown 1lp.sys cups

Commands for working with files

To copy files from one directory to another, use the cp command. For example,
to copy thefile /usr/X11R6/1ib/X11/xinit/Xclients to the Xclients.
sample file in the current directory (such as your home directory), type the
following:

cp /usr/X11R6/1ib/X11l/xinit/xinitrc xinitrc.sample

If you want to copy a file to the current directory but retain the original
name, use a period (.) as the second argument of the cp command. Thus,
the following command copies the Xresources file from the /etc/x11
directory to the current directory (denoted by a single period):

cp /etc/X1ll/Xresources
The cp command makes a new copy of a file and leaves the original intact.

If you want to copy the entire contents of a directory — including all subdirec-
tories and their contents — to another directory, use the command cp -ar
sourcedir destdir.(This command copies everything in sourcedir direc-
tory to destdir.) For example, to copy all files from the /etc/x11 directory
to the current directory, type the following command:

cp -ar /etc/X1l1
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To move a file to a new location, use the mv command. The original copy is
gone, and a new copy appears at the destination. You can use mv to rename
a file. If you want to change the name of today.list to o1d.1list, use the
mv command, as follows:

mv today.list old.list

On the other hand, if you want to move the today.1list file to a subdirec-
tory named saved, use this command:

mv today.list saved

An interesting feature of mv is that you can use it to move entire directories

(with all their subdirectories and files) to a new location. If you have a direc-
tory named data that contains many files and subdirectories, you can move
that entire directory structure to o1d_data by using the following command:

mv data old_data

To delete files, use the rm command. For example, to delete a file named
old.list, type the following command:

rm old.list

Be careful with the rm command — especially when you log in as root. You
can inadvertently delete important files with rm.

Commands for working with directories

To organize files in your home directory, you have to create new directories.
Use the mkdir command to create a directory. For example, to create a
directory named images in the current directory, type the following:

mkdir images

After you create the directory, you can use the cd images command to
change to that directory.

You can create an entire directory tree by using the -p option with the
mkdir command. For example, suppose your system has a /usr/src
directory and you want to create the directory tree /usr/src/book/java/
examples/applets. To create this directory hierarchy, type the following
command:

mkdir -p /usr/src/book/java/examples/applets

When you no longer need a directory, use the rmdir command to delete it.

Book |
Chapter 3

wajsAg aji4 xnury
ay) bunebiney



202 Navigating the File System with Linux Commands

MBER
\x&
&

You can delete a directory only when the directory is empty.
To remove an empty directory tree, you can use the -p option, like this:
rmdir -p /usr/src/book/java/examples/applets

This command removes the empty parent directories of applets. The com-
mand stops when it encounters a directory that’s not empty.

Commands for finding files

The £ind command is very useful for locating files (and directories) that
meet your search criteria.

When I began using UNIX many years ago (Berkeley UNIX in the early 1980s),
[ was confounded by the find command. I stayed with one basic syntax of
find for a long time before graduating to more complex forms. The basic
syntax that I discovered first was for finding a file anywhere in the file
system. Here’s how it goes: Suppose you want to find any file or directory
with a name that starts with gnome. Type the following find command to
find these files:

find / -name "gnome*" -print

If you're not logged in as root, you may get a bunch of error messages.

If these error messages annoy you, just modify the command as follows
and the error messages are history. (Or, as UNIX aficionados say, “Send 'em
to the bit bucket.”)

find / -name "gnome*" -print 2> /dev/null

This command tells £ind to start looking at the root directory (/) to look
for filenames that match gnome* and to display the full pathname of any
matching file. The last part (2> /dev/null) simply sends the error mes-
sages to a special file that’s the equivalent of simply ignoring them.

You can use variations of this simple form of £ind to locate a file in any
directory (as well as any subdirectories contained in the directory). If you
forget where in your home directory you've stored all files named report*
(names that start with report), you can search for the files by using the fol-
lowing command:

find ~ -name "report*" -print
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When you become comfortable with this syntax of £ind, you can use other
options of £ind. For example, to find only specific types of files (such as
directories), use the type option. The following command displays all top-
level directory names in your Linux system:

find / -type d -maxdepth 1 -print

You probably don’t have to use the complex forms of find in a typical Linux
system; but if you ever need to, you can look up the rest of the £ind options
by using the following command:

man find

An easy way to find all files that match a name is to use the 1ocate com-
mand that searches a periodically updated database of files on your system.
For example, here’s a typical output I get when I type locate Xresources on a
Debian system:

/etc/X11l/Xresources
/etc/X11l/Xresources/xbase-clients
/etc/X11l/Xresources/xfree86-common

The locate command isn’t installed by default in SUSE Linux. To install it,
choose Main Menu=>System=YaST from the SUSE desktop to start the YaST2
Control Center. Click Software in the left side of the window and then click
Install/Remove Software in the right side of the window. In the YaST software
installation window, search for 1ocate. Then select the package from the
search results and click Accept to install it.

Commands for mounting and unmounting

Suppose you want to access the files on this book’s companion DVD-ROM
when you are logged in at a text console (with no GUI to help you). To do so,
you have to first mount the DVD-ROM drive’s file system on a specific direc-
tory in the Linux file system.

Start by looking at the /etc/fstab file for clues to the name of the CD-ROM
device. For example, some Linux distributions use the device name /dev/
cdrom to refer to CD/DVD-ROM drives, whereas others may use device
names such as /dev/hdc, /dev/cdroms/cdrom0, or /dev/cdrecorder
(for a DVD/CD-R drive). The entry in /etc/fstab file also tells you the
directory where that distribution expects the CD/DVD to be mounted. Some
distributions use /media/cdrom as the mount point, whereas others use
/media/cdrom0, or /media/cdrecorder. By the way, it is customary to
use the cdrom term to mean both CD-ROM and DVD-ROM.
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Log in as root (or type su - to become root), insert the DVD-ROM in the
DVD drive, and then type the following command:

mount /dev/hdc /media/cdromO

This command mounts the file system on the device named /dev/hdc
(an IDE DVD/CD-ROM drive) on the /media/cdrom0 directory (which is
also called the mount poinf) in the Linux file system.

After the mount command successfully completes its task, you can access
the files on the DVD-ROM by referring to the /media/cdrom0 directory as
the top-level directory of the disc. In other words, to see the contents of the
DVD-ROM, type

ls -F /media/cdromO

When you’re done using the DVD-ROM — and before you eject it from the
drive — you have to unmount the disc drive with the following umount
command:

umount /dev/hdc

You can mount devices on any empty directory on the file system. However,
each distribution has customary locations with directories meant for mount-
ing devices. For example, some distributions use directories in /mnt whereas
others use the /media directory for the mount points.

Commands for checking disk-space usage

[ want to tell you about two commands — df and du — that you can use to
check the disk-space usage on your system. These commands are simple
to use. The df command shows you a summary of disk-space usage for all
mounted devices. For example, when I type df on a PC with many mounted
storage devices, here’s what I get as output of the df command:

Filesystem 1K-blocks Used Available Use% Mounted on
/dev/hdb6 28249372 2377292 25872080 9% /
tmpfs 383968 12 383956 1% /dev/shm

/dev/hda5 5766924 1422232 4051744 26% /ubuntu/boot
/dev/hda7 6258100 2989200 2951004 51% /debian/boot
/dev/hda9 5766924 1422232 4051744 26% /ubuntu
/dev/hdal0 5766924 1872992 3600984 35% /mepis
/dev/hdall 6258100 2989200 2951004 51% /debian
/dev/hdb3 19558500 1370172 18188328 8% /xandros
/dev/hda2 16087676 10593364 5494312 66% /windows/C
/dev/hdbl 107426620 9613028 97813592 9% /windows/D

The output is a table that lists the device, the total kilobytes of storage, how
much is in use, how much is available, the percentage being used, and the
mount point.
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To see the output of df in a more readable format, type df -h. Here is the
output of the df -h command:

Filesystem Size Used Avail Use% Mounted on
/dev/hdb6 27G  2.3G 25G 9% /

tmpfs 375M 12K 375M 1% /dev/shm
/dev/hdab 5.5G 1.4G 3.9G 26% /ubuntu/boot
/dev/hda’7 6.06 2.9G 2.9G 51% /debian/boot
/dev/hda9 5.5G 1.4G 3.9G 26% /ubuntu
/dev/hdall 5.5G6 1.8G 3.5G 35% /mepis
/dev/hdall 6.06 2.9G 2.9G 51% /debian
/dev/hdb3 19G 1.4G 18G 8% /xandros
/dev/hda2 16G 116G 5.3G 66% /windows/C
/dev/hdbl 103G 9.2G 94G 9% /windows/D

If you compare this output with the output of plain df (see the previous list-
ing), you see that df -h prints the sizes with terms like M for megabytes and
G for gigabytes. These are clearly easier to understand than 1K-blocks.

The other command — du — is useful for finding out how much space a direc-
tory takes up. For example, type du /etc/X11 to view the contents of all the
directories in the /etc/X11 directory. (This directory contains X Window
System configuration files.) You end up with the following:

12 /etc/X11l/Xresources
36 /etc/X11l/Xsession.d
272 /etc/X11/app-defaults
20 /etc/X11l/cursors
12 /etc/X11l/xinit

lines deleted .
12 /etc/X11/fonts/misc
8 /etc/X11/fonts/100dpi
8 /etc/X11/fonts/75dpi
8 /etc/X11/fonts/Speedo
8 /etc/X11/fonts/Typel
48 /etc/X11/fonts

2896 /etc/X11

Each directory name is preceded by a number — which tells you the number
of kilobytes of disk space used by that directory. Thus the /etc/X11 directory,
as a whole, uses 2896KB (or about 2.9MB) disk space. If you simply want the

total disk space used by a directory (including all the files and subdirectories

contained in that directory), use the -s option, as follows:

du -s /etc/X11
2896 /etc/X11

Book |
Chapter 3

wajsAg aji4 xnury
ay) bunebiney



206 Navigating the File System with Linux Commands

A\

The -s option causes du to print just the summary information for the entire
directory.

Just as df -h prints the disk-space information in megabytes and gigabytes,
you can use the du -h command to view the output of du in more readable
form. For example, here’s how I combine it with the -s option to see the
space that I'm using in my home directory (/home/naba):

du -sh /home/naba
645M /home /naba
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Chapter 4: Introducing
Linux Applications

In This Chapter

v~ Taking stock of typical Linux applications
v~ Trying out the office applications

1~ Setting up databases

v Playing with multimedia

+* Working with images

Each Linux distribution comes with a whole lot of applications. All you
have to do is look at the menus in the GUI desktops to see what [ mean.
Often, more than one application of the same type exists. Most distributions
come with the OpenOffice.org office application suite with a word proces-
sor, spreadsheet, presentation software, and more. You find many choices
for CD players and multimedia players, not to mention the games, utility
programs, and useful tools, such as a scanner and digital camera applica-
tions. Some commercial distributions come with commercial office suites
such as StarOffice from Sun Microsystems.

When it comes to playing multimedia (audio and video in various formats,
such as MP3, MPEG, QuickTime), freely available Linux distributions rarely
come with the appropriate decoders because of licensing restrictions on
some of these decoders. The end result is that the multimedia application
runs, but it cannot play the MP3 file or the DVD movie because it lacks a
decoder. Commercial distributions, such as Xandros and SUSE, usually come
with some of these decoders.

I give you an overview of some of these Linux applications. After you read
about these applications, you can explore them further and use them when
you need them.

Taking Stock of Linux Applications

Table 4-1 shows a sampling of major Linux applications, organized by cate-
gory. For the major applications, [ also show a relevant Web site where you
can get more information about that application. This list is by no means
comprehensive. Each Linux distribution comes with many more applica-
tions and utilities than the ones I show in this table.
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If your system has both GNOME and KDE installed, most of these applica-
tions are already available from either GUI desktop.

In later sections of this chapter, I briefly introduce some of the applications
from Table 4-1, selecting one or two from each category. I describe the Internet
applications in Book IV.

Table 4-1 A Sampling of Linux Applications

Application Description

Office Applications

OpenOffice.org Free open source office suite (compatible with Microsoft Office) that
includes the Writer word processor, Calc spreadsheet, Impress pres-
entation application, Draw drawing program, and Math equation editor
(www . openoffice.org)

StarOffice Commercial office suite from which OpenOffice.org was derived

(www.sun.com/staroffice)

CrossQver Office

Commercial office suite that enables you to install and run Microsoft
Office software on Linux (www . codeweavers . com/products/
office)

AbiWord A free word processing program similar to Microsoft Word
(www . abisource.com)

Dia Drawing program, designed to be like the Windows application called
Visio (www . gnome . org/projects/dia)

Office Tools

GNOME Calculator ~ Simple calculator for GNOME

KCalc Calculator for KDE

KOrganizer Calendar and scheduling program for KDE (http: //korganizer.
kde.org)

Kontact Personal information management suite for KDE
(www . kontact .org)

Aspell Text mode spell checker (http://aspell.sourceforge.net)

Dictionary Graphical client for the dict.org dictionary server so you can look up

words

Text Editors

emacs Well-known text editor with both text and graphical interfaces
(www.gnu.org/software/emacs)

KWrite Text editor for KDE

Kate Advanced text editor for KDE

vim Text editor with text mode interface and compatible with the well-

known UNIX editor vi (www.vim.org)
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Application Description

Database

PostgreSQL A sophisticated object-relational database-management system (www .
postgresql . org) that supports Structured Query Language (SQL)

MySQL A popular relational database-management system that supports SQL
(www . mysqgl . com)

Multimedia

GNOME CD Player

Audio CD player (needs a working sound card)

KsCD

Audio CD player from KDE (needs a working sound card)

amaroK

A multimedia audio player (http: //amarok.kde.org)thatcan
play several different sound formats, including MP3 files if you have
the MP3 decoders installed

Rhythmbox

A multimedia audio player (http: //rhythmbox. source
forge.net)that can play several different sound formats, including
MP3 files if you download a plugin for the purpose

XMMS

X Multimedia System: a multimedia audio player (www . xmms . org)
that can play many different sound formats, including MP3 files.
(For some distributions, you have to download a plugin to play MP3.)

Xine

A free multimedia player (http: //xinehq. de)that can play CDs,
DVDs, and video CDs (VCDs) and also decode multimedia files such as
AVI, MOV, WMV, and MP3, provided you have the appropriate decoders

Kaffeine

A KDE media player that is based on xine, so Kaffeine's capabilities
are similar to those of xine (http: //kaffeine.source
forge.net)

Totem

A GNOME movie player thatis based on xine, so Totem’s capabilities are
similar to those of xine (www . gnome . org/projects/totem)

cdrdao

A command-line application that can burn audio or data CD-Rs in disk-
at-once (DAO) mode based on the descriptions of the CD's contentin a
textfile (http://cdrdao.sourceforge.net)

cdrecord

A command-line application that can burn audio and data CD-Rs as
well as DVD-Rs (http://cdrecord.berlios.de/old/
private/cdrecord.html)

growisofs

A command-line application that uses the mkisofs command to
append data to an IS0 9660 file system that's used in CD-Rs and DVD-
Rs (http://fy.chalmers.se/~appro/linux/DVD+RW)

X-CD-Roast

GUI front-end for cdrecord and cdrdao that makes burning data
and audio CD-Rs easy (www.xcdroast .org)

K3b

KDE-based GUI front-end for cdrecord, cdrdao, and growisofs
for burning CD-Rs and DVD-Rs (www . k3b . org)

digiKam

A digital camera and photo management application that supports all
the digital cameras supported by gPhoto2 (www .digikam. org)

(continued)
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Table 4-1 (continued)

Application

Description

Graphics and Imaging

The GIMP The GNU Image Manipulation Program: an application suitable for
tasks such as photo retouching, image composition, and image author-
ing (www.gimp.org)

GQview Powerful image viewer (http: //ggview.sourceforge.net)

KFax Fax viewer for KDE

KView Simple image viewer for KDE

GGv Gnome Ghostview (GGv): a PostScript document viewer (www .
gnu.org/directory/print/misc/ggv.html)

Xpdf Adobe PDF document viewer (www . foolabs.com/xpdf/)
XSane Graphical front-end for accessing scanners with the SANE (Scanner
Access Now Easy) library (www . xsane. org)

KSnapshot Screen-capture program

Kooka A scanner program for KDE that uses the SANE library (www . kde .
org/apps/kooka)

xscanimage Graphical front-end for controlling a scanner

Internet

Evolution Personal information management application that integrates e-mail,
calendar, contact management, and online task lists (www.novell.
com/products/evolution)

gFTP Graphical FTP client for downloading files from the Internet

Gaim GNOME Instant Messenger client (http://gaim.source
forge.net)

Kopete KDE Instant Messenger client (http: //kopete.kde.org)

Mozilla Well-known open source Web browser that started with source code
from Netscape (www.mozilla.org)

Firefox New and improved Web browser from the Mozilla project
(www.mozilla.org/products/firefox)

Thunderbird E-mail client from the Mozilla project (www.mozilla.org/
products/thunderbird)

Epiphany A Mozilla-based open source Web browser for GNOME
(www . gnome . org/projects/epiphany)

Lynx Text mode Web browser (http://lynx.browser.org)

KNode A GUI newsreader for KDE (http: //knode. source

forge.net)
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Application Description

Graphics and Imaging

Pan A GUI newsreader for GNOME (http: //pan.rebelbase.com)
Akregator An RSS feed aggregator and reader for KDE (http: //akregator.

sourceforge.net)

KPhone Internet telephony application that supports the Session Initiation
Protocol (SIP) (www.wirlab.net/kphone)

Linphone Internet telephony application that supports the Session Initiation
Protocol (SIP) and Real-time Transport Protocol (RTP) (www .
linphone.org)

Skype Internet telephony application for making voice phone calls using
voice over IP (www . skype . com)

XChat Internet Relay Chat (IRC) client (www . xchat . org)

Konqueror Web browser and file manager in KDE (www . konqueror . org)

KMail E-mail client for KDE (http: //kmail.kde.org)

Not all Linux distributions come with all the applications shown in Table 4-1,
although you can often download and install all these applications in any
distribution. Table 4-2 lists the default availability of major applications in
each of this book’s Linux distributions — Debian GNU/Linux, Fedora Core,
Knoppix, SUSE, and Xandros. A check mark indicates that the application is
available by default.

You typically must select specific groups of applications to install as you
install a Linux distribution. The exact list of applications on your Linux
system depends on the choices you make during the installation.

It’s very easy to install missing applications in Debian (and Debian-based
distributions, such as MEPIS and Ubuntu) as long as you have a broadband
(cable or DSL) connection to the Internet. For example, to see whether the
K3b CD/DVD burner exists for Debian, [ type apt-cache search k3b. [ get the
following output:

k3b - A sophisticated KDE cd burning application

k3b-i1l8n - Internationalized (il8n) files for k3b

k3blibs - The KDE cd burning application library - runtime files
k3blibs-dev - The KDE cd burning application library - development files

Next, | type apt-get install k3b and a few moments later | have K3b installed
on my Debian system. This ease of installing (or upgrading) software is why
Debian users swear by apt-get (even though it’s a command-line tool).
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Table 4-2 Default Availability of Some Applications

Application Debian Fedora Knoppix MEPIS SUSE Ubuntu Xandros
Calculator - Gealctool v v v

Calculator - KCalc v v v v v
CD/DVD burning - K3b v v v

CD player - GNOME v v v

CD player - KsCD v v v v v
Database - PostgreSQL v

Database - MySQL v v

Dictionary - GNOME v v v
dictionary

Dictionary - Kdict v v v

Digital camera tool - v v v
digiKam

Drawing program - Dia v/ v

E-mail - KMail v v v v v
E-mail - Evolution v v v

E-mail - Thunderbird v
File manager - Konqueror v v v v

N
N
N

File manager - Nautilus
(integrated CD writer)

File manager - Xandros v
File Manager (integrated
CD writer)

Image processing - v v v v v v
ImageMagick

Image processing - v v v v v v v
The GIMP

Instant messenger - Gaim v v v v

Instant messenger - v v v
Kopete

Internet Relay Chat - v v v v
XChat

Internet Telephony - v
KPhone

Internet Telephony - v
Linphone

Internet Telephony - v v
Skype

Music player - amaroK v
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Application Debian Fedora Knoppix MEPIS SUSE Ubuntu Xandros

Music player - v v v
RealPlayer

Music player - Rhythmbox v v v

Music player - XMMS v/ v

Newsreader - KNode v v

Newsreader - Pan

AN NN

Office suite - Open v v v
Office.org

\
AN
AN

PDF viewer - Acrobat v Book II
Reader Chapter 4

PDF viewer - Gpdf v

PDF viewer - Kpdf v

PDF viewer - Xpdf v v

Personal organizer - v v v v v
KOrganizer

Personal organizer - v v v v
Kontact

suoneaiddy
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PostScript viewer - v v
GNOME Ghostview (GGv)

PostScript/PDF viewer - v v v v
KGhostview

RSS feed reader - v v v v
Akregator

Scanner - Kooka v

Scanner - XSane

Scanner - xscanimage

ANENEWENR

Screen capture - v
KSnapshot

Sound recorder - v v
GNOME sound recorder

Sound recorder - KDE v v
sound recorder (KRecord)

Spellcheck - Aspell v v v

Web browser - Epiphany v

Web browser - Konqueror v v v v

Web browser - Lynx text v
mode browser

Web browser - Mozilla v v v v v v

(continued)
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Table 4-2 (continued)

Application Debian Fedora Knoppix MEPIS SUSE Ubuntu Xandros
Web browser - Mozilla v v v v v v
Firefox

Word processor - v

AbiWord

Video player - xine v v v

Video player - Kaffeine v* Ve

Video player - Totem v * v

* Requires additional plugin

Office Applications and Tools

Word processor, spreadsheet, presentation software, calendar, calculator —
these are some of the staples of the office. Most Linux distributions come
with the OpenOffice.org (often shortened as OO.o or Ooo) suite of office
applications and tools. You can try all of them one by one and see which one
takes your fancy. Each application is fairly intuitive to use. Even though
some nuances of the user interface may be new to you, you’ll become com-
fortable with them after using it a few times. I briefly introduce a few of the
following applications in this section:

4+ OpenOffice.org Office Suite: A Microsoft Office-like office suite with the
Writer word processor, Calc spreadsheet program, Impress presentation
program, Draw drawing and illustration application, and Math, a mathe-
matical formula editor

Kontact: A personal information management application in KDE
Calculators: A GNOME calculator and KDE calculator
Aspell: A spelling checker

. s+

And more: Commercially available office applications for Linux

OpenOffice.org office suite

OpenOffice.org is an office suite developed by the OpenOffice.org project
(www .openoffice.org). OpenOffice.org is similar to major office suites
such as Microsoft Office. Its main components are the Writer word proces-
sor, Calc spreadsheet, and Impress presentation program.

You can easily start OpenOffice.org — either the overall suite or each indi-
vidual application — from most GUI desktops by clicking a panel icon or by
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You can
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org Writer.

Office Applications and Tools 215

choosing from the Main Menu. For example, in SUSE, you can click a desktop
icon to open the initial window of the OpenOffice.org suite. You can create
new OpenOffice documents or open existing documents (which can be
Microsoft Office files as well) from the main window of the OpenOffice.org.

[ briefly introduce Writer, Calc, and Impress in the following sections.

Writer

Choosing Filem>"Newr>Text Document from any OpenOffice.org window starts
OpenOffice.org Writer with a blank document in its main window. Using
Writer is simple — it’s similar to other word processors such as Microsoft
Word. For example, you can type text into the blank document, format text,
and save text when done.

You can also open documents that you have prepared with Microsoft Word
on a Windows machine. Figure 4-1 shows a Microsoft Word document being
opened in OpenOffice.org Writer.
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When you save a document, by default, Writer saves it in OpenDocument
text format in a file with the . odt extension.
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Figure 4-2:
Prepare
your
spread-
sheets with
OpenOffice.
org Calc.

OpenOffice.org version 2.0 and later uses the standard OASIS Open
Document XML format as the default file format (the file extension is . odt).
The OASIS OpenDocument format is not tied to any vendor or any specific
office suite software. For more information on OpenDocument format, see

http://www.oasis-open.org/committees/tc_home.php?wg_abbrev=office

If you need to share OpenOffice.org Writer documents with Microsoft Word,
save the documents in several formats, including Microsoft Word 6.0/95/97/
2000/XP and Rich Text Format (. rtf). Microsoft Word can open . rtf files.
For exchanging files with users of OpenOffice.org versions prior to 2.0, save
the file in StarOffice text document format with an . odt extension.

I don’t explain how to use Writer because it’s simple and intuitive to use. If
you need it, online help is available. Choose Help=>Contents from the Writer
menu. This brings up the OpenOffice.org Help window with help information
on Writer. You can then click the links to view specific help information.

Calc

Calc is the spreadsheet program in the OpenOffice.org application suite. To
start Calc, choose Spreadsheet from the Office category in the Main Menu or
choose FilewNew=>Spreadsheet from any OpenOffice.org window. Calc dis-
plays its main window, which looks similar to Windows-based spreadsheets,
such as Microsoft Excel. (In fact, Calc can read and write Microsoft Excel
format spreadsheet files.)

Use Calc in the same way you use Microsoft Excel. You can type entries in
cells, use formulas, and format the cells. (For example, you can specify the
type of value and the number of digits after the decimal point.) Figure 4-2
shows a typical spreadsheet in Calc.
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When preparing the spreadsheet, use formulas that you normally use in
Microsoft Excel. For example, use the formula SUM(D2:D6) to add up the
entries from cell D2 to D6. To set cell D2 as the product of the entries A2 and
C2, type =A2*C2 in cell D2. To find out more about the functions available in
OpenOffice.org Calc, choose Help=>Contents from the menu. This opens the
OpenOffice.org Help window, from which you can browse the functions by
category and click a function to read more about it.

To save the spreadsheet, choose Filen>Save As. A dialog box appears, from
which you can specify the file format, the directory location, and the name
of the file. OpenOffice.org Calc can save the file in several formats, including
Microsoft Excel 5.0/95/97/2000/XP, as well as text file with Comma Separated
Values (CSV).

If you want to exchange files with Microsoft Excel, save the spreadsheet in
Microsoft Excel format (choose an appropriate version of Excel). Then you
can transfer that file to a Windows system and open it in Microsoft Excel.

Impress

Impress is similar to Microsoft PowerPoint. You can prepare briefing pack-
ages (slide presentations) with Impress. To run Impress, choose
Presentation from the Office category in the Main Menu or choose
File>Newr>Presentation from any OpenOffice.org window.

When you first start it, Impress prompts you for the presentation style and
template. To begin working, select Empty presentation and click Create. To
open an existing document, select the appropriate option from the
Presentation Wizard and click Open. Then select the presentation file you
want to open. You can open Microsoft PowerPoint files in Impress.

Figure 4-3 shows a typical slide presentation in Impress.

The Impress window shows the first slide together with an outline view of
the slides along the left side. The exact appearance depends on the docu-
ment type and template you select. You can begin adding text and other
graphic objects such as images, text, and lines to the slide.

To insert a new slide, choose Insert=>Slide from the menu. A blank slide
appears. You can then add text and graphics to that new slide.

To save a presentation, choose Filem>Save. For new documents, you have to
provide a filename and select the directory where you want to save the file.
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If you want to share the slides with someone who uses Microsoft

PowerPoint, save the presentation in Microsoft PowerPoint 97/2000/XP
format.

Calendars

KDE comes with Kontact — an application that integrates existing KDE appli-
cations such as KMail mail reader and KOrganizer calendar program in a
single graphical personal information manager. You can start Kontact from
panel icons or the Main Menu. (The exact location of the menu entry
depends on the Linux distribution.)

When Kontact starts, it usually displays the KMail application. You can,
however, switch to other views by clicking the icons on the left pane of
the Kontact window (see Figure 4-4). For example, Figure 4-4 shows the
Kontact window after you click the Calendar icon. In this case, Kontact
displays the output of KOrganizer — the KDE calendar program. The
KOrganizer program displays a calendar view where you can click a date
to set or view that day’s schedule. Figure 4-4 shows a typical calendar.
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To add events or appointments for a specific date and time, select the date
from the calendar, double-click the time, and type a brief description of the
appointment in the New Event dialog box that appears. Click OK when
you’re done. After you finish adding events and appointments, choose
File>Save to save the calendar.

Calculators

You have a choice of the GNOME calculator or the KDE calculator. Both are
scientific calculators, and you can do the typical scientific calculations, such
as square root and inverse, as well as trigonometric functions, such as sine,
cosine, and tangent.

To use the calculator, look for it in the Utilities or Accessories category of
the Main Menu. Figure 4-5 shows the KDE calculator in SUSE.
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You can display additional buttons by selecting options from the Settings
menu. For example, choose Settings=>Trigonometric Buttons to show
buttons that enable you to perform trigonometric calculations with the
calculator.

Commercially available office applications for Linux

Because office applications are important to many businesses as well as
individuals, I briefly mention some of the commercial office applications
available for Linux. These commercial offerings include Applixware Office
and StarOffice. These products do cost some money, but the cost is usually
less than that of Microsoft Office — the leading office application suite for
Windows. (In case you don’t know, Microsoft Office is a collection of several
applications: Microsoft Word for word processing, Microsoft Excel for spread-
sheets, Microsoft PowerPoint for presentation graphics, and Microsoft Access
for databases.)

Another commercial product for Linux is CrossOver Office from
CodeWeavers. With CrossOver Office, you can run your existing Microsoft
Office applications (such as Word, Excel, and PowerPoint) under Linux and
the X Window System.

sQ\I\BER

& This book’s companion DVD-ROM doesn’t include any of these commercial

office applications for Linux, but I briefly describe them in the next few sec-

tions. You can visit each vendor’s Web site for more about the products.

Applixware Office

www.Vvistasource.com

Applixware is an office application suite for all Linux distributions. In April
2000, Applix, Inc., formed a separate group — VistaSource, Inc. — that
focuses solely on Linux applications. Applixware is a set of integrated mod-
ules, including a word processor, a spreadsheet capable of manipulating real-
time data, a programmable vector graphic tool, and database interfaces for
accessing databases. Applixware modules can read and write documents in
Microsoft Office formats, as well as in several other file formats.

StarOffice

www.sun.com/staroffice

StarOffice is another commercial office applications suite; it was created by
StarDivision of Hamburg, Germany, and was purchased by Sun Microsystems
in 1999. StarOffice is a cross-platform solution — it runs on Linux, Windows
95/98/Me/NT/2000/XP, Sun Solaris SPARC, and Sun Solaris x86. Also,
StarOffice is available in several languages: English, French, German,
Spanish, Italian, and Swedish.
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Here’s what StarOffice 7 includes:

4+ StarOffice Writer for word processing (Microsoft Word-compatible)

4+ StarOffice Calc for spreadsheets (Microsoft Excel-compatible)

4+ StarOffice Impress for presentations (Microsoft PowerPoint-compatible)
4+ StarOffice Draw for vector graphics drawing

4+ StarOffice Base for data management

In October 2000, Sun released the source code of StarOffice under open
source licenses. OpenOffice.org, an open source project that Sun supports,
released the OpenOffice.org 1.0 office productivity suite in May 2002. Current
Linux distributions come with OpenOffice.org 2.0 or later versions. To find
out more about OpenOffice.org, visit www.openoffice.org.

The commercial version of Xandros comes with StarOffice 7. Look for the
desktop icon that you can click to start StarOffice. Xandros also includes
OpenOffice.org.

CrossOver Office

www . codeweavers.com/products/cxoffice

Chances are better than good that you have Windows and Microsoft Office
installed on your PC. When you decide to run Linux on the PC, you can con-
tinue to run most Microsoft Office applications from the GNOME or KDE
desktop. The convenience of running Microsoft Office in Linux comes from
a commercial product called CrossOver Office.

CrossOver Office, from CodeWeavers, is a software package that enables

you to install your Microsoft Office applications (all versions of Office includ-
ing Office 97, Office 2000, and Office XP) in Linux. You don’t need Microsoft
Windows to run the Office applications in CrossOver Office. You simply
install CrossOver Office and then install Microsoft Office (as well as many
other Windows applications such as Adobe Photoshop and Quicken) from
the CD-ROM. After you install Microsoft Office, the Office applications are
available directly from GNOME or KDE desktop.

CrossOver Office uses Wine — an open source implementation of the
Windows Win32 and Win16 application programming interfaces (APIs) using
the X Window System and designed to run in UNIX and Linux systems. Wine
includes the Wine loader and WineLib. Wine loader can load and run Windows
applications. WineLib is used for compiling and linking Windows applications
in Linux. Wine is available free of charge from www.winehq. com.
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CodeWeavers created CrossOver Office by using a customized version of
Wine to make sure that the Microsoft Office applications (especially Microsoft
Word, Excel, and PowerPoint) run properly on Wine. CodeWeavers charges

a nominal amount for CrossOver Office — the list price is $39.95 U.S. for
CrossOver Office Standard and $74.95 U.S. for CrossOver Office Professional.
However, all code changes and improvements to Wine are returned to the
Wine project. Thus, the Wine open source project benefits from the sale of
CrossOver Office.

The commercial version of Xandros comes with CrossOver Office. You have
to run the CrossOver Office setup and then install Microsoft Office from the
original CD before you can start using Microsoft Office applications. During
installation, you have to enter the product key for Microsoft Office, just as
you would on a Windows installation.

Aspell spelling checker

The Aspell utility is an interactive spelling checker. You can use it to check
the spelling of words in a text file. To do so, simply type the following com-
mand in a terminal window:

aspell check filename

If you want to try out Aspell, type some notes and save them in a text file
named notes. txt. (The filename can be anything, but I use this filename in
this section.) To run the spelling checker on that file, type the following com-
mand in a terminal window:

aspell check notes.txt

Here’s what Aspell displays:

This note describes the *concensus* reached during the
August 16 meeting.

1) consensus 6) consensual
2) con census 7) consciences
3) con-census 8) incenses

4) condenses 9) consensus's
5) concerns 0) consensuses
i) Ignore I) Ignore all
r) Replace R) Replace all
a) Add x) Exit

2

When Aspell finds a misspelled word (any word that doesn’t appear in its
dictionary), it displays the sentence with the misspelled word (concensus)
and highlights that word by enclosing it in a pair of asterisks. Below that
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sentence, Aspell lists possible corrections, numbering them sequentially
from 1. In this case, Aspell lists consensus — the correct choice — as the
first correction for concensus.

After the sentence, Aspell displays a list of 16 options — ten of them num-
bered 0 through 9, six of which are labeled with single letters i, r, a, I, R,
and x — followed by a question mark prompt. You have to press one of the
numbers or letters from the list shown in the output to indicate what you
want Aspell to do. The numbered options show ten possible replacement
words for the misspelled word. Here are the meanings of the letter options:

4+ Space means accept the word this time. Book I

4 i means ignore the misspelled word. Chapter 4
4 I means ignore all occurrences of the word.
*

r means replace this occurrence. (After pressing r, you have to type a
replacement word.)

<+

R means replace all occurrences. (After pressing R, you have to type a
replacement word.)
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4+ a means accept the word and add it to your private dictionary.

x means save the rest of the file and exit, ignoring misspellings.

‘X@N\BER
& These options are case-sensitive. Make sure you don’t have Caps Lock
engaged.
Databases

Linux distributions typically come with one of two common relational data-
bases — PostgreSQL and MySQL.

PostgreSQL (pronounced POST gres cue el), is a powerful and popular rela-
tional database (the type of database that works as a collection of connected
tables). You can use the Structured Query Language (SQL) to work with the
database. PostgreSQL is developed by a team of developers and distributed
under the BSD (Berkeley Software Distribution) open source license. The
license places no restrictions on how the PostgreSQL source code may

be used. To keep up with the latest PostgreSQL developments, visit www .
postgresqgl.org.

MySQL (pronounced My ESS cue el) is another popular relational database.
You can use SQL to work with MySQL databases. A Swedish company called
MySQL AB develops MySQL (www . mysql . com).
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[ briefly show you how to use MySQL on Fedora. By the way, if you don’t see
MySQL in Debian, log in as root and type apt-get install mysql-admin
mysql-client mysql-common mysql-server in a terminal window.

To use MySQL, you have to first log in as root and start the database server
with the following command:

/etc/init.d/mysqgld start

The database server mysqgld is a daemon (a background process that runs
continuously) that accepts database queries from the MySQL monitor.

Now you have to design a database, create that database in MySQL, and load
it with the data.

Reviewing the steps to build the database

Use this basic sequence of steps to build a database:

1. Design the database.

This involves defining the tables and attributes that will be used to store
the information.

2. Create an empty database.

Before you can add tables, database systems require you to build an
empty database.

3. Create the tables in the database.

In this step, you define the tables by using the CREATE TABLE state-
ment of SQL.

4. Load the tables with any fixed data.

For example, if you have a table of manufacturer names or publisher
names (in the case of books), you’d want to load that table with informa-
tion that’s already known.

5. Back up the initial database.

This step is necessary to ensure that you can create the database from
scratch, if necessary.

6. Load data into tables.

You may either load data from an earlier dump of the database or inter-
actively through forms.

7. Use the database by querying it.

Make queries, update records, or insert new records using SQL
commands.
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To illustrate how to create and load a database, [ set up a simple book cata-
log database as an example.

Designing the database

For my book catalog example, I don’t follow all the steps of database build-
ing. For the example, the database design step is going to be trivial because
my book catalog database will include a single table. The attributes of the
table are as follows:

4+ Book’s title, with up to 50 characters
Name of first author, with up to 20 characters
Name of second author (if any), with up to 20 characters
Name of publisher, with up to 30 characters
Page count, as a number

Year published, as a number (such as 2005)

e e

International Standard Book Number (ISBN), as a 10-character text (such
as 0471752622)

I store the ISBN without the dashes that are embedded in a typical ISBN. I
also use the ISBN as the primary key of the table because ISBN is a world-
wide identification system for books. That means each book entry must
have a unique ISBN because all books have unique ISBNs.

Creating an empty database

To create the empty database in MySQL, use the mysgladmin program. For
example, to create an empty database named books, I type the following
command:

mysgladmin create books

You have to log in as root to run the mysgladmin program. As the name
suggests, mysgladmin is the database administration program for MySQL.

In addition to creating a database, you can use mysgladmin to remove a
database, shutdown the database server, or check the MySQL version. For
example, to see the version information, type the following command:

mysgladmin version
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Using the MySOL monitor

After you create the empty database, all of your interactions with the data-
base are through the mysqgl program — the MySQL monitor that acts as a
client to the database server. You need to run mysqgl with the name of a
database as argument. The mysqgl program then prompts you for input.
Here is the command I type to start the mysgl program and open the
books database:

mysgl books

After displaying its version number and some status information, the mysqgl
program prompts you for input, as follows:

mysqgl>

You can then type mysgl commands at the prompt. When creating tables or
loading data into tables, a typical approach is to place the SQL statements
(along with mysgl commands such as \g) in a file and then run mysqgl with
the standard input directed from that file. For example, suppose a file named
sample.sqgl contains some SQL commands that you want to try out on a
database named books. Then, you should run mysgl with the following
command:

mysgl books < sample.sdgl

[ use mysqgl in this manner to create a database table.

Defining a table
To create a table named books, I edited a text file named makedb. sgl and
placed the following line in that file:

#

# Table structure for table 'books'

#

CREATE TABLE books (
isbn CHAR(10) NOT NULL PRIMARY KEY,
title CHAR(50),
authorl CHAR(20),
author2 CHAR(20),
pubname CHAR(30),
pubyear INT,
pagecount INT

) \g

CREATE TABLE books is an SQL statement to create the table named
books. The \g at the end of the statement is a mysgl command. The attrib-
utes of the table appear in the lines enclosed in parentheses.
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If a table contains fixed data, you can also include other SQL statements
(such as INSERT INTO) to load the data into the table right after the table
is created.

To execute the SQL statements in the makedb. sql file in order to create the
books table, I run mysqgl as follows:

mysgl books < makedb.sgl

Now the books database has a table named books. (Okay, maybe I should
have named them differently, but it seemed convenient to call them by the
same name). | can now begin loading data into the table.

Loading data into a table

One way to load data into the table is to prepare SQL statements in another
file and run mysqgl with that file as input. For example, suppose [ want to add
the following book information into the books table:

isbn = '0764596152"

title = 'SUSE Linux 9.3 For Dummies'
authorl = 'Naba Barkakati'

author2 = NULL

pubname = 'Wiley'

pubyear = 2005
pagecount = 384

Then, the following MySQL statement loads this information into the books
table:

INSERT INTO books VALUES
( '0764596152', 'SUSE Linux 9.3 For Dummies',
'Naba Barkakati', NULL, 'Wiley', 2005, 384) \g

On the other hand, suppose you had the various fields available in a different
order — an order different from the one you defined by using the CREATE
TABLE statement. In that case, you can use a different form of the INSERT
INTO command to add the row in the correct order, as shown in the following
example:

INSERT INTO books (pubyear, authorl, author2, title,
pagecount, pubname, isbn) values

(2005, 'Naba Barkakati', NULL, 'SUSE Linux 9.3 For
Dummies', 384, 'Wiley', '0764596152')\g

Essentially, you have to specify the list of attributes as well as the values and
make sure that the order of the attributes matches that of the values.
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If I save all the INSERT INTO commands in a file named additems.sql, I
can load the database from the mysgl command line by using the source
command like this. (Type mysql books to start the SQL client.)

mysgl> source additems.sql

Ouerying the database

You can query the database interactively through the mysgl monitor. You do
have to know SQL to do this. For example, to query the books database, |
start the SQL client with the command:

mysgl books

Then I type SQL commands at the mysgl> prompt to look up items from the
database. When I'm done, I type quit to exit the mysgl program. Here’s an
example. (I typed all of this in a terminal window.)

mysgl> select title from books where pubyear < 2006 \g

| SUSE Linux 9.3 For Dummies
| Linux All-in-One Desk Reference For Dummies |

2 rows in set (0.06 sec)

mysgl> quit
Bye

Multimedia Applications

Most Linux distributions include quite a few multimedia applications —
mostly multimedia audio players and CD players but also applications for
using digital cameras and burning CD-ROMs. To play some other multimedia
files (such as MPEG video), you may have to download and install additional
software on your Linux system. Here’s a quick sketch of a few typical multi-
media tasks and the applications you can use to perform these tasks:

4+ Using digital cameras: Use a digital camera tool to download photos
from your digital camera in Linux (or simply access the camera as a USB
mass storage device).

4+ Playing audio CDs: Use one of many audio CD players that come with
Linux.
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4+ Playing sound files: Use Rhythmbox or XMMS multimedia audio play-
ers. (You have to download some additional software to play MP3 files
with Rhythmbox or XMMS.) You can also download other players from
the Internet.

4 Burning a CD: Use a CD burner, such as K3b, to burn audio and data CDs.

Using a digital camera

Most Linux distributions come with a digital camera application that you can

use to download pictures from digital cameras. For example, MEPIS, SUSE,
and Xandros come with digiKam, which works with many different makes

and models of digital cameras. Depending on the model, the cameras can

connect to the serial port or the Universal Serial Bus (USB) port.

To use digiKam with your digital camera, follow these steps:

1. Connect your digital camera to the serial port or USB port (whichever

interface the camera supports) and turn on the camera.

2. Start digiKam.
Look for it in the Main Menu under graphics or images.

3. From the digiKam menu, choose Settings=>Configure digiKam.
A configuration dialog box appears.

4. Click the Cameras tab in the dialog box and click Auto Detect.

If your camera is supported and the camera is configured to be in PTP

(Picture Transfer Protocol) mode, the camera is detected. If not, you can

get the photos from your camera by using an alternate method that I
describe after these steps.

5. Choose your camera model from the Camera menu.

A new window appears, and after a short while, displays the photos in

the camera.

6. Click the thumbnails to select the images you want to download; then

choose Camera>Download to download the images.

digiKam then downloads the images. You can save the file in a folder and

edit the photos in The GIMP or your favorite photo editor.

Don’t despair if digiKam doesn’t recognize your digital camera. You can still
access the digital camera’s storage media (compact flash card, for example)

as a USB mass storage device, provided your camera supports USB Mass

Storage. To access the images on your USB digital camera, use the following

steps. (I tested these steps on SUSE Linux, but they should work on most
Linux distributions.)
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1. Read the camera manual and use the menu options of the camera to
set the USB mode to Mass Storage.

If the camera doesn’t support USB Mass Storage, you cannot use this
procedure to access the photos. If the camera supports the Picture
Transfer Protocol mode, you can use digiKam to download the pictures.

2. Connect your digital camera to the USB port by using the cable that
came with the camera and then turn on the camera.

This causes Linux to detect the camera and open the contents of the
camera in a file manager window (see Figure 4-6).

= 106nikon - Kongueror =

Locaticn Ect Wiew Go  Bockmarks  Toals  Settngs  Window  Help
[ERSNT I+ ]IG] G B E] = i
E# Location: || smediafusbaiss deimy LOSnikon b [/
. |EScdrecorder * - -
© [EdDebian 3.1 rie
_| | ®Edovovoume | I 5 I
S w Efeapy £52n0441,ipg dscnidda2.ing dsenli=43.ipq dseniddd.ipg
- [Euaurtu 5 04 11 ’ .
S Eusbisk L 1
—_— S Bas  my
. L] |E3100nikon 0445, dsen4d7 gy d8enDA4 8 g
Figure 4-6: |, Eiotniken
|E3 202nikan | — 1 3
You can Esoamen B e Bzaill
E @104"“‘-“" £2on0d49. nn dscndd50.5ng dscnf451 jpg dscnids3 ipg
accessyour W [EJ105nikan
2 == 1oenikan = s
cameraasa |5 @ S i
USB mass | @ Eimepis £onDd5lipn  dscrddBSnng  dscrlSSSipy  dsenDES6.pg
— ¥
storage 4 = == &2
device. D gssuMS7ipn  cecr0dS8po  den(4SBipe  dsenid6ling =
##|[251 Tterns - 151 Files (53.0 MB Total) - Mo Folders

3. Click to select photos and copy them to your hard drive by dragging
and dropping them into a selected folder.

4. Close the file manager window, disconnect the USB cable from the PC,
and turn off the camera.

Who needs a digital camera tool when you can access the camera just like
any other storage device!

Playing audio CDs
All Linux distributions come with either the GNOME or KDE CD player appli-

cations. To play an audio CD, you need a sound card, and that sound card
must be configured to work in Linux.

In some distributions, you can insert an audio CD into the drive, and a dialog
box appears and asks whether you want to play the CD with the CD player.
For example, Figure 4-7 shows the KDE CD player (KsCD) playing a track
from an audio CD in SUSE Linux.
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The KDE CD player displays the title of the CD and the name of the current
track. The CD player gets the song titles from http://freedb.org—a
free, open source CD database on the Internet (freedb. freedb.org at
port 888). You need an active Internet connection for the CD player to down-
load song information from the CD database. After the CD player downloads
information about a particular CD, it caches that information in a local data-
base for future use. The CD player user interface is intuitive, and you can
figure it out easily. One nice feature is that you can select a track by title.
Playing sound files
You can use Rhythmbox or XMMS to open and play sound files (for example,
MP3 files). Users with large MP3 music libraries like Rhythmbox because it
can help organize the music files. You can start Rhythmbox by choosing
the music player application from the Main Menu in several distributions,
including Debian and Fedora Core. When you first start Rhythmbox, it dis-
plays an assistant that prompts you (see Figure 4-8) for the location of
your music files so that Rhythmbox can manage your music library.
Rhythrmbox manages all of your music in a central music
"library", so you can easily view, search, and organise it.
In arder to use this feature, you need to tell Rhythmbox where
to find your music. You may choose to skip this step; instead,
you can add music to your library at any point later,
Please choose one of the options below:
& Enter location manually:
Figure 4-8: Path: Browse...
Rhythmbox - =
can manage " gkip this step
your music =
library. X close @ Back e

After you identify the locations of music files, Rhythmbox starts and dis-
plays the library in an organized manner. You can then select music and play
it, as shown in Figure 4-9. (Here you see Rhythmbox running on Debian.)
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Figure 4-9:
You can
play music
from your
library in
Rhythmbox.
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Figure 4-10:
You can
play many
different
types of
sound files
in XMMS.

XMMS is another music player that can play many types of sound files,
including Ogg Vorbis, FLAC (Free Lossless Audio Codec, an audio file format
that is similar to MP3), and Windows WAV.

You can start XMMS by choosing the audio player application from the Main
Menu (look under Multimedia or Sound & Video). After XMMS starts, you
can open a sound file (such as an MP3 file) by choosing Window Menu~> Play
File or by pressing L. Then select one or more music files from the Load File
dialog box. Click the Play button, and XMMS starts playing the sound file.
Figure 4-10 shows the XMMS window (in SUSE Linux) when it’s playing a
sound file.
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Figure 4-11:
You can
burn CDs
and DVDs
with the K3b
application.
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In some free Linux distributions, you may not be able to play MP3 files
because the MP3 decoder is not included. However, MP3 playing works fine
in Debian, Knoppix, SUSE, and Xandros. Because of legal reasons, the ver-
sions of Rhythmbox and XMMS in Fedora Core don’t include the code
needed to play MP3 files, so you have to somehow translate MP3s into a sup-
ported format, such as WAV, before you can play them. You can, however,
download the source code for Rhythmbox and XMMS and build the applica-
tions with MP3 support. You can also use the Ogg Vorbis format for com-
pressed audio files because Ogg Vorbis is a patent- and royalty-free format.

Burning a CD

Nowadays, GUI file managers often have the capability to burn CDs. For
example, Nautilus and Xandros File Manager have built-in features to burn
CDs. Linux distributions also come with standalone GUI programs that
enable you to easily burn CDs and DVDs. For example, K3b is a popular
CD/DVD burning application for KDE that’s available in Knoppix and SUSE.

Most CD burning applications are simple to use. You basically gather up the
files that you want to burn to the CD or DVD and then start the burning
process. Of course, for this to work, your PC must have a CD or DVD burner
installed.

Figure 4-11 shows the initial window of the K3b CD/DVD burning application
in SUSE Linux. The upper part of the K3b window is for browsing the file
system to select what you want to burn onto a CD or DVD. The upper-left
corner shows the CD writer device installed; in this example, it’s a DVD/CD-
RW drive so that the drive can read DVDs and CDs, but burn CDs only.
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To burn a CD, you start with one of the projects shown in the lower part of
the K3b window — New Audio CD Project, for example, or New Data DVD
Project. Then you have to add files and finally, burn the project to the CD or
DVD by choosing Project>Burn or pressing Ctrl+B. For an audio CD, you can
drag and drop MP3 files as well as audio tracks.

K3b needs the external command-line programs cdrecord and cdrdao to
burn CDs. K3b also needs the growisofs program to burn DVDs.

If you get an error about missing cdrdao in Debian, make sure that your
Debian system is connected to the Internet and then type apt-get install
cdrdao to install it.

Graphics and Imaging

You can use graphics and imaging applications to work with images and
graphics (line drawings and shapes). | discuss two applications:

4+ The GIMP (GNU Image Manipulation Program) is a program for viewing
and performing image-manipulation tasks, such as photo retouching,
image composition, and image creation.

4+ Gnome Ghostview (GGv) is a graphical application capable of display-
ing PostScript files.

The GIMP

The GIMP is an image-manipulation program written by Peter Mattis and
Spencer Kimball and released under the GNU General Public License (GPL).
Most Linux distributions come with this program, although you may have
to specifically select a package to install it. The GIMP is comparable to
other image-manipulation programs, such as Adobe Photoshop and Corel
PHOTO-PAINT.

To try out The GIMP, look for it under the Graphics category in the Main
Menu. When you start it, The GIMP displays a window with copyright and
license information. Click the Continue button to proceed with the installa-
tion. The next screen shows the directories to be created when you proceed
with a personal installation of The GIMP.

The GIMP installation involves creating a directory in your home directory
and placing a number of files in that directory. This directory essentially
holds information about any changes to user preferences you may make to
The GIMP. Go ahead and click the Continue button at the bottom of the



Figure 4-12:
Touch up
your photos
with The
GIMP.
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window. The GIMP creates the necessary directories, copies the necessary
files to those directories, and guides you through a series of dialog boxes to
complete the installation.

After the installation is done, click the Continue button. From now on, you
don’t see the installation window anymore; you have to deal with installation
only when you run The GIMP for the first time.

The GIMP then loads any plugins — external modules that enhance its func-
tionality. It displays a startup window that shows a message about each
plugin as it loads. After finishing the startup, The GIMP displays a tip of the
day in a window. You can browse the tips and click the Close button to close
the Tip window. At the same time, The GIMP displays a number of windows,
as shown in Figure 4-12.

These windows include a main toolbox window titled The GIMP, a Tool
Options window, a Brush Selection window, and a Layers, Channels, Paths
window. Of these, the main toolbox window is the most important — in fact,
you can close the other windows and work by using the menus and buttons
in the toolbox.
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The toolbox has three menus on the menu bar:

4+ The File menu has options to create a new image, open an existing
image, save and print an image, mail an image, and quit The GIMP.

4+ The Xtns menu gives you access to numerous extensions to The GIMP.
The exact content of the Xtns menu depends on which extensions are
installed on your system.

4+ The Help menu is where you can get help and view tips. For example,
choose Help=~>Help to bring up The GIMP Help Browser with online infor-
mation about The GIMP.

To open an image file in The GIMP, choose File=>Open. The Load Image
dialog box comes up, which you can then use to select an image file. You can
change directories and select the image file that you want to open. The GIMP
can read all common image file formats, such as GIF, JPEG, TIFF, PCX, BMP,
PNG, and PostScript. After you select the file and click OK, The GIMP loads
the image into a new window. (Refer to Figure 4-12 to see an image after it’s
loaded in The GIMP, along with all the other The GIMP windows.)

The toolbox also has many buttons that represent the tools you use to edit
the image and apply special effects. You can get pop-up help on each tool
button by placing the mouse pointer on the button. You can select a tool by
clicking the tool button, and you can apply that tool’s effects to the image.

For your convenience, The GIMP displays a pop-up menu when you right-
click the image window. The pop-up menu has most of the options from the
File and Xtns menus in the toolbox. You can then select specific actions from
these menus.

You can do much more than just load and view images with The GIMP, but a
complete discussion of all its features is beyond the scope of this book. If
you want to try the other features of The GIMP, consult The GIMP User
Manual (GUM), available online at http://manual .gimp.org. You can
also choose Xtns=>Web Browser=>GIMP.ORG~>Documentation to access the
online documentation for The GIMP. (Of course, you need an Internet con-
nection for this command to work.)

Visit The GIMP home page at www.gimp.org to find the latest news about
The GIMP and links to other resources.

GNOME Ghostview

GNOME Ghostview is a graphical application ideal for viewing and printing
PostScript or PDF documents. For a long document, you can view and print
selected pages. You can also view the document at various levels of magnifi-
cation by zooming in or out.
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To run GNOME Ghostview in Fedora Core, choose Main Menu=>Graphics=>
PostScript Viewer from GUI desktop. The GNOME Ghostview application
window appears. In addition to the menu bar and toolbar along the top edge,
a vertical divide splits the main display area of the window into two parts.

To load and view a PostScript document in GNOME Ghostview, choose
File>Open, or click the Open icon on the toolbar. GNOME Ghostview dis-
plays a File-Selection dialog box. Use this dialog box to navigate the file
system and select a PostScript file. You can select one of the PostScript files
that come with Ghostscript. For example, open the file tiger.ps in the
/usr/share/ghostscript/7.07/examples directory. (If your system
has a version of Ghostscript later than 7.07, you have to use the new version
number in place of 7.07.)

To open the selected file, click the Open File button in the File-Selection
dialog box. GNOME Ghostview opens the selected file, processes its con-
tents, and displays the output in its window, as shown in Figure 4-13.

GNOME Ghostview is useful for viewing various kinds of documents that
come in PostScript format. (These files typically have the .ps extension in
their names.) You can also open PDF files — which typically have .pdf
extensions — in GNOME Ghostview.
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Chapter 5: Using Text Editors

In This Chapter

v+~ Using GUI text editors
1 Working with the ed text editor
v Getting to know the vi text editor

In Linux, most system configuration files are text files. If you write any shell
scripts or other computer programs, they’re text files too. Sometimes you
have to edit these files by using programs designed for that purpose: text edi-
tors. For example, you may need to edit files, such as /etc/hosts, /etc/
resolv.conf, /etc/X11/XF86Config-4, /etc/apt/sources.list, and
many more.

In this chapter, I introduce you to a few text editors — both the GUI editors
and text mode editors.

Using GUI Text Editors

Each of the GUI desktops — GNOME and KDE — comes with GUI text editors
(text editors that have graphical user interfaces).

To use a GUI text editor, look in the Main Menu and search for text editors in
an appropriate category. For example, in Debian and Fedora Core, choose
Applications>Accessoriesw>Text Editor from the GNOME desktop. After you
have a text editor up and running, you can open a file by clicking the Open
button on the toolbar, which brings up the Open File dialog box. You can
then change directories and select the file to edit by clicking the OK button.

The GNOME text editor then loads the file in its window. You can open more
than one file at a time and move among them as you edit the files. Figure 5-1
shows a typical editing session with the editor.
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Figure 5-1:
You can use
the GNOME
text editor to
edit text
files.
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# inittab This file describes how the INIT process should set up
# the system in a certain run-lewvel.
#
# Author: Miguel van Smoorenburg, <miquels@idrinkel.nl.mugnet.org>
# Modified for RHS Linux by Marc Ewing and Donnie Barnes

# Default runlevel. The runlevels used by RHS are:

# 0 - halt (Do NOT set initdefault to this)

# 1 - Single user mode

# 2 - Multiuser, without NFS (The same as 3, if you do not have networking)
# 3 - Full multiuser mode

# 4 unused

# 5 - X11

# 6 - reboot (Do NOT set initdefault to this)

#

i

d:5:initdefault:

# System initialization, [=l

nl, Caoll INS

In this case, the editor has three files — hosts, fstab, and inittab (all
from the /etc directory) — open for editing. The filenames appear as tabs
below the toolbar of the editor’s window. You can switch among the files by
clicking the tabs. The current filename appears in the title bar of the window.

If you open a file for which you have only read permission, the text [Read
Only] is appended to the filename shown in the window title to indicate
that the file is read-only. In Figure 5-1, all the files are read-only because here
I'm logged in as a normal user, and I'm opening system files that only the
root can modify.

The rest of the text editing steps are intuitive. To enter new text, click to
position the cursor and begin typing. You can select text, copy, cut, and
paste by using the buttons on the toolbar above the text editing area.

From the KDE desktop, you can start the KDE advanced text editor (Kate) by
choosing Main Menu=>Editors=>Advanced Text Editor. To open a text file,
choose File>Open. Kate displays a dialog box. From this dialog box, you can
go to the directory of your choice, select the file to open, and click OK. Kate
then opens the file and displays its contents in the window. You can then
edit the file.

Text Editing with ed and vi

GUI text editors enable you to edit text files using the mouse and keyboard
much the same way as you use any word processor. Text mode editors are
a completely different beast — you work using only the keyboard and you
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have to type cryptic commands to perform editing tasks, such as cutting and
pasting text or entering and deleting text. Linux comes with two text mode
text editors:

4 <d: aline-oriented text editor

4+ vi:afull-screen text editor that supports the command set of an earlier
editor named ex

The ed and vi editors are cryptic compared to the graphical text editors.
However, you should still get to know the basic editing commands of ed and
vi because sometimes these two may be the only editors available. For
example, if Linux refuses to boot from the hard drive, you may have to boot
from a floppy disk. In that case, you have to edit system files with the ed
editor because that editor is small enough to fit on the floppy. [ walk you
through the basic text editing commands of ed and vi — they’re not that
hard.

Using ed

Typically, you have to use ed only when you boot a minimal version of Linux
(for example, from a floppy you've set up as a boot disk), and the system
doesn’t support full-screen mode. In all other situations, you can use the vi
editor that works in full-screen text mode.

When you use ed, you work in command mode or text input mode:

4+ Command mode is what you get by default. In this mode, anything that
you type is interpreted as a command. The ed text editor has a simple
command set where each command consists of one or more characters.

4+ Text input mode is for typing text. You can enter input mode with the
commands a (append), c (change), or i (insert). After entering lines of
text, you can leave input mode by entering a period (.) on a line by
itself.

To practice editing a file, copy the /etc/£fstab file to your home directory
by issuing the following commands:

cd
cp /etc/fstab

Now you have a file named fstab in your home directory. Type ed -p: fstab
to begin editing a file in ed. The editor responds:

878
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This example uses the -p option to set the prompt to the colon character
(:) and opens the fstab file (in the current directory, which is your home
directory) for editing. The ed editor opens the file, reports the number
of characters in the file (878), displays the prompt (:), and waits for a
command.
< When you’re editing with ed, make sure that you always turn on a prompt
character (use the -p option). Without the prompt, distinguishing whether
ed is in input mode or command mode is difficult.

After ed opens a file for editing, the current line is the last line of the file. To
see the current line number (the current line is the line to which ed applies
your command), use the .= command like this:

9

This output tells you that the fstab file has nine lines. (Your system’s
/etc/fstab file may have a different number of lines, in which case ed
shows a different number.)

You can use the 1, $p command to see all lines in a file, as the following
example shows:

:1,$p
# This file is edited by fstab-sync - see 'man fstab-sync' for details
/dev/VolGroup00/LogVol00 / ext3 defaults 11
LABEL=/boot /boot ext3 defaults 12
/dev/devpts /dev/pts devpts gid=5,mode=620 0 0
/dev/shm /dev/shm tmpfs defaults 00
/dev/proc /proc proc defaults 00
/dev/sys /sys sysfs defaults 00
/dev/VolGroup00/LogVol0l swap swap defaults 00
/dev/scd0 /media/cdrecorder auto

pamconsole, exec,noauto,managed 0 0
/dev/£d0 /media/floppy auto

pamconsole, exec,noauto, managed 0 0
/dev/hdc /media/cdrom auto

pamconsole, exec,noauto, managed 0 0

To go to a specific line, type the line number:
12
The editor responds by displaying that line:

/dev/VolGroup00/LogVol00 / ext3 defaults 11



Text Editing with ed and vi 2 43

Suppose you want to delete the line that contains cdrom. To search for a
string, type a slash (/) followed by the string that you want to locate:

: /cdrom
/dev/hdc /media/cdrom auto
pamconsole, exec,noauto,managed 0 0

The editor locates the line that contains the string and then displays it. That
line becomes the current line.

To delete the current line, use the d command as follows:

:d

To replace a string with another, use the s command. To replace cdrom with
the string cd, for example, use this command:

:s/cdrom/cd/

To insert a line in front of the current line, use the i command:

01
(type the line you want to insert)
(type a single period to indicate you're done)

You can enter as many lines as you want. After the last line, enter a period
(.) on aline by itself. That period marks the end of text input mode, and
the editor switches to command mode. In this case, you can tell that ed
switches to command mode because you see the prompt (:).

When you’re happy with the changes, you can write them to the file with the
w command. If you want to save the changes and exit, type wq to perform
both steps at the same time:

:wq
857

The ed editor saves the changes in the file, displays the number of saved
characters, and exits. If you want to quit the editor without saving any
changes, use the Q command.

These examples give you an idea of how to use ed commands to perform the
basic tasks of editing a text file. Table 5-1 lists some of the commonly used
ed commands.
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Table 5-1

Commonly Used ed Commands

Command

Does the Following

! command

Executes a shell command. (For example, ! pwd shows the current
directory.)

L3

Goes to the last line in the buffer

o

Applies a command that follows to all lines in the buffer. (For exam-
ple, $p prints all lines.)

Goes to the next line

+1n

Goes to the nth next line (where nis a number you designate)

Applies a command that follows to all lines in the buffer. (For exam-
ple, , p prints all lines.) This is similar to %.

Goes to the preceding line

Goes to the nth previous line (where nis a number you designate)

Refers to the current line in the buffer

Searches forward for the specified text

Refers to a range of lines — current through last line in the buffer

Prints the line number

Searches backward for the specified text

Goes to the preceding line. (See also the - command.)

Goes to the nth previous line (where nis a number you designate).
(See also the —n command.)

Appends the current line

Changes the specified lines

Deletes the specified lines

Inserts text before the current line

S|

Goes to line number n

Press Enter

Displays the next line and makes that line current

q Quits the editor

Q Quits the editor without saving changes

r file Reads and inserts the contents of the file after the current line
s/old/new/ Replaces an old string with a new one

u Undoes the last command

W file Appends the contents of the buffer to the end of the specified file
w file Saves the buffer in the specified file. (If no file is named, it saves in

the default file — the file whose contents ed is currently editing.)




Figure 5-2:
You can edit
text files
with the vi
full-screen
text editor.

Text Editing with ed and vi 2 45

Using vi

The vi editor is a full-screen text editor, so you can view several lines at the
same time. Most UNIX systems, including Linux, come with vi. Therefore, if

you know the basic features of vi, you can edit text files on almost any UNIX
system.

When vi edits a file, it reads the file into a buffer — a block of memory — so
you can change the text in the buffer. The vi editor also uses temporary files
during editing, but the original file isn’t altered until you save the changes.

To start the editor, type vi and follow it with the name of the file you want to
edit, like this:

vi /etc/fstab
The vi editor then loads the file into memory and displays the first few

lines in a text screen and positions the cursor on the first line, as shown
in Figure 5-2.

= nabai lecal hest— (Sl
Cile Edit Miew Terminal Tabs Help
E Thiz file is edited by fstab-sync - see 'man fstab-sync' for details B
Jdev/VolGrouphl/ LogVoll0 / extd  d 11
/boot fboot c
evpls fdev/pts
fdev/shm
fproe
K, Vs f5ys
fdev/VolGroup00,/TogVol0l swap
fdev/ sed Seediafedrecorder o,managed 0 0
Sdew/£d0 fmedia/floppy to.managed O O
Fdev/hde feedia/cdron to,managed O 0
"/etc/fstab” [readonly] 11L, B7&C 1.1 A11 [~

The last line shows the pathname of the file as well as the number of lines
(11) and the number of characters (878) in the file. In this case, the text
[readonly] appears after the filename because I'm opening the /etc/
fstab file while I'm logged in as a normal user (which means I don’t have
permission to modify the file). Later, the last line in the vi display functions
as a command entry area. The rest of the lines display the file. If the file con-
tains fewer lines than the screen, vi displays the empty lines with a tilde (~)
in the first column.
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The current line is marked by the cursor, which appears as a small black rec-
tangle. The cursor appears on top of a character.

When using vi, you work in one of three modes:

4 Visual command mode is what you get by default. In this mode, anything
that you type is interpreted as a command that applies to the line con-
taining the cursor. The vi commands are similar to the ed commands.

4+ Colon command mode is for reading or writing files, setting vi options,
and quitting vi. All colon commands start with a colon (:). When you
enter the colon, vi positions the cursor on the last line and waits for
you to type a command. The command takes effect when you press
Enter.

4+ Text input mode is for typing text. You can enter input mode with the
command a (insert after cursor), A (append at end of line), or i (insert
after cursor). After entering lines of text, you have to press Esc to leave
input mode and re-enter visual command mode.

One problem with all these modes is that you cannot easily tell the current
mode that vi is in. You may begin typing only to realize that vi is not in
input mode, which can be frustrating.

If you want to make sure that vi is in command mode, just press Esc a few
times. (Pressing Esc more than once doesn’t hurt.)

To view online help in vi, type :help while in colon command mode. When
you’re done with help, type :q to exit the Help screen and return to the file
you’re editing.

The vi editor initially positions the cursor on the first character of the first
line — and one of the handiest things you can know is how to move the
cursor around. To get a bit of practice, try the commands shown in Table 5-2.

Table 5-2 Cursor Movement Commands in vi

y Does the Following

Moves the cursor one line down

Moves the cursor one line up

Moves the cursor one character to the left

Moves the cursor one character to the right

Moves the cursor one word forward

= 5|y |1|=]<|z

Moves the cursor one word backward

Ctrl+D Moves down half a screen

Ctrl+U Scrolls up half a screen
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You can go to a specific line number at any time by using the handy colon
command. To go to line 6, for example, type the following and then press
Enter:

:6

When you type the colon, vi displays the colon on the last line of the
screen. From then on, vi uses any text you type as a command. You have to
press Enter to submit the command to vi. In colon command mode, vi
accepts all commands that the ed editor accepts — and then some.

To search for a string, first type a slash (/). The vi editor displays the slash
on the last line of the screen. Type the search string and then press Enter.
The vi editor locates the string and positions the cursor at the beginning of
that string. Thus, to locate the string cdrom in the file /etc/fstab, type

/cdrom

To delete the line that contains the cursor, type dd (two lowercase d’s). The
vi editor deletes that line of text and makes the next line the current one.

To begin entering text in front of the cursor, type i (a lowercase i all by
itself). The vi editor switches to text input mode. Now you can enter text.
When you finish entering text, press Esc to return to visual command mode.

After you finish editing the file, you can save the changes in the file with the
:w command. To quit the editor without saving any changes, use the : g!
command. If you want to save the changes and exit, you can type :wq to per-
form both steps at the same time. The vi editor saves the changes in the file
and exits. You can also save the changes and exit the editor by pressing
Shift+ZZ (hold Shift down and press Z twice).

vi accepts a large number of commands in addition to the commands [ men-
tion above. Table 5-3 lists some commonly used vi commands, organized by
task.

Table 5-3 Commonly Used vi Commands
Command Does the Following

Insert Text

a Inserts text after the cursor

A Inserts text at the end of the current line

I Inserts text at the beginning of the current line
i Inserts text before the cursor

(continued)
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Table 5-3 (continued)

Command Does the Following

Delete Text

D Deletes up to the end of the current line

dd Deletes the current line

dc Delete from the current line to the end of the file

dw Deletes from the cursor to the end of the following word
x Deletes the character on which the cursor rests
Change Text

C Changes up to the end of the current line

cc Changes the current line

J Joins the current line with the next one

rx Replaces the character under the cursor with x (where xis any

character)

Move Cursor

hor« Moves one character to the left

jord Moves one line down

korT Moves one line up

L Moves to the end of the screen

lor— Moves one character to the right

w Moves to the beginning of the following word
b Moves to the beginning of the previous word
Scroll Text

Ctrl+D Scrolls forward by half a screen

Ctrl+U Scrolls backward by half a screen

Refresh Screen

Ctrl+L Redraws screen

Cut and Paste Text

vy Yanks (copies) current line into an unnamed buffer
P Puts the yanked line above the current line
jo) Puts the yanked line below the current line

Colon Commands

: | command Executes a shell command
:q Quits the editor
:q! Quits without saving changes
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Command

Does the Following

:r filename

Reads the file and inserts it after the current line

:w filename

Writes a buffer to the file

Twqg

Saves changes and exits

Search Text

/string Searches forward for a string

?string Searches backward for a string

Miscellaneous

u Undoes the last command

Esc Ends input mode and enters visual command mode
U Undoes recent changes to the current line
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Chapter 1: Connecting
to the Internet

In This Chapter

+* Understanding the Internet

 Deciding how to connect to the Internet

1 Connecting to the Internet with DSL

+* Connecting to the Internet with a cable modem

1~ Setting up a dialup PPP link

Fe Internet is quickly becoming a lifeline for most people. Seems like a
lot of folks can’t get through a day without it (and I know I could not
write this book without it). Sometimes, I wonder how we ever managed
without the Internet. Given the prevalence and popularity of the Internet,
it’s a pretty safe bet for me to assume that you want to connect your Linux
system to the Internet. In this chapter, | show you how to connect to the
Internet in several different ways — depending on whether you have a DSL,
cable modem, or dialup network connection.

Two of the options for connecting to the Internet — DSL and cable modem —
involve connecting a special modem to an Ethernet card on your Linux
system. In these cases, you have to set up Ethernet networking on your Linux
system. (I explain networking in Chapter 2 of this minibook.) In this chapter, I
show you in detail how to set up a DSL or a cable modem connection.

I also show you the other option — dialup networking — that involves dial-
ing up an Internet service provider (ISP) from your Linux system.

Understanding the Internet

How you view the Internet depends on your perspective. Common folks see
the Internet in terms of the services they use. For example, as a user, you
might think of the Internet as an information-exchange medium with fea-
tures such as

4+ E-mail: Send e-mail to any other user on the Internet, using addresses
such as mom@home .net.
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4+ Web: Download and view documents from millions of servers through-
out the Internet.

4+ Newsgroups: Read newsgroups and post news items to newsgroups with
names such as comp.os.linux.networking or
comp.os.linux.setup.

4+ Information sharing: Download software, music files, videos, and so on.
Reciprocally, you may provide files that users on other systems can
download.

4+ Remote access: Log on to another computer on the Internet, assuming
that you have access to that remote computer.

The techies say that the Internet is a worldwide network of networks. The term
internet (without capitalization) is a shortened form of internetworking — the
interconnection of networks. The Internet Protocol (IP) was designed with the
idea of connecting many separate networks.

In terms of physical connections, the Internet is similar to a network of high-
ways and roads. This similarity is what has prompted the popular press to
dub the Internet “the Information Superhighway.” Just as the network of
highways and roads includes some interstate highways, many state roads,
and many more residential streets, the Internet has some very high-capacity
networks (for example, a 10 Gbps backbone can handle 10 billion bits per
second) and a large number of lower-capacity networks ranging from 56
Kbps dialup connections to 45 Mbps T3 links. (Kbps is thousand-bits-per-
second, and Mbps is million-bits-per-second.) The high-capacity network is
the backbone of the Internet.

In terms of management, the Internet is not run by a single organization, nor
is it managed by any central computer. You can view the physical Internet
as a network of networks managed collectively by thousands of cooperating
organizations. Yes, a collection of networks managed by thousands of
organizations — sounds amazing, but it works!

Deciding How to Connect to the Internet

So you want to connect to the Internet, but you don’t know how? Let me
count the ways. Nowadays you have three popular options for connecting
homes and small offices to the Internet. (Of course, huge corporations and
governments have many other ways to connect.)

4+ Digital Subscriber Line (DSL): Your local telephone company as well
as other telecommunications companies may offer DSL. DSL provides a
way to send high-speed digital data over a regular phone line. Typically,
DSL offers data transfer rates of between 128 Kbps and 1.5 Mbps. You
can download from the Internet at much higher rates than when you
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send data from your PC to the Internet (upload). One caveat with DSL is
that your home must be between 12,000 and 15,000 feet from your local
central office (the phone company facility where your phone lines end
up). The distance limitation varies from provider to provider. In the U.S.,
you can check out the distance limits for many providers at
www.dslreports.com/distance.

Cable modem: If the cable television company in your area offers
Internet access over cable, you can use that service to hook up your
Linux system to the Internet. Typically, cable modems offer higher data-
transfer rates than DSL — for about the same cost. Downloading data
from the Internet via cable modem is much faster than sending data
from your PC to the Internet. You can expect routine download speeds
of 1.5 Mbps and upload speeds of around 128 Kbps, but sometimes you
may get even higher speeds than these.

Dialup networking: A dialup connection is what most folks were using
before DSL and cable modems came along. You hook up your PC to a
modem that’s connected to the phone line. Then you dial up an ISP to
connect to the Internet. That’s why it’s called dialup networking —
establishing a network connection between your Linux PC and another
network (the Internet) through a dialup modem. In this case, the maxi-
mum data-transfer rate is 56 Kbps.

DSL and cable modem services connect you to the Internet and also act as
your Internet service provider (ISP); in addition to improved speed, what
you’re paying for is an IP address and your e-mail accounts. If you use a
dialup modem to connect to the Internet, first you have to connect to the
phone line (for which you pay the phone company) and then select and pay
a separate ISP — which gives you a phone number to dial and all the other
necessary goodies (such as an IP address and e-mail accounts).

Table 1-1 summarizes all these options. You can consult that table and select
the type of connection that’s available to you and that best suits your needs.

Table 1-1 Comparison of Dialup, DSL, and Cable

Feature Dialup DSL Cable

Equipment Modem DSL modem, Cable modem,
Ethernet card Ethernet card

Also requires

Phone service and
an Internet Service
Provider (ISP)

Phone service and
location within 12,000
to 15,000 feet of central
office

Cable TV connection

Connection type

Dial to connect

Always on, dedicated

Always on, shared

(continued)
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Table 1-1 (continued)
Feature Dialup DSL Cable

Typical speed 56 Kbps maximum 640 Kbps download, 1.5 Mbps download,
128 Kbps upload (higher 128 Kbps upload
speeds cost more)

One-time None Install = $100-200 (none Install = $100-200
costs (estimate) for self install); Equipment= (none for self install);
$50-100 (may be leased Equipment = $50-100
and may require (may be leased)
activation cost)
Typical monthly ~ Phone charges=  $40-50 per month; $40-50 per month;
cost (2005) $20 per month; ISP may require monthly may require monthly
charges = $15-30 modem lease modem lease
per month

Note: Costs vary by region and provider. Costs shown are typical ones for U.S. metropolitan areas.

Besides the three options shown in Table 1-1, a few other less-common
options may be available to you. These include fiber-to-the-home (FTTH),
broadband over power lines (BPL), fixed wireless broadband (called FWB or
WiMax), and satellite Internet access (for example, DIRECWAY and StarBand).
If one or more of these options are available in your geographic area and if
you want to use one of them for Internet access, follow the specific service
provider’s instructions on setting up the Internet connection. Typically, satel-
lite Internet access is available across large geographical regions (even places
that do not have phone or cable), but the initial equipment cost and monthly
fees are higher than DSL and cable. For more information on satellite Internet
access, visit www.satellite-internet-access.net.

Connecting with DSL

DSL stands for Digital Subscriber Line. DSL uses your existing phone line to
send digital data in addition to the normal analog voice signals (analog
means continuously varying, whereas digital data is represented by 1s and
0s). The phone line goes from your home to a central office, where the line
connects to the phone company’s network. By the way, the connection from
your home to the central office is called the local loop. When you sign up for
DSL service, the phone company hooks up your phone line to some special
equipment at the central office. That equipment can separate the digital data
from voice. From then on, your phone line can carry digital data that is then
directly sent to an Internet connection at the central office.



Figure 1-1:
DSL
provides
high-speed
connection
to the
Internet
overa
regular
phone line.
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How DSL works

A special box called a DSL modem takes care of sending digital data from
your PC to the phone company’s central office over your phone line. Your PC
can connect to the Internet with the same phone line that you use for your
normal telephone calls — you can make voice calls even as the line is being
used for DSL. Figure 1-1 shows a typical DSL connection to the Internet.

Your PC talks to the DSL modem through an Ethernet connection, which
means that you need an Ethernet card in your Linux system.

Your PC sends digital data over the Ethernet connection to the DSL modem.
The DSL modem sends the digital data at different frequencies than those
used by the analog voice signals. The voice signals occupy a small portion of
all the frequencies that the phone line can carry. DSL uses the higher fre-
quencies to transfer digital data, so both voice and data can travel on the
same phone line.

To Internet
backbone

Telephone company
Central Office (CO)

Other customers

Telephone Network
Interface Device
(NID) where your
phone wires come

into your home

Local loop
Ethernet card in PC
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The distance between your home and the central office — the loop length —
is a factor in DSL’s performance. Unfortunately, the phone line can reliably
carry the DSL signals over only a limited distance — typically three miles

or less, which means that you can get DSL service only if your home (or
office) is located within about three miles of your phone company’s central
office. Your phone company can tell you whether your location can get

DSL or not. Often, it has a Web site where you can type in your phone
number and get a response about DSL availability. For example, try www .
dslavailability.comfor U.S. locations.

DSL alphabet soup: ADSL, IDSL, SDSL

[ have been using the term DSL as if there were only one kind of DSL. As you
may imagine, nothing is ever that simple. There are in fact three variants of
DSL, each with different features. Take a look:

4+ ADSL: Asymmetric DSL is the most common form of DSL and has much
higher download speeds (from the Internet to your PC) than upload
speeds (from your PC to the Internet). ADSL can have download speeds
of up to 8 Mbps and upload speeds of up to 1 Mbps. ADSL works best
when your location is within about 2% miles (12,000 feet) of the central
office. ADSL service is priced according to the download and upload
speeds you want. A popular form of ADSL, called G.lite, is specifically
designed to work on the same line you use for voice calls. G.lite has a
maximum download speed of 1.5 Mbps and a maximum upload speed of
512 Kbps.

4+ IDSL: ISDN DSL (ISDN is an older technology called Integrated Services
Digital Network) is a special type of DSL that works at distances of up to
five miles between your phone and the central office. The downside is
that IDSL only offers downstream (from the Internet to your PC) and
upstream (from your PC to the Internet) speeds of up to 144 Kbps.

4+ SDSL: Symmetric DSL provides equal download and upload speeds of up
to 1.5 Mbps. SDSL is priced according to the speed you want, with the
higher speeds costing more. The closer your location is to the phone
company central office, the faster the connection you can get.

DSL (and cable modem) speeds are typically specified by two numbers sepa-
rated by a slash, such as this: 1500/384. The numbers refer to data-transfer
speeds in kilobits per second (that is, thousands-of-bits per second, abbrevi-
ated Kbps). The first number is the download speed, the second the upload.
Thus, 1500/384 means you can expect to download from the Internet at a
maximum rate of 1,500 Kbps (or 1.5 Mbps) and upload to the Internet at 384
Kbps. If your phone line’s condition is not perfect, you may not get these
maximum rates — both ADSL and SDSL adjust the speeds to suit existing line
conditions.
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The price of DSL service depends on which variant — ADSL, IDSL, or SDSL —
you select. For most home users, the primary choice is ADSL (or, more accu-
rately, the G.lite form of ADSL) with transfer speed ratings of 1500/128.

Typical DSL setup

To get DSL for your home or business, you have to contact a DSL provider. In
addition to your phone company, you can find many other DSL providers. No
matter who provides the DSL service, some work has to be done at the cen-
tral office — the place where your phone lines connect to the rest of the
phone network. The work involves connecting your phone line to equipment
that can work with the DSL modem at your home or office. The central office
equipment and the DSL modem at your location can then do whatever magic
is needed to send and receive digital data over your phone line.

Because of the need to set up your line at the central office, it takes some
time after you place an order to get your line ready for DSL.

The first step for you is to check out the DSL providers that provide service
and see if you can actually get the service. Because DSL can work only over
certain distances — typically less than 2.5 miles — between your location
and the central office, you have to check to see if you are within that dis-
tance limit. Contact your phone company to verify. You may be able to check
this availability on the Web. Try typing into Google (www.google.com) the
words DSL availability and then your local phone company’s name. The
search results will probably include a Web site where you can type in your
phone number to find out if DSL is available for your home or office.

If DSL is available, you can look for the types of service — ADSL versus

SDSL — and the pricing. The price depends on what download and upload
speeds you want. Sometimes, phone companies offer a simple residential DSL
(basically the G.lite form of ADSL) with a 1500/128 speed rating — meaning
you can download at up to 1,500 Kbps and upload at 128 Kbps. Of course,
these are the maximums, and your mileage may vary.

After selecting the type of DSL service and provider you want, you can place
an order and have the provider install the necessary equipment at your
home or office. Figure 1-2 shows a sample connection diagram for typical
residential DSL service.

Here are some key points to note in Figure 1-2:

4+ Connect your DSL modem’s data connection to the phone jack on a wall
plate.

4 Connect the DSL modem’s Ethernet connection to the Ethernet card on
your PC.
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Figure 1-2:
You can
connect a
PC's
Ethernet
card directly
to the DSL
modem.
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4+ When you connect other telephones or fax machines on the same phone
line, install a microfilter between the wall plate and each of these

devices.
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Your phone

Because the same phone line carries both voice signals and DSL data, you
need the microfilter to protect the DSL data from possible interference. You
can buy them at electronics stores or from the DSL provider.

When you connect your Linux PC to the Internet using DSL, the connection is
always on, which means a greater potential for outsiders to break into the PC.

You can protect your Linux system from intruders and as an added bonus,
share the high-speed connection with other PCs in a local area network (LAN)
by using a router that can perform Network Address Translation (NAT). Such
a NAT router translates multiple private Internet Protocol (IP) addresses from
an internal LAN into a single public IP address, which allows all the internal
PCs to access the Internet. The NAT router acts as a gateway between your
LAN and the Internet, and it isolates your LAN from the Internet — this makes
it harder for intruders to reach the systems on your LAN.

If you also want to set up a local area network, you need an Ethernet hub to
connect the other PCs to the network. Figure 1-3 shows a typical setup that
connects a LAN to the Internet through a NAT router and a DSL modem.
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Phone Ethernet cables (10BaseT)
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Ethernet cables

Ethernet hup  (10BaseT)

Figure 1-3:
A NAT
router
isolates
your PC
from the
Internet and
also lets
you share
the DSL
connection PCsin alocal area
with other network (LAN). Each
PCsina PC must have a
local area 10BaseT
Ethernet card.

network.
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Here are the points to note when setting up a connection like the one shown
in Figure 1-3:

4+ You need a NAT router with two 10BaseT Ethernet ports (the 10BaseT
port looks like a large phone jack, also known as an RJ45 jack).
Typically, one Ethernet port is labeled Internet (or External or WAN, for
wide area network), and the other one is labeled Local or LAN (for local
area network).

Jauiajuj ay
0} funosauuoy

4 You also need an Ethernet hub. For a small home network, you can buy a
4- or 8-port Ethernet hub. Basically, you want a hub with as many ports
as the number of PCs you intend to connect to your local area network.

4 Connect the Ethernet port of the DSL modem to the Internet port of the
NAT router, using a 10BaseT Ethernet cable. (These look like phone
wires with bigger RJ-45 jacks and are often labeled Category 5 or Cat 5
wire.)

4+ Connect the Local Ethernet port of the NAT router to one of the ports on
the Ethernet hub, using a 10BaseT Ethernet cable.

4+ Now connect each of the PCs to the Ethernet hub. (Of course, to do so
you must first have an Ethernet card installed and configured in each PC.)
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You can also buy a NAT router with a built-in 4- or 8-port Ethernet hub. With
such a combined router and hub, you need only one box to set up a LAN and
connect it to the Internet via a DSL. modem. These boxes are typically sold
under the name Cable/DSL router because they work with both DSL and a
cable modem.

Consult Chapter 2 of this minibook for information on how to configure net-
working on the Linux system so that your system can access the Internet.

DSL providers typically use a protocol known as PPP over Ethernet (PPPoE)
to establish a connection between your PC and the equipment at the
provider’s central office. PPPoE requires you to provide a username and
password to establish the network connection over Ethernet. To set up your
system for a PPPoE DSL connection, all you have to do is run a utility pro-
gram that configures the system for PPPoE. You can find the utility by
searching in the Main Menu in the GUI desktop.

In Fedora Core, you can set up a PPPoE DSL connection by choosing
System=>Administration=>Network, clicking New on the toolbar, and select-
ing xDSL Connection from the device type in the resulting dialog box. Then
go through the successive screens and provide the requested information,
such as login name and password.

Connecting with a Cable Modem

Cable TV companies also offer high-speed Internet access over the same
coaxial cable that carries television signals to your home. After the cable
company installs the necessary equipment at its facility to send and receive
digital data over the coaxial cables, customers can sign up for cable Internet
service. You can then get high-speed Internet access over the same cable
that delivers cable TV signals to your home.

How a cable modem works

A box called a cable modem is at the heart of Internet access over the cable
TV network. (See Figure 1-4.) The cable modem takes digital data from your
PC’s Ethernet card and puts it in an unused block of frequency. (Think of it
as another TV channel, but instead of pictures and sound, this channel car-
ries digital data.)

The cable modem places upstream data — data that’s being sent from your
PC to the Internet — in a different channel than the downstream data that’s
coming from the Internet to your PC. By design, the speed of downstream
data transfers is much higher than that of upstream transfers. The assump-
tion is that people download far more stuff from the Internet than they
upload. (Probably true for most of us.)



Figure 1-4:
Cable
modems
provide
high-speed
Internet
access over
the cable TV
network.
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Cable company head end
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(all homes with Cable modems
share the same cable)

Ethernet card in PC

The coaxial cable that carries all those hundreds of cable TV channels to
your home is a very capable signal carrier. In particular, the coaxial cable
can carry signals covering a huge range of frequencies — hundreds of mega-
hertz (MHz). Each TV channel requires 6 MHz — and the coaxial cable can
carry hundreds of such channels. The cable modem places the upstream
data in a small frequency band and expects to receive the downstream data
in a whole other frequency band.

At the other end of your cable connection to the Internet is the Cable Modem
Termination System (CMTS) — also known as the head end — that your cable
company installs at its central facility. (Refer to Figure 1-4.) The CMTS con-
nects the cable TV network to the Internet. It also extracts the upstream digi-
tal data sent by your cable modem (and by those of your neighbors as well)
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and sends all of it to the Internet. The CMTS also puts digital data into the
upstream channels so that your cable modem can extract that data and pro-
vide it to your PC via the Ethernet card.

Cable modems can receive downstream data at the rate of about 30 Mbps
and send data upstream at around 3 Mbps. However, all the cable modems in
a neighborhood share the same downstream capacity. Each cable modem fil-
ters out — separates — the data it needs from the stream of data that the
CMTS sends out. Cable modems follow a modem standard called DOCSIS,
which stands for Data Over Cable Service Interface. You can buy any DOCSIS-
compliant modem and use it with your cable Internet service; all you have to
do is call the cable company and give them the modem’s identifying informa-
tion so that the CMTS can recognize and initialize the modem.

In practice, with a cable modem, you can get downstream transfer rates of
around 1.5 Mbps and upstream rates of 128 Kbps. These are maximum rates,
and your transfer rate is typically lower, depending on how many users in
your neighborhood are using cable modems at the same time.

If you want to check your downstream transfer speed, go to http://
bandwidthplace.com/speedtest and click the link to start the test. For
my cable modem connection, for example, a recent test reported a down-
stream transfer rate of about 2.2 Mbps, but at other times the rate has been
as high as 5.2 Mbps.

Typical cable modem setup

To set up cable modem access, your cable TV provider must offer high-
speed Internet access. If the service is available, you can call to sign up. The
cable companies often have promotional offers, such as no installation fee or
a reduced rate for three months. Look for these offers. If you are lucky, a
local cable company may have a promotion going on just when you want to
sign up.

The installation is typically done by a technician, who splits your incoming
cable into two — one side goes to the TV and the other to the cable modem.
The technician provides information about the cable modem to the cable
company’s head end for setup at its end. When all that is done, you can plug
in your PC’s Ethernet card to the cable modem, and you're all set to enjoy
high-speed Internet access. Figure 1-5 shows a typical cable-modem hookup.

The cable modem connects to an Ethernet card in your PC. If you don’t
have an Ethernet card in your PC, the cable company technician often
provides one.
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Here are some key points to note about the cable modem setup in Figure 1-5:

4+ Split the incoming cable TV signal into two parts by using a two-way
splitter. (The cable company technician installs the splitter.) By the way,
the two-way splitter needs to be rated for 1 GHz; otherwise, it may not
let the frequencies that contain the downstream data from the Internet
pass through.

4+ Connect one of the video outputs from the splitter to your cable
modem’s F-type video connector using a coaxial cable.

4 Connect the cable modem’s 10BaseT Ethernet connection to the
Ethernet card on your PC.

4+ Connect your TV to the other video output from the two-way splitter.

When you use cable modem to directly connect your Linux PC to the
Internet, the connection is always on, so you have more of a chance that
someone may try to break into the PC. Linux includes the iptables packet
filtering capability, which you may want to use to protect your PC from
unwanted Internet connections.

In Fedora Core, you can set the firewall setting to High Security. To configure
the firewall settings in Fedora Core, choose System=>Administration=>
Security Level and Firewall from the GUI desktop.
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To isolate your Linux PC or local area network from the public Internet, you
may want to add a NAT router between your PC and the cable modem. One
of the NAT router’s network interfaces connects to the Internet, and the
other connects to your LAN; the router then acts as a gateway between your
LAN and the Internet. As an added bonus, you can even share a cable
modem connection with all the PCs in your own local area network (LAN) by
adding an Ethernet hub. Better yet, buy a combination NAT router and hub
so you have only one box do the whole job. By the way, the NAT router and
hubs are typically sold under the name Cable/DSL router because they work
with both DSL and cable modem.

The NAT router translates private IP addresses into a public IP address.
When connected through a NAT router, any PC in the internal LAN can
access the Internet as if it had its own unique IP address. Result: You can
share a single Internet connection among many PCs. (An ideal solution for an
entire family of Net surfers!)

Figure 1-6 shows a typical setup with a cable modem connection being
shared by a number of PCs in a LAN.

Here are the points to note when setting up a connection like the one shown
in Figure 1-6:

4+ You need a Cable/DSL NAT router with two 10BaseT Ethernet ports (the
10BaseT port — also known as an RJ45 jack, which looks like a large
phone jack). Typically, one Ethernet port is labeled Internet (or External
or WAN, for wide area network), and the other one is labeled Local.

4+ If you plan to set up a LAN, you also need an Ethernet hub. For a small
home network, you can buy a 4- or 8-port Ethernet hub. Basically, you
want a hub with as many ports as the number of PCs you intend to con-
nect to your local area network.

4+ Consider buying a single box that acts as both a NAT router and a hub
with a number of Ethernet ports.

<+

Connect the video cable to the video input port of the cable modem.

4+ Connect the Ethernet port of the cable modem to the Internet port of the
NAT router using a 10BaseT Ethernet cable. (These look like phone wires
except that the Ethernet cables have bigger RJ-45 jacks and are often
labeled Category 5 or Cat 5 wire.)

4+ Connect the Local Ethernet port of the NAT router to one of the ports on
the Ethernet hub using a 10BaseT Ethernet cable.

4+ Now connect each of the PCs to the Ethernet hub. Of course, each PC
must have an Ethernet card.
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In Chapter 2 of this minibook, I explain how to configure the PCs in such a
LAN so that they can all access the Internet through the router.
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Setting Up Dialup Networking

Dialup networking refers to connecting a PC to a remote network through a
dialup modem. If you are ancient enough to remember the days of dialing up
with Procomm or some serial communications software, realize that there is
a significant difference between dialup networking and the old days of serial
communication. Both approaches use a modem to dial up a remote com-
puter and to establish a communication path, but the serial communication
software makes your computer behave like a dumb terminal connected to
the remote computer. The serial communication software exclusively uses
dialup connection. You cannot run another copy of the communication soft-
ware and use the same modem connection, for example.
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In dialup networking, both your PC and the remote system run network pro-
tocol (called TCP/IP) software. When your PC dials up and sets up a commu-
nication path, the network protocols exchange data packets over that dialup
connection. The neat part is that any number of applications can use the
same dialup connection to send and receive data packets. So your PC
becomes a part of the network to which the remote computer belongs. (If
the remote computer is not on a network, dialup networking creates a net-
work that consists of the remote computer and your PC.)

In Chapter 2 of this minibook, I describe TCP/IP protocol some more, but I
have to use the term as well as a few concepts such as Internet Protocol (IP)
address and Domain Name Service (DNS) when describing how to set up
dialup networking.

Setting up a TCP/IP network over a dialup link involves specifying the proto-
col — the convention — for packaging a data packet over the communica-
tion link. Point-to-Point Protocol (PPP) is such a protocol for establishing a
TCP/IP connection over any point-to-point link, including dialup phone lines.
Linux supports PPP, and it comes with the configuration tools you can use to
set up PPP so that your system can establish a PPP connection with your ISP.

Here’s what you have to do to set up dialup networking in Linux:

1. Install an internal or external modem in your PC. If your PC did not
already come with an internal modem, you can buy an external modem
and connect it to the PC’s serial or USB port.

2. Connect the modem to the phone line and power up the modem.

3. Get an account with an ISP. Every ISP provides you a phone number to
dial, a username, and a password. Additionally, the ISP gives you the full
names of servers for e-mail and news. Typically, your system automati-
cally gets an IP address.

4. Run a GUI tool (if available) to set up a PPP connection. If you cannot
find a GUI tool, type wvdialconf /etc/wvdial.conf at the shell prompt.
The wvdialconf program automatically detects the modem and sets
up the configuration file /etc/wvdial.conf. Now use a text editor to
edit the file /etc/wvdial.conf and enter the ISP’s phone number as
well as the username and password of your Internet account with the
ISP. (You can guess where to enter these items, just look for the fields
labeled Username, Password, and Phone.)

5. Use a GUI tool (if available) to activate the PPP connection to connect to
the Internet. If there is no GUI tool, log in as root and type wvdial to
establish the PPP connection.

[ briefly go over these steps in the following sections.



Figure 1-7:
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Connecting the modem

The word modem is a contraction of modulator/demodulator — a device
that converts digital signals (strings of 1s and 0s) into continuously varying
analog signals that transmit over telephone lines and radio waves. Thus,
the modem is the intermediary between the digital world of the PC and the
analog world of telephones. Figure 1-7 illustrates the concept of a modem.

.

Inside the PC, 1s and 0s are represented with voltage levels, but signals
carried over telephone lines are usually tones of different frequencies. The
modem sits between the PC and the telephone lines and makes data commu-
nication possible over the phone lines. The modem converts information
back and forth between the voltage/no voltage representation of digital cir-
cuits and different frequency tones that are appropriate for transmission
over phone lines.

Before you can dial out using an external modem, you have to make sure
that the modem is properly connected to one of the serial or USB ports of
your PC.

If you have an external modem, make sure that your modem is properly con-
nected to the power supply and that the modem is connected to the tele-
phone line. Buy the right type of cable to connect the modem to the PC. You
need a straight-through serial cable to connect the modem to the PC. The
connectors at the ends of the cable depend on the type of serial connector
on your PC. The modem end of the cable needs a male 25-pin connector. The
PC end of the cable often is a female 9-pin connector. You can buy modem
cables at most computer stores. Often, you can find 9-pin-female-to-25-pin-
male modem cables sold under the label AT Modem Cable. Connect USB
modems by using a USB cable.
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Winmodems: They do only Windows

A quick word of caution about the Winmodems
that come with many new PCs and laptops:
Winmodems are software-based internal
modems — totally different from the traditional
hardware modems. Also known as Windows
modems or software modems (softmodem for
short), they work only with special driver soft-
ware (which in turn works only with Microsoft
Windows). With Winmodems and Linux, you're
pretty much on your own, but you can find some
useful guidance online at the Linux Winmodem
Support home page at www.linmodems .
org. For example, | found out that the Win-
modem in my laptop uses a Conexant chipset

and that a Linux driver is available from www .
linuxant.com/drivers/hsf/full/
downloads .php. | could then download a
version appropriate for my distribution — the
Web site offered both Debian package (DPKG)
and RPM format files. By the way, the free ver-
sion of the driver from Conexant is limited to 14.4
Kbps only. To go up to 56 Kbps, you have to get
the full version for a modest price of around $15
U.S. dollars. The free version, however, is good
for testing to make sure that the driver works
with your softmodem. By the way, you can
locate Linux drivers for many other Winmodems
by checking the www . 1 inmodems . org Web
site.

A\

If your PC has an internal modem, all you have to do is connect the phone
line to the phone jack at the back of the internal modem card. If it’s a
Winmodem, you still connect the phone line, but you also have to do a bit of
research on the Internet and download a driver that makes the Winmodem
work in Linux. After you install a working Linux driver for a Winmodem, it
works just like the older serial port modems. See the sidebar, “Winmodems:
They do only Windows,” for more information.

Setting up and activating a PPP connection

Most ISPs provide PPP dialup access to the Internet through one or more
systems that the ISP maintains. If you sign up for such a service, the ISP
provides you the information that you need to make a PPP connection to
the ISP’s system. Typically, this information includes the following:

<+

+
system.

+

The phone number to dial to connect to the remote system.

The username and password that you must use to log in to the remote

The names of the ISP’s mail and news servers.

The IP address for your PPP connection. Your ISP does not provide

this address if the IP address is assigned dynamically (which means
the IP address may change every time that your system establishes a

connection).

IP addresses of the ISP’s DNS. The ISP does not provide these addresses

if it assigns the IP address dynamically.
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Of this information, the first two items are what you need to set up a PPP
connection. The exact steps for setting up and using a PPP connection depend
on the distribution. For distributions with a GUI Internet connection tool, you
can easily figure out where to enter your ISP account information — the phone
number, username, and password. | point out a few distribution-specific
approaches for configuring PPP next.

Debian has a GUI tool to set up a PPP connection and the tool uses wvdial,

SPEL‘/

N>,

§ ¢ which is not installed by default. Type apt-get install wvdial to install it.
2 Then you can use the GUI tool to configure and activate the dialup PPP
‘5}0 connection.

N\ SPEC,,  InFedora Core, choose System=>Administration>Network from the GNOME
§ ¢ desktop. (If you are not logged in as root, you will be prompted for the root
5 password.) Click New on the toolbar; then select the Modem Connection
‘5,0 option from the first dialog box (see Figure 1-8) and continue with the

configuration.
Add new Device Type
Select Device Type
DeviceType | s = sl anaiog modem 10
@ Ethemnet connection | dial into to your Intemet Service Provider. These
B ISDN connection maodems use sound over a normal copper
T telephone line to transmit data, These types of

— Token Ring connecti connections are a\rajlalble just about anywhere in

Figure 1-8: <8 Wircless connection the world where there is a phone system.

In Fedora ' xD5L connection

Core,

configure

the PPP

connection

from this

dialOQ box. [ X Cancel & Foward .

N\ SPEC,,  In SUSE, choose Main Menur>System=YaST to open the YaST control center
§ ¢  window. Click Network Devices on the left side of the window and then click
2 Modem on the right side. (See Figure 1-9.) YaST detects the modem and dis-
‘5’,0 plays a window with information about the modem. You can then configure

the detected modem for a PPP connection. You can either select your ISP
from a list or enter the ISP’s name as well as an access phone number and
the ISP account’s username and password.
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Figure 1-9:

In SUSE,

configure

the modem

from YaST.
After you set up the modem in SUSE, the Kinternet tool should start and a
plug icon should appear in the panel, as shown in Figure 1-10 (if the icon
does not appear, select Main Menu=Internetc>Dial-up from the KDE desk-
top). You can then click the Kinternet tool’s icon to activate the PPP connec-
tion. If the connection does not seem to come up, right-click the Kinternet
icon, select View Log, and look for clues about any problems.

Figure 1-10:
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Kinternet "@ TR P
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Configuring CHAP and PAP authentication

The PPP server on your system has to authenticate itself to the ISP’s
PPP server before the PPP connection can get fully up and running.
Authentication requires proving that you have a valid account with the
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ISP, essentially providing a username and a secret (that is, a password). PPP
specifies two ways of exchanging the authentication information between
the two ends of the connection:

4+ Challenge Handshake Authentication Protocol (CHAP) requires the
remote end to send a randomly generated challenge string along with
the remote server’s name. The local system looks up the secret, using
the server’s name; then it sends back a response that includes its name
and a value that combines the secret and the challenge, using a one-way
hash function. The remote system then checks that value against its own
calculation of the expected hash value. If the values match, the authenti-
cation succeeds; otherwise, the remote system terminates the connec-
tion. In this case, the name and secret are stored in the /etc/ppp/
chap-secrets file. Note that the remote system can repeat the CHAP
authentication any time while the PPP link is up.

4+ Password Authentication Protocol (PAP) is like the normal login process.
When using PAP, the local system repeatedly sends a username (name)
and password (secret) until the remote system acknowledges the authen-
tication or ends the connection. The name and secret are stored in the
/etc/ppp/pap-secrets file. Note that the username and password are
sent in the clear (that is, unencrypted).

The Linux PPP server supports both types of authentication. For both

PAP and CHAP, the information that the PPP server needs is a name and

a secret — a username and password pair. This authentication information
is stored in the following configuration files:

4 /etc/ppp/chap-secrets stores the information for CHAP. Here’s what
a typical chap-secrets file looks like:

# Secrets for authentication using CHAP
# client server secret IP addresses
"naba" * "mypassword"

4+ /etc/ppp/pap-secrets stores the information for PAP. Here’s a typi-
cal pap-secrets file:

# Secrets for authentication using PAP
# client server secret IP addresses
"naba" * "mypassword"

As you can see, the formats of the entries are the same for both chap-
secrets and pap-secrets. Four fields are in each line, in the following
order:

4+ client: This field contains the name that is used during authentication.
You get this name from the ISP.
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4+ server: This field contains the name of the remote system to which you
are authenticating the local system. If you don’t know the server’s name,
type an asterisk to indicate any server.

4+ secret: This field is the secret that your system’s PPP server has to
send to the remote system to authenticate itself. You receive this pass-
word from the ISP.

4 IP addresses: This optional field can contain a list of the IP addresses
that the local system may use when connecting to the specified server.
Typically, this field is left blank because the local system usually gets a
dynamic IP address from the server and (therefore) doesn’t know what
IP address it uses.



Chapter 2: Setting Up
a Local Area Network

In This Chapter

+* Understanding TCP/IP networks

v~ Setting up an Ethernet LAN

1 Configuring TCP/IP networking

+* Connecting your LAN to the Internet

Linux comes with built-in support for Transmission Control Protocol/
Internet Protocol (TCP/IP) networking, as do most modern operating
systems from Windows to Mac OS. You can have TCP/IP networking over
many different physical interfaces, such as Ethernet cards, serial ports,
and parallel ports.

Typically, you use an Ethernet network for your local area network (LAN) —
at your office or even your home (if you happen to have two or more sys-
tems at home). To connect to remote systems over a modem, you use
TCP/IP networking over Point-to-Point Protocol (PPP).

This chapter describes how to set up an Ethernet network. Even if you have
a single PC, you may need to set up an Ethernet network interface so that
you can connect your PC to high-speed Internet access that uses a DSL or
cable modem. (I cover DSL and cable modems in Chapter 1 of this minibook.)

Understanding TCP/IP

You can understand TCP/IP networking best if you think in terms of a lay-
ered model with four layers. Think of each layer as responsible for perform-
ing a particular task. The layered model describes the flow of data between
the physical connection to the network and the end-user application. Figure
2-1 shows the four-layer network model for TCP/IP.
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Figure 2-1:
You can
understand
TCP/IP
using the
four-layer
network
model.

4 | Application | Mail, file transfer, TELNET

TCP (Transmission Control Protocol)

3 | Transport | np (yser Datagram Protocol)

Network | IP (Internet Protocol)

Physical | Ethernet

In this four-layer model, information always moves from one layer to the
next. For example, when an application sends data to another application,
the data goes through the layers in this order: Application=>Transport=
Network=>Physical. At the receiving end, the data goes up from Physical~>
Networke>Transport=>Application.

Each layer has its own set of protocols — conventions — for handling and
formatting the data. If you think of sending data as something akin to send-
ing letters through the postal service, a typical protocol is a preferred
sequence of actions for a task, such as addressing an envelope (first the
name, then the street address, and then the city, state, and zip or other
postal code).

Here’s what each of the four layers does, top to bottom:

4+ Application: Runs the applications that users use, such as e-mail read-
ers, file transfers, and Web browsers. Application-level protocols are
Simple Mail Transfer Protocol (SMTP) and Post Office Protocol (POP)
for e-mail, HyperText Transfer Protocol (HTTP) for the Web, and File
Transfer Protocol (FTP) for file transfers. Application-level protocols
also have a port number that you can think of as an identifier for a spe-
cific application. For example, port 80 is associated with HTTP or the
Web server.

4+ Transport: Sends data from one application to another. The two most
important protocols in this layer are Transmission Control Protocol
(TCP) and User Datagram Protocol (UDP). TCP guarantees delivery of
data; UDP just sends the data without ensuring that it actually reaches
the destination.

4+ Network: This layer is responsible for getting data packets from one
network to another. If the networks are far apart, the data packets are
routed from one network to the next until they reach their destination.
The primary protocol in this layer is the Internet Protocol (IP).
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4+ Physical: Refers to the physical networking hardware (such as an
Ethernet card or token ring card) that carries the data packets in a
network.

The beauty of the layered model is that each layer takes care of only its
specific task, leaving the rest to the other layers. The layers can mix and
match — you can have TCP/IP network over any type of physical network
medium, from Ethernet to radio waves (in a wireless network). The software
is modular as well because each layer can be implemented in different mod-
ules. For example, typically the Transport and Network layers already exist
as part of the operating system, and any application can make use of these
layers.

TCP/IP and the Internet

TCP/IP has become the protocol of choice on the Internet — the network of
networks that evolved from ARPAnet. The U.S. Government’s Advanced
Research Projects Agency (ARPA) initiated research in the 1970s on a new
way of sending information, using packets of data sent over a network. The
result was ARPAnet: a national network of linked computers. Subsequently,
ARPA acquired a Defense prefix and became DARPA. Under the auspices of
DARPA, the TCP/IP protocols emerged as a popular collection of protocols
for internetworking — communication among networks.

TCP/IP has flourished because the protocol is open. That means the techni-
cal descriptions of the protocol appear in public documents, so anyone can
implement TCP/IP on specific hardware and software.

TCP/IP also made great inroads because stable, working software was avail-
able. Instead of a paper description of network architecture and protocols,
the TCP/IP protocols started out as working software — and who can argue
with what’s already working? These days, as a result, TCP/IP rules the
Internet.

1P addresses

When you have many computers on a network, you need a way to identify
each one uniquely. In TCP/IP networking, the address of a computer is the IP
address. Because TCP/IP deals with internetworking, the address is based on
the concepts of a network address and a host address. You may think of the
idea of a network address and a host address as having to provide two
addresses to identify a computer uniquely:

4+ Network address indicates the network on which the computer is
located.

4+ Host address indicates a specific computer on that network.
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Next-generation IP (IPv6)

When the 4-byte IP address was created, the
number of available addresses seemed ade-
quate. Now, however, the 4-byte addresses are
running out. The Internet Engineering Task
Force (IETF) recognized the potential for run-
ning out of IP addresses in 1991 and began
work on the next-generation IP addressing
scheme. They called it IPng (for Internet
Protocol Next Generation) and intended that it
will eventually replace the old 4-byte address-
ing scheme (called IPv4, for IP version 4).

Several alternative addressing schemes for
IPng were proposed and debated. The final
contender, with a 128-bit (16-byte) address, was
dubbed IPv6 (for IP version 6). On September
18, 1995, the IETF declared the core set of IPv6
addressing protocols to be an IETF Proposed
Standard. By now, there are many RFCs deal-
ing with various aspects of [Pv6, from IPv6 over
PPP for the transmission of IPv6 packets over
Ethernet.

IPv6 is designed to be an evolutionary step from
IPv4. The proposed standard provides direct
interoperability between hosts using the older
IPv4 addresses and any new |IPv6 hosts. The
idea is that users can upgrade their systems to
use IPv6 when they want and that network
operators are free to upgrade their network
hardware to use IPv6 without affecting current
users of IPv4. Sample implementations of IPv6
are being developed for many operating sys-
tems, including Linux. For more information
about IPv6 in Linux, consult the Linux
IPv6 HOWTO at www. t1dp.org/HOWTO/
Linux+IPv6-HOWTO. For information about
IPv6 in general, visit the IPv6 home page at
www . 1ipv6 .org.

The IPv6 128-bit addressing scheme allows for
a total of 2'% or 340,282,366,920,938,463,463,374,
607,431,768,211,456 theoretically assignable
addresses! That should last us for a while!

The network and host addresses together constitute an IP address, and it’s a
4-byte (32-bit) value. The convention is to write each byte as a decimal value
and to put a dot (.) after each number. Thus, you see network addresses
such as 132.250.112.52. This way of writing IP addresses is known as dotted-
decimal or dotted-quad notation.

In decimal notation, a byte (which has 8 bits) can have a value between 0
and 255. Thus, a valid IP address can use only the numbers between 0 and
255 in the dotted-decimal notation.

Internet services and port numbers

The TCP/IP protocol suite has become the lingua franca of the Internet
because many standard services are available on any system that supports
TCP/IP. These services make the Internet tick by facilitating the transfer of
mail, news, and Web pages. These services go by well-known names such as
the following:
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4+ DHCP (Dynamic Host Configuration Protocol) is for dynamically config-
uring TCP/IP network parameters on a computer. DHCP is primarily used
to assign dynamic IP addresses and other networking information (such
as name server, default gateway, and domain names) needed to config-
ure TCP/IP networks. The DHCP server listens on port 67.

4+ FTP (File Transfer Protocol) is used to transfer files between computers
on the Internet. FTP uses two ports — data is transferred on port 20, and
control information is exchanged on port 21.

4+ HTTP (HyperText Transfer Protocol) is a protocol for sending docu-
ments from one system to another. HTTP is the underlying protocol of
the Web. By default, the Web server and client communicate on port 80.

4+ SMTP (Simple Mail Transfer Protocol) is for exchanging e-mail messages
between systems. SMTP uses port 25 for information exchange.

4+ NNTP (Network News Transfer Protocol) is for distribution of news
articles in a store-and-forward fashion across the Internet. NNTP uses
port 119.

4+ SSH (Secure Shell) is a protocol for secure remote login and other
secure network services over an insecure network. SSH uses port 22.

4+ TELNET is used when a user on one system logs in to another system on
the Internet. (The user must provide a valid user ID and password to log
in to the remote system.) TELNET uses port 23 by default, but the
TELNET client can connect to any port.

4+ SNMP (Simple Network Management Protocol) is for managing all types
of network devices on the Internet. Like FTP, SNMP uses two ports: 161
and 162.

4+ TFTP (Trivial File Transfer Protocol) is for transferring files from one
system to another. (It’s typically used by X terminals and diskless work-
stations to download boot files from another host on the network.) TFTP
data transfer takes place on port 69.

4+ NFS (Network File System) is for sharing files among computers. NFS
uses Sun’s Remote Procedure Call (RPC) facility, which exchanges infor-
mation through port 111.

A well-known port is associated with each of these services. The TCP protocol
uses each such port to locate a service on any system. (A server process — a
special computer program running on a system — provides each service.)

Setting Up an Ethernet LAN

Ethernet is a standard way to move packets of data between two or more
computers connected to a single hub. (You can create larger networks by
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connecting multiple Ethernet segments with gateways.) To set up an
Ethernet LAN, you need an Ethernet card for each PC. Linux supports a wide
variety of Ethernet cards for the PC.

Ethernet is a good choice for the physical data-transport mechanism for the
following reasons:

4+ Ethernet is a proven technology that has been in use since the early
1980s.

4+ Ethernet provides good data-transfer rates: typically 10 million bits per
second (10 Mbps), although 100-Mbps Ethernet and Gigabit Ethernet
(1,000 Mbps) are now available.

4+ Ethernet hardware is often built into the PC or can be installed at a rela-
tively low cost. (PC Ethernet cards cost about $10 — $20 U.S.)

4+ With wireless Ethernet, you can easily connect laptop PCs to your
Ethernet LAN without having to run wires all over the place. (Go to
Chapter 3 of this minibook for more information on wireless Ethernet.)

How Ethernet works

So what makes Ethernet tick? In essence, it’s the same thing that makes any
conversation work: listening and taking turns.

In an Ethernet network, all systems in a segment are connected to the same
wire. Because a single wire is used, a protocol is used for sending and receiv-
ing data because only one data packet can exist on the cable at any time.

An Ethernet LAN uses a data-transmission protocol known as Carrier-Sense
Multiple Access/Collision Detection (CSMA/CD) to share the single transmis-
sion cable among all the computers. Ethernet cards in the computers follow
the CSMA/CD protocol to transmit and receive Ethernet packets.

The idea behind the CSMA/CD protocol is similar to the way in which you
have a conversation at a party. You listen for a pause (that’s sensing the car-
rier) and talk when no one else is speaking. If you and another person begin
talking at the same time, both of you realize the problem (that’s collision
detection) and pause for a moment; then one of you starts speaking again.
As you know from experience, everything works out.

In an Ethernet LAN, each Ethernet card checks the cable for signals — that’s
the carrier-sense part. If the signal level is low, the Ethernet card sends its pack-
ets on the cable; the packet contains information about the sender and the
intended recipient. All Ethernet cards on the LAN listen to the signal, and the
recipient receives the packet. If two cards send out a packet simultaneously,
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the signal level in the cable rises above a threshold, and the cards know a
collision has occurred. (Two packets have been sent out at the same time.)
Both cards wait for a random amount of time before sending their packets
again.

Ethernet was invented in the early 1970s at the Xerox Palo Alto Research
Center (PARC) by Robert M. Metcalfe. In the 1980s, Ethernet was standard-
ized by the cooperative effort of three companies: Digital Equipment
Corporation (DEC), Intel, and Xerox. Using the first initials of the company
names, that Ethernet standard became known as the DIX standard. Later,
the DIX standard was included in the 802-series standards developed by the
Institute of Electrical and Electronics Engineers (IEEE). The final Ethernet
specification is formally known as IEEE 802.3 CSMA/CD, but people continue
to call it Ethernet.

Ethernet sends data in packets (discrete chunks also known as frames). You
don’t have to hassle much with the innards of Ethernet packets, except to
note the 6-byte source and destination addresses. Each Ethernet controller
has a unique 6-byte (48-bit) address at the Physical layer; every packet must
have one.

Ethernet cables

Any time you hear experts talking about Ethernet, you're also going to hear
some bewildering terms used for the cables that carry the data. Here’s a
quick rundown.

The original Ethernet standard used a thick coaxial cable, nearly half an inch
in diameter. This wiring is called thickwire or thick Ethernet although the IEEE
802.3 standard calls it /0Base5. That designation means several things: The
data-transmission rate is 10 megabits per second (10 Mbps); the transmis-
sion is baseband (which simply means that the cable’s signal-carrying capac-
ity is devoted to transmitting Ethernet packets only), and the total length of
the cable can be no more than 500 meters. Thickwire was expensive, and the
cable was rather unwieldy. Unless you’re a technology history buff, you
don’t have to care one whit about 10Base5 cables.

Nowadays, several other forms of Ethernet cabling are more popular. An alter-
native to thick Ethernet cable is thinwire, or 10Base2, which uses a thin, flexi-
ble coaxial cable. A thinwire Ethernet segment can be, at most, 185 meters
long. The other, more recent, alternative is Ethernet over unshielded twisted-
pair cable (UTP), known as 10BaseT. More recent Ethernet cabling options
that support higher transmission rates include 100BaseT4, 100BaseT2, and
100BaseTX for 100 Mbps Ethernet and 1000BaseT for Gigabit Ethernet. The
Electronic Industries Association/Telecommunications Industries Association
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(EIA/TIA) defines the following five categories of shielded and unshielded
twisted-pair cables:

4+ Category 1 (Cat 1): Traditional telephone cable.
4+ Category 2 (Cat 2): Cable certified for data transmissions up to 4 Mbps.

4+ Category 3 (Cat 3): Cable that can carry signals up to a frequency of 16
MHz. Cat 3 is the most common type of wiring in old corporate net-
works, and it normally contains four pairs of wire. Considered obsolete
nowadays.

4+ Category 4 (Cat 4): Cable that can carry signals up to a frequency of 20
MHz. Cat 4 wires are not that common. Considered obsolete nowadays.

4+ Category 5 (Cat 5): Cable that can carry signals up to a frequency of 100
MHz. Cat 5 cables normally have four pairs of copper wire. Cat 5 UTP is
the most popular cable used in new installations today. This category of
cable is being superseded by Category 5e (enhanced Cat 5).

4+ Category 5e (Cat 5e): Similar to Cat 5 but with improved technical
parameters, such as near-end cross talk and attenuation. Cat 5e cables
support 10BaseT, 100BaseT4, 100BaseT2, and 100BaseTX and 1000BaseT
Ethernet. Nowadays, Cat 5e is the minimum acceptable wiring.

4+ Category 6 (Cat 6): Similar to Cat 5e but capable of carrying signals up
to a frequency of 250 MHz. Cat 6 cables can support all existing Ethernet
standards and also support Gigabit Ethernet standard 1000BaseTX that
uses two pairs of wires in each direction as opposed to all four pairs for
1000BaseT Ethernet over Cat 5e cables.

To set up a 10BaseT or 100BaseT Ethernet network, you need an Ethernet

hub — a hardware box with RJ-45 jacks. (These look like big telephone jacks.)
You build the network by running twisted-pair wires (usually Category 5
cables) from each PC’s Ethernet card to this hub. You can get a 4-port 10BaseT/
100BaseT hub for about $40 U.S. Figure 2-2 shows a typical small 10BaseT/100
BaseT Ethernet LAN that you may set up at a small office or your home.

When you install any of the Linux distributions from this book’s companion
DVD-ROM on a PC connected with an Ethernet card, the Linux kernel auto-
matically detects the Ethernet card and installs the appropriate drivers. The
installer also lets you set up TCP/IP networking.

The Linux kernel loads the driver for the Ethernet card every time it boots.
To verify that the Ethernet driver is loaded, type the following command in a

terminal window:

dmesg | grep ethoO
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Ethernet hub

Category 5
cables

Figure 2-2:
You can use
an Ethernet
hub to
setup a
10BaseT/
100BaseT
Ethernet
LAN. )
PCs with Ethernet card
Book IlI
On one of my Linux PCs, I get the following output when I type that command:  Chapter2
eth0: RealTek RTL8139 at 0xf0e20000, 00:0c:76:f4:38:b3, IRQ 161 @
eth0: Identified 8139 chip type 'RTL-8101 =z
ethO: link up, 100Mbps, full-duplex, lpa 0x45E1l 8 ‘g
eth0: no IPv6 routers present =2 c
DT
S o
You should see something similar, showing the name of your Ethernet card E 5
2
and other related information. =~Q

Configuring TCP/IP Networking

When you set up TCP/IP networking during Linux installation, the installa-
tion program prepares all appropriate configuration files using the informa-
tion you provide. This means that you typically never have to manually
configure the network. However, most Linux distributions come with GUI
tools to configure the network devices, just in case something needs chang-
ing. I describe a few distribution-specific examples in this section. For all
other distributions, the steps are similar.
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In Fedora
Core,
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the Ethernet
network
with this
network-
configuration
tool.

Fedora Core comes with the graphical network configuration tool that you
can use to add a new network interface or alter information such as name
servers and host names. To start the GUI network configuration tool, choose
System>Administrationt>Network. If you are not logged in as root, you're
prompted for the root password. The network configuration tool displays a
tabbed dialog box, as shown in Figure 2-3. You can then configure your net-
work through the four tabs that appear along the top of the dialog box. After
configuring the network card, you can select the device and click the

Activate button to turn the Ethernet on.

In most cases, you can set the network card so that it can automatically obtain
an IP address (which is the case when the Ethernet card is connected to DSL or
cable modem) by using the DHCP. If your network does not have a DHCP server
(which is typically built into routers), you have to specify an IP address for the
network card. If you are running a private network, you may use IP addresses
in the 192.168.0.0 to 192.168.255.255 range. (Other ranges of addresses are
reserved for private networks, but this range suffices for most needs.)

In SUSE, choose Main Menur>System=>YaST to open the YaST Control Center.
Enter the root password when prompted. Then select Network Devices on
the left side of the window and Network card on the right side. YaST then
brings up a window (as shown in Figure 2-4) with information about the
already configured network card and any new network cards that it detects.
You can then configure any new network card.

Network Configuration |=|I'E'I'!'I
File Profile Help
¢ B 9 ®
MNew Edt Copy Activate  Deactivate

Devices [ Hardgalel IPsec l DNS | Hosts l
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d :-Q‘

You may configure network devices associated with
physical hardware here. Multiple logical devices can be
associated with a single piece of hardware.
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configure
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Connecting Your LAN to the Internet

If you have a LAN with several PCs, you can connect the entire LAN to the
Internet by using DSL or cable modem. Basically, you can share the high-
speed DSL or cable modem connection with all the PCs in the LAN.

In Chapter 1 of this minibook, I explain how to set up a DSL or cable modem.
In this section, [ briefly explain how to connect a LAN to the Internet so that
all the PCs can access the Internet.

The most convenient way to connect a LAN to the Internet via DSL or cable
modem is to buy a hardware device called DSL/Cable Modem NAT Router
with a 4- or 8-port Ethernet hub. NAT stands for Network Address
Translation, and the NAT router can translate many private IP addresses into
a single, externally known IP address. The Ethernet hub part appears to you
as a number of RJ-45 Ethernet ports where you can connect the PCs to set
up a LAN. In other words, you need only one extra box besides the DSL or
cable modem.

Figure 2-5 shows how you might connect your LAN to the Internet through a
NAT router with a built-in Ethernet hub. Of course, you need a DSL or cable
modem hookup for this scenario to work, and you have to sign up with the
phone company for DSL service or with the cable provider for cable Internet
service.
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Figure 2-5:
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in Ethernet
hub.

When you connect a LAN to the Internet, the NAT router acts as a gateway
for your LAN. The NAT router also dynamically provides IP addresses to the
PCs in your LAN. Therefore, on each PC, you have to set up the networking
options to obtain the IP address dynamically.

Your LAN can mix and match all kinds of computers: Some may be running
Linux, and some may be running Microsoft Windows or any other operating
system that supports TCP/IP. When configuring the network settings, remem-
ber to select the option that enables Linux to automatically obtain IP
address settings and DNS information with DHCP.

To Internet
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NAT router and (10BaseT)

Ethernet hub
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Chapter 3: Adding a Wireless
Ethernet LAN

In This Chapter

+ Understanding wireless Ethernet networks

v~ Setting up the wireless hardware

1 Configuring the wireless network

If you have laptop computers on your LAN — or if you don’t want to run a
rat’s nest of wires to connect a PC to the LAN — you have the option of
using a wireless Ethernet network. In a typical scenario, you have a cable
modem or DSL connection to the Internet, and you want to connect one or
more laptops with wireless network cards to access the Internet through the
cable or DSL modem. This chapter shows you how to set up wireless net-
working for connecting to an Ethernet LAN and accessing the Internet.

Understanding Wireless Ethernet Networks

You've probably heard about Wi-Fi. Wi-Fi stands for Wireless Fidelity network —
a short-range wireless network similar to the wired Ethernet networks. A
number of standards from an organization known as IEEE (the Institute of
Electrical and Electronics Engineers) define the technical details of how Wi-Fi
networks work. Manufacturers use these standards to build the components
that you can buy to set up a wireless network, also known as WLAN for short.

Until mid-2003, two popular IEEE standards — 802.11a and 802.11b — were
for wireless Ethernet networks. These two standards were finalized in 1999.
A third standard — 802.11g — was finalized by the IEEE in the summer of 2003.
All these standards specify how the wireless Ethernet network works at the
Physical layer. You don’t have to fret all the details of all those standards to
set up a wireless network, but knowing some pertinent details is good so
that you can buy the right kind of equipment for your wireless network.

The three wireless Ethernet standards have the following key characteristics:

4+ 802.11b: Operates in the 2.4 GHz radio band (2.4 GHz to 2.4835 GHz) in
up to three non-overlapping frequency bands or channels. Supports a
maximum bit rate of 11 Mbps per channel. One disadvantage of 802.11b
is that the 2.4 GHz frequency band is crowded — many devices (such as
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microwave ovens, cordless phones, medical and scientific equipment, as
well as Bluetooth devices), all work within the 2.4 GHz frequency band.
Nevertheless, 802.11b is very popular in corporate and home networks.

4+ 802.11a: Operates in the 5 GHz radio band (5.725 GHz to 5.850 GHz) in
up to eight non-overlapping channels. Supports a maximum bit rate of
54 Mbps per channel. The 5 GHz band is not as crowded as the 2.4 GHz
band, but the 5 GHz band is not approved for use in Europe. Products
conforming to 802.11a standard are available on the market, and some
wireless access points are designed to handle both 802.11a and 802.11b
connections.

4+ 802.11g: Supports up to 54 Mbps data rate in the 2.4 GHz band. (The same
band that 802.11b uses.) 802.11g achieves the higher bit rate by using a
technology called OFDM (orthogonal frequency-division multiplexing),
which is also used by 802.11a. Equipment that complies with 802.11g is
already on the market. 802.11g has generated excitement by working in
the same band as 802.11b but promising much higher data rates and by
being backward compatible with 802.11b devices. Vendors currently offer
access points that can support both the 802.11b and 802.11g connection
standards.

In all cases, the maximum data throughput that a user actually sees is much
less because all users of that radio channel share the capacity of the chan-
nel. Also, the data transfer rate decreases as the distance between the user’s
PC and the wireless access point increases.

There is a third standard — 802.11n — under development that would
support 100-Mbps data rates in either the 2.4 GHz or the 5 GHz band,
depending on which of the two proposals garner the required membership
approval. Two equally matched groups of companies — known by the titles
TGn Sync (Task Group n Synchronization) and WWISE (Worldwide Spectrum
Efficiency) — have each authored proposals for the 802.11n standard. TGn
Sync proposes to use the 5 GHz band, the same one used by 802.11a, whereas
WWiSE'’s proposal is for the 2.4 GHz that’s used by 802.11b and g. Both groups
agree that some form of multiple input multiple output (MIMO, pronounced
MY-mo) antenna technology would be needed to achieve the 100-Mbps data
rate. (Some MIMO access points are already becoming available on the
market.) At a May 2005 balloting, the TGn Sync proposal obtained the major-
ity votes, but it did not receive the 75 percent votes required to be the basis
for the first draft. You can read the latest news about the IEEE 802.11n proj-
ectat http://grouper.ieee.org/groups/802/11/Reports/tgn_
update.htm.
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If you are buying a new wireless access point, get an 802.11g one. An 802.11¢g
access point can also communicate with older (and slower) 802.11b devices.
You can also consider a MIMO access point that supports multiple 802.11
standards and implements techniques for getting higher throughputs and
better range.

To find out more about wireless Ethernet, visit www.wi-£fi.org, the home
page of the Wi-Fi Alliance, which is the nonprofit international association
formed in 1999 to certify interoperability of wireless LAN products based on
IEEE 802.11 standards.

Understanding infrastructure and ad hoc modes

The 802.11 standard defines two modes of operation for wireless Ethernet
networks: ad hoc and infrastructure. Ad hoc mode is simply two or more
wireless Ethernet cards communicating with each other without an access
point.

Infrastructure mode refers to the approach in which all the wireless Ethernet
cards communicate with each other and with the wired LAN through an
access point. For the discussions in this chapter, [ assume that you set your
wireless Ethernet card to infrastructure mode. In the configuration files, this
mode is referred to as managed mode.

Understanding Wired Equivalent Privacy (WEP)

The 802.11 standard includes Wired Equivalent Privacy (WEP) for protecting
wireless communications from eavesdropping. WEP relies on a 40-bit or
104-bit secret key that is shared between a mobile station (such as a laptop
with a wireless Ethernet card) and an access point (also called a base station).
The secret key is used to encrypt data packets before they transmit, and an
integrity check performs to ensure that packets are not modified in transit.
The 802.11 standard does not explain how the shared key is established.

In practice, most wireless LANs use a single key that is shared between all
mobile stations and access points. Such an approach, however, does not
scale up very well to an environment such as a college campus because the
keys are shared with all users — and you know how it is if you share a secret
with hundreds of people. That’s why, typically, WEP is not used on large
wireless networks, such as the ones at universities. In such wireless net-
works, you have to use other security approaches, such as SSH (Secure
Shell), to log in to remote systems. WEP, however, is good to use on your
home wireless network.
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Is the WEP stream cipher good enough?

WEP uses the RC4 encryption algorithm, which
is known as a stream cipher. Such an algorithm
works by taking a short secret key and gener-
ating an infinite stream of pseudorandom bits.
Before sending the data, the sending station
performs an exclusive-OR operation between
the pseudorandom bits and the bits representing
the data packet, which results in a 7 when two
bits are different and 0if they are the same. The
receiver has a copy of the same secret key and
generates an identical stream of pseudorandom
bits — and performs an identical exclusive-OR
operation between this pseudorandom stream
and the received bits. Doing so regenerates the
original, unencrypted data packet.

Such a method of stream cipher has a few prob-
lems. If a bit is flipped (from a 0to 7 or vice versa)
in the encrypted data stream, the correspon-
ding bitis flipped in the decrypted output, which
can help an attacker derive the encryption key.
Also, an eavesdropper who intercepts two
encoded messages that were encoded with the
same stream can generate the exclusive-OR of
the original messages. That knowledge is
enough to mount attacks that can eventually
break the encryption.

To counter these weaknesses, WEP uses some
defenses:

v Integrity Check (IC) field: To make sure that
data packets are not modified in transit, WEP
uses an Integrity Check field in each packet.

v~ Initialization vector (IV): To avoid encrypting
two messages with the same key stream,
WEP uses a 24-bit IV that augments the
shared secret key to produce a different
RC4 key for each packet. The IV itself is
alsoincluded in the packet.

Experts say that both these defenses are poorly
implemented, making WEP ineffective. IC and
IV have two main problems:

v The Integrity Check field is implemented by
using a checksum algorithm called 32-bit
cyclic redundancy code (CRC-32); that
checksum is then included as part of the
data packet. Unfortunately, an attacker can
flip arbitrary bits in an encrypted message
and correctly adjust the checksum so that
the resulting message appears valid.

v The 24-bit IV is sent in the clear (unen-
crypted). There are only 2% possible initial-
ization vectors (no big challenge for a fast
machine), and they have to be reused after
running through all of them. In other words,
after sending 2*, or 16,777,216 packets, the
IV is repeated. The number may sound like
alot, but consider the case of a busy access
point that sends 1,500-byte packets at a
rate of 11 Mbps. Each packet has 8 x 1,500 =
12,000 bits. That means each second the
access point sends 11,000,000/12,000 = 916
packets. At that rate, the access point
sends 16,777,216 packets in 16,777,216/916 =
18,315 seconds or 5 hours. That means the
IVis reused after 5 hours, and the time may
be less than that because many messages
are smaller than 1,500 bytes. Thus an
attacker has ample opportunities to col-
lect two encrypted messages encrypted
with the same key stream — and perform
statistical attacks (which amount to trying
the possible combinations really fast) to
decrypt the message.
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WEP has its weaknesses, but it’s better than nothing. You can use it in smaller
wireless LANs where sharing the same key among all wireless stations is not
an onerous task.

Work is underway to provide better security than WEP for wireless networks.
In 2003, the Wi-Fi Alliance published a specification called Wi-Fi Protected Access
(WPA) that replaced the existing WEP standard and improved security by
making some changes. For example, unlike WEP, which uses fixed keys, the
WPA standard uses Temporal Key Integrity Protocol (TKIP), which generates
new keys for every 10K of data transmitted over the network. This makes
WPA more difficult to break. In 2004, the Wi-Fi Alliance introduced a follow-on
to WPA called the Wi-Fi Protected Access 2 (WPA2 — the second generation of
WPA security). WPA2 is based on the final IEEE 802.11i standard, which uses
public key encryption with digital certificates and an authentication, authori-
zation, and accounting RADIUS (Remote Authentication Dial-In User Service)
server to provide better security for wireless Ethernet networks. WPA2 uses
the Advanced Encryption Standard (AES) for data encryption.

Setting Up the Wireless Hardware

\\J

To set up the wireless connection, you need a wireless access point and a
wireless network card in each PC. You can also set up an ad hoc wireless
network among two or more PCs with wireless network cards, but that is a
standalone wireless LAN among those PCs only. In this section, I focus on the
scenario in which you want to set up a wireless connection to an established
LAN that has a wired Internet connection through a cable modem or DSL.

In addition to the wireless access point, you also need a cable modem or DSL
connection to the Internet, along with a NAT router and hub, as described in
the previous chapters of this minibook. Figure 3-1 shows a typical setup for
wireless Internet access through an existing cable modem or DSL connection.

As Figure 3-1 shows, the LAN has both wired and wireless PCs. In this exam-
ple, either a cable or DSL modem connects the LAN to the Internet through a
NAT router and hub. Laptops with wireless network cards connect to the
LAN through a wireless access point attached to one of the RJ-45 ports on
the hub. To connect desktop PCs to this wireless network, you can use a USB
wireless network card (which connects to a USB port).

If you have not yet purchased a NAT router and hub for your cable or DSL
connection, consider buying a router and hub that has a built-in wireless
access point.
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Figure 3-1:
Typical
connection
of a mixed
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wireless network (LAN). Each
Ethernet PC must have a
LAN to the 10BaseT
Internet. Ethernet card.

Configuring the Wireless Access Point

Configuring the wireless access point involves the following tasks:

4 Setting a name for the wireless network. (The technical term is ESSID.)

4+ Setting the frequency or channel on which the wireless access point
communicates with the wireless network cards. The access point and
the cards must use the same channel.

4+ Deciding whether to use encryption.

4+ If encryption is to be used, setting the number of bits in the encryption
key and the value of the encryption key. For the encryption key, 24 bits
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are internal to the access point; you specify only the remaining bits.
Thus, for 64-bit encryption, you have to specify a 40-bit key, which
comes to 10 hexadecimal digits. (A hexadecimal digit is an integer from
0-9 or a letter from A-F.) For a 128-bit encryption key, you specify 104
bits, or 26 hexadecimal digits.

4+ Setting the access method that wireless network cards must use when con-
necting to the access point. You can opt for either open access or shared
key. The open-access method is typical (even when using encryption).

4+ Setting the wireless access point to operate in infrastructure (managed)
mode (because that’s the way you connect wireless network cards to an
existing Ethernet LAN).

The exact method of configuring a wireless access point depends on make
and model; the vendor provides instructions to configure the wireless access
point. You typically work through a graphical client application on a Windows
PC to do the configuration. If you enable encryption, make note of the encryp-
tion key; you have to specify that same key for each wireless network card
on your laptops or desktops.

Configuring Wireless Networking
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On your Linux laptop, the PCMCIA or PC Card manager recognizes the wire-
less network card and loads the appropriate driver for the card. Linux treats
the wireless network card like another Ethernet device and assigns it a device
name such as eth0 or ethl. If you already have an Ethernet card in the
laptop, that card gets the eth0 device name, and the wireless PC Card
becomes the ethl device.

You do have to configure certain parameters to enable the wireless network
card to communicate with the wireless access point. For example, you have
to specify the wireless network name assigned to the access point, and the
encryption settings must match those on the access point. You can usually
configure everything using a graphical network configuration tool that’s
available for your Linux distribution — just select the Wireless Network
option and fill in the requested information.

For example, in Fedora Core, choose Systemr>Administrationm>Network
from the GNOME desktop. Then click New on the toolbar to add a network
device. You can then select the wireless device and get to a window where
you can configure the wireless connection. (See Figure 3-2.) In particular,

set the Mode to Managed, specify the name of the wireless network (the one
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Figure 3-2:
In Fedora
Core,
configure
the wireless
connection
from this
window.

you want to connect to), and set the encryption key, if any. You can set the
option for getting the IP address to DHCP (a protocol for obtaining network
configuration parameters, including IP addresses from a server on the net-
work). When you’re done and you return to the Network Configuration tool’s
main window, select the new wireless device and click the Activate button.
If all goes well, the wireless network is up and running after a few moments.

Add new Device Type

Configure Wireless Connection

Mode: Managed hd |

Metwork name (SSID): ) Auto @) Specified: |HOME |
Channel:

Transmit rate:

Key (use Ox for hex): Ox123456?89.;] ]

[ ¥ Cancel | @ Back

In Fedora Core, the Network Configuration tool saves your wireless network
settings in a text file. The name of the text file depends on the wireless network
device name. If the wireless network device name is eth0, the configuration
is stored in the text file /etc/sysconfig/network-scripts/ifcfg-eth0.
If the wireless device name is ethl, the file is /etc/sysconfig/network-
scripts/ifcfg-ethl. This configuration file contains various settings for
the wireless network card. Table 3-1 explains the meaning of the settings.
Here is a slightly edited version of the /etc/sysconfig/network-scripts/
ifcfg-ethl file from my laptop PC running Fedora Core:

IPV6INIT=no

USERCTL=no

PEERDNS=vyes
TYPE=Wireless
DEVICE=ethl
HWADDR=00:02:2d:8c:f9:c4
BOOTPROTO=dhcp
ONBOOT=no

DHCP_HOSTNAME=

NAME=
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ESSID="'HOME'
CHANNEL=6
MODE=Managed
RATE=auto

In Fedora Core, the encryption key is stored separately. For a wireless
Ethernet card whose device name is eth1, the encryption key is stored in
the /etc/sysconfig/network-scripts/keys-ethl file. For example,
here is what this file contains for my example:

KEY=1fdf3fdefe

Note that the key has 10 hexadecimal digits for a 40-bit key (for example,
1fdf-3fde-fe) or 26 hexadecimal digits for a 104-bit key. The keys are, in
fact, 64-bit and 128-bit, but the encryption algorithm automatically generates
24 bits of the key, so you need to specify only the remaining bits. Needless to
say, the longer the key, the more secure the encryption.

If you ever manually edit the parameters in the wireless Ethernet configuration
file in Fedora Core, type the following command to reactivate the wireless
network interface after editing the configuration file:

/etc/init.d/network restart

Table 3-1 Settings in Configuration File for a Wireless
Ethernet Network Interface in Fedora Core
This Parameter Means the Following
BOOTPROTO The name of the protocol to use to get the IP address for the interface.
It's either dhcp or bootp for an Ethernet interface.
CHANNEL Channel number (between 1 and 14 in United States and Canada).

Must be the same as that set for the wireless access point. In man-
aged mode, you dont need to specify the channel.

DEVICE The device name for the wireless Ethernet network interface (eth0
for the first interface, eth1l for the second, and so on).

ESSID Extended Service Set (ESS) Identifier, also known as the wireless net-
work name. Itis case-sensitive and must be the same as the name
specified for the wireless access point. Provide the name within
single quotes (for example, "HOME’).

HWADDR The hardware address (also called the MAC address) of the wireless
network card (six pairs of colon-separated hexadecimal numbers; for
example, 00:02:2d:8c:f9:c4). The wireless card’s device driver automat-
ically detects this address.

(continued)
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Table 3-1 (continued)

This Parameter Means the Following

IPV6INIT When set to yes, this parameter initializes IPv6 configuration for the
wireless interface. Set it to no if you are not using IPv6.

MODE The mode of operation of the wireless network card. Setto Managed
for a typical network that connects through a wireless access point.

NAME A nickname for your wireless network. If you dont specify it, the host
name is used as the nickname.

ONBOOT Setto yes to activate the wireless interface at boot time; otherwise,
settono.

PEERDNS Setto yes to enable the interface to modify your system's /etc/

resolv. conf file to use the DNS servers obtained from the DHCP
server (the same server that provides the IP address for the interface).
If you set this parameter to no, the /etc/resolv. conf file is
left unchanged.

RATE Bit rate for the wireless connection (set to one of the following options:
1M, 2M, 5.5M, 11M, or auto). The Mmeans Mbps or a million bits per
second. Setto auto to use the maximum possible transmission rate.

TYPE Setto Wireless for wireless network interface.

USERCTL When setto yes, a non-root user can control the device. Set it to
no so that only root can control the device.

In SUSE Linux, use YaST to configure the wireless network. SUSE stores the
wireless configuration parameters in a file whose name begins with i fcfg-
wlan, followed by a number such as 0 or 1, depending on the sequence
number of the wireless network interface. The configuration file is stored in
the /etc/sysconfig/network directory. Here is a typical list of wireless
configuration parameters from a configuration file in SUSE Linux:

WIRELESS_MODE='Managed'
WIRELESS_ ESSID='HOME'
WIRELESS_NICK="'"

WIRELESS RATE='auto'
WIRELESS_AUTH_MODE='open'
WIRELESS_KEY 0='0123-4567-89"

To check the status of the wireless network interface, type the following
command:

iwconfig
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Here’s a typical output from a Fedora Core laptop with a wireless Ethernet
PC card. (The output should be similar in other Linux distributions.)

lo no wireless extensions.
eth0 no wireless extensions.
sit0 no wireless extensions.
ethl IEEE 802.11b ESSID:"HOME" Nickname:"localhost.localdomain"

Mode:Managed Frequency:2.437 GHz Access Point: 00:30:AB:06:E2:5D
Bit Rate=11 Mb/s Sensitivity:1/3

Retry limit:4 RTS thr:off Fragment thr:off

Encryption key:1FDF-3FDE-FE Security mode:open

Power Management:off

Link Quality=51/92 Signal level=-40 dBm Noise level=-91 dBm

Rx invalid nwid:0 Rx invalid crypt:0 Rx invalid frag:27

Tx excessive retries:0 Invalid misc:0 Missed beacon:0

Here, the ethl interface refers to the wireless network card. I edited the
encryption key and some other parameters to hide those details, but the
sample output shows you what you’d typically see when the wireless link is
working.
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Chapter 4: Managing the Network

In This Chapter

v Learning the TCP/IP configuration files
» Checking TCP/IP networks

v Configuring networks at boot time

Like almost everything else in Linux, TCP/IP setup is a matter of preparing
numerous configuration files (text files you can edit with any text editor).
Most of these configuration files are in the /etc directory. The Linux installer
tries to be helpful by hiding the details of the TCP/IP configuration files.
Nevertheless, if you know the names of the files and their purposes, editing
the files manually, if necessary, is easier.

Discovering the TCP/IP Configuration Files

You can configure TCP/IP networking when you install Linux. However, if you
want to effectively manage the network, you need to become familiar with
the TCP/IP configuration files so that you can edit the files, if necessary.
(For example, if you want to check whether the name servers are specified
correctly, you have to know about the /etc/resolv.conf file, which
stores the IP addresses of name servers.)

Table 4-1 summarizes the basic TCP/IP configuration files. I describe these
configuration files in the next few sections.

Table 4-1 Basic TCP/IP Network Configuration Files

This File Contains the Following

/etc/hosts IP addresses and host names for your local network as well
as any other systems that you access often

/etc/networks Names and IP addresses of networks

/etc/host.conf Instructions on how to translate host names into IP addresses

/etc/resolv.conf IP addresses of name servers

/etc/hosts.allow Instructions on which systems can access Internet services

on your system

/etc/hosts.deny Instructions on which systems must be denied access to
Internet services on your system

/etc/nsswitch.conf Instructions on how to translate host names into IP addresses
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lete/hosts

The /etc/hosts text file contains a list of IP addresses and host names for
your local network. In the absence of a name server, any network program
on your system consults this file to determine the IP address that corre-
sponds to a host name. Think of /etc/hosts as the local phone directory
where you can look up the IP address (instead of a phone number) for a
local host.

Here is the /etc/hosts file from a system, showing the IP addresses and
names of other hosts on a typical LAN:

127.0.0.1 localhost localhost.localdomain
# Other hosts on the LAN

192.168.0.100 Inbp933
192.168.0.50 1nbp600
192.168.0.200 Inbp200
192.168.0.233 Inbp233
192.168.0.40 1nbp400

As the example shows, each line in the file starts with an IP address followed
by the host name for that IP address. (You can have more than one host name
for any given IP address.)

letc/networks

/etc/networks is another text file that contains the names and IP addresses
of networks. These network names are commonly used in the routing com-
mand (/sbin/route) to specify a network by name instead of by its IP
address.

Don’t be alarmed if your Linux PC does not have the /etc/networks file.
Your TCP/IP network works fine without this file. In fact, the Linux installer
does not create a /etc/networks file.

letc/host.conf

Linux uses a special library (that is, a collection of computer code) called the
resolver library, to obtain the IP address that corresponds to a host name.
The /etc/host. conf file specifies how names are resolved (that is, how the
name gets converted to a numeric IP address). A typical /etc/host.conf
file might contain the following lines:

order hosts, bind
multi on

The entries in the /etc/host . conf file tell the resolver library what serv-
ices to use (and in which order) to resolve names.
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The order option indicates the order of services. The sample entry tells the
resolver library to first consult the /etc/hosts file and then check the name
server to resolve a name.

Use the multi option to indicate whether or not a host in the /etc/hosts
file can have multiple IP addresses. Hosts that have more than one IP address
are called multihomed because the presence of multiple IP addresses implies
that the host has several network interfaces. (In effect, the host lives in sev-
eral networks simultaneously.)

letc/resolv.conf

The /etc/resolv.conf file is another text file used by the resolver — the
library that determines the IP address for a host name. Here is a sample
/etc/resolv.conf file:

nameserver 192.168.0.1 # dhcp: ethO
search nrockv0l.md.comcast.net

The nameserver line provides the IP addresses of name servers for your
domain. If you have multiple name servers, list them on separate lines.
They are queried in the order in which they appear in the file.

The search line tells the resolver how to search for a host name. For exam-
ple, when trying to locate a host name myhost, the search directive in the
example causes the resolver to try myhost .nrockv01l.md.comcast.net
first, then myhost .md.comcast .net, and finally myhost . comcast .net

If you do not have a name server for your network, you can safely ignore this
file. TCP/IP still works, even though you may not be able to refer to hosts by
name (other than those listed in the /etc/hosts file).

lete/hosts.allow

The /etc/hosts.allow file specifies which hosts are allowed to use the
Internet services (such as TELNET and FTP) running on your system. This file
is consulted before certain Internet services start. The services start only if
the entries in the hosts.allow file imply that the requesting host is allowed
to use the services.

The entries in /etc/hosts.allow are in the form of a servername: 1P
address format, where server refers to the name of the program providing
a specific Internet service, and TP address identifies the host allowed to
use that service. For example, if you want all hosts in your local network
(which has the network address 192.168.0.0) to access the TELNET service
(provided by the in.telnetd program), add the following line in the
/etc/hosts.allow file:

in.telnetd:192.168.0.
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If you want to let all local hosts have access to all Internet services, you can
use the ALL keyword and rewrite the line as follows:

ALL:192.168.0.

Finally, to open all Internet services to all hosts, you can replace the IP
address with ALL, as follows:

ALL:ALL
You can also use host names in place of IP addresses.

To find out the detailed syntax of the entries in the /etc/hosts.allow file,
type man hosts.allow at the shell prompt in a terminal window.

letc/hosts.deny

This file is just the opposite of /etc/hosts.allow. Whereas hosts.allow
specifies which hosts may access Internet services (such as TELNET and
TFTP) on your system, the hosts . deny file identifies the hosts that must be
denied services. The /etc/hosts.deny file is consulted if no rules are in
the /etc/hosts.allow file that apply to the requesting host. Service is
denied if the hosts . deny file has a rule that applies to the host.

The entries in /etc/hosts.deny file have the same format as those in the
/etc/hosts.allow file; they are in the form of a server:IP address
format, where server refers to the name of the program providing a specific
Internet service and IP address identifies the host that must not be allowed
to use that service.

If you already set up entries in the /etc/hosts.allow file to allow access
to specific hosts, you can place the following line in /etc/hosts.deny to
deny all other hosts access to any service on your system:

ALL:ALL

To find out the detailed syntax of the entries in the /etc/hosts.deny file,
type man hosts.deny at the shell prompt in a terminal window.

letc/nsswitch.conf

This file, known as the name service switch (NSS) file, specifies how services
such as the resolver library, NIS, NIS+, and local configuration files (such as
/etc/hosts and /etc/shadow) interact.

NIS and NIS+ are network information systems — another type of name-lookup
service. Newer versions of the Linux kernel use the /etc/nsswitch.conf
file to determine what takes precedence: a local configuration file, a service
such as DNS (Domain Name Service), or NIS.
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As an example, the following hosts entry in the /etc/nsswitch. conf file
says that the resolver library first tries the /etc/hosts file, and then tries
NIS+, and finally tries DNS:

hosts: files nisplus dns

\\3
You can find out more about the /etc/nsswitch. conf file by typing man
nsswitch.conf in a terminal window.

Checking Out TCP/IP Networks

After you configure Ethernet and TCP/IP (whether during Linux installation
or by running a network configuration tool or command later on), you can
use various networking applications without much problem. On the off chance
that you do run into trouble, Linux includes several tools to help you monitor
and diagnose problems.

Checking the network interfaces

Use the /sbin/ifconfig command to view the currently configured net-
work interfaces. The i fconfig command is used to configure a network
interface (that is, to associate an IP address with a network device). If you

run ifconfig without any command-line arguments, the command displays c?:;o't(;r"4

information about current network interfaces. The following is a typical g
output when you type /sbin/ifconfig:

. =

eth0 Link encap:Ethernet HWaddr 00:08:74:E5:C1:60 = g

inet addr:192.168.0.7 Bcast:192.168.0.255 Mask:255.255.255.0 ]

inet6 addr: fe80::208:74ff:fee5:c160/64 Scope:Link gg

UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1 2 «

RX packets:612851 errors:0 dropped:0 overruns:0 frame:0 =rE§

(-]

TX packets:574187 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:1000

RX bytes:99834031 (95.2 MiB) TX bytes:76034821 (72.5 MiB)
Interrupt:10 Base address:0x3000

ethl Link encap:Ethernet HWaddr 00:02:2D:8C:F8:C5
inet addr:192.168.0.9 Bcast:192.168.0.255 Mask:255.255.255.0
inet6 addr: fe80::202:2dff:fe8c:£f8c5/64 Scope:Link
UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1
RX packets:3833 errors:0 dropped:0 overruns:0 frame:0
TX packets:1242 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:1000
RX bytes:560194 (547.0 KiB) TX bytes:250287 (244.4 KiB)
Interrupt:3 Base address:0x100

lo Link encap:Local Loopback
inet addr:127.0.0.1 Mask:255.0.0.0
inet6 addr: ::1/128 Scope:Host
UP LOOPBACK RUNNING MTU:16436 Metric:1
RX packets:2456 errors:0 dropped:0 overruns:0 frame:0
TX packets:2456 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:0
RX bytes:2891581 (2.7 MiB) TX bytes:2891581 (2.7 MiB)
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This output shows that three network interfaces — the loopback interface
(10) and two Ethernet cards (eth0 and ethl) — are currently active on
this system. For each interface, you can see the IP address, as well as
statistics on packets delivered and sent. If the Linux system has a dialup
PPP link up and running, you also see an item for the ppp0 interface in the
output.

Checking the IP routing table

The other network configuration command, /sbin/route, also provides
status information when you run it without a command-line argument. If you're
having trouble checking a connection to another host (that you specify with
an IP address), check the IP routing table to see whether a default gateway is
specified. Then check the gateway’s routing table to ensure that paths to an
outside network appear in that routing table.

A typical output from the /sbin/route command looks like the following:

Kernel IP routing table

Destination Gateway Genmask Flags Metric Ref Use Iface
192.168.0.0 * 255.255.255.0 U 0 0 0 etho
192.168.0.0 * 255.255.255.0 U 0 0 0 ethl
169.254.0.0 * 255.255.0.0 U 0 0 0 ethl
default 192.168.0.1 0.0.0.0 UG 0 0 0 etho

As this routing table shows, the local network uses the eth0 and ethl
Ethernet interfaces, and the default gateway is the eth0 Ethernet interface.
The default gateway is a routing device that handles packets addressed to any
network other than the one in which the Linux system resides. In this exam-
ple, packets addressed to any network address other than those beginning
with 192.168.0 are sent to the gateway — 192.168.0.1. The gateway forwards
those packets to other networks (assuming, of course, that the gateway is
connected to another network, preferably the Internet).

Checking connectivity to a host

To check for a network connection to a specific host, use the ping com-
mand. ping is a widely used TCP/IP tool that uses a series of Internet
Control Message Protocol (ICMP, pronounced EYE-comp) messages. ICMP
provides for an Echo message to which every host responds. Using the
ICMP messages and replies, ping can determine whether or not the other
system is alive and can compute the round-trip delay in communicating
with that system.
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The following example shows how [ run ping to see whether a system on my
network is alive:

ping 192.168.0.1

Here is what this command displays on my home network:

PING 192.168.0.1 (192.
64 bytes from 192.168.0.

16
0
64 bytes from 192.168.0.
0
0
0

8.0.1) 56(84) bytes of data.

1: icmp_seg=1 ttl=63 time=0.256 ms

1: icmp_seqg=2 ttl=63 time=0.267 ms

64 bytes from 192.168.0.1
64 bytes from 192.168.0.1

64 bytes from 192.168.0.1: icmp_seqg=5 ttl=63 time=0.275 ms
---192.168.0.1 ping statistics ---

5 packets transmitted, 5 received, 0% packet loss, time 3999ms

rtt min/avg/max/mdev = 0.256/0.267/0.275/0.016 ms

: icmp_seq=3 ttl=63 time=0.272 ms
: icmp_seg=4 ttl=63 time=0.267 ms

In Linux, ping continues to run until you press Ctrl+C to stop it; then it dis-
plays summary statistics showing the typical time it takes to send a packet
between the two systems. On some systems, ping simply reports that a
remote host is alive. However, you can still get the timing information by
using appropriate command-line arguments.

The ping command relies on ICMP messages that many firewalls are con-
figured to block. Therefore, ping may not always work and is no longer a
reliable way to test network connectivity. If ping fails for a specific host, do
not assume that the host is down or not connected to the network. You can
typically use ping to successfully check connectivity within your local area
network.

Checking network status

To check the status of the network, use the netstat command. This com-
mand displays the status of network connections of various types (such as
TCP and UDP connections). You can view the status of the interfaces quickly
by typing netstat -i, which results in an output similar to the following:

Kernel Interface table

Iface MTU Met RX-0OK RX-ERR RX-DRP RX-OVR TX-OK TX-ERR TX-DRP TX-OVR Flg

eth0 1500 0 613175 0 0 1 574695 0 0 0 BMRU
ethl 1500 0 4298 0 0 0 1375 1 0 0 BMRU
lo 16436 0 3255 0 0 0 3255 0 0 0 LRU

In this case, the output shows the current status of the loopback and
Ethernet interfaces. Table 4-2 describes the meanings of the columns.
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Table 4-2 Meaning of Columns in the Kernel Interface Table

Column Meaning

Iface Name of the interface

MTU Maximum Transmission Unit — the maximum number of bytes that a

packet can contain

Met Metric value for the interface — a number indicating distance (in
terms of number of hops) that routing software uses when deciding
which interface to send packets through

RX-0K, TX-0OK Number of error-free packets received (RX) or transmitted (TX)

RX-ERR, TX-ERR  Number of packets with errors

RX-DRP, TX-DRP  Number of dropped packets

RX-0OVR, TX-OVR  Number of packets lost due to overflow

Flg A =receive multicast; B = broadcast allowed; D = debugging turned
on; L = loopback interface (notice the flag on 10), M = all packets
received, N = trailers avoided; O = no ARP on this interface; P = point-
to-pointinterface; R = interface is running; and U = interface is up

Another useful form of netstat option is -t, which shows all active TCP
connections. Following is a typical result of typing netstat -t on one Linux PC:

Active Internet connections (w/o servers)

Proto Recv-Q Send-Q Local Address Foreign Address State

tcp 0 0 localhost:2654 localhost:1024 ESTABLISHED
tcp 0 0 localhost:1024 localhost:2654 ESTABLISHED
tcp 0 0 LNBNECXAN.nrockvO0l.:ssh 192.168.0.6:1577 ESTABLISHED

In this case, the output columns show the protocol (Proto), the number of
bytes in the Receive and Transmit queues (Recv-Q, Send-Q), the local TCP
port in hostname: service format (Local Address), the remote port
(Foreign Address), and the state of the connection.

Type netstat -ta to see all TCP connections — both active and the ones your
Linux system is listening to (with no connection established yet). For exam-
ple, here’s a typical output from the netstat -ta command:

Active Internet connections (servers and established)

Proto Recv-Q Send-Q Local Address Foreign Address State
tcp 0 0 *:32769 *ok LISTEN
tcp 0 0 *:mysql o LISTEN
tcp 0 0 *:sunrpc *x LISTEN
tep 0 0 *:ftp *ok LISTEN
tcp 0 0 localhost.localdomain:ipp ok LISTEN
tcp 0 0 *:telnet *ok LISTEN
tcp 0 0 localhost.localdomain:5335 *:* LISTEN
tcp 0 0 localhost.localdomain:smtp *:* LISTEN
tcp 0 0 192.168.0.9:45876 www.redhat.com:http

ESTABLISHED
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tecp 0 0 192.168.0.9:45877 www.redhat.com:http
ESTABLISHED

tcp 0 0 192.168.0.9:45875 www.redhat.com:http
ESTABLISHED

tcp 0 0 *:ssh *ok LISTEN

tep 0 0 ::ffff:192.168.0.7:ssh (:ff££:192.168.0.3:4932
ESTABLISHED

Sniffing network packets

Sniffing network packets — sounds like something illegal, doesn’t it? Nothing
like that. Sniffing simply refers to viewing the TCP/IP network data packets.
The concept is to capture all the network packets so that you can examine
them later.

If you feel like sniffing TCP/IP packets, you can use tcpdump, a command-
line utility that comes with Linux. As its name implies, it dumps (prints) the
headers of TCP/IP network packets.

To use tcpdump, log in as root and type the tcpdump command in a termi-
nal window. Typically, you want to save the output in a file and examine that
file later. Otherwise, tcpdump starts spewing out results that just flash by on
the window. For example, to capture 1,000 packets in a file named tdout and
attempt to convert the IP addresses to names, type the following command:

tcpdump -a -c¢ 1000 > tdout

After capturing 1,000 packets, tcpdump quits. Then you can examine the
output file, tdout. It’s a text file, so you can simply open it in a text editor
or type more tdout to view the captured packets.

Just to whet your curiosity, here are some lines from a typical output from
tcpdump:

20:05:57.723621 arp who-has 192.168.0.1 tell LNBNECXAN.nrockv0l.md.comcast.net

20:05:57.723843 arp reply 192.168.0.1 is-at 0:9:5b:44:78:fc

20:06:01.733633 LNBNECXAN.nrockv0l.md.comcast.net.1038 > 192.168.0.6.auth: S
536321100:536321100(0) win 5840 <mss 1460, sackOK, timestamp 7030060
0,nop,wscale 0> (DF)

20:06:02.737022 LNBNECXAN.nrockv0l.md.comcast.net.ftp > 192.168.0.6.1596: P 1:72
(71) ack 1 win 5840 (DF)

20:06:02.935335 192.168.0.6.1596 > LNBNECXAN.nrockv0l.md.comcast.net.ftp: . ack
72 win 65464 (DF)

20:06:05.462481 192.168.0.6.1596 > LNBNECXAN.nrockv0l.md.comcast.net.ftp: P 1:12
(11) ack 72 win 65464 (DF)

20:06:05.462595 LNBNECXAN.nrockv0l.md.comcast.net.ftp > 192.168.0.6.1596: . ack
12 win 5840 (DF)

20:06:05.465344 LNBNECXAN.nrockv0l.md.comcast.net.ftp > 192.168.0.6.1596: P
72:105(33) ack 12 win 5840 (DF)

. lines deleted...
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The output does offer some clues to what’s going on: Each line shows informa-
tion about one network packet. Each line starts with a timestamp followed by
details of the packet (information such as where it originates and where it is
going). I don’t try to explain the details here, but you can type man tcpdump
to find out more about some of the details (and more importantly, see what
other ways you can use tcpdump).

If tepdump is not installed in Debian, type apt-get install tcpdump to install it.

You can use another packet sniffer called Ethereal in Linux. To find out more
about Ethereal, visit www.ethereal . com.

Configuring Networks at Boot Time
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It makes sense to start your network automatically every time you boot the
system. For that to happen, various startup scripts must contain appropriate
commands. You don’t have to do anything special other than configure your
network (either during installation or by using the network configuration tool
at a later time). If the network balks at startup, however, you can troubleshoot
by checking the files [ mention in this section.

In Debian, MEPIS, Ubuntu, and Xandros, the /etc/network/interfaces

file describes the network interfaces available in your system, and the /sbin/
ifup command activates the interfaces when you boot the system. Here is the
content of a typical /etc/network/interfaces file from a Debian system:

# This file describes the network interfaces available on your system
# and how to activate them. For more information, see interfaces(5).
# The loopback network interface

auto lo

iface lo inet loopback

# The primary network interface

auto eth0

iface eth0 inet dhcp

The auto eth0 line indicates that you can bring up the Ethernet interface at
initialization by using the command ifup -a invoked by a system startup
script. The line ifup eth0 inet dhcp identifies the Ethernet as a TCP/IP
network interface that is configured by Dynamic Host Configuration Protocol

(DHCP).

In Fedora Core, the network-activation script uses a set of text files in the
/etc/sysconfig directory to activate the network interfaces. For example,
the script checks the variables defined in the /etc/sysconfig/network file
to decide whether to activate the network. In /etc/sysconfig/network,
you see a line with the NETWORKING variable as follows:

NETWORKING=yes
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The network activates only if the NETWORKING variable is set to yes. A number
of scripts in the /etc/sysconfig/network-scripts directory activate
specific network interfaces. For example, the configuration file for activating
the Ethernet interface etho is the file /etc/sysconfig/network-scripts/
ifcfg-eth0. Here is what a typical /etc/sysconfig/network-scripts/
ifcfg-etho file contains:

DEVICE=ethO
BOOTPROTO=dhcp
HWADDR=00:08:74:E5:C1:06
ONBOOT=yes

TYPE=Ethernet

The DEVICE line provides the network device name. The BOOTPROTO variable
is set to dhcp, indicating that the IP address is obtained dynamically by using
DHCP. The ONBOOT variable states whether this network interface activates
when Linux boots. If your PC has an Ethernet card and you want to activate
the ethO interface at boot time, ONBOOT must be set to yes. Of course, the
configuration file i fcfg-eth0 in the /etc/sysconfig/network-scripts
directory works only if your PC has an Ethernet card and the Linux kernel
has detected and loaded the specific driver for that card.

In SUSE, the network information is kept in the /etc/sysconfig/network
directory in files whose names begin with i fcfg. For Ethernet interfaces,
the configuration filename begins with i fcfg-eth-id- followed by the
unique hardware address of the Ethernet card. Here are the key lines in a
typical Ethernet configuration file:

BOOTPROTO="dhcp'
STARTMODE="auto'

The BOOTPROTO="dhcp' line indicates that the interface is set up using
DHCP, and STARTMODE='onboot ' means that the interface is initialized
when the system boots.
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Chapter 1: E-Mailing
and IMing in Linux

In This Chapter

+* Understanding electronic mail

v~ Taking stock of mail readers and IM (Instant Messaging) clients
v+ Introducing Evolution

v+ Introducing Thunderbird

+ Introducing KMail

+ Instant messaging with Gaim and Kopete

E lectronic mail (e-mail) is a mainstay of the Internet. E-mail is great
because you can exchange messages and documents with anyone on the
Internet. One of the most common ways people use the Internet is to keep in
touch with friends, acquaintances, loved ones, and strangers through e-mail.
You can send a message to a friend thousands of miles away and get a reply
within a couple of minutes. Essentially, you can send messages anywhere in
the world from an Internet host, and that message typically makes its way to
its destination within minutes — something you cannot do with paper mail
(also known as snail mail, and appropriately so).

[ love e-mail because I can communicate without having to play the game of
phone tag, in which two people can leave a seemingly infinite number of tele-
phone messages for each other without ever successfully making contact.
When I send an e-mail message, it waits in the recipient’s mailbox to be read
at the recipient’s convenience. I guess I like the converse even better — when
people send me e-mail, I can read and reply at my convenience.

Linux comes with several mail clients — also called mail readers — that can
download mail from your Internet Service Provider (ISP). You can also read
and send e-mail using these mail clients. In this chapter, I mention several
mail clients available in Linux and briefly introduce you to a few of them.
And when you know one, you can easily use any of the mail readers.
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There is yet another type of keeping in touch that’s more in line with today’s
younger generation. I'm talking about /M — instant messaging. IM is basically
one-to-one chat, and Linux includes IM clients for AOL Instant Messenger
(or AIM), as well as other instant messaging protocols such as Jabber, ICQ,
MSN Messenger, Yahoo!, Gadu-Gadu, IRC (Internet Relay Chat), and SMS
(Short Message Service or text messaging). I briefly describe a few IM clients
in this chapter.

Understanding Electronic Mail

E-mail messages are addressed to a username at a host (host is just a fancy
name for an online computer). That means if John Doe logs in with the user-
name jdoe, e-mail to him is addressed to jdoe. The only other piece of
information needed to identify the recipient uniquely is the fully qualified
domain name of the recipient’s system. Thus, if John Doe’s system is named
someplace. com, his complete e-mail address becomes jdoe@someplace.
com. Given that address, anyone on the Internet can send e-mail to John Doe.

How MUA and MTA work

The two types of mail software are as follows:

4 Mail user agent (MUA) is the fancy name for a mail reader — a client
that you use to read your mail messages, write replies, and compose
new messages. Typically, the mail user agent retrieves messages from
the mail server by using the POP3 or IMAP4 protocol. POP3 is the Post
Office Protocol version 3, and IMAP4 is the Internet Message Access
Protocol version 4. Linux comes with mail user agents such as Balsa,
Thunderbird, KMail, and Evolution.

4+ Mail transport agent (MTA) is the fancy name for a mail server that actu-
ally sends and receives mail message text. The exact method used for mail
transport depends on the underlying network. In TCP/IP networks, the
mail transport agent delivers mail using the Simple Mail Transfer Protocol
(SMTP). Linux includes sendmail, a powerful and popular mail transport
agent for TCP/IP networks.

Figure 1-1 shows how the MUAs and MTAs work with one another when Alice
sends an e-mail message to Bob. (In case you didn’t know, using Alice and
Bob to explain e-mail and cryptography is customary — just pick up any
book on cryptography and you see what I mean.) And you may already know
this, but the Internet is always diagrammed as a cloud — the boundaries

of the Internet are so fuzzy that a cloud seems just right to represent it.

(Or is it because no one knows where it starts and where it ends?)
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Bob’s MUA
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The scenario in Figure 1-1 is typical. Alice and Bob both connect to the
Internet through an ISP and get and send their e-mail through their ISPs.
When Alice types a message and sends it, her mail user agent (MUA) sends
the message to her ISP’s mail transfer agent (MTA) using the Simple Mail
Transfer Protocol (SMTP). The sending MTA then sends that message to the
receiving MTA — Bob’s ISP’s MTA — using SMTP. When Bob connects to the
Internet, his MUA downloads the message from his ISP’s MTA using the POP3
(or IMAP4) protocol. That’s the way mail moves around the Internet — from
sending MUA to sending MTA to receiving MTA to receiving MUA.
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Mail message enhancements

Mail messages used to be plain text (and most still are), but many messages
today have much more than text. Two typical features of today’s mail are

4+ Attachments: Many messages today include attached files, which can be
anything from documents to images. The recipient can save the attach-
ment on disk or open it directly from the mail reader. Unfortunately, one
of the ways hackers try to get viruses and worms into your PC is by
placing them in attachments. (If it’s any consolation, most Windows-
based viruses and worms do not work in Linux.)

4+ HTML messages: Mail messages can be in HTML (HyperText Markup
Language), the language used to lay out Web pages. When you read an
HTML message on a capable mail reader, the message appears in its full
glory with nice fonts and embedded graphics.

NG/
&Vg‘ Although HTML messages are nice, they don’t appear right when you use
a text-based mail reader. In a text mail reader, HTML messages appear as a
bunch of gobbledygook (which is just the HTML code).

Q@N\BER If you have an ISP account, all you need is a mail client to access your e-mail.
& In this case, your e-mail resides on your ISP’s server, and the mail reader
downloads mail when you run it. You have to do some setup before you can
start reading mail from your ISP’s mail server. The setup essentially requires
you to enter information that you get from your ISP — the mail server’s name,
server type (POP3, for example), your username, and your password.

Taking Stock of Mail Readers and IM Clients in Linux

Time was when most mail readers were text programs, but times have
changed. Now mail readers are graphical applications capable of displaying
HTML messages and handling attachments with ease. They are easy to use;
if you can work with one, it’s a pretty sure bet that you can use any of the
graphical mail readers out there. (Linux comes with several mail readers;
feel free to try a few out to see which one fits your needs best.)

IM (instant messaging) is a more recent phenomenon, but Linux tries to
stay on top of things, so it comes with two IM clients that can work with
various IM protocols. Table 1-1 gives you an overview of the major mail
readers and IM clients in Linux.
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Table 1-1 Linux Mail Readers and IM Clients

Software Description

KMail The KDE e-mail client that supports both POP3 and IMAP4

Thunderbird A redesign of the Mozilla Mail client, which was a part of the Mozilla open
source \Web browser (open source incarnation of the Netscape Communicator)

Evolution A personal information manager (PIM) that includes e-mail, calendar, contact
management, and an online task list

Gaim An IM client for GNOME that supports a number of instant-messaging proto-
cols such as AIM, ICQ, Yahoo!, MSN, Gadu-Gadu, and Jabber

Kopete An IM client for KDE that supports a number of messaging protocols, such as

Jabber, ICQ, AIM, MSN, Yahoo!, IRC, Gadu-Gadu, and SMS

If you don’t see a specific mail or IM client in your distribution, chances are
that you can easily download and install it from the Internet.

E-Mailing in Linuyx
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Each Linux distribution’s GUI desktop has one or two default e-mail clients.
GNOME desktops typically offer Evolution, whereas KDE desktops go with
KMail. Both GNOME and KDE desktops often come with Mozilla as the Web
browser and Mozilla includes a mail client as well.

Debian includes KMail and Evolution. Fedora Core and Ubuntu offer Evolution
as the default mail client. MEPIS and SUSE use KMail as the default mail reader,
and Xandros provides both KMail and Thunderbird mail.

In the following sections, I briefly introduce you to Evolution, Thunderbird
mail, and KMail. All mail clients are intuitive to use, so you don’t need much
more than an introduction to start using them effectively.

Introducing Evolution
I have heard so much about Evolution that I want to start with it. What better
way than to just jump right in!

In Fedora Core, you can start Evolution by choosing Main Menu=>Internet=>
Evolution Email from the GNOME or KDE desktop. (In Debian, I had to choose
Applications>Debian Menu>Apps=>Net>Evolution.)
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Figure 1-2:
Evolution
Setup
Assistant
guides you
through the
initial setup.

When you start Evolution for the first time, the Evolution Setup Assistant
window appears, as shown in Figure 1-2.

Evalution Setup Assistant

‘elcorme to Evolution, The nest few scraens wil allow
Evelution to connect to your ema’ accounts, and to impor:
files from ather applicatons.

Flease click the "Forward® butten to continue.

X cancel &z

Click Forward in the Welcome screen and the Setup Assistant guides you
through the following steps:

1. Enter your name and e-mail address in the Identity screen and click
the Forward button.

For example, if your e-mail address is jdoe@someplace. com, that’s
what you enter.

2. Set up the options for receiving e-mail and click Forward.

Select the type of mail download protocol — POP or IMAP. Then provide

the name of the mail server (for example, mail.comcast.net). You are

prompted for the password when Evolution connects to the mail server
for the first time.

3. Provide further information about receiving e-mail — how often to
check for mail and whether to leave messages on the server — and
then click Forward.

Typically, you want to download the messages and delete them from the
server (otherwise the ISP complains when your mail piles up).



Figure 1-3:
Evolution
takes care
of mail,
calendar,
contact
manage-
ment, and
to-do lists.
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4. Set up the following options for sending e-mail and click Forward
when you’re done:

e Select the server type as SMTP.
e Enter the name of the server, such as smtp.comcast .net.

e If the server requires you to log in, select the Server Requires
Authentication check box.

e Enter your username — the same username you use to log in to
your ISP’s mail server. (Often, you don’t have to log in to send
mail; you only log in when receiving — downloading — mail
messages.)

5. Indicate if you want this e-mail account to be your default account,
and, if you want, give this e-mail account a descriptive name; click
Forward.

6. Set your time zone by clicking a map; click Forward.
7. Click Apply to complete the Evolution setup.

After you complete the one-time setup, Evolution opens its main window, as
shown in Figure 1-3.
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Figure 1-4:
Read your
e-mail in the
Evolution
Inbox.

Evolution’s main display area is vertically divided into two windows: a
narrow pane on the left with a number of shortcut buttons — Mail, Contacts,
Calendars, Tasks — arranged in a column and a bigger right pane where
Evolution displays information relevant to the currently selected shortcut
icon. In Figure 1-3, Evolution displays the Inbox for mail.

You can click the shortcut buttons in the left window to switch to different
views. These buttons provide access to all the necessary components of a
PIM — e-mail, calendar, task list, and contacts. You will find all of these tasks
intuitive to perform in Evolution.

To access your e-mail, click the Inbox icon. Evolution opens your Inbox, as
shown in Figure 1-4. If you turn on the feature to automatically check for mail
every so often, Evolution prompts you for your mail password and downloads
your mail. The e-mail Inbox looks very much like any other mail reader’s
inbox, such as the Outlook Express Inbox.

To read a message, click the message in the upper window of the Inbox and
the message text appears in the lower window. Figure 1-4 shows a message
with an image file attachment.

To reply to the current message, click the Reply button on the toolbar. A mes-
sage composition window pops up. You can write your reply and then click
the Send button on the toolbar to send the reply. Simple, isn’t it?
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To send a new e-mail, click the New Message button on the Evolution
toolbar. A new message composition window appears. You can type your
message in that window, and when you’re finished composing the message,
click Send.

Evolution comes with extensive online help. Choose Help=>Contents from
the Evolution menu and Evolution 2.0 User’s Guide appears in a window.
You can then read the user’s guide in that window.

Introducing Thunderbird

Thunderbird is a redesign of Mozilla Mail, the mail and newsreader that
comes with the Mozilla Web browser — the open source successor to
Netscape Communicator.

Xandros comes with Thunderbird, but some distributions do not install
Thunderbird by default. You can, however, install Thunderbird easily. For
example, in Debian, type su - and enter the root password in a terminal
window and then type apt-get install mozilla-thunderbird to install
Thunderbird Mail.

After installing it, you can start Thunderbird by choosing Applications=>
Debian Menu=>Apps=Net=>Mozilla Thunderbird from the GNOME desktop
in Debian. When Thunderbird runs, it starts the Account Wizard (shown in
Figure 1-5) and prompts you for information about your e-mail account.

Account Wizard olx

MNew Account Setup

In order to receive messages, you first need to set up a Mail or
Newsgroup account.

This Wizard will collect the information necessary to set up a
Mail or Newsgroup account. If you do not know the information
requested, please contact your System Administrator or
Internet Service Provider.

Select the type of account you would like to set up:

@ Email account
() RSS News & Blogs
) Movemail

() Newsgroup account

MNext > Cancel
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Select the Email Account radio button and click Next. The Account Wizard
then takes you through the following steps:

1. Enter your identity information — your name and your full e-mail
address, such as jdoe@someplace.com — and click Next.

2. Provide information about your ISP’s mail server — the protocol type
(POP or IMAP) as well as the incoming and outgoing server names —
and click Next.

The incoming server is the POP or IMAP server, whereas the outgoing
server is the one through which you send mail out. (It’s the SMTP server.)

3. Enter the username that your ISP has given you; click Next.

4. Enter a name that you want to use to identify this account and
click Next.

This name is just for Thunderbird, so you can pick anything you want,
such as “My home account.”

The Account Wizard displays a summary of the information you enter.

5. Verify the information. If it’s correct, click Finish. Otherwise, click
Back and fix the errors.

After you set up the e-mail account, Thunderbird’s main window appears
and shows you the contents of your Inbox. Soon a dialog box pops up and
asks you for your e-mail password. Thunderbird needs your password to
download your e-mail messages from your ISP. Enter your password and
click OK.

Thunderbird downloads your messages and displays them in a familiar
format. To read a message, click that message, and the full text appears
in the lower window, as shown in Figure 1-6.

Thunderbird is intuitive to use. Most of the time, you can click the toolbar
buttons to do most anything you want to do with the e-mail messages.
Here’s what each toolbar button does:

4+ Get Mail: Downloads messages from your e-mail accounts. (You can set
up as many as you want.)
4+ Write: Opens a window where you can compose and send a message.

4 Address Book: Opens the Address Book window where you can main-
tain a list of your contacts.
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Reply: Opens a window where you can send a reply to the person who
sent you the message you are reading now.

Reply All: Opens a window for sending a reply to everyone who is on
the addressee list of the message you are reading now.

Forward: Brings up the current message in a window so that you can
forward it to someone else.

Delete: Deletes the selected message.

Junk: Marks the selected messages as junk. (You can mark selected
messages as junk and choose Toolsw>Junk Mail Controls to block
similar messages.)

Print: Prints the selected message.

Stop: Stops the current transfers with the mail server.

If you use any GUI mail reader — from Microsoft Outlook Express to Novell
GroupWise — you find a similar set of toolbar buttons. In the following sec-
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Managing your Inbox

Thunderbird downloads your incoming mail and stores it in the Inbox folder.
You can see the folders organized along the narrow window on the left side.
(Refer to Figure 1-6.) Each e-mail account you have set up has a set of folders.
You have the following folders by default:

4+ Inbox: Holds all your incoming messages for this e-mail account.

4+ Unsent Messages: Contains the messages that have not yet been sent to
the mail server.

4+ Drafts: Contains the messages that you save as a draft. (Click the Save
button on the message composition window to save something as a draft.)

+

Sent: Holds all the messages you have successfully sent.

4+ Trash: Contains the messages you delete. (To empty the Trash folder,
choose FilewEmpty Trash from the Thunderbird Mail menu.)

You can create other folders to better organize your mail. To create a folder,
do the following:

1. Right-click on the Local Folder label on the left side of the Thunderbird
window and choose New Folder from the menu that appears.

The New Folder dialog box appears.

2. Fill in the folder name and select where you want to put the folder.
Click OK.

The new folder appears in the left window of Thunderbird. You can then
drag and drop messages into the folder.

When you select a folder from the left window, Thunderbird displays the
contents of that folder in the upper window on the right side. The list is nor-
mally sorted by date, with the latest messages shown at the end of the list.

If you want to sort the list any other way — say, by sender or by subject —
simply click that column heading and Thunderbird sorts the list according to
that column.

Composing and sending messages

To send an e-mail message, you either write a new message or reply to a
message you are reading. The general steps for sending an e-mail message
are as follows:

1. To reply to a message, click the Reply or Reply All button on the tool-
bar as you are reading the message. To write a new message, click
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the Compose button on the toolbar. To forward a message, click the
Forward button.

A message composition window appears.

2. In the message composition window, fill in the subject line and type
your message.

The message can include images as well as links to Web sites. To insert
any of these items, choose Insert~>Image or Inserte>Link from the menu.

3. If you're creating a new message or forwarding a message, type the
e-mail addresses of the recipients.

To select addressees from the Address Book, click the Address button
on the toolbar. Your Address Book opens, from which you can select the
addressees.

4. When you’re done composing the message, click the Send button.

Thunderbird asks whether you want to send the message in HTML
format or plain text or both.

5. Select a format and then click Send to send the message.

If you inserted images and Web links and you know the recipient can
read HTML mail, be sure to select HTML format; otherwise, choose
plain text.

If you want to complete a message later, click Save in the message compo-
sition window and then close the window. Thunderbird saves the message
in the Drafts folder. When you’re ready to work on that message again, go to
the Drafts folder and then double-click the saved message to open it.

Introducing KMail

KMail is a mail reader for KDE. When you first run KMail, you get its main
window (see Figure 1-7), but you cannot start using it to send and receive
e-mail until you have configured the mail accounts in KMail.

To configure KMail, choose Settings=>Configure KMail. In the Configure KMail
window (see Figure 1-8), click Accounts on the left side of the window and
set up the information about your e-mail accounts. KMail uses this informa-
tion to send and receive mail.

For outgoing mail, click the Add button on the Sending tab (see Figure 1-8)
and then select the mail transport agent. Typically, for an ISP-provided mail
account, you should select SMTP and enter the mail server’s name (for exam-
ple, smtp.comcast.net) that your ISP provided you.
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To set up the incoming mail information, click Add on the Receiving tab, and
select the mail protocol, such as POP3 or IMAP. Your ISP would have told
you what protocol to use. (Typically, it’s POP3 or IMAP.) Then enter the mail
server’s name (for example, mail.comcast.net) as well as the username
and password of your ISP account.

After the e-mail account information is set up, you can start using KMail.
The user interface is intuitive and similar to other mail readers such as
Thunderbird and Evolution. KMail periodically checks and downloads mes-
sages from your incoming mail accounts. You can view messages as they
arrive in your Inbox.

Instant Messaging in Linux
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Figure 1-9:
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this window.

There are two major IM clients in Linux. In GNOME desktops, you can use
Gaim, whereas Kopete is designed to work well on KDE desktops. I briefly
describe both IM clients in the following sections.

Using Gaim

You can use Gaim to keep in touch with all of your contacts on many different
IM services, such as AIM, ICQ, Yahoo!, MSN, Gadu-Gadu, and Jabber. If you
use any of the IM services, you’ll be right at home with Gaim.

In Fedora Core, start Gaim by choosing Applications=Internet

Messaging Client from the GNOME desktop. You can start Gaim in a similar
manner from GNOME desktops in other distributions. The initial Gaim
window appears together with an Accounts window, as shown in Figure 1-9.

Accounts

|Screen Mame Online |Auto-login  Protocol

| @ Add | Xglosel
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Figure 1-10:
Enter infor-
mation

about each
IM account.

Start by setting up your messaging accounts in the Accounts window. Click
the Add button and fill in the requested information in the Add Account
window, as shown in Figure 1-10. You have to select the protocol for your
IM service. For example, the protocol for AIM is AIM/ICQ. Other protocol
choices include Gadu-Gadu, Jabber, MSN, and Yahoo!.

Add Account

Login Options
Pratocal: & amico - ]
Screen Name: |momliea |
Password: PR
Alias:
Remember password
A i

User Options

[[J New mail notifications
Buddy icon: _DQpen (= e

+ Show more options

xgancell anve l

Figure 1-11:
Sign onto
AIM with
Gaim.

After you enter account information, the Accounts window shows all cur-
rently defined accounts. You can then select an account from the Gaim main
window and click Sign On, as shown in Figure 1-11.

Account:
& momliea (AIM/ICQ) H]

Password:

a8 x®

Accounts  Preferences
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After Gaim logs you in, it opens the standard Buddy List window. (See
Figure 1-12.)

[ Buddy List SIS
Buddies Tools Help

~ Buddies (1/1)
£ dadiea

To add buddies, choose Buddies=>Add Buddy. In the Add Buddy window that
appears, enter the screen name of the buddy and click Add. To create a new
group, choose Buddies=>Add Group. Type the name of the new group in the
Add Group window that appears and then click Add.

If any of your buddies are online, their names show up in the Buddy List win-
dow. To send a message to a buddy, double-click the name and a message
window pops up. If someone sends you a message, a message window pops
up with the message and you can begin conversing in that window.

Kopete — the KDE IM client — enables you to connect to many messaging
services including AIM, IRC, MSN Messenger, Yahoo!, Gadu-Gadu, and SMS.

You can start Kopete by choosing Chat or Instant Messaging in the applica-
tions menu in Debian, SUSE, and Xandros.

Figure 1-12:
A buddy list
window
in Gaim. L 0 @ 2
M Get Info  Chat Away
Using Kopete
/\\QQSPEC/‘}O
S
Q
<
%

When you first run Kopete, you get the Configure Kopete window (see
Figure 1-13), where you can enter information about your IM and other
messaging service accounts.

For example, to add your AIM account information, click New and then
answer and respond to the prompts from the Account Wizard. The first
step is to select your messaging service. (See Figure 1-14.)
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Select the appropriate messaging service, such as AIM if you use AOL'’s instant
messaging service. Then provide the AIM screen name and the password.

Step One: Select the Messaging Service(s)

Select the messaging service(s) for which you would like to
add accounts from the list below.

Name | Description
d M __Protocol to connect to AIM

Lok Gadu-Gadu Protocol to connect to Gadu-Gadu
&éico Protocol to connect to 1CQ

@IRC Protocol to connect to IRC

\“ Jabber Protocol to connect to Jabber

WIMSN Messenger Protocol to connect to MSN Messenger
& sms Protocol to send SMS messages
¥ vahoo Protocol to connect to Yahoo

Figure 1-14:
Select your
messaging

service in

this window. Help < Back Next = Cancel ]




Figure 1-15:
Viewing a
buddy list
in Kopete.
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After you set up your messaging service accounts, the Account Wizard closes
and you get the regular Kopete window. To sign on with your messaging serv-
ices and begin using Kopete, click the Connect button — the leftmost button
on the toolbar — in the Kopete window. (See Figure 1-15.)

[ 1 Instant Messaging [ (=] £

Elle Edit Settings Help

i momliea &

Click the magnifying-glass icon to see your buddies. You see a solid smiley
face icon for buddies who are online. Right-click an online buddy and select
Start Chat from the menu to start chatting. Choose Filen>Add Contact to add

more contacts.

Well, if you know AIM, you know what to do: Have fun IMing with Kopete!
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Chapter 2: Browsing the Web

In This Chapter

 Discovering the World Wide Web

» Understanding a URL

1 Checking out Web servers and Web browsers
v~ Taking stock of Web browsers for Linux

1 Web browsing with Mozilla Firefox

Isuspect you already know about the Web, but did you know that the Web
(or more formally, the World Wide Web) made the Internet what it is
today? The Internet has been around for quite a while, but it didn’t reach
the masses until the Web came along in 1993.

Before the Web came along, you had to use arcane UNIX commands to down-
load and use files, which was simply too complicated for most of us. With the
Web, however, anyone can enjoy the benefits of the Internet by using a Web
browser — a graphical application that downloads and displays Web docu-
ments. A click of the mouse is all you need to go from reading a document from
your company Web site to downloading a video clip from across the country.

In this chapter, I briefly describe the Web and introduce Mozilla Firefox —
the primary Web browser (and, for that matter, mail and newsreader, too) in
most Linux distributions. I also briefly discuss how you can create your own
‘X@N\BEII Web pages.
& KDE desktops often use Konqueror as the Web browser, but after you have
used one Web browser, you can easily use any other Web browser.

Discovering the World Wide Web

If you have used a file server at work, you know the convenience of sharing
files. You can use the word processor on your desktop to get to any docu-
ment on the shared server.

Now imagine a word processor that enables you to open and view a document
that resides on any computer on the Internet. You can view the document in its
full glory, with formatted text and graphics. If the document makes a reference
to another document (possibly residing on yet another computer), you can
open that linked document by clicking the reference. That kind of easy access
to distributed documents is essentially what the World Wide Web provides.
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Of course, the documents have to be in a standard format, so that any com-
puter (with the appropriate Web browser software) can access and interpret
the document. And a standard protocol is necessary for transferring Web
documents from one system to another.

The standard Web document format is HyperText Markup Language (HTML),
and the standard protocol for exchanging Web documents is HyperText
Transfer Protocol (HTTP). HTML documents are text files and don’t depend
on any specific operating system, so they work on any system from Windows
and Mac to any type of UNIX and Linux.

TEC/, ",

“@\BER A Web server is software that provides HTML documents to any client that

> makes the appropriate HTTP requests. A Web browser is the client software
that actually downloads an HTML document from a Web server and displays
the contents graphically.

R,

Like a giant spider’s web

The World Wide Web is the combination of the Web servers and the HTML
documents that the servers offer. When you look at the Web in this way, the
Web is like a giant book whose pages are scattered throughout the Internet.
You use a Web browser running on your computer to view the pages — the
pages are connected like a giant spider’s web, with the documents every-
where, as illustrated in Figure 2-1.

Figure 2-1:
The Web is
like billions
of pages,
scattered
across the
network,
that you can

]
S L]
ot com ﬁ 5

=[==5)

Web browser

puter by
using a Web

browser.
Web pages




Figure 2-2:
The parts of
a Uniform
Resource
Locator
(URL).
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Imagine that the Web pages — HTML documents — are linked by network
connections that resemble a giant spider’s web, so you can see why the Web
is called the Web. The World Wide part comes from the fact that the Web
pages are scattered around the world.

Links and URLs

Like the pages of real books, Web pages contain text and graphics. Unlike
real books, however, Web pages can include multimedia, such as video clips,
sound, and links to other Web pages.

The links in a Web page are references to other Web pages that you can
follow to go from one page to another. The Web browser typically displays
these links as underlined text (in a different color) or as images. Each link is
like an instruction to you — something like, “For more information, please
consult Chapter 4,” that you might find in a real book. In a Web page, all you
have to do is click the link; the Web browser brings up the referenced page,
even though that document may actually reside on a far-away computer
somewhere on the Internet.

The links in a Web page are referred to as hypertext links because when
you click a link, the Web browser jumps to the Web page referenced by
that link.

This arrangement brings up a question. In a real book, you might ask the
reader to go to a specific chapter or page in the book. How does a hypertext
link indicate the location of the referenced Web page? In the World Wide Web,
each Web page has a special name, called a Uniform Resource Locator (URL).
A URL uniquely specifies the location of a file on a computer. Figure 2-2 shows
the parts of a URL.

Port
l HTML
Domain name Directory path Filename anchor
A
/ ™

http://www.tldp.org:80/HOWTO/Wireless-HOWTO-2.htmliss2.1|

Protocol
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As Figure 2-2 shows, a URL has the following parts:

4+ Protocol: Name of the protocol that the Web browser uses to access
the data from the file the URL specifies. In Figure 2-2, the protocol is
http://, which means that the URL specifies the location of a Web
page. Here are some of the common protocol types and their meanings:

e file:// means the URL points to a local file. You can use this URL
to view HTML files without having to connect to the Internet. For
example, file:///var/www/html/index.html opens the file
/var/www/html/index.html from your Linux system.

* ftp:// means that you can download a file using the File Transfer
Protocol (FTP). For example, ftp://ftp.purdue.edu/pub/
uns/NASA/nasa. jpg refers to the image file nasa . jpg from the
/pub/uns/NASA directory of the FTP server ftp.purdue. edu.

If you want to access a specific user account via FTP, use a URL in
the following form:

ftp://username: password@ftp.somesite.com/

with the username and password embedded in the URL. (Note that
the password is in plain text and not secure.)

* http:// means that you download the file using the HyperText
Transfer Protocol (HTTP). This protocol is the well-known format of
URLs for all Web sites, such as http://fedora.redhat.com for the
Fedora Project’s home page. If the URL does not have a filename, the
Web server sends a default HTML file named index.html. (That’s
the default filename for the popular UNIX-based Apache Web servers;
Microsoft Windows Web servers use a different default filename.)

* https:// specifies that you access the file through a Secure
Sockets Layer (SSL) connection — a protocol designed by Netscape
Communications for encrypted data transfers across the Internet.
Typically, this form of URL is used when the Web browser sends
sensitive information (such as credit card number, username, and
password) to a Web server. For example, a URL such as

https://some.site.com/secure/takeorder.html

may display an HTML form that requests credit card information
and other personal information (such as name, address, and phone
number).

* mailto: specifies an e-mail address that you can use to send an e-mail
message. This URL opens your e-mail program, from which you can
send the message. For example, mailto:webmaster@someplace.
com refers to the Webmaster at the host someplace. com.
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* news:// specifies a newsgroup that you can read by means of the
Network News Transfer Protocol (NNTP). For example,

news://news.md.comcast.giganews.com/comp.os.linux.
setup

accesses the comp.os. linux. setup newsgroup at the news server
news.md.comcast .giganews.com. If you have a default news
server configured for the Web browser, you can omit the news
server’s name and use the URL news :comp.os.linux.setup to
access the newsgroup.

4+ Domain name: Contains the fully qualified domain name of the com-
puter that has the file this URL specifies. You can also provide an IP
address in this field. The domain name is not case-sensitive.

4+ Port: Port number that is used by the protocol listed in the first part
of the URL. This part of the URL is optional; all protocols have default
ports. The default port for HTTP, for example, is 80. If a site configures
the Web server to listen to a different port, the URL has to include the
port number.

4+ Directory path: Directory path of the file referred to in the URL. For Web
pages, this field is the directory path of the HTML file. The directory
path is case-sensitive.

4+ Filename: Name of the file. For Web pages, the filename typically ends
with .htmor .html. If you omit the filename, the Web server returns a
default file (often named index.html). The filename is case-sensitive.

4+ HTML anchor: Optional part of the URL that makes the Web browser
jump to a specific location in the file. If this part starts with a question
mark (?) instead of a hash mark (#), the browser takes the text following
the question mark to be a query. The Web server returns information
based on such queries.

Web servers and Web browsers

The Web server serves up the Web pages, and the Web browser downloads
them and displays them to the user. That’s pretty much the story with these
two cooperating software packages that make the Web work.

In a typical scenario, the user sits in front of a computer that’s connected to the
Internet and runs a Web browser. When the user clicks a link or types a URL
into the Web browser, the browser connects to the Web server and requests
a document from the server. The Web server sends the document (usually in
HTML format) and ends the connection. The Web browser interprets and dis-
plays the HTML document with text, graphics, and multimedia (if applicable).
Figure 2-3 illustrates this typical scenario of a user browsing the Web.
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Web server

Web server sends back
the requested Web page

Internet
Web browser
User
HTTP
Figure 2-3:
The Web
browser
requests
documents Web browser connects to the
and the server and requests a Web page
Web server
sends them.
User
The Web browser’s connection to the Web server ends after the server sends
the document. When the user browses through the downloaded document
and clicks another hypertext link, the Web browser again connects to the
Web server named in the hypertext link, downloads the document, ends the
connection, and displays the new document. That’s how the user can move
from one document to another with ease.
“&N\BER
& A Web browser can do more than simply “talk” HTTP with the Web server —

in fact, Web browsers can also download documents using FTP, and many
have integrated mail and newsreaders as well.

Web Browsing in Linuyx

Web browsing is fun because so many of today’s Web pages are so full of graph-
ics and multimedia. Then there’s the element of surprise — you can click a link
and end up at unexpected Web pages. Links are the most curious (and useful)
aspect of the Web. You can start at a page that shows today’s weather, and a

click later, you can be reading this week’s issue of Time magazine.
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To browse the Web, all you need is a Web browser and an Internet connec-
tion. I assume that you've already taken care of the Internet connection
(see Book III, Chapter 1 if you haven’t yet set up your Internet connection),
so all you need to know are the Web browsers in Linux.

Checking out Web browsers for Linux

Many Linux distributions come with the Mozilla Web browser. Mozilla is an
open source version of the venerable Netscape Communicator.

Several other Web browsers are available for Linux. I briefly mention the other

browsers, but I focus on Firefox in the rest of the discussions. Here are the
major Web browsers for Linux:

4 Mozilla: The reincarnation of that old workhorse — Netscape

Communicator — only better. Includes mail and a newsreader. The Web

browser is called the Mozilla Navigator, or simply Navigator (just as it
was in Netscape Communicator).

4+ Epiphany: The GNOME Web browser that uses parts of the Mozilla code

to draw the Web pages, but has a simpler user interface than Mozilla.

If Epiphany is not installed, you can download it from www . gnome . org/

projects/epiphany.

4+ Firefox: Mozilla’s next-generation browser that blocks pop-up ads,

provides tabs for easily viewing multiple Web pages in a single window,

and includes a set of privacy tools. You can download Firefox from
www.mozilla.org/download.html.

4+ Konqueror: The KDE Web browser that also doubles as a file manager
and a universal viewer.

In addition to these, many other applications are capable of downloading
and displaying Web pages.

Nowadays most distributions include the Mozilla Firefox Web browser. |
briefly introduce the Firefox Web browser in the next section. All other
Web browsers have similarly intuitive user interfaces.

Debian does not install Firefox by default, but you can easily install it by

typing su - to become root and then typing apt-get install mozilla-firefox.

After installation, you can start Firefox by choosing Applications=>
Debian Menur>Net>Mozilla Firefox from Debian’s GNOME desktop.
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Introducing Firefox’s user interface

You can typically start Firefox by clicking an icon on the panel or by select-
ing it from the GUI desktop’s menu.

When Firefox starts, it displays a browser window with a default home
page. (The main Web page on a Web server is known as the home page.)
You can configure Firefox to use a different Web page as the default
home page.

Figure 2-4 shows a Web page from a U.S. government Web site (www. irs.gov),
as well as the main elements of the Firefox browser window. Note that
Firefox supports tabbed browsing, which means that you can open a new tab
(by pressing Ctrl+T) and view a Web page in that tab. That way, you can view
multiple Web pages in a single window.

The Firefox Web browser includes lots of features in its user interface,

but you can master it easily. You can start with just the basics to get going
with Firefox and then gradually expand to areas that you haven’t yet
explored.

Firefox toolbars

Starting from the top of the window, you see a menu bar with the standard
menus (File, Edit, and so forth) followed by the two toolbars — the Navigation
toolbar and the Bookmarks toolbar. The area underneath the Bookmarks
toolbar is where the current Web page appears.

Here’s what you can do with the buttons and text boxes on the Navigation
toolbar that appears just below the menu bar, from left to right:

4+ Back: Move to the previous Web page.
Forward: Move to the page from which you may have gone backward.
Reload: Reload the current Web page.
Stop: Stop loading the current page.

Home: Go to the home page.

IR

Location: Show the URL of the current Web page. (Type a URL in this
box and press Enter to view that Web page.)

<+

Go: Go to the URL typed in the Location text box.

4+ Google Search: Click to search various Web sites such as Google,
Yahoo!, Amazon.com, Dictionary.com, and eBay; type text and press
Enter to search the currently selected Web site (default is Google).



Figure 2-4:
The Firefox
Web
browser

in action.
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Immediately below the Navigation toolbar comes the Bookmarks toolbar
with buttons that take you to specific Web pages.

Status bar

You can think of the bar along the bottom edge of the Firefox window as the
status bar because the middle part of that area displays status information
as Firefox loads a Web page.

In the right corner of Firefox’s status bar, a security padlock icon appears
when you access a secure Web site. Firefox supports a secure version of
HTTP that uses SSL to transfer encrypted data between the browser and the
Web server. When Firefox connects to a Web server that supports secure
HTTP, a locked security padlock icon appears on the right edge of the status
bar. Otherwise there is no security padlock icon, signifying an insecure con-
nection. The URL for secure HTTP transfers begins with https: // instead
of the usual http:// (note the extra s in https).

Firefox displays status messages in the left part of the status bar. You can
watch the messages in this area to see what’s going on. If you mouse over
a link on the Web page, the status bar displays the URL for that link.
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Firefox menus

[ haven’t mentioned the Firefox menus much. That’s because you can usually
get by without having to go to them. Nevertheless, taking a quick look through
the Firefox menus is worthwhile so you know what each one offers. Table 2-1
gives you an overview of the Firefox menus.

Table 2-1 Firefox Menus

This Menu Enables You to Do the Following

File Open a file or Web location, open or close a tab, send a Web page or link
by e-mail, edit a Web page, print the current page, and quit Firefox

Edit Copy and paste selections, find text in the current page, and edit your
preferences

View Show or hide various toolbars, reload the current page, make the text

larger or smaller, and view the HTML code for the page

Go Go backward and forward in the list of pages you have visited, or jump to
other recently visited Web pages

Bookmarks Bookmark a page, manage the bookmarks, and add links to the Bookmarks
toolbar folder. (These then appear in the Bookmarks toolbar.)

Tools Search the Web and manage various aspects of the Web page, such as
themes, and view information about the current page

Help Get online help on Firefox

Changing your home page

Your home page is the page that Firefox loads when you start it. The default
home page depends on the distribution. Often the home page is a file from
your system’s hard drive. Changing the home page is easy.

First, locate the page on the Web that you want to be the home page. You can
get to that page any way you want. You can search with a search engine to find
the page you want, you can type in the URL in the Location text box, or you
may even accidentally end up on a page that you want to make your home
page. It doesn’t matter.

When you’re viewing the Web page that you want to make your home page
in Firefox, choose Edit=>Preferences from the Firefox menu. The Preferences
dialog box appears, as shown in Figure 2-5.

On the right side of Figure 2-5, notice the Home Page section of preferences.
Then you see a Location text box for the home page, and underneath the
address is a Use Current Page button. Click that button to make the current
page your home page.
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page your
home page. Caneel ok
QQ,N\BEH You can set a lot of other options using the Preferences dialog box. Although
& [ do not explain all the options here, you can click around to explore every-

thing that you can do from this window. For example, you can click the
Use Bookmark button to select a saved URL bookmark as the home page.
(You have to select the bookmark from a dialog box.)

Surfing the Net with Firefox

Where you go from the home page depends on you. All you have to do is
click and see where you end up. Move your mouse around. You know when
you are on a link because the mouse pointer changes to a hand with an
extended index finger. Click the link, and Firefox downloads the Web page
referenced by that link.

How you use the Web depends on what you want to do. When you first
get started, you may explore a lot — browsing through Web sites and
following links without any specific goal in mind (what you may call Web
window-shopping).

The other, more purposeful, use of the Web is to find specific information
from the Net. For example, you might want to locate all the Web sites that
contain documents with a specified keyword. For such searches, you can use
one of many Web search tools available on the Net. Firefox’s Search textbox
takes you to the Google Web Search page (www.google. com).
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A\\S

A third type of use is a visit to a specific site with a known URL. For example,
when reading about a specific topic in this book, you may come across a
specific URL. In that case, you want to go directly to that Web page.

If you want to surf the Net with Firefox, all you need is a starting Web page —
then you can click whatever catches your fancy. For example, select the text
in the Location text box in Firefox’s Navigation toolbar, type www.yahoo.com,
and then press Enter. You get to the Yahoo! home page that shows the Yahoo!
Web directory — organized by subject. There’s your starting point. All you
have to do is click and you’re on your way!



Chapter 3: Reading Newsgroups
and RSS Feeds

In This Chapter

+* Understanding newsgroups

* Reading newsgroups from your ISP
+” Reading and searching newsgroups at some Web sites

” Reading RSS feeds

Internet newsgroups are like the bulletin board systems (BBSs) of the pre-
Web age or the forums offered on online systems such as AOL and MSN.
Essentially, newsgroups provide a distributed conferencing system that
spans the globe. You can post articles — essentially e-mail messages to a
whole group of people — and respond to articles others have posted.

Think of an Internet newsgroup as a gathering place — a virtual meeting
place where you can ask questions and discuss various issues. (And best
of all, everything you discuss is archived for posterity.)

To participate in newsgroups, you need access to a news server — your
Internet Service Provider (ISP) can give you this access. You also need a
newsreader. Luckily, Linux comes with software that you can use to read
newsgroups. In this chapter, I introduce you to newsgroups and show you
how to read newsgroups with a few of the newsreaders. I also briefly explain
how you can read and search newsgroups for free from a few Web sites.

Nowadays another popular way to read summaries of Web sites and weblogs is
to use a program that can accept RSS feeds. At the end of this chapter, [ briefly
describe what an RSS feed is and how you can use a program such as the KDE
Akregator to subscribe to RSS feeds and read them on your Linux system.

Understanding Newsgroups

Newsgroups originated in Usenet — a store-and-forward messaging network
that was widely used for exchanging e-mail and news items. Usenet works
like a telegraph in that news and mail are relayed from one system to another.
In Usenet, the systems are not on any network; the systems simply dial up
one another and use the UNIX-to-UNIX Copy Protocol (UUCP) to transfer
text messages.
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Although it’s a very loosely connected collection of computers, Usenet works
well and continues to be used because very little expense is involved in con-
necting to it. All you need is a modem and a site willing to store and forward
your mail and news. You have to set up UUCP on your system, but you don’t
need a sustained network connection; just a few phone calls are all you need
to keep the e-mail and news flowing. The downside of Usenet is that you

cannot use TCP/IP services such as the Web, TELNET, or FTP with UUCP.

From their Usenet origins, the newsgroups have now migrated to the
Internet (even though the newsgroups are still called Usenet newsgroups).
Instead of UUCP, the Network News Transfer Protocol (NNTP) now trans-
ports the news.

Although (for most of the online world) the news transport protocol has
changed from UUCP to NNTP, the store-and-forward concept of news transfer
remains. Thus, if you want to get news on your Linux system, you have to
find a news server from which your system can download news. Typically,
you can use your ISP’s news server.

Newsgroup hierarchy

The Internet newsgroups are organized in a hierarchy for ease of maintenance
as well as ease of use. The newsgroup names help keep things straight by
showing the hierarchy.

Admittedly, these newsgroup names are written in Internet-speak, which can
seem rather obscure at first. But the language is pretty easy to pick up after a
little bit of explanation. For example, a typical newsgroup name looks like this:

comp.os.linux.announce

This name says that comp. os.1inux.announce is a newsgroup for announce-
ments (announce) about the Linux operating system (os . 1inux) and that
these subjects fall under the broad category of computers (comp).

As you can see, the format of a newsgroup name is a sequence of words
separated by periods. These words denote the hierarchy of the newsgroup.
Figure 3-1 illustrates the concept of hierarchical organization of newsgroups.

To understand the newsgroup hierarchy, compare the newsgroup name with
the path name of a file (for example, /usr/1ib/X11/xinit/Xclients) in
Linux. Just as a file’s path name shows the directory hierarchy of the file, the
newsgroup name shows the newsgroup hierarchy. In filenames, a slash (/)
separates the names of directories; in a newsgroup’s name, a period (.) sep-
arates the different levels in the newsgroup hierarchy.
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In a newsgroup name, the first word represents the newsgroup category.
The comp.os.linux.announce newsgroup, for example, is in the comp
category, whereas alt.books. technical is in the alt category.

Top-le

Table 3-1

vel newsgroup categories

lists some of the major newsgroup categories. You find a wide vari-

ety of newsgroups covering subjects ranging from politics to computers.

The Linux-related newsgroups are in the comp. os. linux hierarchy.

Table 3-1 Some Major Newsgroup Categories

Category Subject

alt Alternative newsgroups (not subject to any rules), which run the gamut from

the mundane to the bizarre

bionet Biology newsgroups

bit Bitnet newsgroups

biz Business newsgroups

clari Clarinet news service (daily news)

comp Computer hardware and software newsgroups (includes operating systems

such as Linux and Microsoft Windows)

(continued)
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Table 3-1 (continued)

Category Subject

ieee Newsgroups for the Institute of Electrical and Electronics Engineers (IEEE)
k12 Newsgroups devoted to elementary and secondary education

linux Newsgroups devoted to Linux (includes a 1 inux . redhat hierarchy)
misc Miscellaneous newsgroups

news Newsgroups about Internet news administration

rec Recreational and art newsgroups

sci Science and engineering newsgroups

soc Newsgroups for discussing social issues and various cultures

talk Discussions of current issues (think “talk radio”)

This short list of categories is deceptive because it doesn’t really tell you
about the wide-ranging variety of newsgroups available in each category.
The top-level categories alone number close to a thousand, but many top-
level categories are distributed only in specific regions of the world. Because
each newsgroup category contains several levels of subcategories, the over-
all count of newsgroups can be close to 60,000 or 70,000! The comp category
alone has close to 1,200 newsgroups.

Unfortunately, many newsgroups are flooded with spam, just like your e-mail
inbox only worse because anyone can post anything on a newsgroup. There
are some newsgroups, called moderated newsgroups, that offer some relief.
Anyone who wants to post on a moderated newsgroup must first submit the
article to a moderator — a human being — who can then decide whether to
post the article or reject it. You can reduce the spam overload by browsing
moderated newsgroups whenever possible.

To browse newsgroup categories and get a feel for the breadth of topics cov-
ered by the newsgroups, visit the Google Groups Web site at http://
groups .google.com and click the Browse all of Usenet link.

Linux-related newsgroups

Typically, you have to narrow your choice of newsgroups according to your
interests. If you're interested in Linux, for example, you can pick one or more
of these newsgroups:

4 comp.os.linux.admin: Information about Linux system administration.

4 comp.os.linux.advocacy: Discussions about promoting Linux.

4 comp.os.linux.announce: Important announcements about Linux.
This newsgroup is moderated, which means you must mail the article
to a moderator, who then posts it to the newsgroup if the article is
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appropriate for the newsgroup. (This method keeps the riff-raff from
clogging up the newsgroup with marketing pitches.)

4 comp.os.linux.answers: Questions and answers about Linux. All the
Linux HOWTOs are posted in this moderated newsgroup.

4 comp.os.linux.development: Current Linux development work.

<+

comp.os.linux.development.apps: Linux application development.

4 comp.os.linux.development.system: Linux operating system
development.

<+

comp.os.linux.hardware: Discussions about Linux and various
types of hardware.

comp.os.linux.help: Help with various aspects of Linux.
comp.os.linux.misc: Miscellaneous Linux-related topics.
comp.os.linux.networking: Networking under Linux.
comp.os.linux.redhat: Red Hat Linux-related topics.

comp.os.linux.setup: Linux setup and installation.

IR IR IR

comp.os.linux.x: Discussions about setting up and running the X
Window System under Linux.

<+

linux.debian: Moderated newsgroup about Debian GNU/Linux.

linux.debian.news: Moderated newsgroup for news items about
Debian GNU/Linux.

4 linux.redhat: Discussions about Red Hat Linux.

P You have to be selective about what newsgroups you read because keeping
up with all the news is impossible, even in a specific area such as Linux.
When you first install and set up Linux, you might read newsgroups such
as comp.os.linux.help, comp.os.linux.setup, comp.os.linux.
hardware, and comp.os. linux.x (especially if you have problems with

X). After you have Linux up and running, you may want to find out about Book IV
only new things happening in Linux. For such information, read the Chapter 3
comp.os.linux.announce newsgroup.

=2
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If you sign up with an ISP for Internet access, it can provide you with access %E <«

to a news server. Such Internet news servers communicate by using the 2

Network News Transfer Protocol (NNTP). You can use an NNTP-capable
newsreader, such as KNode, to access the news server and read selected
newsgroups. You can also read news by using Thunderbird. Using a news-
reader is the easiest way to access news from your ISP’s news server.
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My discussion of reading newsgroups assumes that you obtained access to a
news server from your ISP. The ISP provides you the name of the news server
and any username and password needed to set up your news account on the
newsreader you use.

To read news, you need a newsreader — a program that enables you to select
a newsgroup and view the items in that newsgroup. You also have to under-
stand the newsgroup hierarchy and naming conventions (which I describe in
the “Newsgroup hierarchy” section, earlier in this chapter). Now [ show you
how to read news from a news server.

If you don’t have access to newsgroups through your ISP, you can try using
one of the many public news servers that are out there. For a list of public
news servers, visit NewzBot at www.newzbot . com. At this Web site, you can
search for news servers that carry specific newsgroups.

Taking stock of newsreaders

You can use one of several software packages that enable you to download
and read newsgroups in Linux. Here are a few major newsreaders:

4+ Thunderbird: Thunderbird includes the ability to download news from
an NNTP server. You can read newsgroups and post items to newsgroups.
Xandros uses Thunderbird for mail and news.

4+ KNode: This is a newsreader for KDE that you can download from knode.
sourceforge.net. Debian, MEPIS, and SUSE provide KNode as the
newsreader.

4+ Pan: Pan is a GUI newsreader that, according to the developer’s Web site
(http://pan.rebelbase.com), “... attempts to be pleasing to both
new and experienced users.” You can download Pan for various Linux
distributions from http://pan.rebelbase.com/download.

If you don’t find a newsreader in your Linux system, you can download and
install any of these newsreaders easily in any of the Linux distributions. Often,
you can locate the download site by a simple search at a search engine —
just search for the word download followed by the name of the newsreader.

Reading newsgroups with Thunderbird

You can browse newsgroups and post articles from Thunderbird, a mail and
newsreader from the Mozilla project.

In some distributions such as Xandros, the Main Menu has options to start
Thunderbird directly. In many Linux distributions, the mail and news com-
ponent of Thunderbird may not be installed. In that case, you have to
download and install the Thunderbird mail and news component or use
another newsreader.
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When you’re starting to read newsgroups with Thunderbird for the first
time, follow these steps to set up the news account:

1. Choose Edit->Account Settings from the Thunderbird menu.
A dialog box appears.
2. Click Add Account.

The Account Wizard appears, as shown in Figure 3-2.

MNew Account Setup

In order to receive messages, you first need to set up a Mail or
Mewsgroup account.

This Wizard will collect the information necessary to set up a Mail or
Mewsgroup account. If you do not know the infermation requested,
please contact your System Administrator or Internet Service
Provider.

Select the type of account you would like to set up:

' Email account
" RSS Mews & Elogs

' Movemail

® Newsgroup account

MNext > Cancel

3. Select the Newsgroup Account radio button (refer to Figure 3-2) and
click Next.

4. In the new screen that appears, fill in your identity information —
name and e-mail address — and click Next to move to the next screen.

5. Enter your news server name and click Next.
6. Enter a descriptive name of the newsgroup account and click Next.
7. Click Finish to complete the newsgroup account setup.

The new newsgroup account now appears in the list of accounts on the left

side of the Thunderbird window. Click the newsgroup account name, and the
right side of the window shows the options for the newsgroup account.

Click the Subscribe to Newsgroups link. Thunderbird starts to download the
list of newsgroups from the news server.
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“\gN\BEIf If your ISP’s news server requires a username and password, you’re prompted
& for that information. After that, Thunderbird downloads the list of newsgroups
and displays them in the Subscribe dialog box. (You can enter a search string
in a text box to narrow the list.) When you find the newsgroups you want, click
the check box to subscribe to these newsgroups, as shown in Figure 3-3.
Then click OK to close the dialog box.

* x
Account: I newsgroups comcast.net =7

Show items that contain: comp os linux

Select the newsgroups to subscribe to:

: =] Subscribe
A comp.os.linux.advocacy O =
4 comp.os.linux.alpha O Unsubseribe
4 comp.os.linux.announce vl
A comp.os linux.answers vl el
— A comp.os.linux.anwsers O
. . A comp.os linux.developrment O
Flgure 3-3: _Acomp.os linux.development apps O
Indicate LA comp.os linux.development. system [l
. LA comp.os.linux.embedde
hich A comp.os. bedded O
whic _Acomp.os.linux hardawe ]
newsgroups - Acomp.os linux hardware ]
h .
you want to _4comp.os méak ]
subscribe " Acomp.os.linux.misc [ B
to in this
dialog box. Cancel oK

After you subscribe to newsgroups, these newsgroups appear under the
newsgroup account name in the left side of the Thunderbird window. You
can then read a newsgroup using these steps:

1. Click a newsgroup name (for example, comp . os . 1inux.announce).

If your news server requires a username and password, a dialog box
prompts you for this information. Then another dialog box asks you
how many message headers you want to download.

2. Specify the number of headers (for example, 500) you want and click
Download to proceed.

Thunderbird downloads the headers from the newsgroup and displays a
list in the upper-right area of the window.

3. From the list of headers, click an item to read that article, as shown in
Figure 3-4.

To select other subscribed newsgroups, simply click the newsgroup’s name
in the left side of the window.



Figure 3-4:
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Newsgroup subscriptions

Unlike magazines or newspapers, newsgroups don’t require that you sub-
scribe to them; you can read any available newsgroup on the news server.
The news server’s administrator may decide to exclude certain newsgroups,
however; if they aren’t included, you cannot read them.

The only thing that can be called subscribing is indicating the newsgroups
you routinely want to read. The news server does not receive any of this
subscription information — the information is used only by the newsreader
to determine what to download from the news server.

Posting new's

You can use any newsreader to post a news article (a new item or a reply to
an old posting) to one or more newsgroups. The exact command for posting
a news item depends on the newsreader. For example, in the Thunderbird
newsreader, you follow these steps to post an article:

1. Click the Reply button on the toolbar to post a follow-up to a news
item you’re reading. To post a new news article, click the Compose
button.

A window appears where you can compose the message.
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2. Type the names of the newsgroups, just as you would type the addresses
of recipients when sending e-mail. Enter the subject and your message.

For this test posting, type ignore as the subject line and enter
misc.test as the name of the newsgroup.

Otherwise, any site that receives your article replies by mail to tell you
the article has reached the site; that’s in keeping with the purpose of the
misc.test newsgroup.

3. After you finish composing the message, click Send on the toolbar.

Thunderbird sends the message to the news server, which in turn sends
it to other news servers, and soon it’s all over the world!

4. To verify that the test message reaches the newsgroup, choose File->
Subscribe. Then subscribe to the misc. test newsgroup (that’s where
you recently posted the new article). Look at the latest article (or one
of the most recent ones) in misc. test; it should be the article you
recently posted.

If you post an article and read the newsgroup immediately, you see the new
article, but that does not mean the article has reached other sites on the
Internet. After all, your posting shows up on your news server immediately
because that’s where you posted the article. Because of the store-and-
forward model of news distribution, the news article gradually propagates
from your news server to others around the world.

The misc.test newsgroup provides a way to see whether your news post-
ing is really getting around. If you post to that newsgroup and don’t include
the word ignore in the subject, news servers acknowledge receipt of the arti-
cle by sending an e-mail message to the address listed in the Reply To field
of the article’s header.

Using KNode

Debian, MEPIS, and SUSE provide KNode as the default newsreader. Typically,
you can start KNode by selecting Newsreader from the menu (look in the
Internet applications). If you don’t see a choice for Newsreader in the menus,
type knode in a terminal window to start KNode.

When KNode runs for the first time, it brings up the Configure KNode dialog
box, shown in Figure 3-5, through which you can configure everything you
need to read newsgroups and post items to newsgroups.

The left side of the dialog box shows all the items that you can configure,
and the right side is where you enter the information for the item that you
have currently selected on the left side.



Figure 3-5:
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When the Configure KNode dialog box first opens, it prompts for your per-
sonal information. Enter your identification information, such as name,
e-mail address, and organization — this information is used when you post a
new item to a newsgroup.

Then, click Accounts in the left side (refer to Figure 3-5) and click the
Newsgroup Servers tab on the right side to set up information about the
news server from which you will be reading news. Click New in the
Newsgroup Servers tab to bring up a dialog box (see Figure 3-6) where you
can enter the information about the news server. Your ISP should have pro-
vided you with the information needed to access the news server. If the
news server requires a login name and a password, you must enter that
information as well.

After you set up the news account, the KNode window shows the name

of the news server in its left side, as shown in Figure 3-7. Right-click the
server’s name and choose Subscribe to Newsgroups from the pop-up menu.
A dialog box appears where you can subscribe to selected newsgroups
(such as comp.os.linux.announce).

Figure 3-7 shows a typical view of the KNode window while reading an article
from one of the subscribed newsgroups. The KNode user interface is similar
to many other mail and newsreaders, including Thunderbird.
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Reading and Searching Newsgroups at Web Sites

If you don’t have access to newsgroups through your ISP, you can still read
newsgroups and post articles to newsgroups at a number of Web sites. Some
of them archive old news articles and provide good search capabilities, so
you can search these for articles related to some question you may have.

The best part about reading newsgroups through a Web site is that you don’t
even need access to a news server and you can read news from your Web
browser.

Table 3-2 lists Web sites that offer free access to Usenet newsgroups. Some
sites offer Usenet newsgroup service for a fee. [ don’t list them here, but
you can search for them with Google (www.google.com) — type the search
words usenet newsgroup access to get a list of all Web sites that offer news-
group access (including the ones that charge a fee).

Table 3-2 Web Sites with Free Access to Usenet Newsgroups
Web Site URL

Google Groups http://groups.google.com

mail2web http://usenet.mail2web.com
InterBulletin http://news.interbulletin.com
Usenet Replayer www .usenet-replayer.com

Mailgate www.mailgate.org

One of the best places to read newsgroups, post articles, and search old news-
group archives is Google Groups — Google’s Usenet discussion forums — on
the Web at http://groups.google.com. At that Web site, you can select
a newsgroup to browse, and you can post replies to articles posted on vari-
ous newsgroups.

The best part of Google Groups is the search capability. You already know c‘:”': |V3
how good Google’s Web search is; you get that same comprehensive search apler
capability to locate newsgroup postings that relate to your search words. To
search newsgroups, fill in the search form at http://groups.google.com 3
and press Enter. Bz
o8
To browse newsgroups in Google Groups, ignore the search box and look at §-§ g
the list of high-level newsgroup categories such as alt, comp, and soc. Click & o
the category, and you can gradually drill down to specific newsgroups. When 2

viewing an article in Google Groups, you can click a link that enables you to
post a follow-up to that article.
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Reading RSS Feeds

RSS stands for Really Simple Syndication. RSS is a format for syndicating —
gathering and making available — content of Web sites, primarily news-
oriented sites and blogs. The term blog is short for weblog — a frequently
updated journal with thoughts, comments, and opinions of the blog’s cre-
ator. RSS can be used to provide any kind of information that can be broken
down into discrete items and put into RSS format. Such RSSformatted content
is called an RSS feed, and an RSS-aware program can check the feed periodi-
cally for changes, download new items, and make them available to the user.

The RSS format is a dialect of XML (eXtensible Markup Language). All RSS
files conform to XML 1.0 specification.

There are many versions of RSS, but three versions — 0.91, 1.0, and 2.0 —
are in widespread use. Netscape designed RSS version 0.90 for gathering and
displaying headlines from news sites. A simpler version, 0.91, was proposed
and UserLand Software picked up that version for use in its blogging prod-
uct. At the same time, another noncommercial group had evolved RSS 0.90
into RSS 1.0, which is based on resource description format or RDF (see
www.w3 .org/rdf). UserLand did not accept RSS 1.0 but instead continued
evolving RSS 0.91 through versions 0.92, 0.93, 0.94, and finally settled on RSS
2.0 (skipping 1.0 because that version number was already taken). Currently,
many blogs and Web sites use RSS 0.91 for basic syndication (title, URL, and
description); they use RSS 1.0 for readers that use RDF; and they use RSS 2.0
for advanced syndication with more metadata. (Think of metadata as data
about data, which is what the RSS format provides: It provides data about
other information, such as blogs and news.) RSS 1.0 files have a . rdf exten-
sion, whereas RSS 0.91 and 2.0 files have a .xm1 extension. However, all RSS
files are text files that use XML tags.

Examining an RSS Feed

An RSS feed is a text file with XML tags that describe a Web site’s content.
You typically use an automated program to periodically generate the RSS
feed file, but you can prepare the RSS feed file using a text editor. It’s good
to know what an RSS feed looks like, just so you can debug problems with
the feed.

The specific details of an RSS feed depend on the version of RSS. The sim-
plest feed is RSS 0.91 and here’s a typical RSS 0.91 feed:

<?xml version="1.0" ?>
<!-- A comment line --->
<rss version="0.91">
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<channel> <!--- This tag specifies general information
about the feed--->
<title>Title of this feed</title>
<1ink>URL of this feed, for example,
http://naba.typepad.com/</link>
<description>Brief description of feed</description>
<language>en-us</language>
<item>
<title>Title of this item</title>
<1ink>URL for this item</link>
<description>Description of this item</description>
</item>
. more items
</channel>
</rss>

As you can see from that listing, an RSS feed includes a channel with a title,
link, description, and language followed by a series of items, each of which
has a title, link, and description.

The format is more verbose for RSS 1.0, which uses the RDF format. RSS 1.0
essentially provides the basic information that’s in RSS 0.91 and adds more
details such as item-level authors, subject, and publishing dates, which RSS
0.91 does not support.

Reading RSS Feeds

There are many GUI programs available for subscribing to RSS feeds and read-
ing items from a feed. These programs are called RSS aggregators because they
can gather information from many RSS feeds and make everything available
in a single place.

There are two types of RSS aggregators — Web browser plugins and standalone
programs. Browser plugins, such as NewsMonster (www . newsmonster. org),
run in a Web browser so that the feeds appear in the Web browser. Standalone
programs such as GNOME Straw (www.nongnu.org/straw) and KDE
Akregator (http://akregator.sourceforge.net) are complete GUI
applications and usually look similar to other mail and newsreader programs.

Fedora, MEPIS, and SUSE come equipped with the Akregator program, a
standalone RSS feed aggregator. To run it, look for a link in the GUI desktop’s
applications menu, but if you don’t see it listed, type akregator in a terminal
window. In Debian, you can install Akregator by typing apt-get install akregator
(after typing su - to become root).
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Figure 3-8:
You can
organize
and read
RSS feeds in
Akregator.

When Akregator first runs, it displays its main window without any RSS
feeds. To subscribe to a feed, choose Feed=>Add Feed from the menu or
right-click All Feeds in the left pane of the window (see Figure 3-8) and select
Add Feed from the pop-up menu. Then type the URL for the feed in the

Add Feed dialog box and click OK. For example, to read Slashdot’s RSS feed,
I type http://slashdot.org/index.rss. The feed’s title appears in the left pane
of the window. Click the feed title to view the items in this feed. Then you
can click an item in the upper-right pane, and that item appears in the lower-
right pane, as shown in Figure 3-8. You can add many different RSS feeds,
organize them into folders, and browse them in Akregator.
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Chapter 4: Using FTP

In This Chapter
v+~ Using the GNOME FTP client

1 Using any Web browser as an FTP client

v Getting to know the FTP commands

ust as the name implies, File Transfer Protocol (FTP) is used to transfer

files between computers. For example, if your Internet Service Provider
(ISP) gives you space for a personal Web site, you may have already used
FTP to upload the files making up the Web site. Using an FTP client on your
computer, you log in to your ISP account, provide your password, and then
copy the files from your home system to the ISP’s server.

You can also use FTP to download other files anonymously, such as open
source software from other computers on the Internet — in which case, you
don’t need an account on the remote system to download files. You can
simply log in using the word anonymous as the username and provide your
e-mail address as the password. (In fact, your Web browser can do this on
your behalf, so you may not even know this process is happening.) This
type of anonymous FTP is great for distributing files to anyone who wants
them. For example, a hardware vendor might use anonymous FTP to provide
updated device drivers to anyone who needs them.

Linux comes with several FTP clients, both command-line ones and GUI
ones. In this chapter, | introduce you to a few GUI FTP clients and for the
command-line FTP client, describe the commands you use to work with
remote directories.

Using Graphical FTP Clients

You can use one of the following GUI FTP clients in Linux:

4 gFTP — a graphical FTP client for GNOME (http://gftp.seul.orqg)

4+ KBear — a graphical FTP client for KDE (http: //kbear.
sourceforge.net)

4+ Web browser, such as Firefox, for anonymous FTP downloads
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Figure 4-1:
The gFTP
window
just after
opening a
connection
toan FTP
server.

For uploading files, you may want to use gFTP because you typically have to
provide a username and password for such transfers. Web browsers work
fine for anonymous downloads, which is how you typically download soft-
ware from the Internet.

I briefly describe all three GUI FTP clients in the next two sections.

Using gFTP

GNOME comes with gFTP, a graphical FTP client. gFTP is not installed by
default, but you can download it from http://gftp.seul.org and install
it easily. In some distributions, it may be in a package already, and all you
have to do is install that package.

In Debian, type su - in a terminal window and enter the root password, then
type apt-get install gftp.

In Fedora Core, install gFTP from this book’s companion DVD. Log in as root,
insert the DVD into the DVD drive, and type mount /mnt/cdrom in a terminal
window. (You may have to change cdrom to cdroml, if the DVD drive is the
second CD/DVD drive on your system.) Then type c¢d /mnt/cdrom/Fedora/
RPMS, followed by rpm -ivh gftp*.

In Fedora Core, start gFTP by choosing Main Menu=Internet=>gFTP (if you
don’t see gFTP, log in as root and type yum install gftp and then look for it
in the menu). In other distributions, you should be able to find it in the Main
Menu. The gFTP window appears, as shown in Figure 4-1.
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The gFTP window has a menu bar with menus for performing various tasks.
Just below the menu bar is a toolbar with a number of buttons and text
fields. Here you can type the name or IP address of the remote host, the
username, and the password needed to log in to the remote host. Figure 4-1
shows the gFTP window after you fill in this information and establish a con-
nection with the remote host by clicking the button with the icon showing
two computers (the leftmost one on the toolbar).

To upload or download files using gFTP, follow these steps:

1. Fill in the hostname or the IP address of the remote system in the Host
field.

If you have used that host before, you can select it from the drop-down
list that appears when you click the downward-pointing arrow next to
the Host field.

2. Provide the username in the User field and the password in the Pass
field and click the button with the icon showing two computers (to the
left of the Host field).

This operation causes gFTP to connect to your chosen host and to log in
with the username and password you provided. The lower part of the
gFTP window shows the FTP protocol messages exchanged between the
two systems.

3. Observe this area for any indication of error messages.

The directory listing of the remote system appears in the right half of
the gFTP window. The left half shows the current local directory.

4. To upload one or more files from the current system to the remote
system, select the files in the list on the left, and then click the right-
arrow button.

5. To download files from the remote system, select the filenames in the
list on the right, and click the left-arrow button.

6. When you’re done transferring files, choose FTP=>Quit from the menu.

As these steps show, transferring files with a GUI FTP client, such as gFTP, is
a simple task.

Believe it or not, gFTP isn’t for FTP transfers alone. It can also transfer files
using the HTTP protocol and secure file transfers using the Secure Shell
(SSH) protocol.

Introducing KBear

KBear is a GUI FTP client for KDE. You find it in the Main Menu (in the
Internet category) on KDE desktops. In Debian, type apt-get install kbear to
install KBear (after you type su - to become root).
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Figure 4-2:
Enter
information
about the
remote FTP
server and
click
Connect.

When you first start KDE, it runs the KBear Wizard that enables you to con-
figure KBear. This configuration step mostly involves the layout of the KBear
window, so you can just accept the defaults.

When the main KBear window appears, it displays your home folder in a
view similar to that in Windows Explorer. To connect to an FTP server,
choose FTP=>Quick Connect. A dialog box (see Figure 4-2) prompts you for
the hostname of the FTP server as well as the username and password.

o QuickConnect X
Hostname:
192.168.0.6

Port: Protocol:

215 [f'tp

+|

Tl Anonymous Login

Username:

naba

Password:

Default directory:

\CJ Save to Sitemanager

\ Cancel J 1 Connect P

|

After entering the requested information, click Connect. KBear establishes a
connection to the remote FTP server. In the KBear main window, shown in
Figure 4-3, you see both the local and remote directories side by side.

You can now transfer files by dragging them from one system'’s folder and
dropping them on the other system’s folder, so FTP transfers become just
normal drag-and-drop file copying.

When you finish using KBear, choose FTP=>Quit or click the Power Off button
(the leftmost one) on the toolbar.

Using a Web browser as an FTP client

Any Web browser can act as an FTP client, but such programs are best for
anonymous FTP downloads, where the Web browser can log in using the
anonymous username and any password.



Figure 4-3:
KBear
window
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local
directory
and the
remote FTP
server's
directory
side by side.
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For example, you can use the Firefox Web browser as an FTP client. All you
have to know is how to write the URL so that the Web browser can tell that
you want to download a file using FTP. The syntax of the FTP URL is like this:

ftp://hostname/pathname

The first part (ftp: //) indicates that you want an FTP transfer. The
hostname part is the name of the FTP server (the name often starts with an
ftp — for example, ftp.netscape.com). The pathname is the full directory
path and filename of the file that you want to download.

If you simply provide the hostname for the FTP server, the Web browser dis-
plays the contents of the anonymous FTP directory. If you want to access
anonymous FTP on your Linux system, start Firefox (click the Web browser
icon on the GNOME panel), type the FTP URL in the Location text box, and
press Enter. For example, on my system, I type ftp://localhost/pub/ to access
the pub directory.

Figure 4-4 shows a typical appearance of an anonymous FTP directory in
Firefox. You can click folders to see their contents and download any files.
Although I show how you can access your local system by using Firefox’s
FTP capabilities, the purpose of FTP is (of course) to download files from
other systems to your system.
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Figure 4-4:
You can use
a Web
browser to
download
files from
anonymous
FTP servers.
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When you use the ftp://localhost/ URL, you won't get a response from
your system if you're not running an FTP server or if you have set up your
firewall so that no FTP connections are allowed.

In Debian and Fedora Core, log in as root and type /etc/init.d/vsftpd start
(in a terminal window) to start the FTP server. In SUSE, the xinetd super
server controls the FTP server vsftpd. The /etc/xinetd.d/vsftpd con-
figuration file specifies how vsftpd is started. See Book VII, Chapter 1 for
more information about xinetd configuration files.

The same approach of accessing anonymous FTP sites works if you type the
hostname of some other anonymous FTP server. For example, try typing the
following URL:

ftp://ftp.netscape.com/

You get the directory of the ftp.netscape.com server.

Using the Command-Line FTP Client

Knowing how to use FTP from the command line is a good idea — just in
case. For example, if your GUI desktop isn’t working, you may need to down-
load some files in order to fix the problem. If you know how to use the
command-line FTP client, you can download the files and take care of the
problem. It’s not that hard, and the command-line FTP client is available

in all Linux distributions.

The best way to figure out the command-line FTP client is to try it out. The

command is called ftp, and you can try out the ftp commands from your

Linux system. You don’t even need an Internet connection because you can
use the ftp command to connect to your own system — [ show you how.
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Note that the exact output from the £tp command might be different
because some distributions, such as Debian, use a text mode version of gFTP
as the command-line FTP client.

In the following sample FTP session, I use the command-line FTP client to log
in using my username (naba) and browse the directories on one of my Linux
systems. When you try a similar operation, replace the name with your user-
name and provide your password. Here’s the listing illustrating interaction
with a typical command-line FTP client (my comments appear in italics and
the text [ type is in boldface):

ftp localhost

Connected to localhost.localdomain.

220 (vsFTPd 2.0.3)

Name (localhost:naba): (I press Enter.)

331 Please specify the password.

Password: (I type my password.)

230 Login successful.

Remote system type is UNIX.

Using binary mode to transfer files.

ftp> help (I type help to see a list of FTP
commands. )

Commands may be abbreviated. Commands are:

! debug mdir gc send

S dir mget sendport site
account disconnect mkdir put size
append exit mls pwd status
ascii form mode quit struct
bell get modtime quote system
binary glob mput recv sunique
bye hash newer reget tenex
case help nmap rstatus tick

cd idle nlist rhelp trace
cdup image ntrans rename type
chmod lcd open reset user
close 1s prompt restart umask
cr macdef passive rmdir verbose
delete mdelete proxy runique ?

ftp> help mget (I can get help on a specific command.)
mget get multiple files

ftp> cd /var (This changes directory to /var.)
250 Directory successfully changed.
ftp> 1s (This command lists the contents of the
directory.)
227 Entering Passive Mode (127,0,0,1,38,142)
150 Here comes the directory listing.
lines deleted...
226 Directory send OK.
ftp> bye (This command ends the session.)
221 Goodbye.
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As the listing shows, you can start the command-line FTP client by typing
the command ftp hostname, where hostname is the name of the system you
want to access. When the FTP client establishes a connection with the FTP
server at the remote system, the FTP server prompts you for a username
and password. After you supply the information, the FTP client displays

the ftp> prompt, and you can begin typing commands to perform specific
tasks. If you can’t remember a specific FTP command, type help to view a
list of them. You can get additional help for a specific command by typing
help command, where command is what you want help on.

Many FTP commands are similar to the Linux commands for navigating the
file system. For example, cd changes directory, pwd prints the name of the
current working directory, and 1s lists the contents of the current directory.
Two other common commands are get and put: get is what downloads a
file from the remote system to your system, and put uploads (sends) a file
from your system to the remote host.

Table 4-1 describes some commonly used FTP commands. You don’t have to
type the entire FTP command. For a long command, you have to type only
the first few characters — enough to identify the command uniquely. For
example, to delete a file, you can type dele, and to change the file transfer
mode to binary, you can type bin.

When downloading files from the Internet, you almost always want to trans-
fer the files in binary mode because the software is usually archived and
compressed in a binary form. (Its files aren’t plain text files.) So always use
the binary command to set the mode to binary. Then use the get com-
mand to download the files.

When transferring multiple files with similar names (such as imagel . jpg,
image?2. jpg, and so on), type prompt to turn off prompting. (Otherwise the
FTP client will ask you after each file transfer whether you want to transfer
the next file.) Then type mget followed by the filename with wildcard. For
example, to download all files with names starting with image and ending
with the . jpg extension, type mget image* .jpg.

Table 4-1 Commonly Used FTP Commands

Command Description

! Executes a shell command on the local system. For example,
! 1s lists the contents of the current directory on the local

system.
? Displays a list of commands (same as help)
append Appends a local file to a remote file
ascii Sets the file-transfer type to ASCII (or plain text). This command

is the default file-transfer type.
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Command Description

binary Sets the file-transfer type to binary

bye Ends the FTP session with the remote FTP server and quits the
FTP client

cd Changes the directory on the remote system. For example, cd
/pub/Linux changes the remote directory to
/pub/Linux.

chmod Changes the permission settings of a remote file. For example,
chmod 644 index.html changesthe permission set-
tings of the index . html file on the remote system.

close Ends the FTP session with the FTP server and returns to the FTP
client's prompt

delete Deletes a remote file. For example, delete
bigimage. jpg deletes that file on the remote system.

dir Lists the contents of the current directory on the remote system

disconnect Ends the FTP session and returns to the FTP client's prompt.
(This command is the same as close.)

get Downloads a remote file. For example, get junk.tar.gz
junk. tgz downloads the file junk. tar. gz from the
remote system and saves it as the file junk. tgz on the local
system.

hash Turns on or off the hash-mark (#) printing that shows the
progress of file transfer. When this feature is turned on, a hash
mark prints on-screen for every 1,024 bytes transferred from the
remote system. (It's the command-line version of a progress
bar.)

help Displays a list of commands

image Same asbinary

lcd Changes the current directory on the local system. For example,
lcd /var/ftp/pub changesthe currentlocal directory to
/var/ftp/pub.

1s Lists the contents of the current remote directory

mdelete Deletes multiple files on a remote system. For example,
mdelete *.jpg deletes all remote files with names ending
in . jpginthe current directory.

mdir Lists multiple remote files and saves the listing in a specified
local file. For example, mdir /usr/share/doc/w*
wlist saves the listing in the local file named wlist.

mget Downloads multiple files. For example, mget *.jpg down-

loads all files with names ending in . jpg. If the prompt is
turned on, the FTP client asks for confirmation before down-
loading each file.

(continued)
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Table 4-1 (continued)

Command Description

mkdir Creates a directory on the remote system.mkdir images
creates a directory named images in the current directory on
the remote system.

mls Same asmdir

mput Uploads multiple files. For example, mput * . jpg sends all
files with names ending in . jpg to the remote system. If the
prompt is turned on, the FTP client asks for confirmation before
sending each file.

open Opens a connection to the FTP server on the specified host. For
example, open ftp.netscape.comconnectstothe FTP
server on the host ftp.netscape. com.

prompt Turns the prompt on or off. When the prompt is on, the FTP
client prompts you for confirmation before downloading or
uploading each file during a multiple-file transfer.

put Sends a file to the remote system. For example, put
index.html sendsthe index.html file from the local
system to the remote system.

pwd Displays the full path name of the current directory on the
remote system. When you log in as a user, the initial current
working directory is your home directory.

quit Same as bye

recv Same as get

rename Renames a file on the remote system. For example, rename
old.html new.html renames the file 01d.html to
new.html onthe remote system.

rmdir Deletes a directory on the remote system. For example, rmdir
images deletes the images directory in the current direc-
tory of the remote system.

send Same as put

size Shows the size of a remote file. For example, size bigfile.
tar.gz shows the size of that remote file.

status Shows the current status of the FTP client

user Sends new user information to the FTP server. For example,

user naba sendsthe username naba, the FTP server then
prompts for the password for that username.
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Chapter 1: Introducing Basic
System Administration

In This Chapter

+ Introducing the GUI sysadmin tools

» Becoming root

+ Understanding the system startup process

1~ Taking stock of the system configuration files

1~ Viewing system information through the /proc file system
+* Monitoring system performance

» Managing devices

+* Scheduling jobs

System administration or sysadmin refers to whatever has to be done to
keep a computer system up and running. The system administrator (also
called the sysadmin) is whoever is in charge of taking care of these tasks.

If you're running Linux at home or in a small office, you’re most likely the
system administrator for your systems. Or maybe you’re the system admin-
istrator for a whole LAN full of Linux systems. No matter. In this chapter, |
introduce you to basic system administration procedures and show you
how to perform some common tasks.

Each Linux distribution comes with quite a few graphical tools for perform-
ing specific system administration tasks. I introduce you to some of these
GUI tools in this chapter and describe some of them in greater detail in the
other chapters of this minibook.

Taking Stock of System Administration Tasks

So what are system administration tasks? My off-the-cuff reply is anything
you have to do to keep the system running well. More accurately, though, a
system administrator’s duties include the following:

4+ Adding and removing user accounts. You have to add new user
accounts and remove unnecessary user accounts. If a user forgets
the password, you have to change the password.
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4+ Managing the printing system. You have to turn the print queue on or
off, check the print queue’s status, and delete print jobs if necessary.

4 Installing, configuring, and upgrading the operating system and vari-
ous utilities. You have to install or upgrade parts of the Linux operating
system and other software that are part of the operating system.

4+ Installing new software. You have to install software that comes in vari-
ous package formats, such as RPM or DEB. You also have to download
and unpack software that comes in source-code form — and then build
executable programs from the source code.

4+ Managing hardware. Sometimes, you have to add new hardware and
install drivers so the devices work properly.

4+ Making backups. You have to back up files, either in a Zip drive, a USB
memory stick, or on tape (if you have a tape drive).

4 Mounting and unmounting file systems. When you want to access the
files on a CD-ROM, for example, you have to mount that CD-ROM’s file
system on one of the directories in your Linux file system. You may also
have to mount floppy disks, in both Linux format and DOS format.

4+ Automating tasks. You have to schedule Linux tasks to take place auto-
matically (at specific times) or periodically (at regular intervals).

4 Monitoring the system’s performance. You may want to keep an eye on
system performance to see where the processor is spending most of its
time and to see the amount of free and used memory in the system.

4+ Starting and shutting down the system. Although starting the system
typically involves nothing more than powering up the PC, you do have
to take some care when you shut down your Linux system. If your
system is set up for a graphical login screen, you can perform the shut-
down operation by choosing a menu item from the login screen.
Otherwise, use the shutdown command to stop all programs before
turning off your PC’s power switch.

4 Monitoring network status. If you have a network presence (whether a
LAN, a DSL line, or cable modem connection), you may want to check
the status of various network interfaces and make sure your network
connection is up and running.

4 Setting up host and network security. You have to make sure that
system files are protected and that your system can defend itself against
attacks over the network.

4+ Monitoring security. You have to keep an eye on any intrusions, usually
by checking the log files.
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That’s a long list of tasks! I don’t cover all of them in this chapter, but the Book V
rest of the minibook describes most of these tasks. Here, I focus on some of
the basics by introducing you to some GUI tools, explaining how to become
root (the superuser), describing the system configuration files, and show-
ing you how to monitor system performance, manage devices, and set up
periodic jobs.
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Introducing Some GUI Sysadmin Tools

Each Linux distribution comes with GUI tools for performing system admin-
istration tasks. The GUI tools prompt you for input and then run the neces-
sary Linux commands to perform the task. In the following sections, I briefly
introduce the GUI sysadmin tools in Debian, Fedora Core, SUSE, and
Xandros.

GUI sysadmin tools in Debian

Debian uses the GNOME desktop by default and provides some GUI tools for
performing sysadmin tasks. These tools are available in the Applications=>
System Tools menu. Table 1-1 lists some common tasks and the menu
choices you use to start the GUI tool that enables you to perform that task.

Table 1-1 Performing Sysadmin Tasks with GUI Tools in Debian

To Do This Choose the Following from the Debian GNOME Desktop
Add or remove software Applicationst>System Toolst>Synaptic Package Manager
packages

Change date or time Applicationst>System Toolst>Time and Date

Change password Main Menur>Settingse>Change Password

Configure desktop Applicationse>Desktop Preferences

Configure network Applications=>Networking

Format floppy Applications=>System Tools=>Floppy Formatter

Manage printers Applications=>System Tools=>Printers

Manage user accounts Applicationse>System Toolst>Users and Groups

Monitor system Applications=>System Tools=>System Monitor
performance

View system logs Applicationsc>System Tools=>System Log

GUI sysadmin tools in Fedora Core

Fedora Core comes with a set of GUI system configuration tools that can
ease the burden of performing typical sysadmin chores. Table 1-2 briefly
summarizes the menu choices you use to start a GUI tool for a specific task.
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Table 1-2

Starting GUI Sysadmin Tools in Fedora Core

To Configure or
Manage This

Start GUI Tool by Choosing This

Date and time

Systeme>Administration=>Date & Time

Disks and DVD/CD-ROM

Applications=>System Tools=>Disk Management

Display settings

Systeme>Administration=>Display

Firewall settings

Systeme>Administration=>Security Level and Firewall

Hardware Applications=>System Tools>Hardware Browser
Internet connection Systeme=>Administration>Network
Network Systeme=>Administration=>Network

Preferences such as
desktop and password

System=>Preferences

Printer

System=>Administration=>Printing

root password

System=>Administration=>Root Password

Servers

System=>Administration=>Server Settings

Software

System=>Administration=>Add/Remove Applications

System performance

Applications=>System Toolst>System Monitor

User accounts

System=>Administration>Users and Groups

GUI sysadmin tools in Knoppix

Knoppix is a Live CD distribution that you can use either to try out Linux or
to fix problems in an existing Linux system. As such, Knoppix comes with
several GUI tools that you can use for system administration tasks. Table 1-3
summarizes some of the GUI tools in Knoppix.

Table 1-3 Using GUI tools for Sysadmin Tasks in Knoppix
To Do This Choose This from the Knoppix GUI Desktop
Configure desktop Main Menu=>Settings=>Desktop Settings Wizard
Configure KDE Main Menur>Settingse>Control Center

Configure network

Main Menu=>KNOPPIX=>Network/Internete>
Network card configuration

Configure printer

Main Menu=>KNOPPIX=>Configurec>Configure printer(s)

Find files

Main Menuc>Find Files

Manage disk partitions
(for troubleshooting

existing Linux installations)

Main Menu=>System=>QTParted

Open a terminal window
with root permission

Main Menu=>KNOPPIX=>Root Shell
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To Do This

Choose This from the Knoppix GUI Desktop

Start Samba server

Main Menu=>KNOPPIX=>Services=>Start Samba Server

Start SSH server

Main Menuc>KNOPPIXc>Servicest>Start SSH Server

GUI sysadmin tools in MEP]S

You can run MEPIS as a Live CD or install it on the hard drive. MEPIS uses
the KDE desktop and includes some GUI tools for sysadmin tasks. One of the
unique aspects of MEPIS is the MEPIS OS Center that allows you to perform
sysadmin tasks. You can start it by choosing Main Menu=>MEPIS OS Center.
Figure 1-1 shows the main window for the MEPIS OS Center from which you
can install MEPIS on the hard drive (when you’re running MEPIS as a Live
CD) and also perform some system configuration and maintenance tasks.
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Besides the MEPIS OS Center, you can also use the KDE Control Center
(choose Main Menur>Control Center) for some system administration and
configuration tasks. Table 1-4 lists a few other GUI tools by specific sysadmin
tasks that you can use in MEPIS.

Table 1-4 Some GUI Tools for Sysadmin Tasks in MEPIS

To Do This Choose This from the MEPIS GUI Desktop

Configure desktop Main Menur>Systemr>Settingst>Desktop Settings Wizard
Configure KDE Main Menu=>Control Center

(continued)
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Figure 1-2:
YaST
Control
Centeris
your starting
point for
many
sysadmin
tasks in
SUSE.

Table 1-4 (continued)

To Do This Choose This from the MEPIS GUI Desktop
Configure printer Main Menur>Systeme>Settingst>Printing Manager
Find files Main Menu=>Find Files

Install software Main Menur>System=>Synaptic Package Manager

Manage disk partitions Main Menur>Systeme>Filesysteme=>QTParted
(for troubleshooting
existing Linux installations)

Manage user accounts Main Menu=>System=>KUser

Open a terminal window  Main Menuc>System=>Terminal Program - Super User Mode
with root permission

GUI sysadmin tools in SUSE

In SUSE, choose Main Menu=>System=>YaST to start your system administra-
tion tasks in the YaST Control Center. Figure 1-2 shows the YaST Control
Center window.
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The left side of the YaST Control Center shows icons for the categories of
tasks you can perform. The right side shows icons for specific tasks in the
currently selected category. When you click an icon in the right side of the
YaST Control Center, a new YaST window appears and enables you to per-
form that task.
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Table 1-4 summarizes the tasks for each of the category icons you see in the
left side of the YaST Control Center. As you can see from the entries in the
second column of Table 1-5, YaST Control Center is truly one-stop shopping
for all of your sysadmin chores.

Table 1-5 Tasks by Category in the YaST Control Center
This Category Enables You to Configure/Manage the Following
Software Online Update, Installation Source, Installation in Xen

Environment, Installation into Directory, Media Check, Patch CD
Update, Software Management, System Update

Hardware Bluetooth, CD-ROM Drives, Disk Controller, Graphics Card and
Monitor, Hardware Information, IDE DMA Mode, Infrared
Device, Joystick, Keyboard Layout, Mouse Model, Printer,
Scanner, Sound, TV Card

System /etc/sysconfig Editor, Boot Loader Configuration, Boot
or Rescue Floppy, Date and Time, LVM, Language, PCI Device
Drivers, Partitioner, Power Management, Powertweak, Profile
Manager, System Backup, System Restoration, System Services

(Run level)

Network Devices DSL, Fax, ISDN, Modem, Network Card, Phone Answering
Machine

Network Services DHCP Server, DNS Server, DNS Host and Name, HTTP Server,

Host Names, Kerberos Client, LDAP Client, Mail Transfer Agent,
NFS Client, NFS Server, NIS Client, NIS Server, NTP Client,
Network Services (xinetd), Proxy, Remote Administration,
Routing, SLP Browser, Samba Client, Samba Server, TFTP

Server

Security and Users Firewall, Group Management, Local Security, User
Management

Miscellaneous Autoinstallation, Post a Support Query, Vendor Driver CD, View

Start-up Log, View System Log

GUI sysadmin tools in Ubuntu

Ubuntu uses the GNOME desktop, and its menu organization is similar to
that of Fedora Core’s GNOME desktop. You can find Ubuntu’s GUI system
administration tools in the following menus: Applications=>System Tools,
System=>Administration, and System=>Preferences. Table 1-6 lists the menu
choices for starting some of the GUI tools.
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Table 1-6

Starting GUI Sysadmin Tools in Ubuntu

To Configure or
Manage This

Start GUI Tool by Choosing This

Date and time

System=>Administrationc>Time and Date

Display settings

Systemr=>Preferencest>Screen Resolution

Hardware

System=>Administration=>Device Manager

Internet connection

System=>Administration>Networking

Network

System=>Administration>Networking

Preferences such as
desktop and default
applications

System=>Preferences

Printer

System=>Administration=>Printing

root password

System=>Administration=>Root Password

Servers Systeme>Administration=>Server Settings
Software Applications=>System Tools=>Add/Remove Programs
System logs Applications=>System Toolse>System Log

System performance

Applications=>System Tools=>System Monitor

Updates

System=>Administration=>Ubuntu Update Manager

User accounts

Systeme>Administration=>Users and Groups

GUI sysadmin tools in Xandros

Xandros is designed to be a desktop operating system, and as such, you can
access everything easily from the desktop. For most sysadmin tasks, you
start at the Xandros Control Center — choose Main Menu=>Control Center
to get there. (Figure 1-3 shows you what you find when you do get there.)

As you can see, the left side of the window shows a tree menu of task cate-
gories. You can click the plus sign next to a category to view the subcate-

gories. When you click a specific task, the right side of the window displays
the GUI through which you can perform that task.

For some tasks, such as mounting file systems or adding printers, you can
open the Xandros File Manager as a system administrator by choosing Main
Menur>Applications=>Systemr>Administrator Tools>Xandros File Manager
(Administrator). You are prompted for the root password. Figure 1-4 shows
the Xandros File Manager window from which you can perform some sysad-
min tasks.
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How to Become root

You have to log in as root to perform the system administration tasks. The
root user is the superuser and the only account with all the privileges
needed to do anything in the system.

Common wisdom says you should not normally log in as root. When you’re
root, one misstep, and you can easily delete all the files — especially when
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Figure 1-5:
Type the
root
password
and press
Enter to
gain root
privileges.

you'’re typing commands. Take, for example, the command rm *.html that
you may type to delete all files that have the .html extension. What if you
accidentally press the spacebar after the asterisk (*)? The shell takes the
command to be rm * .html and — because * matches any filename —
deletes everything in the current directory. Seems implausible until it hap-
pens to you!

Using the su - command

If you're logged in as a normal user, how do you do any system administra-
tion chores? Well, you become root for the time being. If you're working at
a terminal window or console, type

su -

Then enter the root password in response to the prompt. From this point
on, you're root. Do whatever you have to do. To return to your usual self,
type

exit
That’s it! It’s that easy.

By the way, Knoppix has a root user but does not have a root password, so
you can become root by simply typing su - at the shell prompt in a terminal
window. Also, Ubuntu does not have a root user. To perform any task that
requires root privileges in Ubuntu, you must type sudo followed by the
command and when prompted, provide your normal user password.

Becoming root for the GUI utilities

Most Linux distributions include GUI utilities to perform system administra-
tion chores. If you use any of these GUI utilities to perform a task that requires
you to be root, the utility typically pops up a dialog box that prompts you for
the root password, as shown in Figure 1-5 (except in Ubuntu, where the GUI
tools prompt for your normal user password). Just type the password and
press Enter. If you don’t want to use the utility, click Cancel.

3 Enter Password X

To run this tool, you need administrator privileges

lig

To acquire such privileges, enter your root password
below. If you don't specify a password, you will be
unable to modify your system configuration.

Password: | e

¥ cancel F Pox
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Recovering from a forgotten root password

To perform system administration tasks, you have to know the root pass-
word. What happens if you forget the root password? Not to worry: Just
reboot the PC and you can reset the root password by following these
steps:

1.

Reboot the PC (select Reboot as you log out of the GUI screen) or
power up as usual.

Soon you see the graphical GRUB boot loader screen that shows the
names of the operating systems you can boot. If your system runs the
LILO boot loader, press Ctrl+X and at the boot : prompt, type linux
single and press Enter. Then proceed to step 4.

. If you have more than one operating system installed, use the arrow

key to select Linux as your operating system. Then press the A key.

GRUB prompts you for commands to add to its default boot command.

. Press the spacebar, type the following, and press Enter:

single

Linux starts up as usual but runs in a single-user mode that does not
require you to log in. After Linux starts, you see the following command-
line prompt that ends with a hash mark (#), similar to the following:

sh-3.00#

. Type the passwd command to change the root password as follows:

sh-3.00# passwd
Changing password for user root.
New password:

. Type the new root password that you want to use (it doesn’t appear

on-screen) and then press Enter.
Linux asks for the password again, like this:

Retype new password:

. Type the password again and press Enter.

If you enter the same password both times, the passwd command
changes the root password.

. Now type reboot to reboot the PC.

After Linux starts, it displays the familiar login screen. Now you can log
in as root with the new password.
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In SUSE Linux, in Step 3, type single init=/bin/sh (instead of single) and
before proceeding to Step 4, type mount / -n -0 remount,rw. Then perform
Steps 4 through 6 to change the root password. After changing the pass-
word, type mount / -n -0 remount,ro. Then continue to Step 7 and reboot
the PC.

Make sure that your Linux PC is physically secure. As these steps show,
anyone who can physically access your Linux PC can simply reboot, set a
new root password, and do whatever he or she wants with the system.
Another way to protect against resetting the password is to set a GRUB pass-
word, which causes GRUB to require a valid password before it boots Linux.
Of course, you must then remember to enter the GRUB password every time
you boot your system!

Understanding How Linux Boots

Knowing the sequence in which Linux starts processes as it boots is impor-
tant. You can use this knowledge to start and stop services, such as the Web
server and Network File System (NFS). The next few sections provide you
with an overview of how Linux boots and starts the initial set of processes.
These sections also familiarize you with the shell scripts that start various
services on a Linux system.

Understanding the init process

When Linux boots, it loads and runs the core operating system program
from the hard drive. The core operating system is designed to run other
programs. A process named init starts the initial set of processes on
your Linux system.

To see the processes currently running on the system, type
ps ax | more
You get an output listing that starts off like this:

PID TTY STAT TIME COMMAND
17 S 0:22 init [2]

The first column, with the heading PID, shows a number for each process.
PID stands for process ID (identification) — a sequential number assigned by
the Linux kernel. The first entry in the process list, with a process ID (PID)

of 1, is the init process. It’s the first process, and it starts all other processes
in your Linux system. That’s why init is sometimes referred to as the
“mother of all processes.”
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What the init process starts depends on the following:

4 The run level, an identifier that identifies a system configuration in
which only a selected group of processes can exist.

4+ The contents of the /etc/inittab file, a text file that specifies which
processes to start at different run levels.

4+ A number of shell scripts that are executed at specific run levels. (The
scripts are located in the /etc/init.d directory and a number of
subdirectories in /etc — these subdirectories have names that begin
with rc.)

Most Linux distributions use seven run levels — 0 through 6. The meaning
of the run levels differs from one distribution to another. Table 1-7 shows
the meanings of the run levels and points out some of the actions specific
to Fedora Core, Debian, MEPIS, SUSE, Ubuntu, and Xandros.

Table 1-7 Run Levels in Linux

Run Level Meaning

0 Shuts down the system

1 Runs in single-user standalone mode (no one else can log in; you work
at the text console)

2 Runs in multiuser mode (Debian, Ubuntu, and Xandros use run level 2
as the default run level)

3 Runs in full multiuser mode (used for text mode login in Fedora Core,
MEPIS, and SUSE)

4 Runs in full multiuser mode (unused in Fedora Core, MEPIS, and SUSE)

5 Runs in full multiuser mode (used as the default run level with graphical
login in Fedora Core, MEPIS, and SUSE)

6 Reboots the system

The current run level together with the contents of the /etc/inittab file
control which processes init starts in Linux. The default run level is 2 in
Debian, Ubuntu, and Xandros. In Fedora Core, MEPIS, and SUSE, run level 3
is used for text mode login screens and 5 for the graphical login screen. You
can change the default run level by editing a line in the /etc/inittab file.

To check the current run level, type the following command in a terminal
window:

/sbin/runlevel
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In Debian, the runlevel command prints an output like this:
N 2

The first character of the output shows the previous run level (N means no
previous run level), and the second character shows the current run level
(2). In this case, the system started at run level 2. If you are in a GUI desktop
in Fedora Core or MEPIS, the runlevel command should show 5 as the cur-
rent run level.

Examining the /etc/inittab file

The /etc/inittab file is the key to understanding the processes that init
starts at various run levels. You can look at the contents of the file by using
the more command, as follows:

more /etc/inittab

To see the contents of the /etc/inittab file with the more command, you
don’t have to log in as root.

To interpret the contents of the /etc/inittab file, follow these steps:

1. Look for the line that contains the phrase initdefault.
Here is that line from the /etc/inittab file from a Debian system:
id:2:initdefault:
That line shows the default run level. In this case, it’s 2.

2. Find all the lines that specify what init runs at run level 2. Look for a
line that has a 2 between the first two colons (:). Here is a relevant
line in Debian:

12:2:wait:/etc/init.d/rc 2

This line specifies that init executes the file /etc/init.d/rc with 2
as an argument.

If you look at the file /etc/init.d/rc in a Debian system, you find it’s a
shell script. You can study this file to see how it starts various processes for
run levels 1 through 5.

Each entry in the /etc/inittab file tells init what to do at one or more
run levels — you simply list all run levels at which the process runs. Each
inittab entry has four fields — separated by colons — in the following
format:

id:runlevels:action:process
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Table 1-8 shows what each field means. Book V
Chapter 1
Table 1-8 Meaning of the Fields in Each inittab Entry
Field Meaning
id A unique one- or two-character identifier. The init process

uses this field internally. You can use any identifier you want, as
long as you don't use the same identifier on more than one line.
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runlevels A sequence of zero or more characters, each denoting a run
level. For example, if the runlevels field is 12345, that
entry applies to each of the run levels 1 through 5. This field is
ignored if the action field is setto sysinit, boot, or
bootwait.

action Tells the init process whatto do with that entry. If this
fieldis initdefault, for example, init interprets the
runlevels field as the default run level. If this field is set
towait, init starts the program or script specified in the
process field and waits until that process exits.

process Name of the script or program that init starts. Of course,
some settings of the action field require no process field. For
example, when the actionfieldis initdefault,thereis
no need for a process field.

Trying a new run level with the init command

To try a new run level, you don’t have to change the default run level in the
/etc/inittab file. If you log in as root, you can change the run level (and,
consequently, the processes that run in Linux) by typing init followed by
the run level.

For example, to put the system in single-user mode, type the following:
init 1

Thus, if you want to try run level 3 without changing the default run level
in /etc/inittab file, enter the following command at the shell prompt:
init 3

The system ends all current processes and enters run level 3. By default, the
init command waits 20 seconds before stopping all current processes and
starting the new processes for run level 3.
< To switch to run level 3 immediately, type the command init -t0 3. The
number after the -t option indicates the number of seconds init waits
before changing the run level.
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You can also use the telinit command, which is simply a symbolic link (a
shortcut) to init. If you make changes to the /etc/inittab file and want
init to reload its configuration file, use the command telinit q.

Understanding the Linux startup scripts

The init process runs a number of scripts at system startup. In the
following discussions, [ use a Debian system as an example, but the basic
sequence is similar in other distributions — only the names and locations
of the scripts may vary.

If you look at the /etc/inittab file in a Debian system, you find the follow-
ing lines near the beginning of the file:

# Boot-time system configuration/initialization script.
si::sysinit:/etc/init.d/xrcS

The first line is a comment line. The second line causes init to run the
/etc/init.d/rcS script — the first Linux startup script that init runs in
a Debian system. The rcS script performs many initialization tasks, such

as mounting the file systems, setting the clock, configuring the keyboard
layout, starting the network, and loading many other driver modules. The
rcsS script performs these initialization tasks by calling many other scripts
and reading configuration files located in the /etc/rcsS.d directory.

After executing the /etc/init.d/rcS script, the init process runs the
/etc/init.d/rc script with the run level as argument. For example, for run
level 2, the following line in /etc/inittab specifies what init executes:

12:2:wait:/etc/init.d/rc 2

This example says init executes the command /etc/init.d/rc 2 and
waits until that command completes.

The /etc/init.d/rc script is somewhat complicated. Here’s how it works:

4+ It executes scripts in a directory corresponding to the run level. For
example, for run level 2, the /etc/init.d/rc script runs the scripts
in the /etc/rc2.d directory.

4 In the directory that corresponds with the run level, /etc/init.d/rc
looks for all files that begin with a K and executes each of them with the
stop argument. This argument kills any currently running processes.
Then it locates all files that begin with an S and executes each file with
a start argument. This argument starts the processes needed for the
specified run level.
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To see it executed at run level 2, type the following command:
ls -1 /etc/rc2.d

In the resulting listing, the K scripts — the files whose names begin with K —
stop (or kill) servers, whereas the S scripts start servers. The /etc/init.
d/rc script executes these files in exactly the order in which they appear in
the directory listing.

Manually starting and stopping servers

In Linux, the server startup scripts reside in the /etc/init.d directory.

You can manually invoke scripts in this directory to start, stop, or restart

specific processes — usually servers. For example, to stop the FTP server
(the server program is called vsftpd), type the following command:

/etc/init.d/vsftpd stop

If vsftpd is already running and you want to restart it, type the following
command:

/etc/init.d/vsftpd restart

You can enhance your system administration skills by familiarizing yourself
with the scripts in the /etc/init.d directory. To see its listing, type the
following command:

ls /etc/init.d

The script names give you some clue about which server the script can start
and stop. For example, the samba script starts and stops the processes
required for Samba Windows networking services. At your leisure, you may
want to study some of these scripts to see what each one does. You don’t
have to understand all the shell programming; the comments help you dis-
cover the purpose of each script.

Automatically starting servers at system startup

You want some servers to start automatically every time you boot the
system. The exact commands to configure the servers vary from one distri-
bution to another.

In Fedora Core and SUSE, use the chkconfig command to set up a server
to start whenever the system boots into a specific run level. For example, if
you start the SSH server, you want the sshd server to start whenever the
system starts. You can make that happen by using the chkconfig command.
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To set sshd to start whenever the system boots into run level 3, 4, or 5, you
type the following command (while logged in as root):

chkconfig --level 345 sshd on

In Fedora Core and SUSE, you can also use the chkconfig command to
check which servers are turned on or off. For example, to see the complete
list of all servers for all run levels, type the following command:

chkconfig --list

In Debian, MEPIS, Ubuntu, and Xandros, you can use the update-rc.d
command to enable a server to start automatically at system startup. For
example, to set sshd to start automatically at the default run levels, type
update-rc.d sshd defaults in a terminal window while logged in as root. You
can also specify the exact run levels and the sequence number (the order in
which each server starts). To find out more about the update-rc.d com-
mand, type man update-rc.d in a terminal window.

Taking Stock of Linux System Configuration Files

Linux includes a host of configuration files. All these files share text files that
you can edit with any text editor. To edit these configuration files, you must
log in as root. [ don’t discuss the files individually, but I show a selection of

the configuration files in Table 1-9, along with a brief description of each.
This listing gives you an idea of what types of configuration files a system
administrator has to work with. In many cases, Linux includes GUI utility
programs to set up many of these configuration files.

Table 1-9 Some Linux Configuration Files

Configuration File Description

/boot/grub Location of files for the GRUB boot loader

/boot/grub/ Configuration file for the boot menu that GRUB displays before it
menu.lst boots your system

/boot/System.map

Map of the Linux kernel (maps kernel addresses into names of
functions and variables)

/boot/vmlinuz The Linux kernel (the operating system'’s core)
/etc/apache2/ Configuration file for the Apache Web server (Debian and
httpd.conf MEPIS)

/etc/apt/sources. Configuration file that lists the sources — FTP or Web sites or
list CD-ROM — from which the Advanced Packaging Tool (APT)

obtains packages (Debian, MEPIS, Ubuntu, and Xandros)

/etc/at.allow

Usernames of users allowed to use the at command to sched-
ule jobs for later execution
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Configuration File

Description

/etc/at.deny

Usernames of users forbidden to use the at command

/etc/bashrc

System-wide functions and aliases for the bash shell (Fedora
Core)

/etc/bash.bashrc

System-wide functions and aliases for the bash shell (Debian,
MEPIS, SUSE, Ubuntu, and Xandros)

/etc/cups/cupsd. Printer configuration file for the Common UNIX Printing System

conf (CUPS) scheduler

/etc/fonts Directory with font configuration files. (In particular, you can put
local font configuration settings in the file
/etc/fonts/local.conf.)

/etc/fstab Information about file systems available for mounting and
where each file system is to be mounted

/etc/group Information about groups

/etc/grub.conf

The configuration for the GRUB boot loader in Fedora Core and
SUSE

/etc/hosts

List of IP numbers and their corresponding hostnames

/etc/hosts.allow

Hosts allowed to access Internet services on this system

/etc/hosts.deny

Hosts forbidden to access Internet services on this system

/etc/httpd/conf/ Configuration file for the Apache Web server (Fedora Core)

httpd.conf

/etc/init.d Directory with scripts to start and stop various servers

/etc/inittab Configuration file used by the init process that starts all the
other processes

/etc/issue File containing a message to be printed before displaying the

text mode login prompt (usually the distribution name and the
version number)

/etc/lilo.conf

The configuration for the Linux Loader (LILO) — one of the boot
loaders that can load the operating system from disk (present
only if you use the LILO boot loader)

/etc/login.defs

Default information for creating user accounts, used by the
useradd command

/etc/modprobe.
conf

Configuration file for loadable kernel modules, used by the
modprobe command (Fedora Core and SUSE)

/etc/modules.conf

Configuration file for loadable modules (Debian, MEPIS, and
Xandros)

/etc/mtab Information about currently mounted file systems

/etc/passwd Information about all user accounts. (Actual passwords are
stored in /etc/shadow.)

/etc/profile System-wide environment and startup file for the bash shell

(continued)
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Table 1-9 (continued)

Configuration File

Description

/etc/profile.d

Directory containing script files (with names that end in . sh)
thatthe /etc/profile script executes

/etc/init.d/rcS

Linux initialization script in Debian, MEPIS, SUSE, Ubuntu, and
Xandros

/etc/rc.d/rc.

Linux initialization script in Fedora Core

sysinit

/etc/shadow Secure file with encrypted passwords for all user accounts (can
be read only by root)

/etc/shells List of all the shells on the system that the user can use

/etc/skel Directory that holds initial versions of files such as
.bash_profile thatcopyto anew user's home directory

/etc/sysconfig Linux configuration files (Fedora Core and SUSE)

/etc/sysctl.conf

Configuration file with kernel parameters that are read in and
sethy sysctl at system startup

/etc/termcap Database of terminal capabilities and options (Fedora Core and
SUSE)

/etc/udev Directory containing configuration files for udev — the pro-
gram that provides the ability to dynamically name hot-pluggable
devices and create device files in the /dev directory

/etc/X11 Directory with configuration files for the X Window System
(X11) and various display managers such as gdm and xdm

/etc/X11/XF86 Configuration file for XFree86 X11 (Debian, MEPIS, and Xandros)

Configor/etc/
X11/XF86Config-4

/etc/X1l/xorg.
xonf

Configuration file for X.org X11 — the X Window System
(Fedora Core, Ubuntu, and SUSE)

/etc/xinetd.conf

Configuration for the xinetd daemon that starts a number of
Internet services on demand

/etc/yum.conf

Configuration for the yum package updater and installer
(Fedora Core)

/var/log/apache?2

Web-server access and error logs (Debian and MEPIS)

/var/log/cron

Log file with messages from the cron process that runs
scheduled jobs

/var/log/boot .msg

File with boot messages (SUSE)

/var/log/dmesg File with boot messages (Debian, Fedora Core, MEPIS, Ubuntu,
and Xandros)
/var/log/httpd Web server access and error logs (Fedora Core)

/var/log/messages

System log
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Figure 1-6:
You can see
the top CPU
processes
by using the
top utility.

When you’re the system administrator, you must keep an eye on how well
your Linux system is performing. You can monitor the overall performance
of your system by looking at information such as

4+ Central Processing Unit (CPU) usage
4+ Physical memory usage
4 Virtual memory (swap-space) usage

4+ Hard drive usage

Linux comes with a number of utilities that you can use to monitor one or
more of these performance parameters. Here I introduce a few of these utili-
ties and show you how to understand the information presented by these
utilities.

Using the top utility

To view the top CPU processes — the ones, that use most of the CPU time —
you can use the text mode top utility. To start that utility, type top in a ter-
minal window (or text console). The top utility then displays a text screen
listing the current processes, arranged in the order of CPU usage, along with
various other information, such as memory and swap-space usage. Figure 1-6
shows a typical output from the top utility.

The top utility updates the display every five seconds. If you keep top run-
ning in a window, you can continually monitor the status of your Linux
system. To quit top, press Q or Ctrl+C or close the terminal window.

Session B0 View  Bookmarks  Setings  Help
op - 21:54:33 wp Z min, 3 uscrs, load average: 1.44, 0.81, 0.31 -
Tasks: 76 total, Z running, 74 sleeping, O stopped., @ zonbie
pulsd: 0.0 us, 0.3 sy, ©.02 i, 99.7¢ id, ©.8: wa, 0.0x hi, ©.0: =i
L H 67692k total,  3IBI1ZPEk uscd, Jee11ek frce, 37981k buffers
ap! 1543104k total. Ok used, 1543104k free. 219700k cached
PFID USER I Ul < TINE+ COMHAND
] J 2.0 095,93 X
1 rootl 1 0 hHH “dh4 Zd4 5 0.0 0.8 0:01.3530 inil
2 root 31 19 a L] 65 6.0 0.8 0:00.00 ksoftirgd-8
J root @ -5 o L’} 93 0.0 0.9 0:00.00 cuents B
4 rool 1@ 5 o L] @5 00 0.8 0:00.00 khelper
5 root 1 -5 a L] @35 0.0 0.8 0:0000 kthrcad
7 root 1w -5 0 ] 83 0.0 0.6 0:90.00 kblockd€
39 root 1% 0 o L] @5 00 0.8 0:00.00 kapnd
&0 root 28 @ a L] @3 6.0 0.8 0:0000 pdflush
61 root 15 0 o L’} @3 0.0 0.0 0:00.01 pdflush
63 root P ] o L] @5 0.0 0.8 0:00.00 aind
62 root 25 0 a L] @35 6.0 0.8 0:0000 kswapdd
653 root 1Be -5 o L’} @3 0.0 0.0 0:00.03 kseriod
9549 root 1@ -5 o L] a5 0.0 0.8 0:00.01 reiserfss0
1893 root 13 -4 1840 964 606 5 0.0 0.1 0:00.95 udeud
2225 root 1w® -5 o L] @3 0.0 0.0 0:00.00 kKhubd -
(.“?33 ncssugell 16 0 3520 1544 1312 3 0.0 0.2 0:00.06 dbus—dacmon -
S5| | |l shes
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The first five lines of the output screen (refer to Figure 1-6) provide summary
information about the system. Here is what these five lines show:

4+ The first line shows the current time, how long the system has been up,
how many users are logged in, and three load averages — the average
number of processes ready to run during the last 1, 5, and 15 minutes.

4+ The second line lists the total number of processes and the status of
these processes.

4+ The third line shows CPU usage — what percentage of CPU time is used
by user processes, what percentage by system (kernel) processes, and
during what percentage of time the CPU is idle.

4+ The fourth line shows how the physical memory is being used — the
total amount, how much is used, how much is free, and how much is
allocated to buffers (for reading from the hard drive, for example).

4 The fifth line shows how the virtual memory (or swap space) is being
used — the total amount of swap space, how much is used, how much is
free, and how much is being cached.

The table that appears below the summary information (refer to Figure 1-6)
lists information about the current processes, arranged in decreasing order
by amount of CPU time used. Table 1-10 summarizes the meanings of the
column headings in the table that top displays.

Table 1-10 Meanings of Column Headings in top Utility’s Output

Heading Meaning

PID The process ID of the process

USER Username under which the process is running

PR Priority of the process

NI Nice value of the process — the value ranges from -20 (highest

priority) to 19 (lowest priority) and the default is 0. (The nice
value represents the relative priority of the process: the higher
the value the lower the priority and the nicer the process —
because it yields to other processes.)

VIRT The total amount of virtual memory used by the process, in
kilobytes

RES Total physical memory used by a task (typically shown in kilo-
bytes, but an m suffix indicates megabytes)

SHR Amount of shared memory used by process

S State of the process (S for sleeping, D for uninterruptible sleep,

R for running, Z for zombies — processes that should be dead
but are still running — or T for stopped)

%CPU Percentage of CPU time used since last screen update
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Heading Meaning

SMEM Percentage of physical memory used by the process
TIME+ Total CPU time the process has used since it started
COMMAND Shortened form of the command that started the process

Using the uptime command

You can use the uptime command to get a summary of the system’s state.
Just type the command like this:

uptime
It displays output similar to the following:
15:03:21 up 32 days, 57 min, 3 users, load average: 0.13, 0.23, 0.27

This output shows the current time, how long the system has been up, the
number of users, and (finally) the three load averages — the average

number of processes that were ready to run in the past 1, 5, and 15 minutes.

Load averages greater than 1 imply that many processes are competing for
CPU time simultaneously.

The load averages give you an indication of how busy the system is.

Using the vmstat utility

You can get summary information about the overall system usage with the
vmstat utility. To view system usage information averaged over 5-second
intervals, type the following command (the second argument indicates the
total number of lines of output vmstat displays):

vmstat 5 8

You see output similar to the following listing:

Procs —---------- Memory---------- --- swap-- ----- io---- -- system-- ---- cpu----
b swpd free buff cache si so bi bo in cs us sy id wa
0 31324 4016 18568 136004 1 1 17 16 8 110 33 4 61 1
1 31324 2520 15348 139692 0 0 7798 199 1157 377 8 8
0 31324 1584 12936 141480 0 9 5784 105 1099 437 12 5
0 31324 1928 13004 137136 7 0 1586 138 1104 561 43 6
1 31324 1484 13148 132064 0 0 1260 51 1080 427 50 5 0 46
0 31324 1804 13240 127976 0 0 1126 46 1082 782 19 5
0 31324 1900 13240 127976 0 0 0 0 1010 211 3 1
0 31324 1916 13248 127976 0 0 0 10 1015 224 3 2

OO O WNER oo
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The first line of output shows the averages since the last reboot. After that,
vmstat displays the 5-second average data seven more times, covering the
next 35 seconds. The tabular output is grouped as six categories of informa-
tion, indicated by the fields in the first line of output. The second line shows
further details for each of the six major fields. You can interpret these fields
using Table 1-11.

Table 1-11 Meaning of Fields in the vmstat Utility's Output

Field Name Description

procs Number of processes and their types: r = processes waiting to run, b =
processes in uninterruptible sleep, w = processes swapped out but ready
torun

memory Information about physical memory and swap-space usage (all numbers

in kilobytes): swpd = virtual memory used, free = free physical
memory, buf £ = memory used as buffers, cache = virtual memory
that’s cached

swap Amount of swapping (the numbers are in kilobytes per second): si =
amount of memory swapped in from disk, so = amount of memory
swapped to disk

io Information about input and output. (The numbers are in blocks per

second where the block size depends on the disk device.) bi = rate of
blocks sent to disk, bo = rate of blocks received from disk

system Information about the system: in = number of interrupts per second
(including clock interrupts), cs = number of context switches per
second — how many times the kernel changed which process was
running

cpu Percentages of CPU time used: us = percentage of CPU time used by
user processes, sy = percentage of CPU time used by system processes,
id = percentage of time CPU is idle, wa = time spent waiting for input or
output (I/0)

In the vmstat utility’s output, high values in the si and so fields indicate
too much swapping. (Swapping refers to the copying of information between
physical memory and the virtual memory on the hard drive.) High numbers
in the bi and bo fields indicate too much disk activity.

Checking disk performance and disk usage

Linux comes with the /sbin/hdparm program that you can use to control
IDE or ATAPI hard drives that are common on most PCs. One feature of the
hdparm program is that you can use the -t option to determine the rate at
which data is read from the disk into a buffer in memory. For example, here’s
the result of typing /sbin/hdparm -t /dev/hda on my system:

/dev/hda:
Timing buffered disk reads: 178 MB in 3.03 seconds = 58.81 MB/sec
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The command requires the IDE drive’s device name (/dev/hda for the first
hard drive and /dev/hdb for the second hard drive) as an argument. If you
have an IDE hard drive, you can try this command to see how fast data is
read from your system’s disk drive.

To display the space available in the currently mounted file systems, use the
df command. If you want a more readable output from df, type the following
command:

df -h

Here’s a typical output from this command:

Filesystem Size Used Avail Use% Mounted on
/dev/hdab 7.1G 3.9G 2.9G 59% /
/dev/hda3 99M 18M 77M 19% /boot

none 125M 0 125M 0% /dev/shm
/dev/scd0 2.6G 2.6G 0 100%

/media/cdrecorder

As this example shows, the -h option causes the df command to show the
sizes in gigabytes (G) and megabytes (M).

To check the disk space being used by a specific directory, use the du com-
mand — you can specify the -h option to view the output in kilobytes (k)
and megabytes (M), as shown in the following example:

du -h /var/log

Here’s a typical output of that command:
152K /var/log/cups

4.0K /var/log/vbox

4.0K /var/log/httpd
508K /var/log/gdm

4.0K /var/log/samba
8.0K /var/log/mail
4.0K /var/log/news/OLD
8.0K /var/log/news
4.0K /var/log/squid
2.2M /var/log

The du command displays the disk space used by each directory, and the
last line shows the total disk space used by that directory. If you want to see
only the total space used by a directory, use the -s option. For example,
type du -sh /home to see the space used by the /home directory. The com-
mand produces an output that looks like this:

89M /home
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Viewing System Information via the /proc File System
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Your Linux system has a special file system called the /proc file system.
You can find out many things about your system from this file system. In
fact, you can even change kernel parameters through the /proc file system
(just by writing to a file in that file system), thereby modifying the system’s
behavior.

The /proc file system isn’t a real directory on the hard drive but a collec-
tion of data structures in memory, managed by the Linux kernel, that
appears to you as a set of directories and files. The purpose of /proc (also
called the process file system) is to give you access to information about the
Linux kernel as well as to help you find out about all processes currently
running on your system.

You can access the /proc file system just as you access any other directory,
but you have to know the meaning of various files to interpret the informa-
tion. Typically, you can use the cat or more commands to view the contents
of a file in /proc. The file’s contents provide information about some aspect
of the system.

As with any directory, start by looking at a detailed directory listing of
/proc. To do so, log in as root and type Is -1 /proc in a terminal window. In
the output, the first set of directories (indicated by the letter d at the begin-
ning of the line) represents the processes currently running on your system.
Each directory that corresponds to a process has the process ID (a number)
as its name.

Notice also a very large file named /proc/kcore; that file represents the
entire physical memory of your system. Although /proc/kcore appears in
the listing as a huge file, no single physical file occupies that much space on
your hard drive — so don’t try to remove the file to reclaim disk space.

Several files and directories in /proc contain interesting information about
your Linux PC. The /proc/cpuinfo file, for example, lists the key charac-
teristics of your system, such as processor type and floating-point processor
information. You can view the processor information by typing cat /proc/
cpuinfo. For example, here’s what I get when I type cat /proc/cpuinfo on

my system:

processor : 0

vendor_id : GenuinelIntel

cpu family : 15

model : 3

model name : Intel (R) Celeron(R) CPU 2.53GHz

stepping : 3
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cpu MHz : 2533.129
cache size : 256 KB
fdiv_bug : no
hlt_bug : no
f00f_bug : no
coma_bug : no

fpu : yes
fpu_exception : yes
cpuid level : 5

wp : yes
flags : fpu vime de pse tsc msr pae mce cx8 apic

sep mtrr pge mca cmov pat pse36 clflush dts acpi mmx
fxsr sse sse2 ss ht tm pbe pni monitor ds_cpl cid
bogomips : 4997.12

This output is from a 2.5 GHz Celeron system. The listing shows many inter-
esting characteristics of the processor. Notice the line that starts with
fdiv_bug. Remember the infamous Pentium floating-point-division bug?
The bug is in an instruction called £div (for floating-point division). Thus,
the £fdiv_bug line indicates whether this particular Pentium has the bug.
(Fortunately, my PC’s processor does not.)

The last line in the /proc/cpuinfo file shows the BogoMIPS for the proces-
sor, as computed by the Linux kernel when it boots. BogoMIPS is something
that Linux uses internally to time-delay loops.

Table 1-12 summarizes some of the files in the /proc file system that pro-
vide information about your Linux system. You can view some of these files
on your system to see what they contain, but note that not all files shown in
Table 1-12 are present on your system. The specific contents of the /proc
file system depend on the kernel configuration and the driver modules that
are loaded (which, in turn, depend on your PC’s hardware configuration).

You can navigate the /proc file system just as you’d work with any other
directories and files in Linux. Use the more or cat commands to view the
contents of a file.

Table 1-12 Some Files and Directories in /proc
File Name Content
/proc/acpi Information about Advanced Configuration and Power Interface

(ACPI) — an industry-standard interface for configuration and
power management on laptops, desktops, and servers

/proc/bus Directory with bus-specific information for each bus type, such
as PCI
/proc/cmdline The command line used to start the Linux kernel (for example,

ro root=LABEL=/ rhgb)

(continued)
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Table 1-12 (continued)

File Name Content

/proc/cpuinfo Information about the CPU (the microprocessor)

/proc/devices Available block and character devices in your system

/proc/dma Information about DMA (direct memory access) channels that
are used

/proc/driver/rtc Information aboutthe PC’s real-time clock (RTC)

/proc/filesystems

List of supported file systems

/proc/ide Directory containing information about IDE devices

/proc/interrupts Information aboutinterrupt request (IRQ) numbers and how they
are used

/proc/ioports Information about input/output (I/0) port addresses and how
they are used

/proc/kcore Image of the physical memory

/proc/kmsg Kernel messages

/proc/loadavyg Load average (average number of processes waiting to run in
the last 1, 5, and 15 minutes)

/proc/locks Current kernel locks (used to ensure that multiple processes
don’t write to a file at the same time)

/proc/meminfo Information about physical memory and swap-space usage

/proc/misc Miscellaneous information

/proc/modules List of loaded driver modules

/proc/mounts List of mounted file systems

/proc/net Directory with many subdirectories that contain information
about networking

/proc/partitions Listof partitions known to the Linux kernel

/proc/pci Information about PCI devices found on the system

/proc/scsi Directory with information about SCSI devices found on the
system (present only if you have a SCSI device)

/proc/stat Overall statistics about the system

/proc/swaps Information about the swap space and how much is used

/proc/sys Directory with information about the system. You can change
kernel parameters by writing to files in this directory. (Using this
method to tune system performance requires expertise to do
properly.)

/proc/uptime Information about how long the system has been up

/proc/version

Kernel version number
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Figure 1-7:
An
application
can access
a device
through a
special file
that, in turn,
uses a
device
driver.

Linux treats all devices as files and uses a device just as it uses a file —
opens it, writes data to it, reads data from it, and closes it when done. This
ability to treat every device as a file comes through the use of device driv-
ers. A device driver is a special program that controls a particular type of
hardware. When the kernel writes data to the device, the device driver does
whatever is appropriate for that device. For example, when the kernel writes
data to the floppy drive, the floppy device driver puts that data onto the
physical medium of the floppy disk. On the other hand, if the kernel writes
data to the parallel port device, the parallel port driver sends the data to the
printer connected to the parallel port.

Thus the device driver isolates the device-specific code from the rest of the
kernel and makes a device look like a file. Any application can access a
device by opening the file specific to that device. Figure 1-7 illustrates this
concept of a Linux device driver.

Linux kernel
/dev/tjdrom /dev/fd0 etllo
¥ ¥
CD-ROM Floppy Ethernet
Software driver driver driver
| !

Hardware "g ﬁ

Device files

As Figure 1-7 shows, applications can access a device as if it were a file.
These files are special files called device files, and they appear in the /dev
directory in the Linux file system.
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If you use the 1s command to look at the list of files in the /dev directory,
you see several thousand files. These files do not mean that your system has
several thousand devices. The /dev directory has files for all possible types
of devices — that’s why the number of device files is so large.

So how does the kernel know which device driver to use when an applica-
tion opens a specific device file? The answer is in two numbers called the
major and minor device numbers. Each device file is mapped to a specific
device driver through these numbers.

To see an example of the major and minor device numbers, type the follow-
ing command in a terminal window:

ls -1 /dev/hda
You see a line of output similar to the following:
brw-rw---- 1 root disk 3, 0 Aug 16 14:50 /dev/hda

In this line, the major and minor device numbers appear just before the date.
In this case, the major device number is 3 and the minor device number is 0.
The kernel selects the device driver for this device file by using the major
device number.

You don’t really have to know much about the device files and the device
numbers, except to be aware of their existence.

In case you are curious, all the major and minor numbers for devices are
assigned according to device type. The Linux Assigned Names And Numbers
Authority (LANANA) assigns these numbers. You can see the current device
list at www.lanana.org/docs/device-list/devices. txt.

Block devices

The first letter in the listing of a device file also provides an important clue.
For the /dev/hda device, the first letter is a b, which indicates that
/dev/hda is a block device — one that can accept or provide data in chunks
(typically 512 bytes or 1K). By the way, /dev/hda refers to the first IDE hard
drive on your system (the C: drive in Windows). Hard drives, floppy drives,
and CD-ROM drives are all examples of block devices.

Character devices

If the first letter in the listing of a device file is a ¢, the device is a character
device — one that can receive and send data one character (one byte) at a
time. For example, the serial port and parallel ports are character devices.
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To see the specific listing of a character device, type the following command Book V
in a terminal window:
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1ls -1 /dev/ttySO
The listing of this device is similar to the following:

crw-rw---- 1 root uucp 4, 64 Aug 16 14:50 /dev/ttySO
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Notice that the very first letter is a ¢ because /dev/ttyS0 — the first serial
port — is a character device.

Network devices

Network devices that enable your system to interact with a network — for
example, Ethernet and dialup Point-to-Point Protocol (PPP) connections — are
somewhat special because they need no file to correspond to the device.
Instead, the kernel uses a special name for the device. For example, the
Ethernet devices are named ethO for the first Ethernet card, ethl for the
second one, and so on. PPP connections are named ppp0, pppl, and so on.

Because network devices aren’t mapped to device files, no files correspon-
ding to these devices are in the /dev directory.

Persistent device naming with udev

Linux kernel 2.6 introduces a new approach for handling devices, based on
the following features:

4+ sysfs: Kernel 2.6 provides the sysfs file system that is mounted on the
/sys directory of the file system. The sysfs file system shows all the
devices in the system as well as lots of information about each device.
The information includes location of the device on the bus, attributes
such as name and serial number, and the major and minor numbers of
the device.

4 /sbin/hotplug: This program is called whenever a device is added or
removed. It can then do whatever is necessary to handle the device.

4+ /sbin/udev: This program takes care of dynamically named devices
based on device characteristics such as serial number, device number
on a bus, or a user-assigned name based on a set of rules that are set
through the text file /etc/udev/udev.rules.
QQNER
& The udev program’s configuration file is /etc/udev/udev.conf. Based on
settings in that configuration file, udev creates device nodes automatically
in the directory specified by the udev_root parameter. For example, to
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manage the device nodes in the /dev directory, udev_root should be
defined in /etc/udev/udev.conf as follows:

udev_root="/dev/"

Managing Loadable Driver Modules

WBER
é&‘
&

To use any device, the Linux kernel must contain the driver. If the driver
code is linked into the kernel as a monolithic program (a program that’s in
the form of a single, large file), adding a new driver means rebuilding the
kernel with the new driver code. Rebuilding the kernel means you have to
reboot the PC with the new kernel before you can use the new device driver.
Luckily, the Linux kernel uses a modular design that does away with reboot-
ing hassles. Linux device drivers can be created in the form of modules that
the kernel can load and unload without having to restart the PC.

Driver modules are one type of a broader category of software modules
called Loadable Kernel Modules. Other types of kernel modules include
code that can support new types of file systems, modules for network
protocols, and modules that interpret different formats of executable files.

Loading and unloading modules

You can manage the loadable device driver modules by using a set of com-
mands. You have to log in as root to use some of these commands. In Table
3-13,  summarize a few of the commonly used module commands.

Table 3-13 Commands to Manage Kernel Modules

This Command Does the Following

insmod Inserts a module into the kernel

rmmod Removes a module from the kernel

depmod Determines interdependencies between modules

ksyms Displays a list of symbols along with the name of the module
that defines the symbol

lsmod Lists all currently loaded modules

modinfo Displays information about a kernel module

modprobe Inserts or removes a module or a set of modules intelligently.

(For example, if module A requires B, then modprobe auto-
matically loads B when asked to load A.)
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If you have to use any of these commands, log in as root or type su - in a
terminal window to become root.

To see what modules are currently loaded, type
lsmod

You see a long list of modules that depend on the types of devices installed
on your system.

The list displayed by 1smod includes all types of Linux kernel modules, not
just device drivers. For example, if you use the Ext3 file system, you typically
find two modules — jbd, and ext3 — that are all part of the Ext3 file system
(the latest file system for Linux).

Besides 1smod, one commonly used module command is modprobe. Use
modprobe whenever you need to manually load or remove one or more
modules. The best thing about modprobe is that you don’t need to worry if a
module requires other modules to work. The modprobe command automati-
cally loads any other module needed by a module. On one of my systems, for
example, | manually load the sound driver with the command

modprobe snd-card-0

This command causes modprobe to load everything needed to make sound
work.

You can use modprobe with the -r option to remove modules. For example,
to remove the sound modules, [ use the following command:

modprobe -r snd-card-0

This command gets rid of all the modules that the modprobe snd-card-o0
command had loaded.

Using the /etc/modprobe.conf file

How does the modprobe command know that it needs to load the snd-
intel8x0 driver module when I use a module name snd-card-0? The
answer is in the /etc/modprobe. conf configuration file. That file contains
a line that tells modprobe what it should load when it sees the module name
snd-card-0.

To view the contents of /etc/modprobe. conf, type

cat /etc/modprobe.conf
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On one of my Fedora Core PCs running Linux 2.6, the /etc/modprobe.conf
file contains the following lines:

alias eth0 3c59x
alias snd-card-0 snd-intel8x0
alias usb-controller uhci-hcd

Each line that begins with the keyword alias defines a standard name for
an actual driver module. For example, the first line defines 3c¢59x as the
actual driver name for the alias eth0, which stands for the first Ethernet
card. Similarly, the third line defines snd-intel8x0 as the module to load
when [ use the name snd-card-o0.

The modprobe command consults the /etc/modprobe. conf file to convert
an alias to the real name of a driver module. It also consults the /etc/
modprobe. conf file for other tasks, such as obtaining parameters for driver
modules. For example, you can insert lines that begin with the options
keyword to provide values of parameters that a driver may need.

For example, to set the debug level parameter for the Ethernet driver to 5
(this parameter generates lots of information in /var/log/messages), |
add the following line to the /etc/modprobe. conf file:

options 3c¢59x debug=5

This line specifies 5 as the value of the parameter named debug in the
3¢59x module.

If you want to know the names of the parameters that a module accepts, use
the modinfo command. For example, to view information about the 3c¢59x
driver module, I type

modinfo 3¢59x | more

From the resulting output, I can tell that debug is the name of the parameter
for setting the debug level.

Unfortunately, the information shown by the modinfo command can be
somewhat cryptic. The only saving grace is that you may not have to do
much more than use a graphical utility to configure the device, and the util-
ity takes care of adding whatever is needed to configuration files, such as
/etc/modprobe.conf.
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Scheduling Jobs in Linux
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As a system administrator, you may have to run some programs automati-
cally at regular intervals or execute one or more commands at a specified
time in the future. Your Linux system includes the facilities to schedule jobs
to run at any future date or time you want. You can also set up the system to
perform a task periodically or just once. Here are some typical tasks you can
perform by scheduling jobs on your Linux system:

4+ Back up the files in the middle of the night.
4+ Download large files in the early morning when the system isn’t busy.
4+ Send yourself messages as reminders of meetings.

4+ Analyze system logs periodically and look for any abnormal activities.

You can set up these jobs by using the at command or the crontab facility
of Linux. In the next few sections, I introduce these job-scheduling features
of Linux.

Scheduling one-time jobs

If you want to run one or more commands at a later time, you can use the at
command. The atd daemon — a program designed to process jobs submit-
ted using at — runs your commands at the specified time and mails the
output to you.

Before you try the at command, you need to know that the following config-
uration files control which users can schedule tasks using the at command:

4 /etc/at.allow contains the names of the users who may submit jobs
using the at command.

4 /etc/at.deny contains the names of users not allowed to submit jobs
using the at command.

If these files aren’t present, or if you find an empty /etc/at .deny file, any
user can submit jobs by using the at command. The default in Linux is an
empty /etc/at.deny file; with this default in place, anyone can use the at
command. If you don’t want some users to use at, simply list their user-
names in the /etc/at.deny file.
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To use at to schedule a one-time job for execution at a later time, follow
these steps:

1.

Run the at command with the date or time when you want your com-
mands executed.

When you press Enter, the at> prompt appears, as follows:

at 21:30
at>

This method is the simplest way to indicate the time when you want to
execute one or more commands — simply specify the time in a 24-hour
format. In this case, you want to execute the commands at 9:30 p.m.
tonight (or tomorrow, if it’s already past 9:30 p.m.). You can, however,
specify the execution time in many different ways. (See Table 1-14 for
examples.)

. At the at> prompt, type the commands you want to execute as if

typing at the shell prompt. After each command, press Enter and
continue with the next command. When you finish entering the
commands you want to execute, press Ctrl+D to indicate the end.

Here is an example showing how to execute the ps command at a future
time:

at> ps
at> <EOT>
job 1 at 2006-12-28 21:30

After you press Ctrl+D, the at command responds with a job number
and the date and time when the job will execute.

Table 1-14 Formats for the Time of Execution with the at Command
Command When the Job Will Run

at now Immediately

at now + 15 15 minutes from the current time

minutes

at now + 4 hours 4 hours from the current time

at now + 7 days 7 days from the current time

at noon At noontime today (or tomorrow, if already past noon)
at now next hour Exactly 60 minutes from now

at now next day At the same time tomorrow

at 17:00 tomorrow At 5 p.m. tomorrow

at 4:45pm At 4:45 p.m. today (or tomorrow, if it's already past 4:45 p.m.)
at 3:00 Dec 28, At 3:00 a.m. on December 28, 2006

2006
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After you enter one or more jobs, you can view the current list of scheduled
jobs with the atg command:

atg

The output looks similar to the following:

4 2006-12-28 03:00 a root
5 2006-10-26 21:57 a root
6 2007-10-26 16:45 a root

The first field on each line shows the job number — the same number that
the at command displays when you submit the job. The next field shows the
year, month, day, and time of execution. The last field shows the jobs pend-
ing in the queue named a.

If you want to cancel a job, use the atrm command to remove that job from
the queue. When removing a job with the atrm command, refer to the job by
its number, as follows:

atrm 4
This command deletes job 4 scheduled for 3:00 a.m. December 28, 2006.

When a job executes, the output is mailed to you. Type mail at a terminal
window to read your mail and to view the output from your jobs.

Scheduling recurring jobs

Although at is good for running commands at a specific time, it’s not useful
for running a program automatically at repeated intervals. You have to use
crontab to schedule such recurring jobs — for example, if you want to back
up your files to tape at midnight every evening.

You schedule recurring jobs by placing job information in a file with a spe-
cific format and submitting this file with the crontab command. The cron
daemon — crond — checks the job information every minute and executes
the recurring jobs at the specified times. Because the cron daemon
processes recurring jobs, such jobs are also referred to as cron jobs.

Any output from a cron job is mailed to the user who submits the job. (In
the submitted job-information file, you can specify a different recipient for
the mailed output.)

Two configuration files control who can schedule cron jobs using crontakb:

4 /etc/cron.allow contains the names of the users who may submit
jobs using the crontab command.
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4 /etc/cron.deny contains the names of users not allowed to submit
jobs using the crontab command.

If the /etc/cron.allow file exists, only users listed in this file can sched-
ule cron jobs. If only the /etc/cron.deny file exists, users listed in this file
cannot schedule cron jobs. If neither file exists, the default Linux setup
enables any user to submit cron jobs.

To submit a cron job, follow these steps:

1. Prepare a shell script (or an executable program in any programming
language) that can perform the recurring task you want to perform.

You can skip this step if you want to execute an existing program
periodically.

2. Prepare a text file with information about the times when you want
the shell script or program (from Step 1) to execute, and then submit
this file by using crontab.

You can submit several recurring jobs with a single file. Each line with
timing information about a job has a standard format with six fields —
the first five specify when the job runs, and the sixth and subsequent
fields constitute the actual command that runs. For example, here is a
line that executes the myjob shell script in a user’s home directory at
five minutes past midnight each day:

5 0 * * * SHOME/myjob

Table 1-15 shows the meaning of the first five fields. Note: An asterisk
(*) means all possible values for that field. Also, an entry in any of the
first five fields can be a single number, a comma-separated list of num-
bers, a pair of numbers separated by a dash (indicating a range of num-
bers), or an asterisk.

3. Suppose the text file jobinfo (in the current directory) contains the
job information. Submit this information to crontab with the follow-
ing command:

crontab jobinfo
That’s it! You are set with the cron job. From now on, the cron job runs at
regular intervals (as specified in the job information file), and you receive
mail messages with the output from the job.
To verify that the job is indeed scheduled, type the following command:

crontab -1

The output of the crontab -1 command shows the cron jobs currently
installed in your name. To remove your cron jobs, type crontab -r.
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Table 1-15 Format for the Time of Execution in crontab Files

Field Number Meaning of Field Acceptable Range of Values*
1 Minute 0-59

2 Hour of the day 0-23

3 Day of the month 0-31

4 Month 1-12 (1 means January, 2 means

February, and so on) or the names
of months using the first three
letters — Jan, Feb, Mar, Apr, May,
Jun, Jul, Aug, Sep, Oct, Nov, Dec

5 Day of the week 0-6 (0 means Sunday, 1 means
Monday, and so on) or the three-
letter abbreviations of weekdays —
Sun, Mon, Tue, Wed, Thu, Fri, Sat

* An asterisk in a field means all possible values for that field. For example, if
an asterisk is in the third field, the job is executed every day.

If you log in as root, you can also set up, examine, and remove cron jobs
for any user. To set up cron jobs for a user, use this command:

crontab -u username filename

Here, username is the user for whom you install the cron jobs, and
filename is the file that contains information about the jobs.

Use the following form of crontab command to view the cron jobs for a
user:

crontab -u username -1
To remove a user’s cron jobs, use the following command:
crontab -u username -r

Note: The cron daemon also executes the cron jobs listed in the system-
wide cron job file /etc/crontab. Here’s a typical /etc/crontab file from
a Linux system (type cat /etc/crontab to view the file):

SHELL=/bin/bash
PATH=/sbin:/bin:/usr/sbin: /usr/bin
MAILTO=root

HOME=/

# run-parts

01 * * * * root run-parts /etc/cron.hourly
02 4 * * * root run-parts /etc/cron.daily
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22 4 * * 0 root run-parts /etc/cron.weekly
42 4 1 * * root run-parts /etc/cron.monthly

The first four lines set up several environment variables for the jobs listed in
this file. The MATLTO environment variable specifies the user who receives
the mail message with the output from the cron jobs in this file.

The line that begins with a # is a comment line. The four lines following the
run-parts comment execute the run-parts shell script (located in the
/usr/bin directory) at various times with the name of a specific directory
as argument. Each of the arguments to run-parts — /etc/cron.hourly,
/etc/cron.daily, /etc/cron.weekly, and /etc/cron.monthly — are
directories. Essentially, run-parts executes all scripts located in the direc-
tory that you provide as an argument.

Table 1-16 lists the directories where you can find these scripts and when
they execute. You have to look at the scripts in these directories to know
what executes at these periodic intervals.

Table 1-16 Script Directories for cron Jobs
Directory Name Contents
/etc/cron.hourly Scripts execute every hour
/etc/cron.daily Scripts execute each day
/etc/cron.weekly Scripts execute weekly

/etc/cron.monthly Scripts execute once each month




Chapter 2: Managing
Users and Groups

In This Chapter

» Adding user accounts

+* Understanding the password file
v Managing groups

v~ Exploring the user environment

1 Changing user and group ownerships of files and directories

Linux is a multiuser system, so it has many user accounts. Even if you are
the only user on your system, many servers require a unique username
and group name. Take, for example, the FTP server. It runs under the user-
name ftp. A whole host of system users are not for people but just for running
specific programs.

Also, users can belong to one or more groups. Typically, each username has
a corresponding private group name. By default, each user belongs to that
corresponding private group. However, you can define other groups for the
purpose of providing access to specific files and directories based on group
membership.

User and group ownerships of files are a way to make sure that only the
right people (or the right process) can access the right files and directories.
Managing the user and group accounts is a typical system administration
job. It’s not that hard to do this part of the job, given the tools that come
with Linux. [ show you how in this chapter.

Adding User Accounts

You get the chance to add user accounts when you boot your system for the
first time after installing Linux. The root account is the only one that you
must set up during installation. If you don’t add other user accounts when
you start the system for the first time, you can do so later on, using a GUI
user account manager or the useradd command to add new users on your
system.
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Figure 2-1:
In SUSE, you
can manage
user
accounts
and groups
from YaST.

Creating other user accounts besides root is a good idea. Even if you're the
only user of the system, logging in as a less privileged user is good practice
because that way you can’t damage any important system files inadvertently.
If necessary, you can type su - to log in as root and then perform any system
administration tasks.

Using a GUI user manager to add user accounts

Most Linux distributions come with a GUI tool to manage user accounts.
You can use that GUI tool to add new user accounts. The basic steps,
regardless of the specific GUI tool, involve the following:

1. The tool displays a list of current user accounts and has an Add
button for adding new users.

2. Click the Add button to bring up a dialog box that prompts you for
information about the new user account.

3. Enter the requested information — the username, the password
(enter twice), and the full name of the user.

4. Click the button to create a new account and the GUI tool takes care
of adding the new user account.

For example, in SUSE, select the Security and Users category from the YaST
Control Center’s left side and then click the User Management icon in the right
side of the window. YaST then brings up the User and Group Administration
pane, shown in Figure 2-1, where you can define new user accounts.
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Notice that the pane has two radio buttons: Users and Groups (as shown

in Figure 2-1). Selecting the Users radio button displays the current list of
users from the /etc/passwd file. Selecting the Groups radio button lists
the names of groups from the /etc/group. Initially, the User and Group
Administration tool filters out any system users and groups. However, you
can view the system users by clicking Set Filter and choosing System Users
from the drop-down menu. (System Users refers to user accounts that are not
assigned to human users; rather, these user accounts are used to run vari-
ous services.)

You can Add new Users and Groups or Edit existing Users and Groups from
the pane shown in Figure 2-1.

To add a new user account, click the Add button and enter the information
requested in the New Local User window, as shown in Figure 2-2.
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Fill in the requested information in the window (refer to Figure 2-2), and click
the Accept button. The new user now appears in the list of users in the User
and Group Administration pane.

You can add more user accounts, if you like. When you finish, click the Finish
button in the User and Group Administration pane (refer to Figure 2-1) to
create the new user accounts.
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By default, YaST places all local users in a group named users. Sometimes
you want a user to be in other groups as well, so that the user can access the
files owned by that group. Adding a user to another group is easy. For exam-
ple, suppose [ want to add the username naba to the group called wheel. |
simply type the following command in a terminal window:

usermod -G wheel naba

a\\J

To remove a user account in SUSE, click the username in the list of user
accounts (refer to Figure 2-1). Then click the Delete button.

Using commands to manage user accounts

If you're working from a text console, you can create a new user account by
using the useradd command. Follow these steps to add an account for a
new user:
1. Log in as root.
If you're not already logged in as root, type su - to become root.

2. Type the following useradd command with the -c option to create
the account:

/usr/sbin/useradd -c "Ashley Barkakati" ashley
3. Set the password by using the passwd command, as follows:
passwd ashley
You’re prompted for the password twice. If you type a password that

someone can easily guess, the passwd program rejects it.

The useradd command consults the following configuration files to obtain
default information about various parameters for the new user account:

4 /etc/default/useradd: Specifies the default shell (/bin/bash) and
the default home directory location (/home)

4+ /etc/login.defs: Provides system-wide defaults for automatic group
and user IDs, as well as password-expiration parameters

4 /etc/skel: Contains the default files that useradd creates in the
user’s home directory

Examine these files with the cat or more commands to see what they
contain.
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You can delete a user account by using the userdel command. Simply type
/usr/sbin/userdel username at the command prompt to delete a user’s
account. To wipe out that user’s home directory as well, type /usr/sbin/
userdel -r username.

To modify any information in a user account, use the usermod command.
For example, if | want my username, naba, to have root as the primary
group, I type the following:

usermod -g root naba

To find out more about the useradd, userdel, and usermod commands,
type man useradd, man userdel, or man usermod in a terminal window.

Understanding the /etc/passwd File

Figure 2-3:
This typical
/etc/
passwd
entry illus-
trates the
meaning of
the various
fields.

The /etc/passwd file is a list of all user accounts. It’s a text file and any
user can read it — no special privileges needed. Each line in /etc/passwd
has seven fields, separated by colons (:).

Here is a typical entry from the /etc/passwd file:

naba:x:500:10:Naba Barkakati:/home/naba:/bin/bash

Figure 2-3 explains the meaning of the seven fields in this entry.

Inaba:| x|:500: [10|:Naba Barkakati:|/home/naba| :/bin/bash|

. . ) Login shell
User information (optional)

Home directory
Default group ID

User ID

— Encrypted password (x means
password is stored in /etc/shadow)

— Username (login name)
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As the example shows, the format of each line in /etc/passwd looks
like this:

username:password:UID:GID:GECOS:homedir:shell

Table 2-1 explains the meaning of the seven fields in each /etc/passwd

entry.

Table 2-1 Meaning of the Fields in /etc/passwd File

This Field Contains

username An alphanumeric username, usually eight characters long and unique
(Linux allows usernames to be longer than eight characters, but some
other operating systems do not.)

password When present, a 13-character encrypted password. (An empty field means
that no password is required to access the account. An x means the
password is stored in the /etc/shadow file, which is more secure.)

UID A unique number that serves as the user identifier. (root has a UTD of

0 and usually the UIDs between 1to 100 are reserved for nonhuman
users such as servers; keeping the UID less than 32,767 is best.)

GID The default group ID of the group to which the user belongs (GID 0 s for
group root, other groups are defined in /etc/group, and users can
be, and usually are, in more than one group at a time.)

GECOS Optional personal information about the user. (The £ inger command
uses this field and GECOS stands for General Electric Comprehensive
Operating System, a long-forgotten operating system that's immortalized
by the name of this field in /etc/passwd.)

homedir The name of the user’s home directory

shell The command interpreter (shell), such as bash (/bin/bash), that
executes when this user logs in

Managing Groups
A group is something to which users belong. A group has a name and an

identification number (ID). After a group is defined, users can belong to
one or more of these groups.

You can find all the existing groups listed in /etc/group. For example, here
is the line that defines the group named wheel:

wheel:x:10:root,naba
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As this example shows, each line in /etc/group has the following format,
with four fields separated by colons:

groupname : password:GID:membership

Table 2-2 explains the meaning of the four fields in a group definition.

Table 2-2 Meaning of Fields in /etc/group File

Field Name Meaning

groupname The name of the group (for example, wheel)

password The group password (an x means that the password is stored in the
/etc/shadow file)

GID The numerical group ID (for example, 10)

membership A comma-separated list of usernames that belong to this group

(for example, root , naba)

If you want to create a new group, you can simply use the groupadd com-
mand. For example, to add a new group called class with an automatically
selected group ID, just type the following command in a terminal window
(you have to be logged in as root):

groupadd class

Then you can add users to this group with the usermod command. For exam-
ple, to add the users naba and ashley to the group named class, [ type the
following commands:

usermod -G class naba
usermod -G class ashley

That’s it. Now I check /etc/group to find that it contains the following defi-
nition of class:

class:x:502:naba,ashley
It’s that simple!

If you want to remove a group, use the groupdel command. For example, to
remove a group named class, type

groupdel class

Book V
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Exploring the User Environment

When you log in as a user, you get a set of environment variables that control
many aspects of what you see and do on your Linux system. If you want to
see your current environment, go ahead and type the following command in
a terminal window:

env

(By the way, the printenv command also displays the environment, but
env is shorter.)

The env command prints a long list of lines. That whole collection of lines
is the current environment, and each line defines an environment variable.
For example, the env command displays this typical line:

HOSTNAME=1localhost.localdomain

This line defines the environment variable HOSTNAME, and it’s defined as
localhost.localdomain.

An environment variable is nothing more than a name associated with a
string. For example, the environment variable named PATH is typically
defined as follows for a normal user:

PATH=/usr/local/bin:/bin:/usr/bin: /usr/X11R6/bin

The string to the right of the equal sign (=) is the value of the PATH envi-
ronment variable. By convention, the PATH environment variable is a
sequence of directory names, each name separated from the preceding
one by a colon (:).

Each environment variable has a specific purpose. For example, when the
shell has to search for a file, it simply searches the directories listed in the
PATH environment variable. The shell searches the directories in PATH in the
order of their appearance. Therefore, if two programs have the same name,
the shell executes the one it finds first.

In a fashion similar to the shell’s use of the PATH environment variable, an
editor such as vi uses the value of the TERM environment variable to figure
out how to display the file you edit with vi. To see the current setting of
TERM, type the following command at the shell prompt:

echo S$TERM
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If you type this command in a terminal window, the output is as follows:
xterm

To define an environment variable in bash, use the following syntax:
export NAME=Value

Here, NAME denotes the name of the environment variable, and Value is the
string representing its value. Therefore, you set TERM to the value xterm by
using the following command:

export TERM=xterm

After you define an environment variable, you can change its value by simply
specifying the new value with the syntax NAME=new-value. For example,

to change the definition of TERM to vt 100, type TERM=vt100 at the shell
prompt.

With an environment variable such as PATH, you typically want to append a
new directory name to the existing definition rather than define the PATH
from scratch. For example, if you download and install the Java 2
Development Kit (available from
http://java.sun.com/j2se/1.5.0/download. jsp), you have to

add the location of the Java binaries to PATH. Here’s how you accomplish
that task:

export PATH=$PATH:/usr/java/jdkl.5.0/bin

This command appends the string : /usr/java/jdkl.5.0/bin to the
current definition of the PATH environment variable. The net effect is to
add /usr/java/jdkl.5.0/bin to the list of directories in PATH.

Note: You also can write this export command as follows:

export PATH=${PATH}:/usr/java/jdkl.5.0/bin

After you type that command, you can access programs in the /usr/java/
jdkl1l.5.0/bin directory such as javac, the Java compiler that converts

Java source code into a form that the Java interpreter can execute.

PATH and TERM are only two of a handful of common environment variables.
Table 2-3 lists some of the environment variables for a typical Linux user.

Book V
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Table 2-3 Typical Environment Variables in Linux

Environment Variable Contents

DISPLAY The name of the display on which the X Window System
displays output (typically setto : 0. 0)

HOME Your home directory

HOSTNAME The host name of your system

LOGNAME Your login name

MATL The location of your mail directory

PATH The list of directories in which the shell looks for programs

SHELL Your shell (SHELL=/bin/bash for bash)

TERM The type of terminal

Changing User and Group Ownership of Files

In Linux, each file or directory has two types of owners — a user and a
group. In other words, a user and group own each file and directory. The
user and group ownerships can control who can access a file or directory.

To view the owner of a file or directory, use the 1s -1 command to see the
detailed listing of a directory. For example, here’s a typical file’s information:

-rw-rw-r-- 1 naba naba 40909 Aug 16 20:37
composer. txt

In this example, the first set of characters shows the file’s permission

setting — who can read, write, or execute the file. The third and fourth

fields (in this example, naba naba) indicate the user and group owner of
the file. Each user has a private group that has the same name as the user-
name. So most files’ user and group ownership appear to show the username
twice.

As a system administrator, you may decide to change the group ownership
of a file to a common group. For example, suppose you want to change the

group ownership of the composer. txt file to the class group. To do that,
log in as root and type the following command:

chgrp class composer.txt
This chgrp command changes the group ownership of composer. txt to

class. After I tried this, [ typed Is -1 again to verify the ownership, and
here’s what I got:
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-rw-rw-r-- 1 naba class 40909 Aug 16 20:37 Book V
composer. txt Chapter 2

You can use the chown command to change the user owner. The command
has the following format:

chown username filename

sdnoig pue
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For example, to change the user ownership of a file named sample. jpg to
naba, [ type

chown naba sample.jpg

In fact, chown can change both the user and group owner at the same time.
For example, to change the user owner to naba and the group owner to
class, I type

chown naba.class composer.txt

In other words, you simply append the group name to the username with a
period in between, and use that as the name of the owner.
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Chapter 3: Managing File Systems

In This Chapter

v Navigating the Linux file system
v Sharing files with NFS

1 Backing up and restoring files
1 Mounting the NTFS file system
v Accessing MS-DOS files

A file system refers to the organization of files and directories. As a
system administrator, you have to perform certain operations to
manage file systems on various storage media. For example, you have to
know how to mount — add a file system on a storage medium by attaching
it to the overall Linux file system. You also have to back up important

data and restore files from a backup. Other file-system operations include
sharing files with the Network File System (NFS) and accessing MS-DOS
files. In this chapter, I show you how to perform all the file-system manage-
ment tasks.

Exploring the Linux File System

The files and directories in your PC store information in an organized
manner, just like paper filing systems. When you store information on paper,
you typically put several pages in a folder and then store the folder in a file
cabinet. If you have many folders, you probably have some sort of filing
system. For example, you may label each folder’s tab and then arrange them
alphabetically in the file cabinet. You probably have several file cabinets,
each with lots of drawers, which, in turn, contain folders full of pages.

Operating systems such as Linux organize information in your computer in
a manner similar to your paper filing system. Linux uses a file system to
organize all information in your computer. Of course, the storage medium
isn’t a metal file cabinet and paper. Instead, Linux stores information on
devices such as hard drives, floppy disk drives, and CD-ROM drives.

To draw an analogy between your computer’s file system and a paper filing
system, think of a disk drive as the file cabinet. The drawers in the file cabi-
net correspond to the directories in the file system. The folders in each
drawer are also directories — because a directory in a computer file system
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Figure 3-1:
It's a bit of a
stretch, but
you can
think of the
Linux file
system as
similar to

a filing
cabinet.

can contain other directories. You can think of files as the pages inside the
folder — and that’s where the actual information is stored. Figure 3-1 illus-
trates the analogy between a file cabinet and the Linux file system.
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The Linux file system has a hierarchical structure — directories can contain
other directories, which in turn contain individual files.

Everything in your Linux system is organized in files and directories in the
file system. To access and use documents and programs on your system,
you have to be familiar with the file system.

Understanding the file-system hierarchy

The Linux file system is organized like a tree, with a root directory from
which all other directories branch out. When you write a complete path-
name, the root directory is represented by a single slash (/). Then there is
a hierarchy of files and directories. Parts of the file system can be in different
physical drives or different hard drive partitions.

Linux uses a standard directory hierarchy. Figure 3-2 shows some of the
standard parts of the Linux file system. Of course, you can create new
directories anywhere in this structure.

Write the name of any file or directory by concatenating the names of directo-
ries that identify where that file or directory is and using the forward slash (/)
as a separator. For example, in Figure 3-2, the usr directory at the top level

is written as /usr because the root directory (/) contains usr. On the other



Figure 3-2:
The Linux
file system
uses a
standard
directory
hierarchy
similar to
this one.
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hand, the X11R6 directory is inside the usr directory, which is inside the
root directory (/). Therefore, the X11R6 directory is uniquely identified by
the name /usr/X11Ré6. This type of full name is called a pathname because
the name identifies the path you take from the root directory to reach a file.
Thus, /usr/X11R6 is a pathname.

|bin ||b00t||dev|| etc ||home|| lib ||mnt|| opt ||r00t||sbin||tmp| usr |var|

[X11Rs6] [ bin | [include] [ lib | [local | [ shin | [share][ src |

The Filesystem Hierarchy Standard (FHS) specifies the organization of files and
directories in UNIX-like operating systems such as Linux. FHS defines a stan-
dard set of directories and their intended use. The FHS, if faithfully adopted
by all Linux distributions, should help improve the interoperability of appli-
cations, system administration tools, development tools, and scripts across
all Linux distributions. FHS even helps the system documentation as well as
books like this one because the same description of the file system applies
to all Linux distributions. Version 2.3 of FHS was announced on January 29,
2004. FHS 2.3 is part of the Linux Standard Base version 3.0 (LSB 3.0), which
was released on July 1, 2005. LSB 3.0 (see www . 1linuxbase.org) is a set of
binary standards aimed at reducing variations among the Linux distributions
and promoting portability of applications. To find out more about FHS, check
out the FHS home page at www.pathname.com/fths.

Each of the standard directories in the Linux file system has a specific pur-
pose. Table 3-1 summarizes these directories.

Table 3-1 Standard Directories in Linux File System
Directory Used to Store

/bin Executable files for user commands (for use by all users)
/boot Files needed by the boot loader to load the Linux kernel
/dev Device files

/etc Host-specific system configuration files

(continued)
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Table 3-1 (continued)

Directory Used to Store

/home User home directories

/1lib Shared libraries and kernel modules

/media Mount point for removable media

/mnt Mount point for a temporarily mounted file system

/opt Add-on application software packages

/root Home directory for the root user

/sbin Utilities for system administration

/srv Data for services (such as Web and FTP) offered by this system

/ tmp Temporary files

The /usr Hierarchy Secondary Directory Hierarchy

/usr/X11R6 X Window System, version 11 release 6

/usr/bin Most user commands

/usr/include Directory for include files — files that are inserted into source code
of applications by using various directives — used in developing
Linux applications

/usr/1lib Libraries used by software packages and for programming

/usr/libexec Libraries for applications

/usr/local Any local software

/usr/sbin Nonessential system administrator utilities

/usr/share Shared data that does not depend on the system architecture
(whether the system is an Intel PC or a Sun SPARC workstation)

/usr/src Source code

The /var Hierarchy Variable Data

/var/cache Cached data for applications

/var/lib Information relating to the current state of applications

/var/lock Lock files to ensure that a resource is used by one application only

/var/log Log files organized into subdirectories

/var/mail User mailbox files

/var/opt Variable data for packages stored in the /opt directory

/var/run Data describing the system since it was booted

/var/spool Data that's waiting for some kind of processing

/var/tmp Temporary files preserved between system reboots

/var/yp

Network Information Service (NIS) database files
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Mounting a device on the file system Book V

The storage devices that you use in Linux contain Linux file systems. Each Chapter3
device has its own local file system consisting of a hierarchy of directories.
Before you can access the files on a device, you have to attach the device’s
directory hierarchy to the tree that represents the overall Linux file system.

Mounting is the operation you perform to cause the file system on a physical
storage device (a hard drive partition or a CD-ROM) to appear as part of the
Linux file system. Figure 3-3 illustrates the concept of mounting.
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Figure 3-3:
You have to
mount a
device on
the Linux file
system
before
accessing it.
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/dev/cdrom /dev/fd0

Figure 3-3 shows each device with a name that begins with /dev. For exam-
ple, /dev/cdrom is the first DVD/CD-ROM drive and /dev/£d0 is the floppy
drive. These physical devices are mounted at specific mount points on the
Linux file system. For example, the DVD/CD-ROM drive, /dev/cdrom, is
mounted on /media/cdrom in the file system. After mounting the CD-ROM
in this way, the Fedora directory on a CD-ROM or DVD-ROM appears as
/media/cdrom/Fedora in the Linux file system.
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You can use the mount command to manually mount a device on the Linux
file system at a specified directory. That directory is the mount point. For
example, to mount the DVD/CD-ROM drive at /media/cdrom directory, you
type the following command (after logging in as root):

mount /dev/cdrom /media/cdrom

The mount command reports an error if the DVD/CD-ROM device is mounted
already or if no CD or DVD media is in the drive. Otherwise, the mount oper-
ation succeeds, and you can access the DVD or CD’s contents through the
/media/cdrom directory.

You can use any directory as the mount point. If you mount a device on a
non-empty directory, however, you cannot access the files in that directory
until you unmount the device by using the umount command. Therefore,
always use an empty directory as the mount point.

To unmount a device when you no longer need it, use the umount command.
For example, for a DVD/CD-ROM device with the device name /dev/cdrom,
type the following command to unmount the device:

umount /dev/cdrom

The umount command succeeds as long as no one is using the DVD/CD-ROM.
If you get an error when trying to unmount the DVD/CD-ROM, check to see if
the current working directory is on the DVD or CD. If you're currently work-
ing in one of the DVD/CD-ROM’s directories, that also qualifies as a use of the
DVD/CD-ROM.

Examining the /etc/(stab file

The mount command has the following general format:
mount device-name mount-point

However, you can mount by specifying only the CD-ROM device name or the
mount-point name, provided there is an entry in the /etc/fstab file for
the CD-ROM mount point. That entry specifies the CD-ROM device name
and the file system type. That’s why you can mount the CD-ROM with a
shorter mount command.

For example, in Debian, you can mount the CD-ROM by typing one of the fol-
lowing commands:

mount /dev/cdrom
mount /media/cdrom
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The /etc/fstabfile is a configuration file — a text file containing information
that the mount and umount commands use. Each line in the /etc/fstab
file provides information about a device and its mount point in the Linux file
system. Essentially, the /etc/fstab file associates various mount points
within the file system with specific devices, which enables the mount com-
mand to work from the command line with only the mount point or the
device as argument.

Here is a /etc/fstab file from a SUSE system. (The file has a similar format
in other Linux distributions.)

/dev/hdall / reiserfs acl,user_xattr 11
/dev/hda’7 /boot ext3 acl,user_xattr 12
/dev/hdab /datal auto noauto, user 00
/dev/hda9% /data2 auto noauto, user 00
/dev/hdal0 /data3 auto noauto, user 00
/dev/hdab /datad auto noauto, user 00
/dev/hda2 /windows/C ntfs
ro,users,gid=users,umask=0002,nls=utf8 0 0

/dev/hda8 swap swap pri=42 00
devpts /dev/pts devpts mode=0620,gid=5 00
proc /proc proc defaults 00
usbfs /proc/bus/usb usbfs noauto 00
sysfs /sys sysfs noauto 00

/dev/cdrecorder /media/cdrecorder subfs
fs=cdfss, ro,procuid, nosuid, nodev, exec, iocharset=utf8 0 0
/dev/£d0 /media/floppy subfs
fs=floppyfss,procuid,nodev,nosuid, sync 0 0

The first field on each line shows a device name, such as a hard drive parti-
tion. The second field is the mount point, and the third field indicates the
type of file system on the device. You can ignore the last three fields for now.

This /etc/fstab file shows that the /dev/hda8 device functions as a swap
device for virtual memory, which is why both the mount point and the file-
system type are set to swap.

The Linux operating system uses the contents of the /etc/£fstab file to
mount various file systems automatically. During Linux startup, the init
process executes a shell script that runs the mount -a command. That com-
mand reads the /etc/fstab file and mounts all listed file systems (except
those with the noauto option). The third field on each line of /etc/fstab
specifies the type of file system on that device, and the fourth field shows a
comma-separated list of options that the mount command uses when mount-
ing that device on the file system. Typically, you find the defaults option in
this field. The defaults option implies — among other things — that the
device mounts at boot time, that only the root user can mount the device,
and that the device mounts for both reading and writing. If the options include
noauto, the device doesn’t mount automatically as the system boots.

Book V
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In Fedora Core, you often find the managed option in the fourth field of
/etc/fstab entries. The managed option indicates that the line was
added to the fstab file by the HAL (hardware abstraction layer) daemon
that runs the fstab-sync command to add entries in the /etc/fstab file
for each removable drive that it detects. You typically find that the entries
for DVD/CD-ROM drive (/dev/hdc in most systems) and floppy drive
(dev/£d0) have the managed option in the fourth field.

Sharing Files with NFS
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Sharing files through the NFS is simple and involves two basic steps:

4+ On the NFS server, export one or more directories by listing them in the
/etc/exports file and by running the /usr/sbin/exportfs command.
In addition, you must run the NFS server.

4 On each client system, use the mount command to mount the directo-
ries the server has exported.

How you start the NFS server depends on the Linux distribution. If a GUI
sysadmin tool is available, you can start the NFS server from the GUI tool.
Otherwise, you can type a command in a terminal window to start the NFS
server. For example, in Debian, you can type invoke-rc.d nfs-kernel-server
start and invoke-rc.d nfs-common start to start the NFS server. In Fedora
Core, type service nfs start. In SUSE, you can use YaST Control Center
(Main Menu=>System=>YaST) to start the NFS server. (It’s in the Network
Services category.) In Xandros, you can start the NFS server from the
Xandros Control Center (Main Menu=>Control Center) or you can type
invoke-rc.d nfs-user-server start in a terminal window.

The only problem in using NFS is that each client system must support it.
Most PCs don’t come with NFS — that means you have to buy NFS software
separately if you want to share files by using NFS. If, however, all systems on
your LAN run Linux (or other variants of UNIX with built-in NFS support),
using NFS makes sense.

NFS has security vulnerabilities. Therefore, do not set up NFS on systems
directly connected to the Internet.

In the upcoming section, [ walk you through an NFS setup, using an example
of two Linux PCs on a LAN.

Exporting a file system with NFS
Start with the server system that exports — makes available to the client
systems — the contents of a directory. On the server, you must run the NFS
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service and also designate one or more file systems to be exported to the
client systems.

To export a file system, you have to add an appropriate entry to the
/etc/exports file. For example, suppose you want to export the /home
directory and you want to enable the host named LNBP75 to mount this file
system for read-and-write operations. (You can use a host’s IP address in
place of the host name.) You can do so by adding the following entry to the
/etc/exports file:

/home LNBP75 (rw)
If you use the IP address of a host, the entry might look like this:
/home 192.168.0.2 (rw)

This specifies that 192.168.0.2 is the IP address of the host that’s allowed full
access to the /home directory.

After adding the entry in the /etc/exports file, start the NFS server using
a method appropriate for your Linux distribution. For example, in Fedora
Core, I log in as root and type the following command in a terminal window:

service nfs start

When the NFS service is up, the server side of NFS is ready. Now you can
try to mount the exported file system from a client system and access the
exported file system.

If you ever make any changes to the exported file systems listed in the
/etc/exports file, remember to restart the NFS service. For example, in
Fedora Core, I type service nfs restart in a terminal window. In Xandros,

[ type invoke-rc.d nfs-user-server restart.

Mounting an NFS file system

To access an exported NFS file system on a client system, you have to mount
that file system on a mount point — which is, in practical terms, nothing more
than a local directory. For example, suppose you want to access the /home
directory exported from the server named LNBP200 at the local directory
/mnt/1nbp200 on the client system. To do so, follow these steps:

1. Log in as root and create the directory with the following command:
mkdir /mnt/lnbp200

2. Type the following command to perform the mount operation:
mount 1nbp200:/home/public /mnt/1lnbp200

Book V
Chapter 3
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If you know only the IP address of the server, replace the host name
(in this case, 1nbp200) with the IP address.

3. Change the directory to /mnt/1nbp200 with the command cd
/mnt/1nbp200.

Now you can view and access exported files from this directory.

To confirm that the NFS file system is indeed mounted, log in as root on the
client system and type mount in a terminal window. You see a line similar to
the following one about the NFS file system:

1nbp200:/home/public on /mnt/lnbp200 type nfs (rw,addr=192.168.1.200)

Backing Up and Restoring Files

SMBER
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Backing up and restoring files is a crucial system administration task. If some-
thing happens to your system’s hard drive, you have to rely on the backups
to recover important files. Here I present some back up strategies, describe
several back up media, and explain how to back up and restore files by using
the tape archiver (tar) program that comes with Linux. Also, you find out
how to perform incremental and automatic backups on tapes.

If you have a CD burner, you can also back up files by recording them on a
CD-R. Consult Book II, Chapter 4, for information on what application you
can use to burn a data CD.

Selecting a back up strateqy and media

Your Linux system’s hard drive contains everything you need to keep the
system running — as well as other files (such as documents and databases)
that keep your business running. You have to back up these files so you
can recover quickly and bring the system back to normal in case the hard
drive crashes. Typically, you have to follow a strict regimen of regular
backups because you can never tell when the hard drive may fail or the
file system may get corrupted. To implement such a regimen, first decide
which files you want to back up, how often, and what back up storage
media to use. This process is what | mean by selecting a back up strategy
and back up media.

Your choice of back up strategy and back up media depends on your assess-
ment of the risk of business disruption due to hard drive failure. Depending
on how you use your Linux system, a disk failure may or may not have much
impact on you.
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For example, if you use your Linux system as a learning tool (to find out
more about Linux or programming), all you may need are back up copies of
some system files required to configure Linux. In this case, your back up
strategy can be to save important system configuration files on one or more
floppies every time you change any system configuration.

On the other hand, if you use your Linux system as an office server that pro-
vides shared file storage for many users, the risk of business disruption due
to disk failure is much higher. In this case, you have to back up all the files
every week and back up any new or changed files every day. You can perform
these back ups in an automated manner (using the job-scheduling features
that I describe in Chapter 1 of this minibook). Also, you probably need a
back up storage medium that can store large amounts (many gigabytes) of
data. In other words, for high-risk situations, your back up strategy is more
elaborate and requires additional equipment (such as a tape drive).

Your choice of back up media depends on the amount of data you have to
back up. For a small amount of data (such as system configuration files), you
can use floppy disks or USB flash drives as the back up media. If your PC has
a Zip drive, you can use Zip disks as back up media; these are good for back-
ing up a single-user directory. To back up entire servers, use a tape drive,
typically a 4mm or 8mm tape drive that connects to a SCSI controller. Such
tape drives can store several gigabytes of data per tape, and you can use
them to back up an entire file system on a single tape.

When backing up files to these media, you have to refer to the back up device
by name. Table 3-2 lists device names for some common back up devices.

Table 3-2 Device Names for Common Back up Devices

Backup Device Linux Device Name

Floppy disk /dev/£d0

IDE Zip drive /dev/hdc4 or /dev/hdd4

SCSI Zip drive /dev/sda (assuming it's the first SCSI drive — otherwise, the
device name depends on the SCSI ID)

SCSI tape drive /dev/st0 or /dev/nst0 (The n prefix means that the tape isn't

rewound after files copy to the tape.)

Commercial back up utilities for Linux

In the next section, I explain how to back up and restore files using the
tape archiver (tar) program that comes with Linux. Although you can
manage backups with tar, a number of commercial back up utilities come
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with graphical user interfaces and other features to simplify backups.
Here are some well-known commercial back up utilities for Linux:

4+ BRU: A back up and restore utility from the TOLIS Group, Inc.
(www.tolisgroup.com)

4+ LONE-TAR: Tape back-up software package from Lone Star Software
Corp. (www.cactus.com)

4+ Arkeia: Back up and recovery software for heterogeneous networks
from Arkeia (www.arkeia.com)

4+ Bare Metal Plus: Back up and recovery software from UniTrends
(www.unitrends.com)

4 BrightStor ARCserve Backup for Linux: Data-protection technology for
Linux systems from Computer Associates (www3 .ca.com/solutions/
product.asp?id=3370)

Using the tape archiver — tar

You can use the tar command to archive files to a device, such as a floppy
disk or tape. The tar program creates an archive file that can contain other
directories and files and (optionally) compress the archive for efficient stor-
age. The archive is then written to a specified device or another file. In fact,
many software packages are distributed in the form of a compressed tar file.

The command syntax of the tar program is as follows:
tar options destination source

Here, options are usually specified by a sequence of single letters, with
each letter specifying what tar does. The destination is the device name
of the back up device. And source is a list of file or directory names denot-
ing the files to back up.

Backing up and restoring a single-volume archive

For example, suppose you want to back up the contents of the /etc/xX11
directory on a floppy disk. Log in as root, place a disk in the floppy drive,
and type the following command:

tar zcvi /dev/£fd0 /etc/X11l

The tar program displays a list of filenames as each file copies to the com-
pressed tar archive on the floppy disk. In this case, the options are zcvf,



Backing Up and Restoring Files 43 7

the destination is /dev/£d0 (the floppy disk), and the source is the /etc/X11
directory (which implies all its subdirectories and their contents). You can
use a similar tar command to back up files to a tape — simply replace
/dev/£d0 with the tape device — such as /dev/st0 for a SCSI tape drive.

Table 3-3 defines a few common tar options.

Table 3-3 Common tar Options

Option  Does the Following

Creates a new archive

Specifies the name of the archive file or device on the next field in the command line

Specifies a multivolume archive. (The next section describes multivolume archives.)

Lists the contents of the archive

Displays verbose messages

X< || R|Imh|aQ

Extracts files from the archive

z Compresses the tar archive using gzip

To view the contents of the tar archive you create on the floppy disk, type
the following command:

tar ztf /dev/£d0

You see a list of the filenames (each begins with /etc/x11) indicating what’s
in the backup. In this tar command, the t option lists the contents of the
tar archive.

To extract the files from a tar backup, follow these steps while logged in
as root:

1. Change the directory to /tmp by typing this command:

cd /tmp

This step is where you can practice extracting the files from the tar
backup. For a real backup, change the directory to an appropriate
location (typically, you type cd /).

2. Type the following command:
tar zxvf /dev/£d0

This tar command uses the x option to extract the files from the archive
stored on /dev/£d0 (the floppy disk).
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Now if you check the contents of the /tmp directory, you notice that the tar
command creates an etc/X11 directory tree in /tmp and restores all the
files from the tar archive into that directory. The tar command strips off
the leading / from the filenames in the archive and restores the files in the
current directory. If you want to restore the /etc/X11 directory from the
archive on the floppy, use this command:

tar zxvft /dev/fd0 -C /

The / at the end of the command denotes the directory where you want to
restore the backup files.

You can use the tar command to create, view, and restore an archive. You can
store the archive in a file or in any device you specify with a device name.

Backing up and restoring a multivolume archive

Sometimes the capacity of a single storage medium is less than the total
storage space needed to store the archive. In this case, you can use the M
option for a multivolume archive — meaning the archive can span multiple
tapes or floppies. Note, however, that you cannot create a compressed, mul-
tivolume archive. That means you have to drop the z option. To see how
multivolume archives work, log in as root, place one disk in the floppy
drive, and type the following tar command:

tar cviM /dev/£fd0 /usr/share/doc/ghostscript*

Note: The M option is in the option letters; it tells tar to create a multivol-
ume archive. The tar command prompts you for a second floppy when the
first one is filled. Take out the first floppy and insert another floppy when
you see the following prompt:

Prepare volume #2 for '/dev/£fd0' and hit return:

When you press Enter, the tar program continues with the second floppy.
In this example, you need only two floppies to store the archive; for larger
archives, the tar program continues to prompt for floppies in case more
floppies are needed.

To restore from this multivolume archive, type cd /tmp to change the
directory to /tmp. (I use the /tmp directory for illustrative purposes here,
but you have to use a real directory when you restore files from archive.)
Then type

tar xvifM /dev/£fd0
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The tar program prompts you to feed the floppies as necessary.

Use the du -s command to determine the amount of storage you need for
archiving a directory. For example, type du -s /etc to see the total size of the
/etc directory in kilobytes. Here’s a typical output of that command:

35724 /etc

The resulting output shows that the /etc directory requires at least 35,724K
of storage space to back up.

Backing up on tapes

Although backing up on tapes is as simple as using the right device name in
the tar command, you do have to know some nuances of the tape device to
use it well. When you use tar to back up to the device named /dev/st0
(the first SCSI tape drive), the tape device automatically rewinds the tape
after the tar program finishes copying the archive to the tape. The /dev/st0
device is called a rewinding tape device because it rewinds tapes by default.

If your tape can hold several gigabytes of data, you may want to write sev-
eral tar archives — one after another — to the same tape (otherwise much
of the tape may be left empty). If you plan to do so, your tape device can’t
rewind the tape after the tar program finishes. To help you with scenarios
like this one, several Linux tape devices are non-rewinding. The non-rewinding
SCSI tape device is called /dev/nst0. Use this device name if you want to
write one archive after another on a tape.

After each archive, the non-rewinding tape device writes an end-of-file (EOF)
marker to separate one archive from the next. Use the mt command to con-
trol the tape — you can move from one marker to the next or rewind the
tape. For example, after you finish writing several archives to a tape using
the /dev/nst0 device name, you can force the tape to rewind with the fol-
lowing command:

mt -f /dev/nst0 rewind

After rewinding the tape, you can use the following command to extract files
from the first archive to the current disk directory:

tar xvf /dev/nstO

After that, you must move past the EOF marker to the next archive. To do so,
use the following mt command:

mt —-f /dev/nst0 fsf 1
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This positions the tape at the beginning of the next archive. Now use the tar
xvf command again to read this archive.

If you save multiple archives on a tape, you have to keep track of the archives
yourself. The order of the archives can be hard to remember, so you may be
better off simply saving one archive per tape.

Performing incremental backups

Suppose you use tar to back up your system’s hard drive on a tape. Because
such a full backup can take quite some time, you don’t want to repeat this
task every night. (Besides, only a small number of files may have changed
during the day.) To locate the files that need backing up, you can use the
find command to list all files that have changed in the past 24 hours:

find / -mtime -1 -type f —-print

This command prints a list of files that have changed within the last day.
The -mtime -1 option means you want the files that were last modified less
than one day ago. You can now combine this find command with the tar
command to back up only those files that have changed within the last day:

tar cvf /dev/st0 “find / -mtime -1 -type f -print’

When you place a command between single back quotes, the shell executes
that command and places the output at that point in the command line.
The net result is that the tar program saves only the changed files in the
archive. What this process gives you is an incremental backup of only the
files that have changed since the previous day.

Performing automated backups

In Chapter 1 of this minibook, I show you how to use crontab to set up
recurring jobs (called cron jobs). The Linux system performs these tasks
at regular intervals. Backing up your system is a good use of the crontab
facility. Suppose your backup strategy is as follows:

4+ Every Sunday at 1:15 a.m., your system backs up the entire hard drive on
the tape.

4+ Monday through Saturday, your system performs an incremental backup
at 3:10 a.m. by saving only those files that have changed during the past
24 hours.

To set up this automated back up schedule, log in as root and type the fol-
lowing lines in a file named backups (this example assumes that you use a
SCSI tape drive):
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15 1 * * 0 tar zcvf /dev/st0 / Book V
10 3 * * 1-6 tar zcvf /dev/st0 ‘find / -mtime -1 -type f -print’ Chapter 3

Next, submit this job schedule by using the following crontab command:
crontab backups
Now you are set for an automated backup. All you need to do is to place a

new tape in the tape drive every day. Remember to also give each tape an
appropriate label.
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Accessing a DOS/Windows File System

If you have Microsoft Windows 95/98/Me installed on your hard drive,
you’ve probably already mounted the DOS/Windows partition under Linux.
If not, you can easily mount DOS/Windows partitions in Linux. Mounting
makes the DOS/Windows directory hierarchy appear as part of the Linux
file system.

Mounting a DOS/Windows disk partition

To mount a DOS/Windows hard drive partition or floppy in Linux, use the
mount command but include the option -t vfat to indicate the file-system
type as DOS. For example, if your DOS partition happens to be the first parti-
tion on your IDE (Integrated Drive Electronics) drive and you want to mount
it on /dosc, use the following mount command:

mount -t vfat /dev/hdal /dosc

The -t vfat part of the mount command specifies that the device you
mount — /dev/hdal — has an MS-DOS file system. Figure 3-4 illustrates
the effect of this mount command.

Figure 3-4 shows how directories in your DOS partition map to the Linux file
system. What was the C: \DOS directory under DOS becomes /dosc/dos
under Linux. Similarly, C: \WINDOWS now is /dosc/windows. You probably
can see the pattern. To convert a DOS filename to Linux (when you mount
the DOS partition on /dosc), perform the following steps:

1. Change the DOS names to lowercase.
2. Change C:\ to /dosc/.
3. Change all backslashes (\) to slashes (/).
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Figure 3-4:
Here's how
you mount
a DOS par-
tition on
the /dosc
directory.

/(root) Linux File System

/bin /boot /dev /dosc  /etc  /media ... /shin fusr

/dosc/dos  /dosc/windows ...

DOS Partition
/dev/hda1

/DOS  /WINDOWS

Mounting DOS floppy disks

Just as you mount a DOS hard drive partition on the Linux file system, you
can also mount a DOS floppy disk. You must log in as root to mount a floppy,
but you can follow the steps | show in the latter part of this section to set up
your system so that any user can mount a DOS floppy disk. You also have to
know the device name for the floppy drive. By default, Linux defines the fol-
lowing two generic floppy device names:

4+ /dev/£do0 is the A drive (the first floppy drive)

4+ /dev/£dl is the B drive (the second floppy drive, if you have one)
As for the mount point, you can use any empty directory in the file system as
the mount point, but the Linux system comes with a directory, /media/
floppy, specifically for mounting a floppy disk.

To mount a DOS floppy disk on the /media/floppy directory, put the
floppy in the drive and type the following command:

mount -t vfat /dev/fd0 /media/floppy
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After you mount the floppy, you can copy files to and from the floppy by using
the Linux copy command (cp). To copy the file gnomel . pcx from the current
directory to the floppy, type the following:

cp gnomel.pcx /media/floppy
Similarly, to see the contents of the floppy disk, type the following:
ls /media/floppy

If you want to remove the floppy disk from the drive, first unmount the floppy
drive. Unmounting removes the association between the floppy disk’s file
system and the mount point on the Linux file system. Use the umount com-
mand to unmount the floppy disk like this:

umount /dev/£fd0

You can set up your Linux system so that any user can mount a DOS floppy.
To enable any user to mount a DOS floppy in the A drive on the /a directory,
for example, perform the following steps:

1. Log in as root.

2. Create the /a directory (the mount point) by typing the following
command in a terminal window:

mkdir /a

3. Edit the /etc/fstab file in a text editor (such as vi or emacs) by insert-
ing the following line, and then save the file and quit the editor:

/dev/£d0 /a vfat noauto, user 00

The first field in that line is the device name of the floppy drive
(/dev/£d0); the second field is the mount directory (/a); the third field
shows the type of file system (vfat). The user option (which appears
next to noauto) is what enables all users to mount DOS floppy disks.

4. Log out and then log back in as a normal user.

5. To confirm that you can mount a DOS floppy as a normal user and not
just as root, insert a DOS floppy in the A drive and type the following
command:

mount /a

The mount operation succeeds, and you see a listing of the DOS floppy
when you type the command Is /a.

6. To unmount the DOS floppy, type umount /a.
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Mounting an NTFS partition

Nowadays, most PCs come with Windows XP or Windows 2000 pre-installed
on the hard drive. Both Windows XP and 2000, as well as Windows NT, typi-
cally use the NT File System (NTFS). Linux supports read-only access to
NTFS partitions, and many distributions come with the ntfs. ko kernel
module that’s needed to access an NTFS partition.

If you have installed Linux on a Windows XP system and want to access files
on the NTFS partition but your distribution does not include the ntfs.ko
module, you can build the kernel after enabling an NTFS module during the
kernel configuration step. (See Chapter 5 of this minibook for detailed
instructions on configuring, building, and installing the kernel.)

After rebuilding and booting from the new kernel, log in as root, and type
the following command to create a mount point for the NTFS partition.
(In this case, I'm creating a mount point in the /mnt directory.)

mkdir /mnt/xp
Now, you can mount the NTFS partition with the following command:
mount /dev/hda2 /mnt/xp -t ntfs -r -o umask=0222

“@N\BER Replace /dev/hda2 with the device name for the NTFS partition on your

> system. On most PCs that come with Windows XP pre-installed, the NTFS par-
tition is the second one (/dev/hda2) — the first partition (/dev/hdal) is
usually a hidden partition used to hold files used for Windows XP installation.

Using mtools

One way to access the MS-DOS file system is to first mount the DOS hard
drive or floppy disk by using the mount command and then use regular
Linux commands, such as 1s and cp, to work with the mounted DOS file
system. This approach of mounting a DOS file system is fine for hard drives.
Linux can mount the DOS partition automatically at startup, and you can
access the DOS directories on the hard drive at any time.

If you want a quick directory listing of a DOS floppy disk, however, mounting
can soon become quite tedious. First, you have to mount the floppy drive.
Then you must use the 1s command. Finally, you must use the umount com-
mand before ejecting the floppy out of the drive.

This situation is where the mtools package comes to the rescue. The mtools
package implements most common DOS commands; the commands use the
same names as in DOS except that you add an m prefix to each command.

Thus the command for getting a directory listing is mdir, and mcopy copies
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files. The best part of mtools is the fact that you don’t have to mount the
floppy disk to use the mtools commands.

Because the mtools commands write to and read from the physical device
(floppy disk), you must log in as root to perform these commands. If you
want any user to access the mtools commands, you must alter the permis-
sion settings for the floppy drive devices. Use the following command to
permit anyone to read from and write to the first floppy drive:

chmod o+rw /dev/£d0

Trying mtools

To try out mtools, follow these steps:

1. Place an MS-DOS floppy disk in your system’s A drive.
2. Type mdir.

You see the directory of the floppy disk (in the standard DOS directory-
listing format).

Typically, you use the mtools utilities to access the floppy disks. The default
configuration file, /etc/mtools.conf, is set up to access the floppy drive
as the A drive. Although you can edit that file to define C and D drives for
your DOS hard drive partitions, you can access the hard drive partitions as
well by using the Linux mount command to mount them. Because you can
mount the hard drive partitions automatically at startup, accessing them
through the Linux commands is normally just as easy.

Understanding the /etc/mtools.conf file

The mtools package works with the default setup, but if you get any errors,
check the /etc/mtools. conf file. That file contains the definitions of the
drives (such as A, B, and C) that the mtools utilities see. Following are a few
lines from a typical /etc/mtools. conf file:

drive a: file="/dev/fd0" exclusive mformat_only
drive b: file="/dev/fdl" exclusive mformat_only

# First SCSI hard disk partition

#drive c: file="/dev/sdal"

# First IDE hard disk partition on a Windows 98 PC
drive c: file="/dev/hdal"

# Internal IDE Zip drive

drive e: file="/dev/hdd4" exclusive

The pound sign (#) indicates the start of a comment. Each line defines a drive
letter, the associated Linux device name, and some keywords that indicate
how to access the device. In this example, the first two lines define drives

A and B. The third noncomment line defines drive C as the first partition on
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the first IDE drive (/dev/hdal). If you have other DOS drives (D, for exam-
ple), you can add another line that defines drive D as the appropriate disk
partition.

If your system’s A drive is a high-density, 3.5-inch drive, you don’t need to
change anything in the default /etc/mtools. conf file to access the floppy
drive. If you also want to access any DOS partition in the hard drive, uncom-
ment and edit an appropriate line for the C drive.

You also can access lomega Zip drives through mtools. Simply specify a
drive letter and the appropriate device’s filename. For built-in IDE (ATAPI)
Zip drives, try /dev/hdd4 as the device file and add the following line in
the /etc/mtools.conf file:

drive e: file="/dev/hdd4"

After that, you can use mtools commands to access the Zip drive (refer to it
as the E drive). For example, to see the directory listing, place the Zip disk in
the Zip drive and type:

mdir e:

Learning the mtools commands

The mtools package is a collection of utilities. So far, [ have been using
mdir — the mtools counterpart of the DIR command in DOS. The other
mtools commands are fairly easy to use.

If you know MS-DOS commands, using the mtools commands is easy. Type
the DOS command in lowercase letters and remember to add m in front of each
command. Because the Linux commands and filenames are case-sensitive,
you must use all lowercase letters as you type mtools commands.

Table 3-4 summarizes the commands available in mtools.

Table 3-4 The mtools Commands
mtools Utility MS-DOS Command  The mtools Utility Does the Following
(If Any)
mattrib ATTRIB Changes MS-DOS file-attribute flags
mbadblocks Tests a floppy disk and marks the bad blocks in
the file allocation table (FAT)
mcd CD Changes an MS-DOS directory
mcopy COPY Copies files between MS-DOS and Linux
mdel DEL or ERASE Deletes an MS-DOS file

mdeltree DELTREE Recursively deletes an MS-DOS directory
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mtools Utility MS-DOS Command  The mtools Utility Does the Following

(If Any)

mdir DIR Displays an MS-DOS directory listing

mdu Lists space that a directory and its contents
occupy

mformat FORMAT Places an MS-DOS file system on a low-level-
formatted floppy disk (Use £fdformat to low-
level-format a floppy disk in Linux.)

minfo Gets information about an MS-DOS file system

mkmanifest Makes a list of short name equivalents

mlabel LABEL Initializes an MS-DOS volume label

mmd MD or MKDIR Creates an MS-DOS directory

mmove Moves or renames an MS-DOS file or
subdirectory

mmount Mounts an MS-DOS disk

mpartition Creates an MS-DOS file system as a partition

mrd RD or RMDIR Deletes an MS-DOS directory

mren REN or RENAME Renames an existing MS-DQS file

mshowfat Shows FAT entries for an MS-DOS file

mtoolstest Tests and displays the currentmtools
configuration

mtype TYPE Displays the contents of an MS-DOS file

mwrite COPY Copies a Linux file to MS-DOS

mzip Performs certain operations on SCSI Zip disks

You can use the mtools commands just as you use the corresponding DOS
commands. The mdir command, for example, works the same as the DIR com-
mand in DOS. The same goes for all the other mtools commands shown in
Table 3-4.

You can use wildcard characters (such as *) with mtools commands, but you
must remember that the Linux shell is the first program to see your command.
If you don’t want the shell to expand the wildcard character all over the place,
use quotation marks around filenames that contain any wildcard characters.
For example, to copy all * . txt files from the A drive to your current directory,
use the following command:

mcopy "a:*.txt"
If you omit the quotation marks, the shell tries to expand the string a: * . txt

with filenames from the current Linux directory. It also tries to copy those
files (if any) from the DOS floppy disk.
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On the other hand, if you want to copy files from the Linux directory to the
DOS floppy disk, you do want the shell to expand any wildcard characters.
To copy all *. jpg files from the current Linux directory to the DOS floppy
disk, for example, use mcopy like this:

mcopy *.jpg a:

With the mtools utilities, you can use the backslash character (\) as the
directory separator, just as you do in DOS. However, when you type a file-
name that contains the backslash character, you must enclose the name in
double quotation marks (" ™). For example, here’s a command that copies
a file from a subdirectory on the A drive to the current Linux directory:

mcopy "a:\test\sample.dat"
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Chapter b: Installing and
Updating Applications

In This Chapter

+* Working with RPM files with the rpm command

v Working with DEB files with dpkg, dselect, and APT
v~ Building applications from source files

+~ Updating Linux applications online

M ost software packages for Linux are distributed in one of two special
file formats: Red Hat Package Manager (RPM) files or Debian (DEB)

files. That’s why you have to know how to install or remove software pack-
ages that come in the form of RPM or DEB files. Luckily for you, this is the

chapter where I show you how to work with RPM and DEB files.

You can install RPM and DEB files in all Linux distributions, but each distri-
bution has its favored distribution format. Fedora Core, with its Red Hat
Linux heritage, favors RPM files, whereas most Debian-based distributions,
such as Knoppix, MEPIS, Ubuntu, and Xandros, use DEB files for distributing
software. SUSE Linux uses RPM format.

Many other open source software packages come in source-code form, usually
in compressed archives. You have to unpack, build, and install the software
to use it. [ describe the steps you typically follow when downloading, building,
and installing source-based software packages.

Finally, I briefly describe how to update your Linux system online. As you’ll
find out, each distribution has its own tools for online updates.

Working with RPM Files

RPM is a system for packaging all the necessary files for a software product
in a single file — called an RPM file, or simply, an RPM. In fact, the entire
Fedora Core and SUSE distributions are a whole lot of RPMs. The best way
to work with RPMs is through the RPM commands. You have to type these
commands at the shell prompt in a terminal window or a text console.
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In Fedora Core, the RPM commands are suitable only if you have to install
only a handful of RPM files. To install a large number of RPM files, you
should choose Applications=>Add/Remove Software from the desktop. If

you install RPM files from a CD or DVD, first mount the CD/DVD and then
type system-cdinstall-helper /media/cdrom. (If your CD/DVD is mounted
at some other directory, replace /media/cdrom with that directory name.)
That should bring up a Package Management window from which you can
select and install groups of packages.

Using the RPM commands

When you install an RPM-based distribution such as Fedora Core, the installer
uses the rpm command to unpack the packages (RPM files) and to copy the
contents to your hard drive.

You don’t have to understand the internal structure of an RPM file, but you
need to know how to use the rpm command to work with RPM files. Here are
some of the things you can do with the rpm command:

4 Find out the version numbers and other information about the RPMs
installed on your system.

4+ Install a new software package from an RPM. For example, you may
install a package you skipped during the initial installation.

4+ Remove (uninstall) unneeded software you previously installed from an
RPM. You may uninstall a package to reclaim the disk space, if you find
that you rarely (or never) use the package.

4+ Upgrade an older version of an RPM with a new one. For example, in
Fedora Core, you may upgrade after you download a new version of a
package from Fedora Core download sites (listed online at http://
fedora.redhat.com/download/mirrors.html). You must upgrade
an RPM to benefit from the fixes in the new version.

4+ Verify that an RPM is in working order. You can verify a package to check
that all necessary files are in the correct locations.

As you can see, the rpm command is versatile — it can do a lot of different
things, depending on the options you use.

If you ever forget the rpm options, type the following command to see a list:
rpm --help | more

The number of rpm options will amaze you!
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Understanding RPM filenames Bookv

An RPM contains a number of files, but it appears as a single file on your P

Fedora Core system. By convention, the RPM filenames have a specific

format. A typical RPM filename looks like this: = 5
fgd

openoffice.org-writer-1.9.104-2.1386.rpm é' g ?
= 5a

This filename has the following parts, the first three of which are separated % <« %’_

by dashes (-):

4+ Package name: openoffice.org-writer
4 Version number: 1.9.104
4 Release number: 2

4 Architecture: 1386 (this package is for Intel 80x86 or Pentium-compatible
Processors)

Usually, the package name is descriptive enough for you to guess what the
RPM may contain. The version number is the same as that of the software
package’s current version number (even when it’s distributed in some other
form, such as a tar file). Developers assign the release number to keep track
of changes. The architecture is 1386 or noarch for the RPMs you want to
install on a PC with an Intel x86-compatible processor.

Querying RPMs

As it installs packages, the rpm command builds a database of installed RPMs.
You can use the rpm -g command to query this database to find out informa-
tion about packages installed on your system.

For example, to find out the version number of the Linux kernel installed on
your system, type the following rpm -g command:

rpm -g cups
You see a response similar to the following:
cups-1.1.23-15

The response is the name of the RPM for the kernel. (This version is the
executable version of the kernel, not the source files.) The name is the same
as the RPM filename, except that the last part — . 1386 . rpm — isn’t shown.
In this case, the version part of the RPM tells you that you have cups (the
Common UNIX Printing System) version 1.1.23 installed.
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You can see a list of all installed RPMs by using the following command:
rpm -ga

You see a long list of RPMs scroll by your screen. To view the list one screen
at a time, type

rpm -ga | more

If you want to search for a specific package, feed the output of rpm -ga to
the grep command. For example, to see all packages with kernel in their
names, type

rpm -dga | grep kernel
The result depends on what parts of the kernel RPMs are installed on a system.

You can query much more than a package’s version number with the rpm -g
command. By adding single-letter options, you can find out other useful
information. For example, try the following command to see the files in the
cups package:

rpm -gl cups

Here are a few more useful forms of the rpm -g commands to query infor-
mation about a package. (To use any of these rpm -g commands, type the
command, followed by the package name.)

4+ rpm -gc: Lists all configuration files in a package.

4+ rpm -gd: Lists all documentation files in a package. These are usually
the online manual pages (also known as man pages).

4+ rpm -gf: Displays the name of the package (if any) to which a specified
file belongs.

4+ rpm -qgi: Displays detailed information about a package, including ver-
sion number, size, installation date, and a brief description.

4+ rpm -gl: Lists all the files in a package. For some packages, you see a
very long list.

4+ rpm -gs: Lists the state of all files in a package. (The state of a file can
be one of the following: normal, not installed, or replaced.)

QgN\BEIf These rpm commands provide information about installed packages only. If you
& want to find information about an uninstalled RPM file, add the letter p to the
command-line option of each command. For example, to view the list of files
in the RPM file named rdist-6.1.5-792.1586.rpm, go to the directory
where that file is located and type the following command:
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rpm -gpl rdist-*.rpm

Of course, this command works only if the current directory contains that
RPM file.

Two handy rpm -g commands enable you to find out which RPM file pro-
vides a specific file and which RPMs need a specified package. To find out
the name of the RPM that provides a file, use the following command:

rpm -gq --whatprovides filename

For example, to see which RPM provides the file /etc/vsftpd.conft, type
rpm -gq --whatprovides /etc/vsftpd.conf

RPM then prints the name of the package that provides the file, like this:

vsftpd-2.0.3-1

If you provide the name of a package instead of a filename, RPM displays the
name of the RPM package that contains the specified package.

On the other hand, to find the names of RPMs that need a specific package,
use the following command:

rpm -gq --whatrequires packagename
For example, to see which packages need the openssl package, type
rpm -gq --whatrequires openssl

The output from this command shows all the RPM packages that need the
openssl package.

Installing an RPM

To install an RPM, use the rpm -i command. You have to provide the name
of the RPM file as the argument. If you want to view the progress of the RPM
installation, use rpm -ivh. A series of hash marks (#) displays as the pack-
age is unpacked.

For example, to install the kernel-devel RPM (which contains the header
files for the Linux operating system) for Fedora Core from the companion
DVD-ROM, I insert the DVD, and after it’s mounted, I type the following
commands:

cd /media/cdrom/Fedora/RPMS
rpm -ivh kernel-devel*
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You don’t have to type the full RPM filename — you can use a few characters
from the beginning of the name followed by an asterisk (*). Make sure you
type enough of the name to identify the RPM file uniquely.

If you try to install an RPM that’s already installed, the rpm -i command
displays an error message. For example, here is what happens when I type
the following command to install the man package on my system:

rpm -1 man-2*
I get the following error message from the rpm -i command:
package man-2.4.1-221 is already installed

To force the rpm command to install a package even if errors are present,
just add --force to the rpm -i command, like this:

rpm -1 --force man-2*

Removing an RPM

You may want to remove — uninstall — a package if you realize you don'’t really
need the software. For example, if you have installed the X Window System
development package but discover you're not interested in writing X applica-
tions, you can easily remove the package by using the rpm -e command.

You have to know the name of the package before you can remove it. One good
way to find the name is to use rpm -ga in conjunction with grep to search
for the appropriate RPM file.

For example, to remove the package named gt3-devel, type
rpm -e gt3-devel

To remove an RPM, you don’t need the full RPM filename; all you need is the
package name — the first part of the filename up to the dash (-) before the
version number.

The rpm -e command does not remove a package that other packages need.

Upgrading an RPM

Use the rpm -U command to upgrade an RPM. You must provide the name
of the RPM file that contains the new software. For example, if [ have version
1.1.20 of cups (printing system) installed on my system but I want to upgrade
to version 1.1.23, I download the RPM file cups-1.1.23-15.1386.rpm from
a repository and use the following command:

rpm -U cups-1.1.23-15.1386.rpm
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The rpm command performs the upgrade by removing the old version of the
cups package and installing the new RPM.

Whenever possible, upgrade rather than remove the old package and install
a new one. Upgrading automatically saves your old configuration files, which
saves you the hassle of reconfiguring the software after a fresh installation.

When you’re upgrading the kernel packages that contain a ready-to-run
Linux kernel, install it by using the rpm -i command (instead of the rpm -U
command). That way, you won’t overwrite the current kernel.

Verifying an RPM

You may not do so often, but if you suspect that a software package isn’t
properly installed, use the rpm -V command to verify it. For example, to
verify the kernel package, type the following:

rpm -V kernel

This command causes rpm to compare the size and other attributes of each
file in the package against those of the original files. If everything verifies
correctly, the rpm -V command does not print anything. If it finds any
discrepancies, you see a report of them. For example, | have modified the
configuration files for the Apache httpd Web server. Here is what I type to
verify the httpd package:

rpm -V httpd
Here’s the result I get:
S.5....T ¢ /etc/httpd/conf/httpd.conf

In this case, the output from rpm -V tells me that a configuration file has
changed. Each line of this command’s output has three parts:

4+ The line starts with eight characters: Each character indicates the type
of discrepancy found. For example, S means the size is different, and T
means the time of last modification is different. Table 4-1 shows each
character and its meaning. A period means that that specific attribute
matches the original.

4+ For configuration files, a ¢ appears next; otherwise, this field is blank.
That’s how you can tell whether or not a file is a configuration file.
Typically, you don’t worry if a configuration file has changed; you
probably made the changes yourself.

4+ The last part of the line is the full pathname of the file. From this part,
you can tell exactly where the file is located.
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Table 4-1 Characters Used in RPM Verification Reports
Character Meaning

Size has changed

Permissions and file type are different

Checksum computed with the MD5 algorithm is different

Device type is different

Symbolic link is different

File's user is different

File's group is different

HlQ|c|E|g|lu|=R|n

File's modification time is different

Working with DEB Files
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Debian packages with .deb file extensions store executable files together with
configuration files, online documentation, and other information. You can
unpack and manipulate these DEB files using the Debian utility dpkg, which is
a command-line program that takes many options. A text mode, menu-driven
program called dselect is also available for you to manage the packages
without having to type dpkg commands.

You typically use a higher-level utility called APT (Advanced Packaging Tool)
to work with packages in Debian. For example, instead of downloading a
DEB file and installing it with the dpkg command, you can simply use the
apt-get command to install the package. The apt-get command can even
download the package from an online Debian repository and install it on
your system. The dpkg command is still useful when you want to look at the
contents of a DEB file that you have manually downloaded from a repository
or that might be in the APT cache directory (/var/cache/apt/archives
in Debian).

[ introduce you to dpkg, dselect, and APT in the following sections.

Understanding DEB filenames

A typical DEB package has a filename of the following form:
mozilla-firefox_1.0.4-2_1386.deb

The filename has three parts separated by underscores (_):
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4+ Package name: mozilla-firefox

4+ Version and Revision: 1.0.4-2 (Version has two parts separated by a
dash. The first part is the package maintainer’s version number; the
second part is the Debian revision number.)

4 Architecture: 1386. (The package is for Intel x86-compatible systems.)

The filename has a . deb extension, which indicates that this is a DEB file.

Using the dpkg command

To get a feel for the dpkg command, type dpkg -help | more. The output
shows the large number of options that dpkg accepts. You can also type
man dpkg to read the online man page for dpkg.

You can use dpkg to perform a whole lot of operations on packages, but you
have to work at a shell prompt in a terminal window or a text console. The
format of a dpkg command is

dpkg [options] action package

with zero or more options, an action indicating what dpkg has to do, and
the name of a package, a DEB file, or a directory (depends on the action
argument). Sometimes the dpkg command does not need any name of pack-
age or file, just an action.

Here are some examples of actions you can perform with dpkg:

4+ Install a package from a DEB file with the command dpkg -i
packagefile where packagefile is the name of the DEB file
(for example, vsftpd-*.deb).

4+ Remove a package but retain the configuration files with the command
dpkg -r packagename, where packagename is the name of the package
(for example, vsftpd)

4+ Configure a package with the command dpkg --configure
packagename, where packagename is the name of a package
(for example, vsftpd)

4 Purge — remove everything including the configuration files — with the
command dpkg -P packagename, where packagename is the name of
a package (for example, vsftpd)

4+ Audit packages (and find the ones that are partially installed on
your system) with the command dpkg -C (does not need a file or
package name)
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4+ List contents of a DEB file with the command dpkg -c packagefile,
where packagefile is the name of the DEB file (for example,
vsftpd-*.deb)

4 View information about a DEB file with the command dpkg -I
packagefile, where packagefile is the name of the DEB file
(for example, vsftpd-*.deb)

4+ List packages matching pattern with the command dpkg -1 pattern,
where pattern is the package name pattern — usually with wildcard
characters — that you want to match (for example, kernel *)

4+ Find packages that contain files with the command dpkg -S pattern,
where pattern is the filename pattern — usually with wildcard
characters — that the package contains (for example, stdio*)

4 List files installed from a package with the command dpkg -L
packagename, where packagename is the name of a package
(for example, vsftpd)

You can try these commands out on a Debian system or any system that uses
DEB packages. For example, to look for all packages matching names that
begin with mozilla, type dpkg -1 mozilla* in a terminal window. Here is the
relevant portion of this command’s output on my Debian system:

||/ Name Version Description

+++-====== ==-======== =-========== ============ ============
un mozilla <none> (no description available)

un mozilla-bonobo <none> (no description available)

ii mozilla-browse 1.7.8-1 The Mozilla Internet application suite - cor
ii mozilla-firefo 1.0.4-2 lightweight web browser based on Mozilla

The i1 in the first column indicates that the package is installed; un means
the package is not installed.

Another common use of dpkg -1 is to list all packages and use grep to

find lines that match a search string. For example, to find anything contain-
ing kernel, type dpkg -1 | grep kernel. If the package names (in the second
column of the dpkg -1 output) are truncated, adjust the width of the output
lines with a command like this:

COLUMNS=132 dpkg -1 | grep kernel

[ find the dpkg -S command a handy way to locate which package provided
a specific file in the system. For example, if | want to figure out what package
includes the /etc/host. conf file, | type dpkg -S /etc/host.conf and the

output shows that the base-files package contains /etc/host.conf:

base-files: /etc/host.conf



Figure 4-1:
You can use
dselect
to manage
packages
in Debian.
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Introducing dselect

The dselect is meant to be a front-end to the dpkg utility. To try out
dselect, log in as root and type dselect in a terminal window (or a text
console). When dselect starts, you get dselect’s text mode menu

(as shown in Figure 4-1).

naba@lnbdeb: home/naba

Fle Edit Miew Terminal Tabs Helo

pebian “dselect’ package handling frontend. =

[Alccess

Che [
[Ulpdate

e List of availaole packes, 1f possible.

1.

2. [slelect Fequest which packages you want on your system.
3. [1lnstall  Instsll and upgrade wanted packages.

2. [clenfig Confrgure any packages that are anconfigured.
5. [Rlemova Ramove unwantaed software,

6. [Qluit fuit dselect.

Move around with =P and “N, curser keys, initial letters, or digits;
Press <enter> to confirm selection. ~L redraws screen.

version 1.10.28 (1385).
Copyright (] 1 18946 Tan Jacksen.

Copyright i wichert fkkerman.

This 15 free are; see the OMJ General Public Licence wersien 2
ar later for ng conditions, Thers is M) warranty. See
dselect --licence for getsils.

I won’t describe dselect in detail, but here are some of the tasks you can
perform from the dselect main menu:
4+ Specify an access method — how to find the DEB packages
Update the list of available packages
View the status of installed and available packages
Select packages and manage dependencies among packages
Install new packages or upgrade existing ones to newer versions

Configure packages that are not yet configured

+ 4 e+ e

Remove packages

One common sequence in dselect is to update the list of available packages
and then upgrade all packages for which updates are available. You can, of
course, perform that same task with a simple APT command as well.

Using APT to manage DEB packages

APT is truly an advanced utility for keeping your Debian system up to date.
You can use a number of APT utilities to manage DEB packages. The two
commonly used commands are apt-get and apt-cache.
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To install a package with apt-get, simply type apt-get install packagename,
where packagename is the name of the package that you want to install.
For example, to install the vsftpd package, type apt-get install vsftpd.

Removing a package is equally simple. Type apt-get remove packagename,
where packagename is the name of the package you want to remove.

If you want to find the name of a package and you know some terms asso-
ciated with the package, you can look for it with the apt-cache utility.
For example, to look for a CD/DVD burner package, I type apt-cache search
burn | more to search through the APT’s package cache (which is the list
of Debian packages that APT downloads from the servers listed in the
/etc/apt/sources.list file). Here are some lines of output from that
command:

arson - KDE frontend for burning CDs
burn - Command line Data-CD, Audio-CD, ISO-CD, Copy-CD writing tool
caca-utils - text mode graphics utilities
cdcontrol - A parallel burner that allow you to write to one or more CD-Writers
at once
cdlabelgen - generates front cards and tray cards for CDs and DVDs
cdrtoaster - Tcl/Tk front-end for burning cdrom
cdw - Tool for burning CD's - console version
cdw-common - Tool for burning CD's - common files
cpuburn - a collection of programs to put heavy load on CPU
cwedr - Chez Wam CD Ripper
dvd+rw-tools - DVD+-RW/R tools
dvdbackup - tool to rip DVD's from the command line
edenmath.app - Scientific calcualtor for GNUstep
gcdw - Tool for burning CD's - graphical version
gcombust - GTK+ based CD mastering and burning program
. lines deleted ...

The output shows several potential CD/DVD burning programs that [ could
install. To discover more about any of the packages, I type apt-cache show
packagename, where packagename is the name of the package for which
[ want information. For example, to find out more about the dvd+rw-tools
package, | type apt-cache show dvd+rw-tools and the output shows me a
description of the package. I can then install the package with apt-get
install.

To search for a keyword that appears in the package’s name only, use the --
names-only option like this: apt-cache search - -names-only keyword,
where keyword is something that appears in the package’s name. For exam-
ple, if [ want to find packages that contain selinux in their names, [ type
apt-cache search - -names-only selinux.
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/var/cache/apt/archives directory) of DEB files that have already been Chapter 4
installed. You can free up some disk space by removing these DEB files.

Building Software Packages from Source Files

Many open source software packages are distributed in source-code form,
without executable binaries. Before you can use such software, you have to
build the executable binary files by compiling, and you have to follow some
instructions to install the package. In this section, I show you how to build
software packages from source files.
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Downloading and unpacking the software

Typically, open source software source files are distributed in compressed
tar archives. These archives are created by the tar program and com-
pressed with the gzip program. The distribution is in the form of a single
large file with the .tar.gz or . tar.Z extension — often referred to as

a compressed tarball. If you want the software, you have to download the
compressed tarball and unpack it.

Download the compressed tar file by using anonymous FTP or going through
your Web browser. Typically, this process involves no effort on your part
beyond clicking a link and saving the file in an appropriate directory on your
system.

To try your hand at downloading and building a software package, you can
practice on the X Multimedia System (XMMS) — a graphical X application
for playing MP3 and other multimedia files. XMMS is bundled with Fedora
Core and already installed on your system. However, you do no harm in
downloading and rebuilding the XMMS package again.

Download the source files for XMMS from www . xmms . org/download.php.
The files are packed in the form of a compressed tar archive. Click the http
link for the source files and save them in the /usr/local/src directory in
your Linux system. (Be sure to log in as root; otherwise you cannot save in
the /usr/local/src directory.)

After downloading the compressed tar file, examine the contents with the
following tar command:

tar ztf xmms*.gz | more
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You see a listing similar to the following:

xmms-1.2.10/

xmms-1.2.10/intl/
xmms-1.2.10/intl/ChangelLog
xmms-1.2.10/intl/Makefile.in
xmms-1.2.10/intl/config.charset
xmms-1.2.10/intl/locale.alias
xmms-1.2.10/intl/ref-add.sin
xmms-1.2.10/intl/ref-del.sin
xmms-1.2.10/intl/gmo.h
xmms-1.2.10/intl/gettextP.h
xmms-1.2.10/intl/hash-string.h

xmms-1.2.10/intl/loadinfo.h
lines deleted

The output of this tar command shows you what’s in the archive and gives
you an idea of the directories that are created after you unpack the archive.
In this case, a directory named xmms-1.2.10 is created in the current direc-
tory, which, in my case, is /usr/local/src. From the listing, you also figure
out the programming language used to write the package. If you see . c and
.hfiles, the source files are in the C programming language used to write
many open source software packages.

To extract the contents of the compressed tar archive, type the following
tar command:

tar zxvi xmms*.gz

You again see the long list of files as they extract from the archive and copy
to the appropriate directories on your hard drive.

Now you're ready to build the software.

Building the software from source files

After you unpack the compressed tar archive, all source files are in a direc-
tory whose name is usually that of the software package with a version
number suffix. For example, the XMMS version 1.2.10 source files extract

to the xmms-1.2.10 directory. To start building the software, change
directories with the following command:

cd xmms*

You don’t have to type the entire name — the shell can expand the directory
name and change to the xmms-1.2.10 directory.



WMBER
é«‘
&

Building Software Packages from Source Files 463

Nearly all software packages come with some sort of README or INSTALL
file — a text file that tells you how to build and install the package. XMMS
is no exception; it comes with a README file you can peruse by typing
more README. An INSTALL file contains instructions for building and
installing XMMS.

Most open source software packages, including XMMS, also come with a file
named COPYING. This file contains the full text of the GNU General Public
License (GPL), which spells out the conditions under which you can use and
redistribute the software. If you're not familiar with the GNU GPL, read this
file and show the license to your legal counsel for a full interpretation and an
assessment of applicability to your business.

To build the software package, follow the instructions in the README or
INSTALL file. For the XMMS package, the README file lists some of the pre-
requisites (such as libraries) and tells you what commands to type to build
and install the package. In the case of XMMS, the instructions tell you to use
the following steps:

1. Type ./configure to run a shell script that checks your system configu-
ration and creates a file named Makefile — a file the make command
uses to build and install the package. (You can type ./configure —help
to see a list of options that configure accepts.)

If you get any errors about missing packages, you have to install those
missing packages. Use your distribution’s software installation tools

to add the missing packages. For example, in Debian use the apt-get
install command. In Fedora Core, choose Applications=>Add/Remove
Software. In SUSE, use the YaST GUI tool.

2. Type make to build the software.

This step compiles the source files in all the subdirectories. (Compiling
source code converts each source file into an object file — a file contain-
ing binary instructions that your PC’s processor can understand.)

3. Type make install to install the software.

This step copies libraries and executable binary files to appropriate
directories on your system.

Although these steps are specific to XMMS, most other packages follow
these steps — configure, make, and install. The configure shell
script guesses system-dependent variables and creates a Makefile with
commands needed to build and install the software.
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Usually, you don’t have to do anything but type the commands to build the
software, but you must install the software-development tools on your
system. In Fedora Core, you must install the Development Tools and the
GNOME Software Development packages. In Debian, to build and run XMMS,
you must also install the X Software Development package because it’s an X
application.

After you've installed XMMS, try running it from the GNOME or KDE desktop
by typing xmms in a terminal window. From the XMMS window, press L to get
the Load File dialog box. Select an MP3 file to play. Your PC must have a sound
card, and the sound card must be configured correctly for XMMS to work.

To summarize, here’s an overview of the steps you follow to download,
unpack, build, and install a typical software package:

1. Use a Web browser to download the source code, usually in the form
of a . tar.gz file, from the anonymous FTP site or Web site.

2. Unpack the file with a tar zxvf filename command. (If the com-
pressed tar file has a .bz2 extension, that means the file is compressed
with bzip2 and you can unpack that file with a tar jxvf filename
command.)

3. Change the directory to the new subdirectory where the software is
unpacked, with a command such as cd software_dir.

4. Read any README or INSTALL files to get a handle on any specific
instructions you must follow to build and install the software.

5. The details of building the software may differ slightly from one soft-
ware package to another, but typically you type the following com-
mands to build and install the software:

./configure
make
make install

6. Read any other documentation that comes with the software to find
out how to use the software and whether you must configure the soft-
ware further before using it.

Installing SRPMs

If you have the source CDs for Fedora Core (you can download the source
CD images from one of the sites listed at http: //fedora.redhat.com/
download/mirrors.html), you can install the source files and build vari-
ous applications directly from the source files. Fedora Core source-code files
also come in RPMs, just as the executable binary files, and these source-code
RPM files are generally known as SRPMs (short for source RPMs).
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To install a specific source RPM and build the application, follow these steps:

1. Mount the DVD-ROM by typing mount /media/cdrom or wait for the
GNOME desktop to mount the DVD.

2. Typically, source RPMs are in the SRPMs directory. Change to that
directory by typing the following command:

cd /media/cdrom/SRPMS

3. Install the source RPM file by using the rpm -i command. For exam-
ple, to install the Web server (bt tpd) source, type

rpm -ivh httpd*.src.rpm

The files install in the /usr/src/redhat/SOURCES directory. A spec
file with a . spec extension is placed in the /usr/src/redhat/SPECS
directory. The spec file describes the software and also contains infor-
mation used to build and install the software.

4. Use the rpmbuild command with the spec file to build the software.
You perform different tasks, from unpacking the source files to building
and installing the binaries by using different options with the rpmbuild
command. For example, to process the entire spec file, type:

rpmbuild -ba packagename.spec

Here packagename is the name of the SRPM. This command typically
builds the software and installs the binary files.

Updating Linux Applications Online
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Each of the Linux distributions — Debian, Fedora Core, MEPIS, SUSE, Ubuntu,
and Xandros — come with utilities that enable you to update the software
online. In the following sections, I provide an overview of the update methods
in Debian, Fedora Core, MEPIS, SUSE, Ubuntu, and Xandros.

You need a fast Internet connection (such as a DSL or cable modem) to
easily update your Linux applications or download new software packages.
Make sure that your Internet connection is up and running before you
attempt to update your Linux system online.

Keeping Debian, MEPIS, and
Ubuntu updated with APT

The best way to keep your Debian system updated is to use APT. More specif-
ically, you use the apt-get command-line utility with appropriate options.
Because MEPIS and Ubuntu are Debian-based, you can use APT to update
MEPIS and Ubuntu as well.

Book V
Chapter 4

suoneaiddy
funepdn
pue buijjeisuj



466 Updating Linux Applications Online

CMBER
@&

(2

Q\s“ RIB(/,}

SPE(,‘/
N\ B

In a nutshell, assuming the APT sources were configured during Debian
installation, you can keep the current collection of software updated with
the following two commands, typed in this order:

apt-get update
apt-get upgrade

The apt-get update command checks the current list of packages against
the ones available from the locations specified in /etc/apt/sources.list
file and gathers information about new versions of installed packages.

The apt-get upgrade command actually installs any available new ver-
sions of the packages installed in your Debian system. You must perform
apt-get upgrade to install any available upgrades.

To install new packages in Debian, use apt-cache search to find the pack-
age name in APT’s package cache and then use apt-get install to install
the package.

Updating Fedora Core Applications

Fedora Core comes with Up2date — a graphical Update Agent that can down-
load any new RPM files your system requires and install those files for you.
Up2date is also known as the Red Hat Update Agent because Red Hat devel-
oped it for its Red Hat Network, through which Red Hat provides services to
its commercial customers.

To update Fedora Core software packages using Up2date, follow these steps:

1. Log in as root, and choose Applications->System Tools=>
Red Hat Network. You can also type up2date in a terminal window.

(If you don’t see Red Hat Network in the menu or if you get an error when
you type up2date, log in as root, type yum install up2* in a terminal
window and then look for it in the menu.) The Update Agent starts,

and if you're using Up2date for the first time, the Red Hat Network
Configuration dialog box appears and guides you through the configu-
ration steps. Typically, you can click OK to accept the default settings.
Another dialog box then prompts you to install a public key in your GPG
key ring. (GPG refers to GNU Privacy Guard or GnuPG, a program for
encrypting, decrypting, and signing e-mail and other data using the
OpenPGP Internet standard.) That public GPG key verifies that the
package developer has securely signed the package that Up2date has
downloaded. If prompted to do so, click Yes to install the public key.

2. Up2date displays a window with a welcome message. Click the
Forward button to proceed.
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3. Up2date displays a list of what it calls channels — repositories from
where the agent downloads package headers. Click Forward to continue.

By default, the Update Agent uses a channel that works with Yum — a
command-line package updater/installer that I describe in the next sec-
tion. The channels are identified in the text configuration file /etc/
sysconfig/rhn/sources. Besides Yum, Up2date can also access repos-
itories meant for APT — the Advanced Packaging Tool used in Debian.

After you click Forward, Up2date figures out what needs to be updated
and retrieves a list of all headers from the specified channel.

4. After Up2date downloads the headers, it displays a list of packages.
You can scroll through the list and pick the packages you want to
update; click the box to the left of a package’s name to select it.
Click Forward to continue.

Up2date then checks for any package dependencies and begins down-
loading the packages. Progress bars show the status of the download.

5. After the download finishes, click the Forward button to proceed with
the installation.

6. Up2date displays progress bars as it installs each package update.
Click the Forward button when the installation is complete.

Up2date displays a message about the package(s) it installs successfully.
7. Click the Finish button to exit Up2date.

Fedora Core 5 comes with another graphical utility called Package Updater
that you can use to update software packages installed on your Fedora Core
system. To start the Package Updater, choose Applications>System Tools=>
Software Updater or type su - in a terminal window to become root and
then type pup.

In Fedora Core, you can also use Yum (which, by the way, stands for Yellow
dog Updater, Modified). Yum is a command-line utility for updating as well as
installing and removing RPM packages. Yum downloads RPM package headers
from a specified Web site and uses the rpm utility to figure out any interde-
pendencies among packages and what needs to be installed on your system.
Then it downloads and uses rpm to install the necessary packages. Yum
downloads just the headers to do its job, and the headers are much smaller
in size than the complete RPM packages. Yum is much faster than the alter-
native, where you manually download the complete RPM packages using the
rpm command.

Typically, you keep your system up to date with the graphical Update Agent
because it’s easy to use. However, knowing how to run Yum from the com-
mand line is good, just in case you have problems with the Update Agent.
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You can read more about Yum and keep up with Yum news by visiting the
Yum Web page at http://linux.duke.edu/projects/yum.

The command line for Yum has the following syntax:
yum [options] command [packagenames]

options is alist of Yum options, command specifies what you want Yum to
do, and packagenames are the names of a packages on which Yum per-
forms that action. You must provide the command, but the options and
packagenames are optional. That’s why [ show them in square brackets in
the syntax. Table 4-2 summarizes the Yum commands and Table 4-3 lists
some common Yum options.

Table 4-2 Yum Commands

Command What Yum Does for This Command

check-update Checks for available updates for your system

clean Cleans up the cache directory

info Displays summary information about the specified packages

install Installs latest versions of specified packages, making sure that all
dependencies are satisfied

list Lists information about available packages

provides Provides information on which package provides a file

remove Removes specified packages as well as any packages that depend

on the packages being removed

search Finds packages whose header contains what you specify as the
package name

update Updates specified packages, making sure that all dependencies
are satisfied

Table 4-3 Some Common Yum Options
Option Causes Yum to Do the Following
--download-only Downloads the packages, but does not install them

--exclude=pkgname Excludes the specified package. (You can use this option
more than once on the command line.)

--help Displays a help message and quits

--installroot=path Uses the specified path name as the directory under which
all packages are installed

-y Assumes that your answer to any question is yes
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If you simply want Yum to update your system, just type the following.
(You have to be logged in as root.)

yum update

Yum consults its configuration file, /etc/yum. conf, and does everything
needed to update the packages installed on your system.

You can specify package names to update only some packages. For exam-
ple, to update the kernel and xorg-x11 packages, use the following Yum
command:

yum update kernel* xorg-xl11*

This command updates all packages whose names begin with kernel and
xorg-x11.

You may use the options to further instruct Yum what to do. For example,
if you want to download the updated packages, but not install them, type

yum --download-only update

Another typical option is --exclude, which enables you to exclude one or
more packages from the update process. Suppose you want to update every-
thing except the GNOME packages (whose names begin with gnome) and the
rhythmbox package. Then you type the following Yum command:

yum --exclude=gnome* --exclude=rhythmbox update

Updating SUSE online

SUSE comes with YOU — YaST Online Update — for online software updates.
To access YOU, choose Main Menur>System=>YaST and from the YaST Control
Center’s Software category, click Online Update. This brings up the YaST
Online Update window, as shown in Figure 4-2.

To set up YOU automatic updates, click the Configure Fully Automatic
Update button. You can then specify a time of the day when you want YOU
to download any available patches and install them. If you want, you can
specify that YOU only download the patches and not install them.

To update your SUSE system online, select the installation source and click
Next. (See Figure 4-2.) YOU then downloads the list of patches and displays
them, as shown in Figure 4-3.
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Using Xandros Networks

In Xandros, use Xandros Networks to update applications or install new
ones. Choose Main Menur>Xandros Networks (or double-click the Xandros
Networks icon on the desktop) to open the Xandros Networks window, as
shown in Figure 4-4.
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To install the latest updates from Xandros, choose Filew>Install All Latest
Updates from Xandros or click the Update button (to the left of the key in the
toolbar at the top of Figure 4-4). Xandros Networks then downloads informa-
tion about the available updates and shows a summary (see Figure 4-5) of the
packages to be downloaded and the disk space needed to install them.
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Click OK. Xandros Networks prompts you for the root password, and after you
enter the root password, it downloads the software updates and installs them.

Behind the scenes, Xandros Networks uses Debian’s apt -get command to
download and install the software updates.

The Xandros Networks window also offers options to install new software.
You can even shop for new applications through Xandros Networks. If you have
RPM or DEB files to install, you can do so in Xandros Networks by choosing
FilewInstall RPM File or File=>Install DEB File.



Chapter 5: Customizing
the Linux Kernel

In This Chapter

v Configuring the kernel

v~ Building a new kernel and any modules

v~ Installing the modules

v~ Building and installing a new initial RAM disk file
v~ Installing the kernel and setting up GRUB

0 ne reason that Linux is so exciting is that many programmers constantly
improve it. Some programmers, for example, write drivers that add
support for new hardware, such as a new sound card or a new networking
card. All these innovations come to you in the form of new versions of the
Linux kernel.

Although you don’t have to upgrade or modify the Linux operating system —
the kernel — every time a new version is available, sometimes you have to
upgrade simply because the new version corrects some problems or supports
your hardware better. On the other hand, if an earlier kernel version has
everything you need, you don’t have to rush out and upgrade.

Sometimes, you may want to rebuild the kernel even when it has no fixes or
enhancements. The Linux kernel on the companion DVD-ROM is generic and
uses modules to support all types of hardware. You may want to build a new
kernel that links in — incorporates into the kernel’s binary file — the drivers
for only the devices installed on your system. In particular, if you have a
SCSI hard drive, you may want to create a kernel that supports your SCSI
adapter. Depending on your needs, you may also want to change some of
the kernel-configuration options, such as creating a kernel that’s specific for
your processor (instead of a generic Intel 386 processor).

In this chapter, [ explain how to rebuild and install a new Linux kernel.
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Rebuilding the kernel refers to creating a new binary file for the core Linux
operating system. This binary file is the one that runs when Linux boots.
You may wonder why you would ever want to rebuild the kernel. Well, here
are a few reasons:

4+ After you initially install Linux, you may want to create a new kernel that
includes support for only the hardware installed on your system. In par-
ticular, if you have a SCSI adapter, you may want to create a kernel that
links in the SCSI driver. The kernel on the companion DVD-ROM includes
the SCSI driver as an external module that the kernel loads at startup.

4+ If you have a system with hardware for which only experimental support
is available, you have to rebuild the kernel to include that support into
the operating system.

4+ You may want to recompile the kernel and generate code that works well
on your specific Pentium processor (instead of the generic 386 processor
code that comes in most Linux distributions).

To rebuild the Linux kernel, you need the kernel source files. The kernel
source files are not normally installed. Use your distribution’s software
installation tool to install the kernel source package.

Fedora Core does not provide the kernel -source package. Instead, you
have to install the source RPM (SRPM) file kernel-version.src.rpm
where version is the kernel version number. You can find the kernel SRPM
in the SRPMs directory of a Fedora Core online repository. You have to install
the kernel SRPM with the command rpm -Uvh kernel-version.src.rpm.
Then type cd /usr/src/redhat/SPECS followed by rpmbuild -bp --target S(arch)
kernel.spec. To make the kernel sources available at the /usr/src/linux
directory, type the following commands. (Replace version with the version
number of the kernel that you can get with the uname -r command.)

cd /usr/src/redhat/BUILD/kernel-VERSION/usr/src/
mv linux-VERSION /usr/src/

cd /usr/src

In -s ./1linux-VERSION linux

In SUSE, use YaST’s Software Management tool to install the kernel sources —
to find it, use the search feature (search for kernel-source) in YaST’s
software installation window. After installing the kernel-source package,

the source files appear in the /usr/src/linux-version directory, where
version is the version number of the kernel. Thus, for kernel version 2.6.13,
the source files are in the /usr/src/linux-2.6.13 directory. Some distribu-
tions automatically set up /usr/src/1linux as a symbolic link (shortcut) to
the version-specific directory containing the source files for the Linux kernel.
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In Debian-based distributions, the kernel sources are installed in the /usr/
src/kernel-source-version directory, where version is the kernel ver-
sion. Therefore, for kernel version 2.6.11, the sources are in /usr/src/
kernel-source-2.6.11. To change to the kernel source directory in
Debian, type cd /usr/src/kernel-source*.

Building the kernel involves the following phases:

4+ Configuring the kernel

4 Building the kernel

4 Building and installing the modules

4+ Building a new initial RAM disk (initrd) file
4+ Installing the kernel and setting up GRUB

[ explain these phases in the next few sections, but first you need to know
the difference between linking in a driver versus building a driver as a load-
able module.

Creating a monolithic versus a modular kernel
You have two options for the device drivers needed to support various hard-
ware devices in Linux:

4+ Link in support: You can link the drivers for all hardware on your
system into the kernel. The size of the kernel grows as device-driver
code incorporates into the kernel. A kernel that links in all necessary
code is called a monolithic kernel because it’s one big file.

4+ Use modules: You can create the device drivers in the form of loadable
kernel modules. A module is a block of code that the kernel can load
after it starts running. A typical use of modules is to add support for
a device without having to rebuild the kernel for each new device.
Modules don’t have to be device drivers; they can also add new func-
tionality to the kernel. A kernel that uses modules is called a modular
kernel.

You don’t have to create a fully monolithic or fully modular kernel. In fact,
linking some support directly into the kernel but building infrequently used
device drivers in the form of modules is common practice. For a Linux distri-
bution, including a mostly modular kernel makes sense, along with a large
number of modules that can support many different types of hardware.
Then the Linux installer configures the system to load only modules needed
to support the hardware installed in a user’s system.
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When you create a custom kernel for your hardware configuration, you may
want to link all required device drivers into the kernel. You can still keep the
size of such a monolithic kernel under control because you link in device
drivers only for the exact set of hardware installed on your system.

Configuring the kernel

The first phase in rebuilding a kernel is to configure it. To configure the
kernel, log in as root. Then change the kernel source directory by using
the cd command as follows:

cd /usr/src/linux*

To configure the kernel, you have to indicate which features and device driv-
ers you want to include in your Linux kernel. In essence, you build your very
own version of the Linux kernel with just the features you want.

Linux provides several ways for you to configure the kernel:

4+ Type make menuconfig to enter the kernel-configuration parameters
through a text-based interface similar to the one the text mode Linux
installation program uses.

4+ Type make xconfig to use an X Window System-based configuration
program to configure the kernel. You have to run X to use this config-
uration program with a graphical interface. You also have to install the
Qt development (gt -devel) package and set the QTDIR environment
variable to the directory where Qt is installed. (If you have installed the
gt-devel package, type export QTDIR=/usr/lib/qt-3.3 to correctly
define QTDIR.)

4+ Type make config to use a shell script that prompts you for each config-
uration option one by one. You can use this configuration program from
the Linux command prompt. When you use this option, you undergo a
long question-and-answer process to specify the configuration parame-
ters. For each question, respond with a y to link support into the kernel,
m to build a module, and n to skip the support for that specific device.

4+ Type make oldconfig to use a shell script to reconfigure the kernel after
upgrading the sources. This configuration script keeps the existing options
and prompts you for only new or changed options.

The make menuconfig, make xconfig, make config, and make
oldconfig commands achieve the same end result — each stores your
choices in a text file named .configlocated in the /usr/src/linux*
directory. Because the filename starts with a period, you don’t see it when
you use the 1s command alone to list the directory. Instead, type Is -a to see
the . config file in the directory listing.
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The kernel-configuration step merely captures your choices in the .config
file. (In fact, the . config file does not exist until you configure the kernel
once.) The kernel file does not change until you compile the kernel with the
make command. That means you can go through the kernel-configuration
option as many times as you want. If you want to start over with default set-
tings, type the following command before you start configuring the kernel:

make mrproper

For an overview of the kernel-configuration build steps that you can perform
with the make command, type the following in a terminal window (after

you type cd /usr/src/linux* to change the current directory to the correct
location):

make help | more

Before starting to reconfigure the kernel, take a look at a typical .config
file. For example, here are some lines of output when I type more .config on
a Linux system (after I configure the kernel):

#

# Automatically generated make config: don't edit
#

CONFIG_X86=y

CONFIG_MMU=y

CONFIG_UID16=y

CONFIG_GENERIC_ISA_DMA=y

CONFIG_GENERIC_TIOMAP=y

#

# Code maturity level options
#

CONFIG_EXPERIMENTAL=y
CONFIG_CLEAN_COMPILE=y
CONFIG_BROKEN_ON_SMP=y
CONFIG_INIT_ENV_ARG_LIMIT=32

#

# General setup

#

CONFIG_LOCALVERSION=""

CONFIG_SWAP=y

CONFIG_SYSVIPC=y
lines deleted

Essentially, each configuration option has a name, and each one is assigned
a value. The name begins with CONFIG_ followed by a word that identifies
the option. Each selected option has a value of y (to link in support for that
feature) or m (to use a module for that feature). Lines beginning with # are
comments. Comment lines list features not selected.
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[ describe the configuration process through the make config command.
Although this approach is somewhat tedious because it walks you through
each option one by one, it is ideal as a learning tool. As you step through the
groups of configuration options, I provide notes explaining what most of the
options mean. You can then configure the kernel using whichever config-
uration tool (make xconfig, make menuconfig, make config, or make
oldconfig) you like most.

As you configure the kernel with the make config command, you have to
select how to include support for specific devices. Typically, for each config-
uration option, you have to respond with one of the following choices:

4 vy to link support into the kernel

4+ mto use a module

4+ n to skip the support for that specific device or feature

4+ 2 to get help on that kernel-configuration option

If a device does not have a modular device driver, you won’t see the m option.
For some configuration options, you may have to pick a number from a list.

Starting the kernel configuration

To start configuring the kernel, log in as root, change to the directory with the
Linux kernel’s source (type cd /usr/src/linux* or cd /usr/src/kernel-source*,
depending on your distribution), and type make menuconfig in a terminal
window. The configuration tool then displays the first prompt:

Linux Kernel Configuration

¥k ok ok ok

Code maturity level options

Prompt for development and/or incomplete code/drivers (EXPERIMENTAL) [Y/n/?]

Press Enter to accept the default Yes answer. This causes the configuration
process to show all experimental device drivers.

The possible answers to each prompt appear in square brackets with the
default answer in uppercase. Thus, [Y/n/?] means the default answer is
Yes, and two other possible answers are n and ?. To accept the default,
press Enter. For help on this option, press 2. If you have questions about any
option, press ? and carefully read the help text before you decide what to
do. You can use this general guideline to make your choices. In the following
sections, I explain only selected groups of kernel-configuration options.
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General setup options

This group of options enables you to indicate if you want to enable support
for general features such as System V Inter Process Communication (IPC),
process accounting based on BSD (Berkeley Software Distribution) UNIX,
and hot-pluggable devices. You can press Enter to accept the default
choices.

Loadable module support

This group of options asks you about support for loadable modules. A load-
able module is a block of code that the Linux kernel can load and execute as
if it were a part of the operating system.

*

* Loadable module support
*

Enable loadable module support (MODULES) [Y/n/?]

Module unloading (MODULE_UNLOAD) [Y/n/?]

Forced module unloading (MODULE_FORCE_UNLOAD) [N/y/?]

Module versioning support (EXPERIMENTAL) (MODVERSIONS) [Y/n/?]

Source checksum for all modules (MODULE_SRCVERSION_ALL) [Y/n/?]

Module signature verification (EXPERIMENTAL) (MODULE_SIG) [Y/n/?]
Required modules to be validly signed (EXPERIMENTAL) (MODULE_SIG_FORCE)
[N/y/?]

Automatic kernel module loading (KMOD) [Y/n/?]

You want to include support for modules, so answer Yes to the first question
and accept the defaults for the other questions. Notice that a few of the
options are marked EXPERIMENTAL. These questions appear only if you
enabled support for EXPERIMENTAL code at the beginning of the configura-
tion session.

Processor type and features

This set of options is for setting the Subarchitecture Type, the processor
family, and support for specific processor-related features:

*

* Processor type and features
*
Subarchitecture Type
> 1. PC-compatible (X86_PC)
2. AMD Elan (X86_ELAN)
3. Voyager (NCR) (X86_VOYAGER)
4. NUMAQ (IBM/Sequent) (X86_NUMAQ)
5. SGI 320/540 (Visual Workstation) (X86_VISWS)
choice[1l-5]:
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The Subarchitecture Type options enable you to select from different types
of fundamental system designs that make use of the Intel x86 processor
family but that may differ fundamentally from the well-known PC-compatible
machines. Prior to version 2.6, the Linux kernel made an implicit assumption
that the system’s architecture was based on the old IBM PC-AT family. Starting
with kernel version 2.6, you can build the kernel for other types of Intel
x86-based architectures, such as SGI visual workstation and multiprocessor
systems with Non-Uniform Memory Access (NUMA). You probably can select
the default PC-compatible Subarchitecture, but the other options are avail-
able if you have to build the kernel for a different type of x86-based system.

The next set of options prompt you for the processor family:

> 386 (M386)
486 (M486)
586/K5/5x86/6x86/6x86MX (M586)
Pentium-Classic (M586TSC)
Pentium-MMX (M586MMX)
Pentium-Pro (M686)
Pentium-II/Celeron (pre-Coppermine) (MPENTIUMII)
Pentium-III/Celeron(Coppermine) /Pentium-III Xeon (MPENTIUMIII)
9. Pentium M (MPENTIUMM)
10. Pentium-4/Celeron(P4-based)/Pentium-4 M/Xeon (MPENTIUM4)
11. K6/K6-II/K6-III (MK6)
12. Athlon/Duron/K7 (MK7)
13. Opteron/Athlon64/Hammer/K8 (MK8)
14. Crusoe (MCRUSOE)
15. Efficeon (MEFFICEON)
16. Winchip-C6 (MWINCHIPC6)
17. Winchip-2 (MWINCHIP2)
18. Winchip-2A/Winchip-3 (MWINCHIP3D)
19. MediaGX/Geode (MGEODE)
20. CyrixIII/VIA-C3 (MCYRIXIII)
21. VIA C3-2 (Nehemiah) (MVIAC3_2)
choice[1-21]:

0 oUW N

If you select 386, the compiled kernel can run on any other processor (such
as a 486 or any type of Pentium). However, if you're creating a kernel specifi-
cally for your system’s processor, select your processor type from the list.

Subsequent options prompt you for a host of other processor-related options,
which you can leave in their default settings. If in doubt, you can read the help
for each option by pressing ? and select the ones that apply to your system.

Power management options

This set of options deals with managing the system’s power and includes
Advanced Configuration and Power Interface (ACPI), Advanced Power
Management (APM) BIOS support, and CPU frequency scaling. You can
simply accept the default settings for these options. If you don’t understand
what an option means, press ? to get help on that option.
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Bus options

These options ask you about supporting specific buses: PCI, ISA, EISA, MCA,
and PCMCIA. The Industry Standard Architecture (ISA) bus was once the
most widely used bus (until the PCI bus came along); this bus was used in
the original IBM PC-AT. The Micro Channel Architecture (MCA) bus is IBM’s
proprietary bus, which first appeared in the PS/2 PCs. IBM designed this bus
as a high-speed bus, but its proprietary nature kept it from being widely used
in PCs. The Extended Industry Standard Architecture (EISA) bus came about
as an alternative to the MCA bus, with performance comparable to that of
the MCA. The EISA bus is not widely used because the EISA bus peripheral
cards are more expensive than their ISA bus counterparts. The Peripheral
Component Interconnect (PCI) bus is the latest high-performance bus; the
current crop of PCs use the PCI bus, but also offer ISA bus slots so that you
can continue to use ISA cards.

PCMCIA stands for Personal Computer Memory Card International Association,
a nonprofit organization that standardized the interface for adding memory
cards to laptop computers. Although originally conceived for memory cards,
PCMCIA devices became popular for a wide variety of add-ons for laptops.
The PCMCIA devices are called PC Cards, and the term CardBus refers to the
electrical specification of PC Cards.

Typically, you want to build in support for PCI and ISA and build modules
for PCMCIA support. You can also add support for the PCI hot plug if your
system supports adding or removing PCI cards while the system is powered
up and running.

Executable file formats

Turn on the support for Executable and Linkable Format (ELF), which is

the standard format for executables and libraries in Linux. Prior to ELF, the
format for executables was called a.out (based on the default name of the
executable generated by the C compiler). In kernel version 2.6, you can build
a module to support the old a.out format.

Memory technology devices

This category of options provides support for file systems resident on
memory technology devices, such as flash memory and random access
memory. These file systems are often used in embedded devices. This cate-
gory includes a number of options for building kernel modules to support
various memory devices. There is no harm in building the modules because
they are not loaded if your computer doesn’t have the appropriate memory
device.

Book V
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Pavallel port support

These options are important if you use any devices such as printers or paral-
lel port Zip drives connected to the parallel port of your PC. Answer m to the
Parallel port support and PC-style hardware options so that the drivers are
built as modules.

Plug and Play support

These options ask if you want to enable Plug and Play (PnP) support in the
kernel. If you enable PnP support, the kernel automatically configures PnP
devices (just as Windows does). Enable these options.

Block devices

Block devices (such as disk drives) transfer data in chunks (as opposed to
keyboards, which transfer data one character at a time). This set of options
involves the floppy and IDE (Integrated Drive Electronics) devices connected
to the PC’s parallel port as well as other block devices.

*

* Block devices
*

Normal floppy disk support (BLK_DEV_FD) [M/n/y/?]
XT hard disk support (BLK_DEV_XD) [N/m/y/?]
Parallel port IDE device support (PARIDE) [M/n/?]

The first question asks if you want floppy drive support. Because most PCs
do have a floppy drive, your answer generally is Yes. You should press Enter
to accept the default for the third question if you have external CD-ROM or
disk devices that connect through your PC’s parallel port. Some IDE devices
use a parallel port IDE adapter — that’s what the PARIDE option refers to.

The next set of options is for various parallel IDE drivers. You may want to
build in support for parallel port IDE devices through loadable modules.
That way, the modules are there if you need them, but the kernel doesn’t
get bloated with extra code.

Next comes another set of options for block devices. The BLK_DEV_LOOP
option is for a loopback device. Enabling the loopback device lets the Linux
kernel manipulate an entire file system image stored in a single, large file.
This option is useful if you want to mount a CD or DVD image (for example,
a Linux ISO file) and check it out before actually burning the CD or DVD.

The RAM disk support allows the kernel to use a portion of your system’s
memory as a disk capable of storing a file system. Typically, a RAM disk func-
tions only during system startup when the hard drive may not be available
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yet. The RAM disk is essential if you are booting a SCSI disk and you haven’t
compiled the SCSI drivers into the kernel.

ATA/ATAPIMFM/RLL support

The next set of questions involves IDE devices, such as hard drives and
ATAPI CD-ROM drives.

*

* ATA/ATAPI/MFM/RLL support

*

ATA/ATAPI/MFM/RLL support (IDE) [M/n/y/?]
Enhanced IDE/MFM/RLL disk/cdrom/tape/floppy support (BLK_DEV_IDE) [M/n/?]

When you’re configuring an operating system, you have to expect a fair
share of acronyms — this one has four acronyms: ATA, ATAPI, MFM, and RLL.
All these relate to hard drives or the interface that links disk drives to the
PC. Here’s what they mean:

4+ ATA stands for AT Attachment and refers to the PC-AT style interface
that connects hard drives and CD-ROM drives to the PC’s motherboard.

4+ ATAPI stands for AT Attachment Packet Interface and refers to the origi-
nal PC hard drives that integrate the disk controller onto the hard drive
itself. This interface used to be called Integrated Drive Electronics, or IDE.
You typically see the terms IDE, ATA, and ATAPI used interchangeably.

4+ MFM stands for Modified Frequency Modulation, which is the way data
was encoded on older hard drives. These hard drives can work over an
IDE interface.

4+ RLL stands for Run Length Limited, an old technique for storing data on
a hard drive from the early days of the PC. RLL disks can work over an
IDE interface.

The first question asks if you want the kernel to support IDE devices. The
second question asks if you want to use the full-featured IDE device that

can control up to ten IDE interfaces. Because each IDE interface can have a
master and a slave device, this enables Linux to access a total of up to 20 IDE
devices, such as disks or CD-ROM drives. You can press Enter to accept the
default choices of module for both of these options.

The next set of options concerns various IDE drivers. You can accept the
default answers for these options. Note that IDE/ATAPI FLOPPY refers

to IDE floppy drives, such as the lomega Zip drive or the Imation Superdisk
LS-120 drive. The questions about CMD640 and RZ1000 bug fixes refer to
some known problems with specific chipsets used in IDE interfaces.
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SCSI device support

This set of options has to do with SCSI devices. SCSI stands for Small Computer
Systems Interface — a type of interface through which you can connect multi-
ple devices (such as hard drives and scanners) to the PC. If your system has a
SCSI adapter, you should start by answering Yes to the SCST option. After that,
you have to answer questions about the types of devices (disk, tape, CD-ROM)
connected to the SCSI adapter. Finally, you must enable support for the spe-
cific SCSI adapter model on your system.

IEEE 1394 (FireWire) support

The next set of options is for enabling IEEE 1394 support, either as a module
or linked into the kernel. IEEE 1394 is a high-speed serial bus for connecting
peripherals to PCs. Apple calls this bus FireWire; Sony calls it i.Link. IEEE
1394 is similar to USB, but it can transfer data at rates up to 400 Mbps, which
is more than 30 times the data rate of the older USB version 1.1. (Note that
USB 2.0 is much faster; it can transfer data at rates of up to 480 Mbps.)
Because of its high data-transfer rates, IEEE 1394 is ideal for connecting
high-speed peripherals, such as digital audio and video devices and external
hard drives, to the PC.

Currently, Linux supports IEEE 1394 chipsets that are compatible with Texas
Instruments PCILynx/PCILynx2 and OHCI chipsets. If your PC has an IEEE
1394 adapter, you can build the necessary drivers through these options.

*

* TEEE 1394 (FireWire) support

*

IEEE 1394 (FireWire) support (IEEE1394) [M/n/y/?]

To find out more about using IEEE 1394 peripherals in Linux, visit the Web
site of the IEEE 1394 for Linux project at www.1inux1394.org.

120 device support

Pronounced eye-two-OH, 120 refers to Intelligent Input/Output — a new device
driver architecture independent of the operating system and the controlled
device. 120 functions by logically separating the part responsible for manag-
ing the device from the part that contains operating system-specific details.
(The logical separation of the driver’s capabilities is called the 120 Split
Driver model.) The two parts of an 120 driver are the OS Services Module
(OSM), which works with the operating system, and the Hardware Device
Module (HDM) that interfaces with the particular device the driver manages.
The OSM and HDM communicate by passing messages to each other.

Linux comes with some I20 drivers for SCSI and PCI devices. You can build
the 120 drivers through the following configuration options:
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*

* I20 device support
*

I20 support (I20) [M/n/y/?]
I20 Configuration support (I20_CONFIG) [M/n/?]
I20 Block OSM (I20_BLOCK) [M/n/?]
I20 SCSI OSM (I20_SCSI) [M/n/?]
I20 /proc support (I20_PROC) [M/n/?]

Networking support

This set of options deals with networking. How you set these options depends
on how you want to use your Linux system in a network. Always say Yes to
the TCP/IP Networking option because the X Window System uses TCP/IP
networking (even if your PC isn’t on any network). You can also enable
experimental support for IPv6 — the next-generation Internet Protocol.

Answer Yes to the Network packet filtering option if you want to use your
Linux system as a firewall — an intermediary system that controls informa-
tion flowing between a local area network (LAN) and the Internet.

Other categories in the Networking Support options include wireless LAN,
Ethernet (10/100 Mpbs as well as Gigabit), ATM (Asynchronous Transfer
Mode), Token ring, ARCnet, AppleTalk, wide area network (WAN), PCMCIA
network devices, amateur radio, infrared, and Bluetooth. For Ethernet, you
can build support for the Ethernet card installed on your system. This cate-
gory also includes support for wireless networking and drivers for wireless
Ethernet cards. You can also enable experimental support for SCTP —
Stream Control Transmission Protocol — designed to transport public
switched telephone network signaling messages over IP networks (RFC 3758
describes SCTP).

The infrared support is for infrared communication using the protocols spec-
ified by the Infrared Data Association (IrDA). IrDA communication is used

by many laptops and personal digital assistants (PDAs), such as Palm and
Handspring. Many IR interfaces are in the form of dongles — small adapters
that typically attach to the serial port of the PC. You can use the options in
this section to enable support for several common types of dongles.

Bluetooth is a low-power, short-range wireless technology for connecting
devices on the 2.4 GHz frequency band. Devices that use Bluetooth can usu-
ally connect when they are within 10 meters of one another. To find out more
about Bluetooth, visit www.bluetooth. com. Linux supports Bluetooth
through a core driver and several other modules. You can answer y to
enable Bluetooth support and then select other options specific to your
Bluetooth device.
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ISDN subsystem

This set of options enables you to include support for ISDN (Integrated
Services Digital Network) — a digital telephone line that you can use to con-
nect the Linux system to the Internet. These ISDN-related options include
the configuration of specific ISDN adapters.

Build the ISDN driver only if your PC has an ISDN card. If you anticipate
adding an ISDN card and purchase ISDN service from the phone company,
you can build the driver as a module.

Telephony support

With the right hardware and software, the Telephony Support options
enable you to use the Linux system for making phone calls over the Internet
(also known as voice over Internet Protocol or VoIP). You can choose to build
driver modules for telephony support if you have a telephony card, such as
the Internet PhoneJACK or Internet LineJACK manufactured by Quicknet
Technologies, Inc. If you don’t have a telephony card, you can safely leave
these options turned off.

Input devices and character devices

The next few options deal with configuring input devices such as keyboard,
mice, joystick, and touch screens, as well as devices connected to the serial
and parallel ports. These options also include configuration of multiport serial
interface cards that enable you to connect multiple terminals or other devices
to your Linux system. Answer No if you do not have any such devices on your
system. Near the end of the list, you see a question about parallel printer sup-
port (PRINTER). If you plan to connect a printer to the parallel port, answer
Yes to this option.

Watchdog timer

These configuration options enable you to turn on support for the watchdog
timer. Essentially, this causes the kernel to create a special file; failure to open
the file and write to it every minute causes the system to reboot. Some watch-
dog boards can monitor the PC’s status (including the temperature). You can
also enable support for specific watchdog cards from this set of options.

If you want access to the PC’s nonvolatile (battery-backed) memory —
NVRAM — in the real-time clock, answer Yes to the NVRAM option. You can
access the real-time clock by enabling the RTC option.

Floppy tape drive

If you have a tape drive connected to your floppy controller, answer y or m
to the next option and select the other parameters appropriately (or accept
the default choices):
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*

* Ftape, the floppy tape device driver
*

Ftape (QIC-80/Travan) support (FTAPE) [N/m/y/?]

You can also enable several parameters related to floppy tape drives.

Advanced graphics support

The next set of options configures support for advanced video cards that
can perform hardware-accelerated, 3-D graphics. You can enable the first
option to build the AGP (Accelerated Graphics Port) driver and can answer
Yes to the option for your specific chipset.

/dev/agpgart (AGP Support) (AGP) [Y/m/?]

Next, you have to configure a set of options for the Direct Rendering
Manager (DRM) — a device-independent driver that supports the XFree86
Direct Rendering Infrastructure (DRI). DRI is meant for direct access to 3-D
graphics hardware in advanced graphics cards, such as 3Dfx Banshee and
Voodoo3+. To find out more about DRI, use the Web browser to visit the URL
http://dri.freedesktop.org/wiki.

If you have a 3-D graphics card, you can answer Yes to DRM and build the
module for the graphics card in your system. If you do not have one of the
listed graphics cards, you should answer No to these options.

12C Support

I2C (Inter-Integrated Circuit) — pronounced EYE-squared-see — is a protocol
Philips has developed for communication between integrated circuit chips
over a pair of wires at rates between 10 and 100 kHz. System Management
Bus (SMBus) is a subset of the 12C protocol. Many modern motherboards
have an SMBus meant for connecting devices such as EEPROM (electrically
erasable programmable read only memory) and chips for hardware monitor-
ing. Linux supports the 12C and SMBus protocols. You need this support for
video for Linux. If you have any hardware sensors or video equipment that
needs [2C support, answer m (for module) to the [2C Support option and
answer m for the specific driver for your hardware. For example, if you want
to use a BT848 frame-grabber board (to capture video), you should answer m
to I2C, I2C_ALGOBIT, and VIDEO_BT848 options (the [2C_ALGOBIT option
enables support for what is known as the I12C bit-banging interface that the
BT848 board supports).

Multimedia devices

This category of options configures support for multimedia devices such as
video cameras, television tuners, and FM radio cards.

Book V
Chapter 5

|auw1ay] xnury
ay buiziwoysny



48 8 Rebuilding the Kernel

Frame buffer

Through these options you can enable support for frame-buffer devices.

A frame buffer is an abstraction for the graphics hardware so that the kernel
and other software can produce graphical output without having to rely on
the low-level details (such as hardware registers) of a video card. Frame
buffer support is available for many video cards.

Sound

Use this set of options to configure sound card support. If you have a sound
card installed, start by answering m to the Sound Card Support option. After
that, answer m for Advanced Linux Sound Architecture (ALSA) and the sound
devices. You can always build the sound modules for all types of sound cards.
That way, the modules needed for your system’s sound card are available
when needed.

USB support

Use this category of options to configure support for the Universal Serial Bus
(USB) — a serial bus that comes built into most new PCs. USB version 1.1
supports data-transfer rates as high as 12 Mbps — 12 million bits per second
or 1.5MB per second — compared with 115 Kbps or the 0.115 Mbps transfer
rate of a standard serial port (such as COM1). You can daisy chain up to 127
devices on a USB bus. The bus also provides power to the devices, and you
can attach or remove devices while the PC is running — a capability commonly
referred to as hot swapping or hotplugging. USB version 2.0 (or USB 2.0 or
USB2, for short) ups the data-transfer ante to 480 Mbps, slightly faster than
the competing IEEE 1394 (FireWire) bus.

USB can replace the functionality of the PC’s serial and parallel ports, as well
as the keyboard and mouse ports. Nowadays, many PC peripherals — such
as the mouse, keyboard, printer, scanner, modem, digital camera, and so

on — are designed to connect to the PC through a USB port.

If your PC has a USB port, answer m to the Support for USB option (so that a
module is built). Then you have to answer m to the EHCI_HCD, UHCI_HCD,
or OHCI_HCD option, depending on the type of USB interface — EHCI (for
USB 2.0), UHCI (Intel) or OHCI (Compaq and others) — your PC has. To
determine the type of USB interface, type Ispci in a terminal window and
look for the USB controller’s make and model in the output.

For USB 2.0 support, you can answer m to the EHCI_HCD (that’s host con-
troller device) option.

After you select the UHCI or OHCI interface support, you have to build the
driver modules for specific USB devices on your system.
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Through this category of options, you can turn on support for specific types
of file systems. You’d be amazed by the many different file systems that the
Linux kernel can support. (Table 5-1 lists just some of them.) You typically
build a kernel with support for the core Linux file systems (Ext2 and Ext3),
CD-ROM file system (ISO 9660 and Joliet), and DOS/Windows file systems
(MSDOS, FAT, and VFAT). For sharing files with Windows 2000/XP systems,
you also build the module for CIFS.

Table 5-1

Some File Systems Supported by the Linux Kernel

File System

Description

Apple Macintosh

The Macintosh HFS file system. (Linux can read and write Macintosh-
formatted floppy disks and hard drives.)

CIFS The Common Internet File System (CIFS) — a successor to the Server
Message Block (SMB) protocol — is the new file system for Windows
servers such as Windows 2000, Windows XP, and Samba.

Coda An advanced network file system that is similar to NFS but that better
supports disconnected operation (for example, laptops) and is a better
security model

Ext2 The second extended file system — the current standard file system
for Linux

Ext3 Ext2 file system with support for journaling — a facility that allows quick
recovery of the disk after a crash

FAT Refers to any File Allocation Table (FAT)-based file system (including
MS-D0S and Windows 95 VFAT file systems)

HPFS The 0S/2 HPFS file system. (Linux can only read HPFS files.)

1S0 9660 The standard 1S0 9660 file system used on CD-ROMs. (This system is
also known as the High Sierra File System and is referred to as hsfs
on some UNIX workstations.)

Joliet Microsoft's Joliet extension for the ISO 9660 CD-ROM file system, which
allows for long filenames in Unicode format. (Unicode is the new 16-bit
character code that can encode the characters of almost all languages
of the world.)

Minix The Minix file system — the original file system of Linux

MSDOS The MS-DQS file system

NFS Network File System for sharing files and directories from other systems
on a network

NTFS NT file system (NTFS) — the file system used by Microsoft Windows NT
and XP. (Linux can only read NTFS disks.)

/proc A virtual file system through which you can get information about the

kernel. The /proc file system does not exist on the disk; files are cre-
ated when you access them.

(continued)
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Table 5-1 (continued)

File System Description

ReiserFS An efficient file system that stores both filenames and files in a balanced
tree and uses journaling

SMB File system that uses the Server Message Block (SMB) protocol to access
shared directories from networked PCs running Windows 95/98/NT/2000

System V File system used by SCO, Xenix, and Coherent variants of UNIX for Intel PCs

UDF A new file system used on some CD-ROMs and DVDs. (For example, the

UDF file system is used on rewritable CDs written in packet mode or
written by UDF utilities such as DirectCD.)

UFS File system used by the BSD (Berkeley Software Distribution) variants of
UNIX (such as Sun0S, FreeBSD, NetBSD, and NeXTstep).
VFAT Windows 95/98/NT/2000 file systems with long filenames.

Partition types

Linux can read and manipulate disk partitions created by many different
systems. These options enable you to include support for specific partition
types:

*

* Partition Types
*

Advanced partition selection (PARTITION_ADVANCED) [Y/n/?]
Acorn partition support (ACORN_PARTITION) [N/y/?]
Alpha OSF partition support (OSF_PARTITION) [Y/n/?]
Amiga partition table support (AMIGA_PARTITION) [N/y/?]
Atari partition table support (ATARI_PARTITION) [N/y/?]
Macintosh partition map support (MAC_PARTITION) [Y/n/?]
PC BIOS (MSDOS partition tables) support (MSDOS_PARTITION) [Y/n/?]
. lines deleted ...

Native language support

This set of configuration options requires you to select a native language
character set. The Microsoft FAT file systems use these character sets to
store and display filenames in one of several languages. The character sets
are stored in files called DOS codepages. You have to include the appropriate
codepages so that the Linux kernel can read and write filenames correctly in
any DOS partitions on the hard drive. Note that the codepages apply only to
filenames; they have nothing to do with the actual contents of files.

You can include support for as many codepages as you want. Simply answer
Yes to the codepages for your selection of languages.
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Kernel debugging Book V
This set of options enables you to debug the kernel and use the SysRq key D
(equivalent to pressing Alt+Print Screen) to get important status information
right after a system crash. This information is useful if you are a Linux devel- -2
oper who expects to debug the kernel. Most users answer No to disable 5 g
these options (because most users run a stable version of the kernel and do x 3
not expect to fix kernel errors). ? =
=
cE

Security options

Through these options, you can include support for the Security Enhanced
Linux (SELinux), which was developed by the National Security Agency
(NSA) — a U.S. government agency. SELinux comes with Linux, but you
can turn it off during booting by providing selinux=0 as a boot option.
For more information on SELinux, visit www.nsa.gov/selinux.

Cryptography support
This set of options is for enabling cryptography support in the kernel. You
can enable support, as the default selections of the following options show:

*

* Cryptographic options
*

Cryptographic API (CRYPTO) [Y/?] y
HMAC support (CRYPTO_HMAC) [Y/?] vy
Null algorithms (CRYPTO_NULL) [M/n/y/?]
MD4 digest algorithm (CRYPTO_MD4) [M/n/y/?]
MD5 digest algorithm (CRYPTO_MD5) [Y/m/?]
SHA1 digest algorithm (CRYPTO_SHALl) [M/y/?]
SHA256 digest algorithm (CRYPTO_SHA256) [M/n/y/?]
SHA384 and SHA512 digest algorithms (CRYPTO_SHA512) [M/n/y/?]
. lines deleted ...

You can also enable support for some hardware cryptographic devices and
build the modules for a few cyclic redundancy check (CRC) algorithms.

Building the Kernel and the Modules

After configuring the kernel options, you have to build the kernel. This part
can take a while. Depending on your system, making a new kernel can take
anywhere from a few minutes to over an hour.

Type the following on a single line to initiate the process:

make
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The make command creates the new kernel as well as any modules that you
have specified through the configuration step.

As the kernel is built, you see a lot of messages on-screen. When it’s all over, a
new kernel in the form of a compressed file named bzImage is in the arch/
1386 /boot subdirectory of where the kernel sources are located.

To use the new kernel, you have to copy the kernel file and the System.map
file to the /boot directory under a specific name and edit the GRUB menu to
set up GRUB — the boot loader. Before you proceed with the kernel installa-

tion, however, you have to install the modules and build a new initial RAM disk.

Installing the Modules

If you select any modules during the kernel configuration, the kernel-building
step also builds the modules. All you have to do is install them. Perform this
task with the following commands:

cd /usr/src/linux*
make modules_install

The make modules_install command copies all the modules to a new sub-
directory in the /1ib/modules directory. The subdirectory name should be
the same as the kernel version number.

Now you can install the kernel and make it available for GRUB to boot.

Creating the Initial RAM Disk File

The new kernel needs a new initial RAM disk file that you can create by using
the mkinitrd command. Usually, the initial RAM disk image is stored in a
file whose name begins with initrd. As you might have guessed, initrdis
shorthand for initial RAM disk, and the mkinitrd command is so named
because it makes an initrd file.

The mkinitrd program is in the /sbin directory, and you have to log in as
root and use a command line of the following form to create the initrd file:

/sbin/mkinitrd /boot/initrd-filename.img module-directory

The initrd file has to be in the /boot directory where the kernel is also
located. You can use any filename for initrd-filename. The module-
directory is the name of the directory in /1ib/modules where the
module files for the new kernel are located. The make modules_install
step places the modules in a directory whose name is the kernel version
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number. For example, if your kernel version (as reported by the uname -r
command) is 2.6.11, the module-directory;, after the make modules_
install step,is2.6.11.

Another common practice is to use an initrd filename created by appending
the module directory name to the initrd- prefix. Thus, for module directory
2.6.11, the initrdfile would be initrd-2.6.11.1img.

To create the initial RAM disk image for the newly built kernel, type the fol-
lowing command:

/sbin/mkinitrd /boot/2.6.11.img 2.6.11

This command creates the file initrd-2.6.11.img in the /boot directory.
You have to refer to this initrd file in the GRUB menu file (/etc/grub.conf)
in Fedora Core and /boot/grub/menu.lst in Debian and SUSE).

Installing the New Kernel and Setting Up GRUB
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Most Linux distributions use GRUB to load the Linux kernel from the disk.
You have to add the new kernel to the GRUB menu so that GRUB can display
it as an option that you can boot.

In Debian, MEPIS, SUSE, and Ubuntu, the GRUB menu is the /boot/grub/
menu. lst file. In Fedora Core, the GRUB menu is specified by the /etc/
grub. conf file. You should edit the file that applies to your distribution.

Here is a typical GRUB menu file on one of my systems:

default 0

# Set a timeout, in seconds, before automatically booting the default entry
# (normally the first entry defined).

timeout 5

# Ubuntu Linux

title Ubuntu, kernel 2.6.10-5-386

root (hdo0, 4)

kernel /vmlinuz-2.6.10-5-386 root=/dev/hda9 ro acpi=off quiet splash
initrd /initrd.img-2.6.10-5-386

# The next entry automatically added by the Debian installer for an existing
# linux installation on /dev/hdb3.
title Xandros on /dev/hdb3

root (hdl,2)

chainloader +1

# Windows XP

title Windows XP
root (hd0, 1)
chainloader +1
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Here’s what some of the lines in the GRUB menu file mean (the lines that
begin with # are comments):

4+ default 0: Specifies the first boot entry as the default one that GRUB
boots. If this line is set to 1, GRUB boots the second entry (2 means the
third entry, 3 is the fourth, and so on).

4+ timeout 5:Causes GRUB to boot the default entry automatically after
waiting for 5 seconds. If other boot entries are in the file, the user may
select another one from a boot menu that GRUB displays.

4+ The lines starting with title constitute the first boot entry or section
(the next entry begins with another title line), and this entry defines
a specific kernel file GRUB can boot. You can make GRUB boot another
kernel by adding a similar section to the configuration file. Here’s the
meaning of the lines in this boot entry:

e root (hdo,4):Sets the root device to the first logical partition of the
first hard drive. This partition is where the Linux kernel for Ubuntu is
installed on this particular system.

® kernel /vmlinuz-2.6.10-5-386 root=/dev/hda9 ro
acpi=off quiet splash:Identifies the kernel that GRUB loads
if the user selects this boot entry. In this case, the kernel file is
/vmlinuz-2.6.10-5-386, which is located in the root device. In a
Linux system, that partition is typically mounted on the /boot direc-
tory. In other words, GRUB loads the kernel file /boot/vmlinuz-
2.6.10-5-386. The items following the kernel name are options
provided to the kernel. For example, the root option identifies the
partition containing the root filesystem (/).

e initrd /initrd.img-2.6.10-5-386: Specifies a file that contains
an initial RAM disk (initrd) image that serves as a file system before
the disks are available. The Linux kernel uses the RAM disk — a block
of memory used as a disk — to get started; then it loads other driver
modules and begins using the hard drive.

4+ The next section that begins with title is for booting Xandros from the
third partition of the second IDE drive. Xandros uses the LILO bootloader,
and this boot entry uses GRUB’s chainloader command to transfer
control to the LILO bootloader.

4 The next section starting with title Windows XP is the third boot
entry and refers to the Windows XP operating system that happens to
be on this system. The text next to the title line appears in the GRUB
menu from which the user selects which operating system to boot.
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To configure GRUB to boot the new Linux kernel (the one you just built),
follow these steps:

1. Copy the new kernel binary to the /boot directory.

The new, compressed kernel file is in the arch/i386 /boot subdirectory
where the kernel source resides. The kernel filename is usually bz Image.
I simply copy that file to the /boot directory with the same name.

If the kernel filename is vimlinux, make sure you use vmlinux instead
of bzImage. You can change the kernel filename in /boot to anything
you want, as long as you use the same filename when referring to the
kernel in the GRUB menu file in Step 3.

. Copy the new System.map file from the kernel source directory to

the /boot directory.

. Use your favorite text editor to edit the GRUB menu file to add the
